Chapter 1: Getting Started

What is SimVision? .......................................................... 2
Using SimVision to Meet Your Objectives .......................... 2
Benefits of Using SimVision ........................................... 3
Important Terms .......................................................... 4
System Requirements .................................................... 5
Installing and Upgrading SimVision ................................... 5
Authorizing SimVision .................................................... 6
Versions of SimVision in this Release ................................. 6
A Quick Tour of the Interface .......................................... 7
Using the Properties Pane .............................................. 8
Using the Model Pane .................................................. 9
Using the Tree Pane ....................................................... 9
Using Table View ......................................................... 9
Using the Fix Simulator Errors Pane ................................. 9
Shapes and Links .......................................................... 9
Adding Text to Shapes ................................................... 11
Navigating through Linked Shapes ................................. 11
Charts ........................................................................... 13
Positioning and Alignment Toolbars ............................... 14
Getting Help .................................................................... 14
Viewing or Printing the User Guide ................................. 14
Using the F1 Key for Context-Sensitive Help ..................... 15
Reporting Problems ..................................................... 15
Using the Tutorials ....................................................... 15
Defining Requirements .................................................. 16
Defining the Business Objective ...................................... 17
Defining Program and Project Requirements ..................... 17
Defining the Organizations ............................................. 17
Two Steps of Modeling ................................................... 17
Step 1: Building and Validating the Baseline Model .......... 18
Step 2: Comparing “What-if” Cases ............................... 18

Chapter 2: Modeling a Project ........................................... 19
Understanding Models, Programs, Projects, and Cases ........ 20
Understanding the Startup Model .................................... 21
The Default Program ..................................................... 21
The Default Project ....................................................... 22
Viewing the Startup Model in the Tree Pane ..................... 24
Creating Projects ......................................................... 24
Renaming the Default Project ....................................... 25
To rename the default project ........................................ 25
Creating New Projects .................................................. 25
To create a new project ................................................ 25
To delete a project ....................................................... 26
Copying Existing Projects ............................................. 26
To copy an existing project .......................................... 26
Adding Multiple Copies of Objects ............................... 26
To copy objects with the Rubber Stamp tool .................. 27
## Adding Skills
- Defining the Master Skill List
- Defining a Position's Skill Set and Skill Levels
  - To add a new skill to the program
  - To add a skill to a position's skill set
  - To change the level of a position's skill
  - To delete a skill from the master skill list
- Editing a Position's Skill Set
  - To edit a project's skill set
  - To edit a position's skill set

## About Task Interdependence
- Modeling Failure Dependency
- Modeling Information Exchange

## Modeling Rework
- Understanding Rework
- Example of Rework
- Understanding Forward Rework
- Understanding the Verification Failure Probability
- Correcting a VFP Limit Problem
- Understanding Failure Dependency
- Understanding Functional and Project Exceptions
- Responding to Exceptions
- Understanding Types of Work
- Connecting Tasks with a Rework Link
  - To connect tasks with a rework link
  - To connect tasks with a rework link using the rework link shape
- Setting Rework Link Strength
  - To set the strength of a rework link

## Adding Communications Links
- Connecting Tasks with Communications Links
  - To add a communications link between tasks
  - To add a communications link between tasks using the communications link shape
- Setting Task Uncertainty Levels
  - To set task uncertainty level

## Defining Meetings
- Adding a Meeting to a Project
  - To add a meeting to a project
  - To rename a meeting
  - To move a meeting
  - To delete a meeting
- Assigning a Participant to a Meeting
  - To assign a position to a meeting
  - To set the level of meeting attendance for a position
# Chapter 3: Setting Project Properties

To set a project's revenue properties ............................................................................................ 104
To set a project's cost properties .................................................................................................. 104
To set project error probability ...................................................................................................... 102
To set functional error probability.................................................................................................. 101
To set noise probability ................................................................................................................. 101
To set project information exchange probability ............................................................................ 100
To set project centralization ........................................................................................................... 96
To set project formalization ............................................................................................................. 97
To set project matrix strength........................................................................................................... 98
To set project team experience....................................................................................................... 95
To add or delete a project revision .................................................................................................. 92
To associate a business driver with a project.................................................................................. 91
To create a business driver for a project........................................................................................... 90
To set a project’s chart color ........................................................................................................... 89
To set a project's WBS.................................................................................................................... 89
To set a project’s WBS .................................................................................................................... 89
To set the normal work day for a project ......................................................................................... 88
To set the normal work week for a project ...................................................................................... 89
To set meeting properties .............................................................................................................. 81
To set the project name, description, and priority .......................................................................... 88
To set project chart color ............................................................................................................... 89
To set project salary escalators ....................................................................................................... 93
To set project centralization ........................................................................................................... 96
To set project formalization ............................................................................................................. 97
To set project matrix strength......................................................................................................... 98
To set project team experience ....................................................................................................... 95
To set project formalization ............................................................................................................. 97
To set project centralization ........................................................................................................... 96
To set project chart color ............................................................................................................... 89
To set a project’s chart color .......................................................................................................... 89
To set a project’s WBS .................................................................................................................... 89
To set project centralization ........................................................................................................... 96
To set project formalization ............................................................................................................. 97
To set project matrix strength......................................................................................................... 98
To set project team experience ....................................................................................................... 95

© 2005, ePM, LLC.
Checking Task Durations and Responsible Positions ................................................................. 138
  To check a task’s duration ................................................................................................... 138
  To check a task’s responsible position .................................................................................. 138
Checking Milestone Dates ........................................................................................................ 139
  To check milestone dates .................................................................................................. 139
  To check milestone precedence relationships ................................................................. 139
Checking Position FTEs and Allocations .................................................................................. 139

Running Simulations ............................................................................................................... 139
Setting the Number of Simulation Trials .................................................................................. 140
  To change the number of simulation trials ......................................................................... 140
Running the Simulation .......................................................................................................... 140
  To run a simulation ............................................................................................................. 140
Fixing Simulation Errors ........................................................................................................ 141
  To locate simulation errors ............................................................................................... 143
Correcting Baseline Problems ............................................................................................... 143

Working with the Simulation Charts ....................................................................................... 144
Using the Chart Window ........................................................................................................ 144
  To resize the charts and viewing area .................................................................................. 145
Viewing Simulation Charts .................................................................................................... 146
Keeping Track of Charts ....................................................................................................... 148
Filtering Data in Simulation Charts ..................................................................................... 148
  To filter data in simulation charts ..................................................................................... 149
Matching Data Between Charts ............................................................................................ 149
  To match a chart’s settings to another chart ....................................................................... 150
  To make a chart’s settings the default ................................................................................. 150
  To reset a chart’s settings to the original defaults .............................................................. 150
Viewing the Time and Date in Charts ................................................................................... 150

Key Simulation Data Concepts .............................................................................................. 150
Understanding the Critical Path ............................................................................................. 150
  To view the critical path in a program or project ................................................................. 151
Simulated vs. Critical Path Method Results .......................................................................... 152
About Product Risk Metrics ................................................................................................. 152
Understanding FRI and PRI Measurements ....................................................................... 153

Viewing a Post Simulation Analysis ...................................................................................... 154
  To view a post simulation analysis .................................................................................... 155

Chapter 6: Analyzing and Using Simulation Data ............................................................... 157
Finding Information in the Simulation Charts ...................................................................... 158
  The Gantt Charts ................................................................................................................ 158
  The Summary Statistics Charts .......................................................................................... 159
  The Schedule Growth Charts ............................................................................................. 159
  The Breakdown Charts ...................................................................................................... 159
  The Quality Risk Charts ..................................................................................................... 159
  The Backlog Charts .......................................................................................................... 160
  The Resource Charts ........................................................................................................ 160
  The Finance Charts ........................................................................................................... 160
  The Statistics Charts ........................................................................................................ 161
  The Person Work Charts .................................................................................................. 162
The Project Charts ................................................................................................................. 163
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counteracting High Communications Risk</td>
<td>193</td>
</tr>
<tr>
<td>Analyzing Meeting Risk</td>
<td>194</td>
</tr>
<tr>
<td>Analyzing Coordination Risk</td>
<td>195</td>
</tr>
<tr>
<td><strong>Analyzing Backlog</strong></td>
<td>196</td>
</tr>
<tr>
<td>Analyzing Person Backlog in a Project</td>
<td>197</td>
</tr>
<tr>
<td>Reading the Person Backlog Charts</td>
<td>197</td>
</tr>
<tr>
<td>To view a project, organization, department, or person’s person backlog chart</td>
<td>198</td>
</tr>
<tr>
<td>Comparing Person and Position Backlog</td>
<td>199</td>
</tr>
<tr>
<td>Counteracting High Person Backlog</td>
<td>199</td>
</tr>
<tr>
<td>Splitting Tasks</td>
<td>200</td>
</tr>
<tr>
<td>Using Secondary Task Assignments</td>
<td>200</td>
</tr>
<tr>
<td>Examples of Using Secondary Task Assignments</td>
<td>202</td>
</tr>
<tr>
<td>Analyzing Position Backlog in a Project</td>
<td>203</td>
</tr>
<tr>
<td>Reading the Project Position Backlog Chart</td>
<td>204</td>
</tr>
<tr>
<td>To view the position backlog chart</td>
<td>204</td>
</tr>
<tr>
<td>Rescaling the Backlog Charts</td>
<td>206</td>
</tr>
<tr>
<td>To change the time period of the Backlog Charts</td>
<td>207</td>
</tr>
<tr>
<td>To set the number of FTEs on the Backlog Chart’s Y axis</td>
<td>207</td>
</tr>
<tr>
<td>Counteracting High Position Backlog</td>
<td>207</td>
</tr>
<tr>
<td>To check the tasks a position is responsible for</td>
<td>208</td>
</tr>
<tr>
<td>To set task allocation allowing for slack time</td>
<td>208</td>
</tr>
<tr>
<td><strong>Analyzing the Project Resource Charts</strong></td>
<td>208</td>
</tr>
<tr>
<td>Viewing and Manipulating the Resource Charts</td>
<td>208</td>
</tr>
<tr>
<td>To view the Project Resource charts</td>
<td>208</td>
</tr>
<tr>
<td>Example of Resource Demand Analysis</td>
<td>210</td>
</tr>
<tr>
<td>Viewing Staffed and Unstaffed Positions</td>
<td>210</td>
</tr>
<tr>
<td>Viewing the Number of FTEs Available</td>
<td>213</td>
</tr>
<tr>
<td>Viewing Aggregate FTE Availability</td>
<td>213</td>
</tr>
<tr>
<td>Viewing Line Instead of Area Charts</td>
<td>215</td>
</tr>
<tr>
<td>Rescaling the Resource Chart Axes</td>
<td>215</td>
</tr>
<tr>
<td>To change the time period of the Resource Charts</td>
<td>216</td>
</tr>
<tr>
<td>To set a different number of FTEs on the Resource Charts’ Y axis</td>
<td>216</td>
</tr>
<tr>
<td><strong>Analyzing the Project Financial Charts</strong></td>
<td>216</td>
</tr>
<tr>
<td>Analyzing the Project Finance Chart</td>
<td>217</td>
</tr>
<tr>
<td>To view the Project Finance chart</td>
<td>219</td>
</tr>
<tr>
<td>Changing the Time Period or Currency Scales of the Finance Charts</td>
<td>220</td>
</tr>
<tr>
<td>To change the time period or currency scale of the Finance charts</td>
<td>220</td>
</tr>
<tr>
<td><strong>Reading the Project Statistics Charts</strong></td>
<td>221</td>
</tr>
<tr>
<td>Reading the Project Statistics Chart</td>
<td>221</td>
</tr>
<tr>
<td>To view a project’s statistics chart</td>
<td>222</td>
</tr>
<tr>
<td>Reading a Project’s Task Statistics Chart</td>
<td>224</td>
</tr>
<tr>
<td>To view a project’s Task Statistics chart</td>
<td>224</td>
</tr>
<tr>
<td>Reading a Project’s Milestone Statistics Chart</td>
<td>225</td>
</tr>
<tr>
<td>To view a project’s Milestone Statistics chart</td>
<td>225</td>
</tr>
<tr>
<td>Reading a Project’s Position Statistics Chart</td>
<td>226</td>
</tr>
<tr>
<td>To view a project’s Position Statistics chart</td>
<td>226</td>
</tr>
<tr>
<td>Reading a Project’s Meeting Statistics Chart</td>
<td>227</td>
</tr>
<tr>
<td>To view a project’s Meeting Statistics chart</td>
<td>227</td>
</tr>
<tr>
<td>Reading a Project’s Resource Statistics Chart</td>
<td>228</td>
</tr>
<tr>
<td>To view a project’s Resource Statistics chart</td>
<td>228</td>
</tr>
</tbody>
</table>
Chapter 7: Working with Programs ........................................... 243

Understanding Programs .......................................................... 244
Benefits of Programs ............................................................... 244
Program Elements in the Tree Pane ........................................... 245
Program Element Tabs ............................................................. 245

Creating Programs .................................................................... 246
To switch between open programs ........................................ 246
Saving and Naming Programs .................................................. 246
To create, save, and name a program ..................................... 246
Defining Program Milestones .................................................. 246
To add a milestone to a program .......................................... 247
To link program milestones to projects and to each other ..... 247
Using Property Locks ............................................................. 248
To set property overrides ..................................................... 249
To return properties with overrides to their program values .. 249

Setting Program Properties .................................................... 249
To set program properties ..................................................... 251

Linking Projects within Programs .......................................... 253
Defining Project Precedence ................................................... 254
To link projects with a successor link .................................. 254
To switch between projects in a program .......................... 254
Setting Project Successor Link Properties ............................ 254
To set the time lag for a successor project ......................... 255

Implementing Products .......................................................... 255
About Product Completion Phases ......................................... 255
Adding Products to a Program ............................................... 256
To add a product to a program ............................................. 256
Chapter 8: Analyzing Program Simulation Data

The Program Charts

Analyzing the Program Gantt Chart

To expand and collapse the Program Gantt chart

Reading the Program Summary Statistics

To view the summary statistics chart for a program

Analyzing Program Schedule Growth

To view the program schedule growth chart

Analyzing Program Cost and Work Breakdown

To view the program cost and work breakdown charts

Analyzing Program Risk

To view the program quality risk charts

Analyzing Person Backlog in a Program

Analyzing the Program Resource Charts

To view the Program Resource charts

Adding Organization Assignment Links

Adding Ghost Tasks and Milestones

Example of Using a Ghost Milestone

Example of Linking a Ghost Task to Multiple Tasks

Assigning Organizations to Projects

To assign an existing organization to a project

Using Categories

Overriding Locked Categories

Creating, Renaming, and Deleting Cases

To create a new case

To rename a case or change its description

To delete a case

To switch between cases

Modifying Properties Across Multiple Cases

To set properties across multiple cases

Generating a Case Difference Report

To generate a case difference report for two cases

Comparing Case Simulation Data

To filter simulation data by category

To delete a category from the master category list

To apply a category to an object

To add categories to a program

To apply a category to an object

To delete a category from the master category list

To filter simulation data by category

Comparing Case Simulation Data

Generating a Case Difference Report

Modifying Properties Across Multiple Cases

To ensure all objects have unique IDs

Ensuring All Objects Have Unique IDs

To view and modify object IDs

Using Categories

Adding Categories to a Program

To add categories to a program

To apply a category to an object

To delete a category from the master category list

To filter simulation data by category

To generate a project dependency report

To expand and collapse the Program Gantt chart

To view the summary statistics chart for a program

To view the program schedule growth chart

To view the program cost and work breakdown charts

To view the program quality risk charts

To view the Program Resource charts
Analyzing Program Financial Data ................................................................. 288
Reading the Program Statistics Charts ................................................................. 288
Reading a Program’s Statistics Chart ................................................................. 288
To view a program’s statistics chart ................................................................. 288
Reading a Program’s Project Statistics Chart ..................................................... 289
To view the program’s Project Statistics chart ..................................................... 289
Reading a Program’s Organization Statistics Chart .......................................... 290
To view the program’s Organization Statistics chart .......................................... 290
Reading a Program’s Milestone Statistics Chart ............................................... 290
To view the program’s Milestones Statistics chart ............................................ 290
Reading a Program’s Persons Work Report ...................................................... 291
To view the program’s Persons Work Report .................................................... 291
Reading a Program’s Resource Statistics Chart ................................................. 292
To view a program’s Resource Statistics chart ............................................... 292

The Organization Charts .................................................................................. 294
Analyzing the Organization Gantt Chart ............................................................ 295
Analyzing Organization Backlog ........................................................................ 295
Analyzing the Organization Resource Charts .................................................. 295
To view the Organization Resource charts ....................................................... 295
Reading an Organization’s Statistics Chart ....................................................... 296
To view an organization’s Statistics chart ....................................................... 296
Reading an Organization’s Department Statistics Chart .................................... 297
To view an organization’s Department Statistics chart ..................................... 297
Reading an Organization’s Person Statistics Chart ........................................... 297
To view an organization’s Person Statistics chart ............................................ 297
Reading an Organization’s Persons Work Report .............................................. 299
To view an organization’s Persons Work Report ............................................. 299

The Department Charts .................................................................................... 300
Analyzing the Department Gantt Chart ............................................................. 301
Analyzing Department Backlog ......................................................................... 301
Analyzing the Department Resource Charts .................................................... 301
To view the Department Resource charts ....................................................... 301
Reading a Department’s Statistics Chart ......................................................... 302
To view a department’s or subdepartment’s Statistics chart ............................. 302
Reading a Department’s Person Statistics Chart .............................................. 303
To view a department’s or subdepartment’s Person Statistics chart .................. 303
Reading a Department’s Persons Work Report ............................................... 304
To view a department’s or subdepartment’s Person Work Report ..................... 304

The Person Charts ............................................................................................ 305
Analyzing the Person Gantt Chart .................................................................... 306
Analyzing the Person Resource Charts ............................................................. 306
To view the Person Resource charts ............................................................... 306
Analyzing Individual Person Backlog .............................................................. 306
Reading a Person’s Statistics Chart ................................................................. 307
To display a person’s Statistics chart .............................................................. 307

Using the Executive Dashboard ...................................................................... 308
Setting Program Goals ...................................................................................... 308
To set program goals ...................................................................................... 309
Selecting the Cases to Compare ...................................................................... 310
To filter cases for the Executive Dashboard simulation .................................... 310
Chapter 9: Viewing, Sharing, and Printing Model Data ........... 321

Navigating Complex Models .......................................................... 322
Changing the Model View ............................................................... 322
To change the model view .............................................................. 322
Navigating with Object Right-Click Menus ....................................... 322
Model Re-layout ............................................................................ 323
To re-layout a model ...................................................................... 324
Using Layers in a Model ................................................................. 324
To turn layers on and off ............................................................... 327
Selecting Model Elements by Type ................................................ 328
To select model elements by type .................................................. 328
Using Table View ........................................................................... 329
Viewing Properties in Table View ................................................ 329
To display Table View .................................................................... 329
To make changes to properties in Table View ................................. 330
Sorting and Selecting Objects with Table View .............................. 330
To sort data in Table View ............................................................ 330
To sort a subset of objects in Table View ....................................... 330
To select data above or below a specific object in Table View ....... 330
Setting Multiple Object Properties with Table View ..................... 332
To set multiple properties simultaneously in Table View ............. 332
Exporting Table View Data to a Spreadsheet File ......................... 333
To export Table View data into a spreadsheet file ......................... 333
Example of Using Table View to Change a Single Property ........ 334
Example of Using Table View to Change Multiple Properties ....... 335
To change the Uncertainty property of all Business skill tasks .... 335
Sharing SimVision Information ....................................................... 336
Saving Charts as Web Sites ......................................................... 337
To save open charts as a Web site ................................................ 337
Importing Models from Older Versions of SimVision ...................... 339
To save a workspace as a VPX file ............................................... 339
To open VPX files in SimVision .................................................... 339
Sharing Information with Spreadsheet Files ............................... 339
Saving Case Data as a Comma-Separated Text Data File .............. 340
To save simulation results as a CSV file ...................................... 341
Chapter 10: Customizing SimVision .......................... 353

Customizing the Workspace .................................................. 354
  Setting Canvas Size ............................................................... 354
  To set canvas size ............................................................... 354
  Displaying Workspace Elements ........................................ 354
  To show and hide workspace elements ................................. 354
  Arranging Open Model Panes .............................................. 355
  To cascade open Model panes ............................................ 355
  To tile open Model panes .................................................. 356
  To arrange open Model pane icons ..................................... 356
  Using the Grid and Snap ..................................................... 357
  To turn the grid on ............................................................. 357
  To turn the grid on in all new models ............................... 358
  To set grid properties ....................................................... 358
  Customizing Workspace Toolbars ...................................... 358
  To display and hide toolbars ......................................... 359
  To create a new toolbar ............................................... 359
  To customize an existing toolbar .................................. 360
To delete a custom toolbar............................................................................................................ 360
To reset toolbars to their defaults.................................................................................................. 360
Setting General Options ............................................................................................................. 360
To set General options for a model............................................................................................. 360
Setting View Options .................................................................................................................. 361
To change view options for models.............................................................................................. 361
Setting Options for New Models ................................................................................................. 362
To specify the default startup model ........................................................................................... 362
To turn off the company logo display ......................................................................................... 363
To replace the default logo in new models.................................................................................... 363
Setting Options for Symbols ....................................................................................................... 363
To change object symbol appearance .......................................................................................... 364
To turn data blocks off.................................................................................................................. 364
To modify label text properties ................................................................................................... 364
Setting Default Object Properties ............................................................................................. 364
To set default object properties .................................................................................................. 365
Setting Simulation Options ........................................................................................................ 365
To set simulation options ........................................................................................................... 365
Saving the Workspace .................................................................................................................. 366
To save a version of the workspace .............................................................................................. 366
To undock and dock the panes and toolbars .............................................................................. 366
Customizing the Chart Window ................................................................................................ 366
Maximizing the Chart Viewing Space .......................................................................................... 366
To view and hide the Chart Bar.................................................................................................... 366
To view and hide the Tree View ................................................................................................... 367
Changing Chart Icon Order and Size ......................................................................................... 367
To reorder the chart icons ........................................................................................................... 367
To make chart icons larger............................................................................................................ 367
Moving the Chart Bar .................................................................................................................... 367
To move the Chart Bar .................................................................................................................. 367
Customizing Chart Window Toolbars ....................................................................................... 367
To customize Chart Window toolbars ........................................................................................ 368
Saving the Chart View ................................................................................................................. 368
To save a chart view .................................................................................................................... 368
Adding Hyperlinks to Objects .................................................................................................. 369
Adding Hyperlinks ..................................................................................................................... 369
To add a hyperlink to a shape or annotation .............................................................................. 369
To delete a hyperlink from a shape or annotation ...................................................................... 371
Navigating to Hyperlinks ............................................................................................................. 371
Using Templates ........................................................................................................................ 372
Creating Templates ..................................................................................................................... 373
To create a template model ......................................................................................................... 373
To clear template data from a template model ........................................................................... 374
Creating a Model from a Template ............................................................................................. 375
To use a template model .............................................................................................................. 375
Annotating Models ..................................................................................................................... 376
Adding Lines, Boxes, and Ellipses ............................................................................................... 376
To draw a line in a model .............................................................................................................. 376
To draw a box in a model ............................................................................................................. 376
To draw an ellipse in a model ...................................................................................................... 376
To change line properties ............................................................................................................ 376
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Information Form</td>
<td>395</td>
</tr>
<tr>
<td>Program Information Form</td>
<td>394</td>
</tr>
<tr>
<td>Appendix A: Forms</td>
<td>393</td>
</tr>
<tr>
<td>Program Information Form</td>
<td>394</td>
</tr>
<tr>
<td>Project Information Form</td>
<td>395</td>
</tr>
<tr>
<td>Organization Form</td>
<td>398</td>
</tr>
<tr>
<td>Appendix B: Troubleshooting Simulation</td>
<td>399</td>
</tr>
<tr>
<td>Simulation Errors</td>
<td>400</td>
</tr>
</tbody>
</table>

Changing Object Appearance

<table>
<thead>
<tr>
<th>Task</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>To fill a box or ellipse</td>
<td>377</td>
</tr>
<tr>
<td>Using the Visual Model Delineators</td>
<td>378</td>
</tr>
<tr>
<td>Adding Text</td>
<td>378</td>
</tr>
<tr>
<td>To add and manipulate text</td>
<td>378</td>
</tr>
<tr>
<td>To change text properties</td>
<td>379</td>
</tr>
<tr>
<td>Adding Images</td>
<td>379</td>
</tr>
<tr>
<td>To add an image to a model</td>
<td>379</td>
</tr>
<tr>
<td>Adding Revision Blocks</td>
<td>381</td>
</tr>
<tr>
<td>To add a revision block</td>
<td>382</td>
</tr>
<tr>
<td>To add a revision to an existing revision block</td>
<td>382</td>
</tr>
<tr>
<td>To add a hyperlink to a revision block</td>
<td>383</td>
</tr>
<tr>
<td>Generating a Revision Report</td>
<td>384</td>
</tr>
<tr>
<td>To generate a revision report</td>
<td>384</td>
</tr>
<tr>
<td>Adding Legends</td>
<td>384</td>
</tr>
<tr>
<td>To add a model legend</td>
<td>384</td>
</tr>
<tr>
<td>Positioning and Aligning Objects</td>
<td>385</td>
</tr>
<tr>
<td>Moving and Resizing Objects</td>
<td>385</td>
</tr>
<tr>
<td>To move an object by dragging</td>
<td>385</td>
</tr>
<tr>
<td>To resize an object</td>
<td>385</td>
</tr>
<tr>
<td>To reshape a link</td>
<td>385</td>
</tr>
<tr>
<td>To move objects a pixel at a time</td>
<td>386</td>
</tr>
<tr>
<td>Aligning Objects</td>
<td>386</td>
</tr>
<tr>
<td>To align objects horizontally</td>
<td>386</td>
</tr>
<tr>
<td>Distributing Objects</td>
<td>387</td>
</tr>
<tr>
<td>To distribute objects horizontally</td>
<td>387</td>
</tr>
<tr>
<td>To distribute objects vertically</td>
<td>387</td>
</tr>
<tr>
<td>To give objects equal width</td>
<td>387</td>
</tr>
<tr>
<td>To give objects equal height</td>
<td>387</td>
</tr>
<tr>
<td>To make objects exactly the same size</td>
<td>387</td>
</tr>
<tr>
<td>Grouping Objects</td>
<td>388</td>
</tr>
<tr>
<td>To group objects</td>
<td>388</td>
</tr>
<tr>
<td>To ungroup a group</td>
<td>389</td>
</tr>
<tr>
<td>Ordering Objects</td>
<td>389</td>
</tr>
<tr>
<td>To move an object in the draw order</td>
<td>389</td>
</tr>
<tr>
<td>Changing Link Appearance</td>
<td>391</td>
</tr>
<tr>
<td>To change link appearance</td>
<td>391</td>
</tr>
<tr>
<td>Appendix A: Forms</td>
<td>393</td>
</tr>
<tr>
<td>Program Information Form</td>
<td>394</td>
</tr>
<tr>
<td>Project Information Form</td>
<td>395</td>
</tr>
<tr>
<td>Organization Form</td>
<td>398</td>
</tr>
<tr>
<td>Appendix B: Troubleshooting Simulation</td>
<td>399</td>
</tr>
<tr>
<td>Simulation Errors</td>
<td>400</td>
</tr>
</tbody>
</table>

... xv ...
Welcome to SimVision®, the modeling and simulation tool that helps you to engineer and manage projects.

Planning can be tedious. When a project presents itself, most people want to start on it immediately, to tackle it while they’ve got the impulse to do so. SimVision makes project planning easier by allowing you to create a map of the whole process and actively validate and update the map through successive simulations. SimVision helps you break down any project into a series of steps, each of which you can manipulate on-screen to achieve the desired results. Based on extensive research at Stanford and MIT, and hundreds of studies for projects worldwide, SimVision brings you virtual reality modeling that helps you to become a better project manager.

This section covers the following:

- An overview of SimVision’s purpose and application areas.
- A list of the main benefits of using SimVision.
- A list of important terms.
- System requirements.
- How to install and upgrade from previous versions.
- A quick tour of the interface.
- How to get help.
- How to use the tutorials.
- Defining requirements before you begin modeling.
- The two fundamental steps of modeling in SimVision.
What is SimVision?

SimVision is a modeling, project design, and simulation tool that integrates organizational and process views of strategic, time-critical projects. You can use SimVision to build, view, analyze, and refine a case (or instance) of a project, no matter how large and complex, and no matter how aggressive the schedules and performance targets.

The vision behind SimVision is to provide a tool and methods to design an organization the way an engineer designs a bridge, that is, by first creating and analyzing a virtual computer model, and then implementing the organization that has predictable capabilities and known limits.

Using SimVision, you develop a case of your project or projects and run simulations to see project time lines. Simulations also identify risks to development quality, schedule, and cost. Software simulation helps you set up, monitor, and troubleshoot a large project or a program of projects successfully. By altering the SimVision planning components, you can experiment with different solutions to determine which one meets your program quality, cost, and scheduling objectives.

SimVision links a project plan, the responsible organization, and a simulator program that uses discrete event simulation to run the project. The simulator results include information such as the predicted time to complete a project, the total effort to do the project, and several measures of process quality. Using the SimVision charts and reports, you can identify any plan, organization, and performance risks. More detailed case behaviors include the time-varying backlog of individual organizations and the exceptions associated with tasks.

SimVision results are detailed and specific, so they can guide specific managerial changes in a project team and can support studies of the relative effects of different organizational changes.

Using SimVision to Meet Your Objectives

Using SimVision allows you to meet the following universal project management objectives:

- **Conceptualize your work process and organization** in a clear, graphical manner. When several members of a product development team collaborate in building a baseline model, the process helps the team develop a shared mental map of the process.
- **Define project and organization interdependencies** within a program.
- **Clarify task and role interdependencies** among participants in the different projects.
• **Predict project and program risks** to high-level projects and organizations and to lower-level tasks, groups and individual participants. SimVision predicts risks that project participants will become backlogged by a combination of direct work, coordination, rework, and decision wait time. SimVision predicts risks of task, project, and program schedule delay by dynamically simulating participant workloads. It also predicts risks to project and program communication and work process quality.

• **Model and analyze management interventions** to shorten the duration of a program and its individual projects while maintaining the desired product quality and cost. You can investigate the predicted effects on program performance of redesigning work flow, adding or reallocating resources, or adjusting product performance targets to fit time and resource constraints.

**Benefits of Using SimVision**

Using SimVision has the following benefits:

**Pre-project strategic planning**—You can plan projects, considering the tasks and the organization concurrently.

**Goal alignment and consensus building**—Build consensus among project stakeholders about project objectives, risks, managerial contingencies, and significant milestones. Stakeholders can include both groups with direct project responsibilities and other interested parties such as customers and senior executive staff.

**Effective organization design and staffing**—By including position analysis and skill levels, you can put together the team that will meet the product schedule and quality objectives.

**Periodic program and project checkup**—Programs and projects follow a natural growth and completion cycle. In addition, requirements, constraints and opportunities often change. SimVision cases can help you review and manage programs and projects whenever conditions change.

**Process refinement**—Given a baseline project definition, consider the predicted benefits of a number of possible interventions in the management of tasks, positions and the project management style. It may be necessary to scale down technical requirements of the product or to stretch out the desired delivery date to achieve a feasible solution.

**Outsource evaluation**—Outsourcing can often help improve your schedule, quality, and cost performance, but it requires coordination to support the supplier or contractor. Multiple projects are organized into a program and the program
must be coordinated to produce a successful product. SimVision cases can help you plan and manage the way work is distributed among product-development groups.

Risk analysis—SimVision produces data showing the project risks based on your project data.

Portfolio management—Manage a portfolio of projects that have related objectives and compete for limited resources.

Process knowledge communication—SimVision cases can be distributed worldwide using the Internet. Practices that work well once can be reviewed, modified, and reused at different times and locations.

Important Terms
Before you start using SimVision, you should understand the following concepts:

Model—A visual representation of a program and its projects.

Program—A set of related projects that together produce the product or products. A program also includes the associated responsible organizations, milestones, and relationships between projects.

Project—A set of related product development tasks including positions (groups of one or more individuals) that perform tasks and the dependencies between tasks and positions.

Case—A specific instance of a program.

Portfolio—A program of multiple projects.

Pane—An area of the workspace. SimVision has five panes: the Model, Tree, and Properties panes, Table View, and the Fix Simulator Errors and Warnings pane.

Workspace—The area of the application where you work, which contains the Model pane, other optional panes, and the toolbars.

Simulator—Software that simulates the work done by positions as they perform individual project tasks, including both planned direct work and coordination and rework.

Simulation charts—Charts that summarize and provide details of the simulated performance of the program and the individual modeled projects.
Shapes—A set of color-coded objects that represent projects, milestones, tasks, positions, organizations, departments, meetings, ghost milestones, and ghost tasks.

Links—A set of color-coded arrows that represent the relationships between shapes.

Objects—An umbrella term for shapes and links.

System Requirements
To run SimVision, you need the following:

• **Operating system:** Windows 2000 Professional or later, or Windows NT 4.0 recommended.
• **Processor:** 300 MHz required. 500+ MHz recommended.
• **Memory:** 64MB minimum. 96MB RAM with 50 MB disk space recommended.
• **Monitor:** XVGA or better.
• **Browser:** able to view HTML 2.0 or better (Internet Explorer 5.0 or higher is necessary to view online Help).

Installing and Upgrading SimVision
You install SimVision from the product CD ROM, or by downloading it from a protected ePM web site. To download SimVision, you must contact ePM (TechSupport@epm.cc) for the access username and password. Also, we have received reports that some browsers don't handle the required web security well, so please use Microsoft® Internet Explorer.

**To install SimVision from a CD ROM**
1 Insert the CD ROM into your CD drive.
2 If the installation does not start automatically, click Run on the Windows Start menu and type d:\setup.exe, where D is the letter of your CD drive.
3 Follow the on-screen instructions.
4 On the Start menu, click Programs>ePM>SimVision to launch the application.
5 Enter your authorization information and click OK. For authorization information, see “Authorizing SimVision” next.

**To download SimVision from the ePM web site**
1 In Microsoft Internet Explorer, navigate to http://support.epm.cc/Downloads/index.htm.
To upgrade from an earlier version of SimVision

1. Insert the upgrade CD ROM into your CD drive.
2. If the installation does not start automatically, click Run on the Windows Start menu and type d:\setup.exe, where D is the letter of your CD drive.
3. Follow the onscreen instructions.

Authorizing SimVision

Once you have installed SimVision, you need to authorize your copy of the program before you can save a model. You will receive an authorization code by e-mail when you e-mail your product serial number to ePM. Even point release upgrades require a new authorization code. Codes expire on the indicated date.

To authorize SimVision

1. Launch the application.
2. On the Help menu, click Authorize SimVision.
3. Send an e-mail with the serial number you see in the Authorize dialog box to authcode@epm.cc.
4. When you receive the authorization code by e-mail, enter it in the Authorization dialog box and click OK.

Versions of SimVision in this Release

This release of SimVision includes five different versions of the product. The distinguishing factor is the number of projects you can modify. You can tell which version you have by looking in the About box (click About SimVision on the Help menu). The version name is also displayed on the splash screen when you launch SimVision. The five versions are:

- SimVision Portfolio—You can create or modify more than 10 projects.
- SimVision Program—You can create or modify 2-10 projects.
- SimVision Project—You can create or modify a single project.
- SimVision Educational—The attached authorization code determines how many projects you can create or modify. Watermarks appear on all screens and outputs of the SimVision Educational application identifying it as such.
SimVision **Viewer**—You can view previously created projects, but not create or modify projects, or save files or simulation results. Watermarks appear on all screens and outputs similar to the Educational version.

SimVision **Demo**—Same as the Viewer version, except that you can change data values for existing objects and save files and simulation results. However, you cannot create or delete objects.

**A Quick Tour of the Interface**

The SimVision interface consists of standard Microsoft® Windows elements—menus, toolbars, dialog boxes, and windows and their panes. While you’re probably already familiar with how these types of Windows elements work, the sections that follow give you a quick tour of their characteristics in SimVision and introduces you to the various elements—panes, shapes, links, charts, and toolbars. Cross-references indicate where you can get more information on using each feature.

**Panes**

SimVision has five data-display areas, or *panes*. Three of these panes are visible by default: the Model pane, the Tree pane, and the Properties pane. You can display the other two panes—Table View and the Fix Simulator Errors and Warnings pane—using the View or right-click menus. Each pane enables you to perform a
different action on your SimVision model or view different types of information about it. The following illustration shows the panes of the SimVision interface and the sections after describe how to use each pane.

**Model pane**—use to create the model by adding shapes and linking them. The model pane can display program, project, and organization models.

**Properties pane**—use to set properties of the objects in the Model pane.

**Tree pane**—use to view the structure of the program and projects.

**Fix Simulator Errors and Warnings pane**—use to troubleshoot simulations.

**Table View**—use to view and modify properties of multiple objects.

**Using the Properties Pane**

The Properties pane lists all the properties you can set for the object currently selected in the Model pane. If no object is selected, the Properties pane shows the property values for the currently active page—that is, for the program, project, or organization. You can change the value of a property by clicking its Value field, then either typing a new value or selecting one from the field’s drop-down list. For date values, you can use either a date choose (calendar) or a date editor where you type in the date or use the up and down arrows to change the date. What you use depends on the option set in the Options dialog box. See “Setting General Options” on page 360. To enter multiple lines in the Properties pane—for example, for descriptions—press CTRL+ENTER at the end of each line. You can also resize the rows and columns by clicking and dragging in the column header to allow for more text entry.
Using the Model Pane
In SimVision’s Model pane, you place objects to graphically define your program, organization, or project model. Using the shapes available on SimVision toolbars, you can lay out a representation of your work process plan, complete with various types of links to express relationships among parts of the plan. With the tabs along the bottom of the pane, you can switch between the program and its projects and organizations. The bottom row of tabs shows the cases, or instances, of the program you’ve created. For more information on cases, see “Comparing Case Simulation Data” on page 270.

Using the Tree Pane
SimVision’s Tree pane shows you all the objects you’ve created in your model and organizes them by case and shape type. For more information on navigating within the Tree pane, see “Viewing the Startup Model in the Tree Pane” on page 24.

Using Table View
Table View lets you view and edit properties across the current program, project, or organization. For example, you can view all the task work volumes in Project A and change them on the fly. This provides comprehensive control over properties by object type instead of per object, as in the Properties pane. You can dock the pane below the Model pane. For more information, see “Using Table View” on page 328.

Using the Fix Simulator Errors Pane
The Fix Simulator Errors pane lists any errors or warnings that occur in a simulation and lets you navigate to the place in the program where the error arises. You can dock the pane below the Model pane. You can also choose whether to display noncritical warnings as well as errors and critical warnings. Noncritical warnings arise for unusual model situations such as a position being assigned to multiple simultaneous meetings. For more information, see “Fixing Simulation Errors” on page 141.

Shapes and Links
SimVision’s modeling tools include a number of graphical components, or objects, you can use to lay out your project model. Objects you use to represent the work, events, and personnel in your model—such as projects, tasks, milestones, meetings, organizations, and positions—are referred to as shapes. The various means you use to connect shapes to one another to express their relationships are called links. For each of these shapes and links, you can define parameters, or properties.
The following illustration shows the three toolbars of shapes and links. By default, these toolbars are docked between the Tree and Model panes, but you can have them floating or docked anywhere in the workspace. The Annotations toolbar is also docked between the Tree and Model panes by default. See “Annotating Models” on page 376.

You create shapes in your model by clicking a shape tool, then clicking in the Model pane. You create links by right-clicking shapes, selecting the kind of link to create, and choosing another shape to link to. You can quickly create multiple duplicates of shapes and links using the Rubber Stamp tool. See “Adding Multiple Copies of Objects” on page 26.

**Note:** The Person object is an exception, in that persons are not graphically represented as shapes in the model, but as part of a department in an organization. However, persons are still considered as objects. For this reason, this Guide refers to a person as “it” and not “he” or “she.”
Adding Text to Shapes
You can name shapes, or add other text to them to describe their function. You add text to shapes by double-clicking them in the Model pane and replacing the highlighted default name. After typing the text, click elsewhere in the Model pane to apply the text.

![Diagram showing double-click shape to highlight default name, type new name over default name, click elsewhere to apply new name.]

**Tip:** If you experience an orphaned object label—that is, a label with no object attached—you should remove it by selecting it and holding the following keys down simultaneously: `SHIFT+CTRL+ALT+R`.

Navigating through Linked Shapes
Shapes and links have right-click menus that list connected shapes and links. For example, a project’s right-click menu lists the milestones, other projects, and project successor links connected to the project. You can quickly navigate to a connected object by selecting it on an object’s right-click menu. For example, suppose you want to check the work volume of all the tasks a position is
responsible for. You can simply right-click the position, click Tasks, and navigate to each task in turn. When you navigate to a task, its properties appear in the Properties pane and you can check the work volume.
Charts

The following illustration shows the charts that display by default when you run a simulation. These are the program charts. If you select a project, organization, or other object in the Chart Window’s tree pane, the set of charts changes accordingly. For information on the project, milestone, task, position, and meetings charts, see “Analyzing and Using Simulation Data” on page 157. For more information on program, organization, department, and person charts, see “Analyzing Program Simulation Data” on page 275.

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gantt chart</td>
<td>Displays projects, tasks, and milestones in rows with duration represented as color-coded bars.</td>
</tr>
<tr>
<td>Schedule Growth</td>
<td>Displays the tasks or projects at greatest risk of taking longer than planned.</td>
</tr>
<tr>
<td>Quality Risk</td>
<td>Shows the tasks or projects at greatest risk of exception-handling failures.</td>
</tr>
<tr>
<td>Breakdown Charts</td>
<td>Display the cost and work breakdown for each project or task.</td>
</tr>
<tr>
<td>Person Backlog</td>
<td>Shows the backlog for each person in the model, which indicates predicted overload of positions over time.</td>
</tr>
<tr>
<td>Resource Charts</td>
<td>Show the FTE utilization and demand across all projects.</td>
</tr>
<tr>
<td>Finance Charts</td>
<td>Show accumulated cost and revenue values for the program.</td>
</tr>
<tr>
<td>Summary Statistics</td>
<td>Displays a summary bar graph for program or project statistics such as simulated duration and cost.</td>
</tr>
<tr>
<td>Statistics Charts</td>
<td>Display a summary grid for program or project statistics, such as the percentage of staffing.</td>
</tr>
</tbody>
</table>
Positioning and Alignment Toolbars

The following illustration shows the positioning and alignment toolbars in SimVision and briefly describes what each tool is for. For more information on using these toolbars, see “Positioning and Aligning Objects” on page 385.

Getting Help

SimVision features a User Guide that leads you through using the product to build, analyze, and refine a model. You can view the User Guide as an online Help system within the SimVision application, or print a PDF version of the Guide from the Documents folder included with the application (the filename is UserGuide.pdf). The printable PDF version is identical to the online Help, except that Help contains three extra reference sections listing all of SimVision’s properties, menu items, and dialog box options.

Viewing or Printing the User Guide

You can view the User Guide online as a Help system or in printable PDF format.

To access the User Guide

1 To access the online Help version, click Help on the SimVision Help menu.
Using the F1 Key for Context-Sensitive Help

You can get help specific to any workspace element, property, dialog-box, or simulation chart by clicking F1 while your cursor hovers over the element. For help on model objects and properties, you must select the object or property and press F1. For help on the Work Volume Calculator or the Fix Simulation Errors and Warnings dialog box, you must select something in the dialog box and press F1. Otherwise, the help topic that appears will be general to the pane in which the object or property resides, or to panes themselves.

To get context-sensitive help

1. For help on an area of the workspace, hover the cursor over the item and press F1.
2. For help on a dialog box, open the dialog box and press F1.
3. For help on a model object or property, select the object or property and press F1.
4. For help on the Work Volume Calculator or the Fix Simulation Errors and Warnings dialog box, select something in the dialog box and press F1.
5. For help on a simulation chart, click in the chart to make it current and press F1.

Reporting Problems

Should you locate a problem in SimVision’s functionality, please report it using the form as described next.

To report a bug

2. Type the bug description on the supplied Web form, including as much detail as possible.
3. Click Submit.

The bug report is e-mailed to SimVision support staff.

Using the Tutorials

SimVision has three tutorials to help you learn how to build and analyze models. The tutorials are aimed at different levels of SimVision users and each focuses on a different aspect of modeling. Use the tutorials as follows:
### Tutorial, Proficiency Level, Purpose

<table>
<thead>
<tr>
<th>Tutorial</th>
<th>Proficiency Level</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fundamentals of Modeling</td>
<td>Beginner</td>
<td>Build a simple, single-project model from the ground up; make interventions to meet program schedule and cost objectives; model simple bonus/penalty financial data.</td>
</tr>
<tr>
<td>Schedule-Constrained</td>
<td>Intermediate</td>
<td>Examine and refine a multi-project model; import organizations from a CSV file; staff the projects; reduce schedule by adding resources and reusing information.</td>
</tr>
<tr>
<td>Finance</td>
<td>Advanced</td>
<td>Work with portfolio of projects; meet program objectives by adding resources and fixing skill mismatches; analyze program’s return on investment; examine and manipulate program financial data.</td>
</tr>
</tbody>
</table>

You can find PDF files of the tutorials in the `documents` folder on your SimVision CD or, after a standard SimVision installation, in `C:\Program Files\ePM\SimVision\documents`. You can find the pre-built models required for the tutorials in the `models` folder on your SimVision CD or in `C:\Program Files\ePM\SimVision\models\tutorials`.

### To use the tutorials

1. In the `documents` folder on your SimVision CD or standard installation, double-click one of the following tutorial files:
   - Fundamentals Tutorial.pdf
   - Schedule-Constrained Tutorial.pdf
   - Finance Tutorial.pdf

   The tutorial file opens in Acrobat Reader. (If you don’t have Acrobat Reader, you can download it free from www.adobe.com.)

2. In Acrobat Reader, print the tutorial if required by selecting File>Print and then clicking OK in the Print dialog box.

3. The tutorials contain instructions on where to find the required models. To open a tutorial model in SimVision, double-click the model file in the `models` folder on your SimVision CD or standard installation.

### Defining Requirements

Before you begin constructing your SimVision model, you should have a clear sense of your business objectives and clear documentation of your organizational structure. Knowing what you need to accomplish with your model will make the modeling process much more productive and will ensure an effective plan.
Defining the Business Objective
Before building a SimVision case, it is essential that the modeling team spend time to get a clear understanding of the business objectives and the trade-offs among them for this project. It might help if you ask yourself these questions:

- What tangible benefits do you hope to achieve through successfully completing this project?
- Why is your organization undertaking the project?
- If the project represents a new product development effort, what is special about the new product?
- Is your business strategy achieving product differentiation, matching features with a competitor’s product, or producing the most value for money?
- How important is maximizing the product’s level of unique technical performance?
- Is product time-to-market as important as maximizing the performance level of specific technical features?
- What are the worst-case threshold values for the product’s technical performance, time-to-market, and cost? Worst-case values would render the product uneconomical and mean canceling the project.
- What are the possible trade-offs between time-to-market and cost? For example, “delivering the product to market a day earlier is worth $2 million.”
- What are the possible trade-offs for achieving greater levels of technical performance?
- How important is quality?
- What sort of information should this modeling effort produce to eventually help drive decision-making?

Defining Program and Project Requirements
Before building a SimVision case, it’s important to identify key information for the program and each of its projects, such as start and finish dates and major milestones. To help capture this information, as well as to understand what information to look for, you can use the “Program Information Form” on page 394 and the “Project Information Form” on page 395.

Defining the Organizations
Use the “Organization Form” on page 398 to map out the organizations in the program, listing their departments and subdepartments.

Two Steps of Modeling
There are two main steps involved in using SimVision to manage your projects. To ensure that your models accurately reflect the conditions of the projects you’re planning, you should perform both of these steps for each project you create.
Step 1: Building and Validating the Baseline Model

Step 1 involves creating a basic model of your projects and organizations, including a small number of major tasks, milestones, and positions, and assigning the tasks to the positions. The baseline model is a preliminary model that meets your most important performance requirements.

The baseline is actually the first case, or instance of a program. You usually model several cases of a program, which allows you to compare cases with different characteristics until you find the most favorable outcome. For more information on using cases, see “Comparing Case Simulation Data” on page 270.

Like any model, the baseline contains a network of SimVision graphical components, or shapes. You begin with only certain shapes and basic connections, or links, between them. The shapes you start with are tasks, milestones, and positions. You then use links to connect the milestones and tasks to one another and to assign positions to tasks. For each of these shapes and links, you allocate only basic parameters, or properties, then run a simulation in order to validate the model. The baseline still shows only the direct work, or work that positions do on a task the first time through, so then you update the model with the information you have available, such as the amount of rework and communication required, the meetings, and the probabilities of errors and noise.

Evaluate the baseline model, and use the SimVision simulator to chart the projected results. Compare the results to the performance requirements and identify areas where the preliminary solution is inadequate.

Tip: It is always easier to add detail to your model than to remove it. For your Baseline case, start with only the most basic network of shapes to accomplish the project’s goals. You can then add detail to flesh out those areas of the model that require more depth.

Step 2: Comparing “What-if” Cases

The second step in modeling is iterative. Continue to generate new cases, making interventions in the model in each, until you find a configuration that is feasible and achieves the best trade-off among the various performance requirements. See “Running Simulations” on page 137 and “Analyzing and Using Simulation Data” on page 157.
CHAPTER 2

Modeling a Project

Once you have defined the requirements of the project you wish to model, you can begin laying out SimVision objects to build the model. Typically, you start a model by creating a single project that contains only basic components. (Some versions of SimVision allow for only a single project, some for more than one.)

The recommended strategy for modeling a project is as follows:

• Create and name the project.
• Define important project milestones.
• Define the proper number of tasks for your project.
• Define positions—managers and small technical subteams.
• Connect the tasks to the milestones to specify precedence.
• If necessary, connect positions to one another to define their supervisory hierarchy. This is for information flow, not a reporting hierarchy.
• Assign positions to the tasks.
• Add a master skill list and assign skills to positions and tasks.
• Add rework links between tasks.
• Add communications links between tasks.
• Define meetings and assign meeting participants.
Understanding Models, Programs, Projects, and Cases

Before you begin constructing a SimVision model of your project, it’s helpful to understand how SimVision defines models, and the difference between a program, a project, and a case.

A model is the graphical representation of a program. Programs contain one or more projects and organizations. A case is a specific instance of a program, and allows you to capture iterations of a model and analyze the effect of the changes in each iteration.

The hierarchy of programs, cases, projects, and organizations is best illustrated by the Tree pane. For example, in the following illustration the ABC Company Demo program has six cases, each with the same six projects, four program milestones, and two organizations. The case names indicate what factors changed in each case.

You can switch between cases, projects, and organizations using the tabs under the Model pane. You can also use the Navigate menu for this purpose. The menu is useful when you have so many projects and organizations in a program that you have to scroll among their tabs under the Model pane.

This Guide covers creating and simulating a project, then explains how to link multiple projects within a program and assign organizations to the projects.
Understanding the Startup Model

When you first launch SimVision, the Model pane may display a default startup model. Whether it displays this model, opens empty, or displays the previously opened model depends on a setting in the Options dialog box. See “Setting Options for New Models” on page 362. The default model consists of a program with Start and Finish milestones and a single default project called Project1.

The Default Program

The default program has a title, which you can customize by clicking and retyping, and a default company logo (ePM), which you can augment or replace with a custom logo. See “Setting Options for New Models” on page 362. There is a
default case, called Baseline. The default project has a tab (the Project1 tab beside the Program tab), which you can click to see the project pane and the default project elements.

The Default Project

The default project can be empty or it can contain default objects, depending on a setting in the Options dialog box. See “Setting Options for New Models” on page 362. You view the project by clicking the Project1 tab at the bottom of the Model pane. The project pane displays, and if it contains default objects it looks like the following illustration.
The default project objects are:

- A default logo and title. These are independent of the program logo and title but can be similarly customized.
- Default Start and Finish milestones.
- A default position, meeting, and task.
- Horizontal blue bars used as annotations to visually delineate the areas of the model. For example, in complex models these bars can be very helpful for separating positions, meetings, and tasks. For more information, see “Using the Visual Model Delineators” on page 378.
Viewing the Startup Model in the Tree Pane

The Tree pane, when you expand its contents by clicking the plus signs beside the object names, displays all the elements in the startup model, as shown in the following illustration.

The Tree pane’s object hierarchy operates similarly to the folder hierarchy in Windows Explorer, with some added features. Clicking a “+” sign next to an object’s name, or double-clicking the object, expands the list of shapes within that object or shows a list of shapes of that object type; clicking a “−” sign, or double-clicking the object again hides the list. Clicking a shape in the Tree pane selects that shape in the Model pane. If the program, project, or organization to which that shape belongs is not currently visible in the Model pane, clicking the object opens the appropriate page. For example, if the program page is displayed and you click a position in the Tree pane, the position’s project page displays in the Model pane.

Right-clicking an element in the Tree pane centers that element in the Model pane. This is a useful way of navigating complex models. For example, if a project has forty tasks spread widely across the Model pane so that scrolling is required to view all the tasks, you can focus on a specific task by right-clicking it in the Tree pane.

Creating Projects

In SimVision, a project is a set of graphical objects that represent the work process performed by members of one or more organizations to achieve a key business milestone. Each project is composed of tasks, milestones, positions, meetings, and the links among these objects.
Creating Projects

Because building the initial baseline model does not usually require setting project properties, this section describes only the basics of dealing with projects—creating and deleting them. For more information on setting project properties, see “About Project Properties” on page 86.

You can create your initial project by renaming the default project in the startup model. Create subsequent projects by adding new ones or making copies of existing ones.

Renaming the Default Project

You can create your first project by simply renaming the default project in the startup model, if there is one. First, you need to save and name the program.

To rename the default project

1. On the File menu, click Save As and save and name the program’s .vpm file.
2. In the Model pane, make sure the Program page is selected.
   The default program shows Start and Finish milestones and a default project, Project1.
3. Select the project shape.
   The project’s properties appear in the Properties pane.
4. Type a new value for the project’s Name property.
5. To apply the name, click elsewhere in the Model pane.

Creating New Projects

You create new projects by clicking the Project button on the Program Shapes toolbar and clicking within the Model pane to place the project shape. You can set properties for each project in the Properties pane. For more information, see “About Project Properties” on page 86. Whether new projects are empty or contain default elements depends on a setting in the Options dialog box. See “Setting Options for New Models” on page 362.

You can delete a project by selecting it and pressing DELETE. If you press CTRL+DELETE, you also delete all links associated with the project.

To create a new project

6. In the Model pane, click the Program tab.
7. In the Program Shapes toolbar, click Project.
8. In the Model pane, click where you want to place the new project.
The project appears in the Model pane. The project also appears in the Tree pane, and the Project properties appear in the Properties pane.

9 Double-click the project to highlight its default name.
10 Type a new project name.
11 To apply the name, click in the Model pane outside the shape.

Tip: You can also add or change a project’s name by selecting the name in the Properties pane and typing a new name.

To delete a project
1 In the Model pane, select the Program tab.
2 Also in the Model pane, select the project to delete.
3 Click DELETE.

The project and all its components are deleted.

Copying Existing Projects
You can save a lot of time by copying existing projects and then making appropriate changes. When you copy a project, the new project contains all the same elements. A new tab is created for the copied project. You can rename the copy on the Program page.

To copy an existing project
1 On the Program page of the Model pane, right-click the project to copy.
2 On the right-click menu, click Copy.
3 Right-click elsewhere on the Program page and click Paste.

The copy appears, initially with the same name as the original. A new tab for the copied project appears at the bottom of the Model pane. If you click this tab, you can see all the elements of the copied project on its page.

4 To rename the copied project, double-click the project on the program page and change the name.

Adding Multiple Copies of Objects
Many models require a large number of tasks, positions, or other shapes. With the Rubber Stamp tool, you can add multiple copies of the same shape or link at once. Clicking this tool (or pressing CTRL+R) and then clicking a shape or link button
enables you to place multiple duplicates of that shape or link in the Model pane. Simply clicking in the pane at each spot you want to place the shape puts a duplicate at that spot.

To copy objects with the Rubber Stamp tool

1. On the Model toolbar, click Rubber Stamp.
2. On the appropriate Shapes toolbar, click the shape or link you want to add.
3. In the Model pane, do one of the following:
   - To place multiple duplicates of a shape, click once for each object duplicate you want to create. The shapes are placed wherever you click. You can move them after you exit the Rubber Stamp tool.
   - To place multiple duplicates of a link, click the connecting point of one shape, then a connecting point of a second shape, for each link duplicate you want to create.
4. To finish placing object duplicates, click the Rubber Stamp again to de-select it, or press ESC or CTRL+R again.

Defining Milestones

SimVision’s milestones are shapes you use to mark where a segment of a program or project is completed, or where a key event occurs. Your business objectives should determine the milestones you define in a project or program, and you should use each milestones to indicate a specific business event, such as Contract Issued, Design Released, or Quality Test Passed. As goals to meet in a project or program, milestones provide the anchors for your models.

Adding Milestones to a Project

In any model, you create the most important project milestones for each of the projects. Very often, you create several projects, each with the proper number of milestones and tasks to adequately express the project’s goals. In the baseline model, you should begin with the 3-5 most important milestones for each project (in addition to the default Start and Finish milestones), though you can start with fewer or more. It can be helpful to begin by renaming the Start and Finish milestones, then adding as many new milestones as the project requires. You can quickly place multiple milestones with the Rubber Stamp tool.

It’s a good idea to spread milestones out both vertically and horizontally, as shown in the following illustration. It is also good practice to add milestones below the bottom blue annotation bar. The bars are provided to help visually separate areas of the model. Meetings are typically added between the bars and
positions above the top one. Although the location of model elements does not affect the simulation, we advise striving for a balanced visual layout that conveys the model's message and allows you to navigate it with ease.

At any time, you can rename, move, or delete milestones. When you physically move a milestone shape, it remains linked to its tasks and other milestones. To link a milestone to different tasks or milestones, you must move the appropriate links. When you delete a milestone, you also need to delete any links attached to it, unless you are moving the links to another task or milestone.

**To rename the Start and Finish milestones**

1. In the Model pane, double-click the Start or Finish milestone.
2. Type the new name. If the name's length exceeds the width of the shape, the text wraps vertically.
3. Click elsewhere to apply the name.

**To add a milestone to a project**

1. In the Model pane, display the project.
2. In the Project Shapes toolbar, click Milestone.
3. Click in the Model pane to place the milestone.
4. Double-click the milestone icon and type a name for it. If the name’s length exceeds the width of the shape, the text wraps vertically.
The milestone name appears as a label in the Model and Tree panes and in the Properties pane.

**To rename a milestone**
1. Double-click the milestone to rename.
2. Type the new name.
3. Click elsewhere to apply the name.

**To move a milestone**
- Drag the milestone to a new location in the Model pane.

Any links to the milestone stay connected and follow the milestone to its new location.

**To delete a milestone**
1. In the Model pane, select the milestone to delete.
2. Move any links associated with the milestone that you want to keep as links.
3. Press CTRL+DELETE to delete the milestone and all associated links.

**Relative and Absolute Milestones**
For each milestone, you can set a date by which you expect the project’s participants to reach the milestone. This date is the milestone’s **planned date**. You can choose a calendar date as a milestone’s planned date (an **absolute** planned date), or you can make the date dependent on a previous milestone’s completion (a **relative** planned date).

It is often useful to specify absolute planned dates for all milestones. The management team should specify the expected program and project start dates. For intermediate and final milestones, the planned dates describe important, sometimes crucial, business objectives. If you don’t specify an absolute planned date, the assumed program start date is the current date.

Relative milestones take place a certain length of time after a previous milestone has occurred. You can select which milestone in your model you want the current milestone to start after, and you can set how long after the previous milestone you want the current milestone to start. The length of time that you want to pass before the current milestone occurs is the milestone’s **lag**.

For example, if a Manufacturing milestone must occur one day after a Specification milestone, you would set Manufacturing’s planned date as relative to Specification with a lag of 1 day. The default lag is zero, which means the predecessor and successor milestones occur at the same time.
Absolute milestones are planned to finish on the date you specify, independent of any other milestone. SimVision does not alter absolute milestones during the simulation. Use absolute planned dates only for those events that must occur on a certain date due to factors beyond your control, such as a project team’s attendance at a conference, or a product’s completion for an industry trade show.

The program and project Gantt charts show planned milestone dates as green diamonds. If a milestone has a relative planned date, its green diamond is at the same date as the project or program start milestone.

If a milestone has an absolute planned date, you can compare the CPM (Critical Path Method) and simulated dates with the absolute date in the Gantt chart. Simply compare the gray and black diamonds with the green diamond.

### Setting Milestone Properties

As with all shapes, you can set a number of properties for each milestone you place in the Model pane. For each milestone, you can set the following properties:

- **Name**—Milestone names can contain any combination of text, numbers, and punctuation.
- **Description**—A more complete explanation of what the milestone is for. The description displays in the Milestone Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.
• **Planned Date**—The date the modeler expects the milestone to be completed. See “Relative and Absolute Milestones” on page 29.

• **Lag**—The length of time after the start of the previous milestone that this milestone should start. Lags apply to relative milestones only. See “Relative and Absolute Milestones” on page 29.

• **Fixed Cost**—The non-labor cost of the milestone, such as interest or fees, expressed in terms of thousands of currency units.

• **Fixed Revenue**—Any revenue that the milestone generates, expressed in terms of thousands of currency units.

• **Penalty Rate**—Any financial penalty that missing the planned milestone date will incur. You can choose whether the penalty amount is incurred per minute, hour, day, week, or month. For example, a space exploration project’s Rocket Launch milestone might incur a penalty for every day beyond the planned rocket launch date that the rocket fails to launch. The milestone must have a planned date attached for this value to take effect. See “Relative and Absolute Milestones” on page 29.

• **Bonus Rate**—Any financial bonus that hitting the planned milestone date early will generate. You can choose whether the bonus amount is incurred per minute, hour, day, week, or month. For example, a space exploration project might generate a bonus for every day earlier than the planned rocket launch date that the rocket launches.

• **Actual Cost**—A placeholder value for comparing actual to projected costs for the milestone. This value is ignored by the simulator but appears in the Milestone Statistics form.

• **Actual Revenue**—A placeholder value for comparing actual to projected revenue for the milestone. This value is ignored by the simulator but appears in the Milestone Statistics form.

• **WBS**—The Work Breakdown Structure scheme for the milestone. You can sort milestones by WBS in the Gantt and statistics charts and in Table View. To allow for sorting, you cannot mix alphabetic and numeric characters within a single field of the WBS. For example, “17.25.BD” is a valid WBS but “17A.1B” is not. You can choose a separator for the scheme, for example periods or dashes, at the program level. See “Setting Program Properties” on page 249.

• **Chart Color**—The color that represents this milestone in the simulation charts. You can change the default color of each milestone.

• **Categories**—The category, if any, to which the milestone belongs. For more information, see “Using Categories” on page 271.

• **Hyperlinks**—You can add one or more hyperlinks to a milestone to link it to a URL or file. For example, you might link to a document describing the business objectives that drive the milestone date. For more information, see “Adding Hyperlinks to Objects” on page 369.
To set milestone properties

1. In the Model pane, select the milestone for the project. The milestone’s properties display in the Properties pane.

2. To change the name, click in the Name property, select the old name and type a new one. To see the new name in the Model pane, click the renamed milestone, or anywhere else in the Model pane.

3. To add a description, click in the Description property and type a brief description of the milestone.

4. To set the planned date, select either Relative or Absolute in the Unit field and do one of the following:
   a. For a Relative planned date, click the Planned Date’s Value field and select a milestone from the list (you must select a milestone that occurs previous to the current one).
   b. For an Absolute planned date, click the Planned Date’s Value field. The current completion date appears. Click the portion of the date you want to change (day/month/year) and click the up and down arrows to change it. You can also select the date portion and type over it.

5. To set the lag, click the Units field and select the unit of time you want to use (minutes, hours, days, weeks, or months). Under Value, enter the number of time units for the lag.

6. To set a fixed cost, enter an amount. The amount is measured in generic currency units. Although the fixed cost is a negative amount in terms of project finances, the minus sign is assumed.

7. To set a fixed revenue, enter an amount. The amount is measured in generic currency units.

8. To set a penalty rate, enter the amount of the penalty. Do not use a comma or a currency symbol. Under Units, select whether the penalty will be incurred by the minute, hour, day, week, or month.

9. To set a bonus rate, enter the amount of the bonus. Do not use a comma or a currency symbol. Under Units, select whether the bonus will be incurred by the minute, hour, day, week, or month.

10. To associate an actual cost with the milestone, enter the amount. Do not use a comma or a currency symbol. The amount is measured in generic currency units.

11. To associate actual revenue with the milestone, enter the amount. Do not use a comma or a currency symbol. The amount is measured in generic currency units.

12. To define the milestone WBS, enter alphanumeric characters separated by the separator defined for the program. See “Setting Program Properties” on page 249. To allow for sorting milestones by WBS, do not mix alphabetic and numeric characters within a single field of the WBS.

13. To change the color that identifies the milestone in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.
14. To assign a category to a milestone, or change its category, click the lock by the Categories property to open it and indicate that the milestone category overrides the project category. Then click Edit by the Categories property, select a category in the Categories dialog box, and click OK.

15. To add a hyperlink to a milestone, click Edit by the Hyperlink property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.

16. To delete a hyperlink from a milestone, click Edit by the Hyperlink property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.

**Defining Tasks**

Once you’ve defined a framework for your model with milestones, you can flesh out the plan by adding tasks. Where milestones give you an overview of the project, tasks fill in necessary details, providing the steps to accomplish each milestone. To add tasks to the baseline model, you normally do the following:

- Add about 1-10 tasks for each milestone (although a milestone doesn’t have to have any tasks associated with it).
- Connect the tasks to each other with successor links.
- Connect the tasks to the milestones, from first to last, in sequence.

**Understanding Tasks**

A task is a job performed by a position in a project—that is, a task represents work done by an individual or group of individuals. Tasks usually have relationships to one another. One task may need to follow or precede another, for example, or they may need to occur in parallel. Tasks can occur fully in parallel—that is, they start and finish at the same time—or partly in parallel—that is, they occur simultaneously for only part of their respective durations.

You set how tasks relate to one another (and to milestones) by connecting them with *successor links*. Successor links determine which tasks succeed, or follow, other tasks or milestones. Among other properties, you can set a task to have a time lag relative to a milestone or another task via a successor link (the lag indicates that the task starts a certain length of time after the other event starts or finishes). For more information on successor links, see “Linking Tasks and Milestones” on page 56.
You can link tasks only forward in time in a project. Linking a task to another task that occurs before it in time causes illegal loops in the simulation. For example, the following illustrations show legal and illegal arrangements of tasks.

Adding Tasks to a Project
For the baseline model, add 1-10 tasks for each of the milestones you’ve defined. Since you may have a number of tasks to add at once, you can add duplicates using the Rubber Stamp tool. For more information, see “Adding Multiple Copies of Objects” on page 26.

Once you’ve added a task to the model in the Model pane, you can rename it, move it, and delete it. When you physically move a task shape, it remains linked to any other tasks, milestones, and positions it is connected to. To assign a task to a different position, or give it a different predecessor or successor, you must move the appropriate links. When you delete a task, you also need to delete any links attached to it, unless you are moving the links to another task.

You may find the best way to place tasks in the Model pane is to lay them out from left to right according to how they occur in time, below the lower blue annotation bar. Using this method, you place the first task to the right of the Start milestone and continue placing subsequent tasks to its right, leading towards the Finish milestone. Once you’ve added a number of tasks—those leading up to a certain milestone, for example—you may also find it easiest to then name each one, then go back and set their properties. For more information on setting task properties,
The following example shows some tasks placed in a model to fulfill the first milestone for a software development project.

To add a task to a project
1. In the Model pane, display the project.
2. In the Project Shapes toolbar, click Task.
3. Click in the Model pane to place the task.
4. Double-click the task icon and type a name for it.
   The task name appears as a label in the Model and Tree panes and in the Properties pane.

To rename a task
1. Double-click the task to rename.
2. Type the new name.
3. Click elsewhere to apply the name.

To move a task
- Drag the task to a new location in the Model pane.
  Any links to the task stay connected and follow the task to its new location.

To delete a task
1. In the Model pane, select the task to delete.
2. Move any links associated with the task that you want to keep as links.
3. Press CTRL+DELETE to delete the task and all remaining links.
Setting Task Properties

You can set a number of properties for each task in your model. These properties determine such factors as the amount of work involved in the task, what skills are required to perform the task, and how the task affects other tasks.

For the initial baseline model, you should leave most of the properties at their default settings, so as to introduce as few variables as possible and produce a model that is easier to validate. For the final baseline and further cases, you can set properties more exactly to refine the model and make it more closely match the reality of your project.

You can set the following properties for each task in your model:

- **Name**—A short title for the task. Task names can contain any combination of text, numbers, and punctuation.
- **Description**—A further explanation of the task’s significance or meaning. The description can contain any combination of text, numbers, and punctuation, and displays in the Task Statistics chart when you run a simulation.
- **Priority**—The importance of a task relative to others in the project, expressed as High, Medium, or Low. By setting a task’s priority, you can influence how a position will treat it compared to other tasks that occur simultaneously. Positions typically attend to tasks in order of priority. Thus, highest-priority tasks tend to finish before lower-priority tasks.
  
  Rework also affects a task’s completion. A task’s duration will probably increase if the task has rework links because positions usually ignore information and meetings in favor of rework. For more information on rework, see “Modeling Rework” on page 68.
- **Work Type**—The type of work you predict the task will require. You can use one of four settings to determine how SimVision interprets the work type: Work Volume, Work Duration, Max Duration, and Supervisory. For more information, see “Setting Task Work Type” on page 39.
- **Skills**—The primary area of expertise needed to perform this task. The default skill is Generic, indicating that the task requires only those abilities possessed by the average worker. You can add other skills to the project, enabling you to select a skill more appropriate to the task’s requirements. The task’s required skill combined with the assigned position’s skill set affects task duration, exception levels, and project quality. For more information on adding skills, see “Defining a Position’s Skill Set and Skill Levels” on page 64.
- **Requirement Complexity**—The degree of task complexity, specified as the number of internal project requirements that the task must satisfy. Low requirement complexity generally results in fewer errors, and a High setting results in more errors. A highly optimized design, for example, has many tasks with a High requirement complexity. Increasing the requirement complexity...
increases functional exception levels (as against solution complexity, which increases project exception levels). Naturally, this also has an effect on task duration, cost, and rework. The task’s starting VFP, or the probability that it will generate an error, also depends on a combination of its requirement complexity, the skill level (or mismatch) of the assigned position/person, and the current project error rate.

- **Solution Complexity**—The number of solutions to which this task contributes. The degree of complexity reflects the effect that a task has on the tasks that depend on it. Low solution complexity generally results in fewer errors, and a High setting results in more errors. Increasing the solution complexity increases project exception levels (as against requirement complexity, which increases functional exception levels). Naturally, this also has an effect on task duration, cost, and rework. The task’s starting VFP, or the probability that it will generate an error, also depends on a combination of its solution complexity, the skill level (or mismatch) of the assigned position/person, and the current project error rate.

- **Uncertainty**—The amount of communication across communications links that is required to perform a task and the tasks that depend on it for information. Task uncertainty reflects the effect that other tasks can have on this one, as shown in the following table. Task Coordination volume and the number of communications increase with higher uncertainty.

<table>
<thead>
<tr>
<th>Frequency of communication</th>
<th>Uncertainty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Less than 5 times over task lifetime</td>
<td>Low</td>
</tr>
<tr>
<td>5 to 15 times over task lifetime</td>
<td>Medium</td>
</tr>
<tr>
<td>More than 20 times over task lifetime</td>
<td>High</td>
</tr>
</tbody>
</table>

- **Fixed Cost**—The non-labor cost of the task, such as interest or fees, in terms of currency units. For example, a planning permission request task might incur a one-time fee from the planning board. This fee would be the fixed cost of the task.

- **Fixed Revenue**—Any revenue that the task generates, in terms of currency units.

- **Cost Rate**—The non-labor cost of the task applied over its lifetime, in terms of currency units per minute, hour, day, week, or month. For example, a concrete mixing task might incur a cost of $100 per day for the rental of the concrete mixer. This task would have a cost rate of 100 per day.

- **Revenue Rate**—Any revenue that the task generates over its lifetime, in terms of currency units per minute, hour, day, week, or month. For example, you might want to track the revenue produced per week by a production task.
• **Actual Cost**—A placeholder value for comparing actual to projected costs for the task. This value is ignored by the simulator but appears in the Task Statistics form.

• **Actual Revenue**—A placeholder value for comparing actual to projected revenue for the task. This value is ignored by the simulator but appears in the Task Statistics form.

• **WBS**—The Work Breakdown Structure scheme for the task. You can sort tasks by WBS in the Gantt and statistics charts and in Table View. To allow for sorting, you cannot mix alphabetic and numeric characters within a single field of the WBS. For example, “17.25.BD” is a valid WBS but “17A.1B” is not. You can choose a separator for the scheme, for example periods or dashes, at the program level. See “Setting Program Properties” on page 249.

• **Chart Color**—The color that represents this task in the simulation charts. You can change the default color of each task.

• **Categories**—The category, if any, to which the task belongs. For more information, see “Using Categories” on page 271.

• **Hyperlinks**—You can add one or more hyperlinks to a task to link it to a URL. For example, you might link to some documents pertaining to the task, or to a vendor’s Web site. For more information on adding hyperlinks to shapes, see “Adding Hyperlinks to Objects” on page 369.

**To set task properties**

1. In the Model pane, select the task whose properties you want to set. The task’s properties display in the Properties pane.

2. In the Properties pane, do any or all of the following:
   - To change the name, click in the Name property, select the old name and type a new one. (To see the new name in the Model pane, click the task.)
   - To add a description, click in the Description property and type a description of the task.
   - To set the task’s priority, click in the Priority Value field and select Low, Medium, or High from the list.
   - To set the work type, select the type under Task (Work Volume, Work Duration, Max Duration, or Supervisory). Under Units, select the units (a time period of minutes, hours, days, weeks, or months if you chose one of the first three work types; FTEs is the only choice for supervisory tasks). Under Value, enter the number of time units or FTEs. For more information on task work types, see “Setting Task Work Type” on page 39.
   - To set the skill required for the task, click the Skill Value field and select a skill from the list.
   - To set the requirement complexity, or degree of complexity of the task, select Low, Medium, or High from the list.
Defining Tasks

Modeling a Project

Setting Task Work Type
A task’s work type determines how long you expect the task to take and is a vital property to set. You can choose one of four types of task:

- To set the solution complexity, or number of solutions to which this task contributes, select Low, Medium, or High from the list.
- To set the uncertainty, or frequency of communication demanded by the task, select Low, Medium, or High from the list.
- To set a fixed cost for the task, enter an amount. The amount is measured in generic currency units. Do not use a comma or a currency symbol. Although the fixed cost is a negative amount in terms of project finances, the minus sign is assumed.
- To set a fixed revenue for the task, enter an amount. Do not use a comma or a currency symbol. The amount is measured in generic currency units.
- To set a cost rate for the task, enter the cost amount in currency units. Do not use a comma or a currency symbol. Under Units, select whether the cost is incurred by the minute, hour, day, week, or month.
- To set a revenue rate for the task, enter the revenue amount in currency units. Do not use a comma or a currency symbol. Under Units, select whether the revenue is generated by the minute, hour, day, week, or month.
- To associate an actual cost with the task, enter the amount. Do not use a comma or a currency symbol. The amount is measured in generic currency units.
- To associate actual revenue with the task, enter the amount. Do not use a comma or a currency symbol. The amount is measured in generic currency units.
- To define the task WBS, enter alphanumeric characters separated by the separator defined for the program. See “Setting Program Properties” on page 249. To allow for sorting tasks by WBS, do not mix alphabetic and numeric characters within a single field of the WBS.
- To change the color that identifies the task in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.
- To assign a category to a task, or change its category, click the lock by the Categories property to open it and indicate that the task category overrides the project category. Then click Edit by the Categories property, select a category in the Categories dialog box, and click OK.
- To add a hyperlink to a task, click Edit by the Hyperlink property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.
- To delete a hyperlink from a task, click Edit by the Hyperlink property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.

3 Click elsewhere to accept the new property values.

Setting Task Work Type
A task’s work type determines how long you expect the task to take and is a vital property to set. You can choose one of four types of task:
Work Volume Tasks

Work Duration Tasks

Max Duration Tasks

Supervisory Tasks

For information on how to set the task work type, see “Setting Task Work Type” on page 39.

It’s important to understand the distinction between task volume and task duration. Task volume is the amount of work that needs to be done to complete the task. Task duration is the amount of time the task takes. A good way to remember the distinction between volume and duration is that adding FTEs (full-time equivalents) to a task can reduce task duration but not task volume. For example, if a hole takes 4 hours for one person to dig, adding a second person reduces the duration of the task to 2 hours but the volume of the task remains the same: the holes till takes 4 job hours to dig.

Task duration also depends on the Work Day and Work Week properties you set for the project. For example, a task of 3 days’ duration will take 24 hours if the Work Day is 8 hours, but 27 if it is 9 hours. For more information on setting the Work Day and Work Week, see “Setting the Normal Work Day” on page 88 and “Setting the Normal Work Week” on page 89. SimVision includes weekend days in tasks of 5 or more days’ duration. For more information on how the SimVision calendar works, see “Understanding the SimVision Calendar” on page 45.

Work Volume Tasks

Use the Work Volume setting for tasks where the amount of direct work is fixed, so that the task duration varies in inverse proportion to the number of FTEs assigned. However, adding additional staff normally increases the amount of coordination. Thus, if a group size is changed significantly, you should adjust the work volume upwards appropriately. When assigning the work volume, consider how many FTE days of effort it will take for a position with a typical level of experience with this type of application and the appropriate skill set to complete this task, assuming that the position gets it right the first time. The work volume for the task is computed by multiplying this number of days by the number of FTEs assigned to the responsible position. This number is a property of the position. See “Calculating the Work Volume of a Task” on page 43.

There are two ways to estimate work volume for a variable-duration task:

- Productivity factor—Estimate the work volume directly from the task requirements. Use this method for low-level tasks such as drawing or machining parts.
For example, a design task requires the production of 20 layout drawings, each of which will take one person working full-time about two days (= 2 FTE days) to prepare. Total work volume for the task is 20*2 = 40 FTE days work volume.

- **Historical comparison**—Compute the work volume using data from analogous tasks or estimates of the task’s duration for a given position size. Use this method for higher-level tasks such as designing or testing components.

  For example, on comparable projects in the past, a position of three engineers took 20 working days to complete this task. Thus work volume was 3*20 = 60 FTE days.

**Work Duration Tasks**

Use the Work Duration setting for tasks whose duration is determined by factors other than the number of FTEs assigned. Rework and coordination can cause the task to take longer than specified, but it will be at least the specified duration. Note that this duration is not calendar duration, but rather the total task duration in simulated minutes, not counting nights, weekends, and so on.

For example, a contractor may require 20 days to do some work. Adding extra staff to the client organization will not speed up the task. However, any required coordination and rework will affect the duration.

**Max Duration Tasks**

Use the Max Duration setting for tasks whose duration is determined by factors other than the number of FTEs assigned—that is, tasks that are not constrained by their work volume but by time, and where coordination and rework do not affect the task.

For example, suppose a pharmaceutical company needs to have a new culture tested for two hours each day for a two week period. To model this scenario, you could assign 0.2 FTEs to a 14-day testing task with a Max Duration setting.

When you use the Max Duration setting for a task, the simulated and CPM durations both equal the task duration you specify. The simulated task volume, however, will equal the product of the Max Duration value and the number of FTEs assigned to the task, plus any rework, coordination, or other noise. That is:

\[ \text{Simulated task volume} = (\text{Max Duration value} \times \text{FTE value}) + \text{rework, etc.} \]

For this reason, you should be wary of adding extra resources in an attempt to shorten the duration of a max duration task. You will not only fail to shorten the task, but you might significantly increase the task’s work volume, which will have a negative affect on cost and other factors.
For example, suppose you have a max duration task with 10 days of work volume and 1 FTE assigned. You add another 9 FTEs, thinking that this will reduce the task duration. In fact, the duration stays the same and the task’s work volume increases to 100 days because of the multiplier affect of the duration:

Simulated task volume = (10 * 10) = 100 days, plus rework, etc.

Be aware that if you set a task to have a Max Duration work volume, it means the responsible position is occupied with that task for the entire duration of the task’s work volume, even if the position is not actually working on the task all the time. To allow the position time for other activities such as meetings, it’s advisable to set the task allocation to less than 100%. You do this by setting the Allocation property of the Primary Assignment link between the position and the task. Set the allocation to 90-95% rather than 100% to avoid the position becoming backlogged.

**Supervisory Tasks**

Supervisory tasks model the supervisory relationship a position can have to a work process. For example, a plant manager might be responsible for supervising a production cycle that involves three discreet tasks assigned to the manager’s subordinate positions. You can model this scenario with a supervisory task assigned to the manager that starts at the same time as the first of the three tasks, ends at the same time as the last of the three, and is linked with a Finish-Finish link from the last task, as shown in the following example.

There are three important things to note about supervisory tasks and their supervised work flows:
Supervisory tasks must terminate with a Finish-Finish successor link from the last supervised task to the supervisory task, or the simulation will terminate with an error.

Supervised work processes must flow logically to the finish, so they cannot terminate in a supervised task with a Finish-Finish link to the supervisory task. Thus, Production Task 3 in the previous illustration also has a successor link to another work flow—represented by the End Production milestone.

Do not add a successor link from the supervisory task to the first supervised task, as this causes an endless loop.

Unlike other tasks, supervisory tasks are measured in FTE resources rather than in units of time. A supervisory task loads its responsible position with direct work according to the FTE resources assigned to the task. For example, if the plant manager position has an FTE value of 2, and the supervisory task has an FTE value of 0.5, a quarter of the manager position’s FTE resources are used up by the task for its duration.

Supervisory tasks accrue task growth risk that is the sum of the growth risk of all their supervised tasks. You cannot reduce this growth risk directly for the supervisory task. For more information on task growth risk, see “Analyzing Project Schedule Growth” on page 181.

**Calculating the Work Volume of a Task**

The Work Volume Calculator calculates the work volume of a selected task when you enter the task’s start and end dates. The work volume measured here is the number of days of work the task is expected to generate, rather than how long the task is expected to take. The calculator takes into account the number of FTEs assigned to the responsible position and the percentage allocation of the task assignment link. The allocation specifies the percentage of time that the position’s FTEs devote to the task. You can also control the number of days counted as work days and the number of hours per work day by modifying the Work Week and Work Day values within the calculator. This clarifies whether weekend days are counted in the task’s duration.

The calculator computes the total work volume for the task by multiplying the number of work days in the task’s duration by the number of FTEs and their percentage of allocation, as follows:

\[ \text{Task Duration} \times \text{FTE value} \times \text{Allocation \%} = \text{Work Volume}. \]
For example, the task shown in the calculator here starts on 11/9/2004 and ends on 11/22/2004. This is a duration of 10 days if you include the start and end dates and use a 5-day working week. The task has 2 FTEs allocated full-time (100% allocation). The work volume generated is thus 20 days, 10 days for each FTE.

The calculator will calculate any one of the five values (not Work Week or Work Day) given the other four. For example, you can calculate how many FTEs are required if you know the task duration, allocation percentage, and work volume. Suppose you knew the Work Volume value for the task shown above was 10 days. To find out how many FTEs would then be required to complete the task at 100% allocation, select the FTEs radio button and click Calculate Selected Value. The result is approximately 1 FTE, because it only takes 1 FTE to complete 10 days’ worth of work within 10 days at 100% allocation.

If you frequently calculate work volumes, you can permanently display the Work Volume Calculator as a floating window or docked to one side of the workspace. See “Displaying Workspace Elements” on page 354.

**To calculate the work volume of a task**

1. In the Model pane, select the task.
2. On the View menu, click Work Volume Calculator.
3. Click the down-arrow by Start.
   
   A calendar displays the current month.

4. Select a start date. To pick a different month, use the forward and back arrows at the top of the calendar.
5. Click the down-arrow by End and select an end date.
6. To change the number of days counted as work days in the week, change the value under Work Week.
7. To change the number of hours in a work day, change the value under Work Day.
Defining Positions

Once you have the project tasks in place, you need to add the positions that are responsible for completing the tasks. A position represents one or more full-time equivalents, or FTEs, with responsibility for one or more tasks. For example, a position with an FTE value of 2 has the equivalent of 2 full-time employees to perform tasks. When designing the baseline model, start by adding responsible positions for each task. This hierarchy is not necessarily the same as that of the permanent organization, which usually has more detail, such as which persons staff which positions.

Positions are linked by supervision relationships that specify the information-processing behavior. See “Assigning Position Supervision Links” on page 58.

Understanding the SimVision Calendar

The SimVision calendar assumes that tasks of 5 days or longer that start on Mondays include weekends. If a task starts on another day of the week, the weekend is included if appropriate. For example, a task of 3 days’ duration starting on Thursday would be calculated to take 5 days, including the two weekend days.

For this reason, simulated task durations may not match exactly the task durations as they appear in the Properties pane for the task. For example, suppose a project contains a single task that starts on a Monday, has a duration of 5 days, and is assigned with 100% allocation to a position with 1 FTE. The program’s Work Week property is set to 5 days, meaning that no work occurs on the weekends. The project will nevertheless show a simulated duration of 7 days. This calculation includes the weekend at the end of the task, because it is assumed that any subsequent tasks start on the following Monday.
Positions are linked to tasks by primary or secondary task assignment links. See “Linking Milestones, Tasks, and Positions” on page 52.

Understanding Positions and Persons

A position does not have to represent an actual or a single person. For example, you can define a position called Foreman without specifying the person carrying out that position’s tasks. You can define a position called Board Members that represents a group of people. For more information on persons, see “Defining Persons” on page 117.

Adding Positions to a Project

For the baseline model, add 15-30 positions to the model. Keep the documentation of your organization at hand. This will help you add positions in logical places to match the structure of your organization.

Start by adding a new position, then use the Rubber Stamp tool to add subsequent positions. See “Adding Multiple Copies of Objects” on page 26. When you have added all the positions, set the properties for each position. You can link the positions with supervision links later.

At any time, you can rename, move, or delete positions. When you physically move a position shape, it remains linked to its tasks, meetings, and other positions. To assign a position to different tasks, meetings, or positions, you must move the appropriate links. When you delete a position, you also need to delete any links attached to it, unless you are moving the links to another position.

To add a position to a project

1. In the Model pane, display the project.
2. In the Project Shapes toolbar, click Position.
3. Click in the Model pane to place the position.
4. Double-click the position icon and type a name for it.
   - The position name appears as a label in the Model and Tree panes and in the Properties pane.

To rename a position

1. Double-click the position to rename.
2. Type the new name.
3. Click elsewhere to apply the name.

To move a position

- Drag the position to a new location in the Model pane.
Any links to the position stay connected and follow the position to its new location.

**To delete a position**

1. In the Model pane, select the position to delete.
2. Move any links associated with the position that you want to keep as links.
3. Press CTRL+DELETE to delete the position and all remaining links.

**Setting Position Properties**

A position has the following properties:

- **Name**—Names can contain any combination of text, numbers, and punctuation.
- **Description**—An explanation of the position’s role in the project. The description displays in the Position Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.
- **Role**—One of three functions. See “Setting a Position’s Role” on page 49.
- **Application Experience**—How experienced the position is with this type of project. See “Setting a Position’s Application Experience” on page 49.
- **FTE**—The number of full-time equivalent persons represented by the position. See “Setting the Number of FTEs for a Position” on page 50.
- **Salary**—The hourly wage of each position’s FTE in currency units (curr/FTE/hr). Salary is applied to the hours worked by a position to accumulate labor costs. See “Tracking Project Costs” on page 103. The Salary value is only used if the position is not staffed. The property is white if the position is unstaffed and blue if it is staffed.
- **Chart Color**—The color that represents this position in the simulation charts. You can change the default color of each position.
- **Skill Set**—Defines the set of skills the position has and also the level of each skill. See “Defining a Position’s Skill Set and Skill Levels” on page 64.
- **Staffing**—The person or persons assigned to the position. See “Staffing Positions” on page 123.
- **Categories**—The category, if any, to which the position belongs. See “Using Categories” on page 271.
- **Escalators**—A mechanism for varying the position’s salary rates over the project’s or program’s lifetime. For more information on escalators and how to set them, see “Setting Project Salary Escalators” on page 93.
• **Hyperlinks**—You can add one or more hyperlinks to a position to link it to a URL. For example, you might link to some documents pertaining to the position, or to a vendor’s Web site.

**To set a position’s properties**

1. In the Model pane, select the position whose properties you want to set. The position’s properties display in the Properties pane.

2. In the Properties pane, do any or all of the following:
   - To change the name, click in the Name property, select the old name and type a new one. (To see the new name in the Model pane, click the position.)
   - To add a description, click in the Description property and type a description of the position.
   - To change the role, click under Value for the Role property and select a role. See “Setting a Position’s Role” next.
   - To set a position’s application experience, click under Value for the Application Experience property and select Low, Medium, or High. See “Setting a Position’s Application Experience” on page 49.
   - To set the number of FTEs for the position, click under Value for the FTE property and enter the number of FTEs. See “Setting the Number of FTEs for a Position” on page 50.
   - To set the position’s salary, click under Value for the Salary property and enter a salary amount.
   - To change the color that identifies the position in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.
   - To define a position’s skill set, click Edit in the Skill Set property. For more information, see “Defining a Position’s Skill Set and Skill Levels” on page 64.
   - To staff the position, click Edit in the Staffing property and use the Staffing dialog box. For more information, see “Staffing the Project” on page 121.
Defining Positions

Modeling a Project

Setting a Position’s Role

The role describes the position’s organizational function on the project team. It also affects the types of decisions that are made. There are three position roles.

- **Project Manager (PM)**—Typically only one position in a project has this role.

- **Subteam (ST)**—Subteams actually do most of the work. This is the default role. The ST passes some exceptions to the Subteam Leader (SL), which in turn passes some exceptions to the PM. The PM normally does more rework than the SL, which in turn generates more rework than the ST. Thus, projects with a backlogged PM normally have greater verification risk than projects with a PM which is not backlogged.

- **Subteam Leader (SL)**—All positions between the PM and STs are usually subteam leaders.

For information on how position role affects decisions, see “Responding to Exceptions” on page 72.

Setting a Position’s Application Experience

Application Experience describes how experienced the position is with this type of project. This value is only used if the position is unstaffed. If the position is staffed, the application experience of the assigned person or persons is used. The property value has a white background if the position is unstaffed and a blue background if it’s staffed.

The values for the Application Experience property of a position translate as follows:

- To add the position to a category or change its category, click the lock by the Categories property to open it and indicate that the position category overrides the project category. Then click Edit by the Categories property, select a category in the Categories dialog box, and click OK.
- To set a salary escalator for the position, click the lock by the Escalators property to open it and indicate that the position escalator overrides the project escalator. Then click Edit to set the escalator. See “Setting Project Salary Escalators” on page 93.
- To add a hyperlink to the position, click Edit by the Hyperlink property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.
- To delete a hyperlink from the position, click Edit by the Hyperlink property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.

3 Click elsewhere to accept the new property values.
• **High**—The position has frequently done this kind of work.
• **Medium**—The position has done some of this kind of work.
• **Low**—The position may have done this kind of work once, or not at all.

Because of its effect on position work processing speed, application experience has a dramatic effect on project duration, internal and external exceptions, and cost. It does not affect rework risk.

Do not confuse application experience with skill level, which you set when you apply skills to a position. Otherwise, you might double-count the effect of a position working on a new type of project. The following table shows how a position’s experience combines with its skill level to provide values for both Application Experience and Skill Level.

<table>
<thead>
<tr>
<th>Position’s Experience</th>
<th>Application Experience</th>
<th>Skill Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lots of experience / excellent skills</td>
<td>High</td>
<td>High</td>
</tr>
<tr>
<td>Little experience / excellent skills</td>
<td>Low</td>
<td>High</td>
</tr>
<tr>
<td>Lots of experience / weak skills</td>
<td>High</td>
<td>Low</td>
</tr>
<tr>
<td>Little experience / weak skills</td>
<td>Low</td>
<td>Low</td>
</tr>
</tbody>
</table>

Bear in mind when you assign Application Experience values that positions do not usually change their experience over the course of a project. It is good practice to establish realistic levels from the start, rather than experiment with increasing levels later to try and shorten the project schedule. However, one way that application experience can have a bearing in shortening the schedule is if you recommend outsourcing at-risk work to outside contractors with high application experience.

**Setting the Number of FTEs for a Position**

The position’s FTE value shows the number of full-time equivalent (FTE) people that an unstaffed position represents. This number is fixed over the life of the project, but you can vary the number of a position’s available FTEs assigned to its tasks. You do this by changing the percentage value of the Assignment link’s Allocation property. See “Refining Task Allocation” on page 61.

The FTE property value has a white background if the position is unstaffed and a blue background if it’s staffed. The default value is 1, but a position can represent multiple full-time people, part-time people, or a combination of both. You can set the value to zero, for example to keep a placeholder position. However, if you leave an unstaffed position’s FTE value as zero or staff a zero-FTE position with a zero-FTE person, you will cause a simulation error.
The following table shows sample FTE values for positions that represent different numbers of full-time and part-time people.

<table>
<thead>
<tr>
<th>Position represents</th>
<th>FTE Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single person available full-time</td>
<td>1.0</td>
</tr>
<tr>
<td>A team of four available full-time</td>
<td>4.0</td>
</tr>
<tr>
<td>A single person available half-time</td>
<td>0.5</td>
</tr>
<tr>
<td>A team of four available 1 day each week</td>
<td>0.8</td>
</tr>
</tbody>
</table>

SimVision assumes that the position’s number of FTEs remains constant for the duration of the project. However, not all of a position’s available FTE capacity needs to be assigned to each task.

**About Decision Wait Time and Decision Wait Volume**

When a position encounters an exception while performing a task, the position might ask its supervisor what to do. The simulator specifies the time that a position should wait for a response from the supervisor before taking a default action on the exception. Decision wait time prevents a position from waiting indefinitely if the supervisor can’t get to the decision. The cumulative decision wait time is called Decision Wait Volume. This is measured per project for a position in the Position Statistics chart. Wait Cost is the wait volume weighted by average cost per FTE of waiting positions.

Wait Cost is tracked on the Cost Breakdown chart. For more information, see “Analyzing Project Cost and Work Breakdown” on page 186.

**Tip:** When positions ignore exceptions rather than reworking them, this is a risk to the project quality, which is tracked on the Quality Risk chart when you run a simulation. Typically, sub-team and individual positions ignore more exceptions than project managers. To avoid a high quality risk, set a higher level of centralization so that more high-level positions, such as Project Managers, are making exception-handling decisions. For information on the Quality Risk chart, see “Analyzing and Counteracting Functional and Project Risk” on page 190.

**Changing a Position’s Application Experience**

Application experience refers to how much a position has applied the skill to the same or similar types of projects. A position can have a high skill level but a low application experience level. For example, an electrical engineer might have a Ph.D. in electrical engineering and many years of experience designing generating systems for power plants, but might never have worked on designing power...
supplies for consumer electronic products. Such an engineer would have a high Power Engineering skill but low application experience for the tasks in a project to design the power supply for a portable television.

A position’s Application Experience property allows you to model this aspect of their skills independently of the skill set and skill levels. Application experience works with the fit between the task’s skill requirement and position’s skill set to determine the processing speed and exception rate of the position’s tasks. For example, a position with a medium skill level but a high application experience level might make better progress than a highly skilled position with low application experience.

If a position’s skills and skill levels match the task requirements, increasing the position’s application experience to High results in the position processing the task 50% faster. The same applies to raising a required Medium skill level to High. Raising the application experience can also mitigate the reduction in processing speed caused by skill mismatches. For more information, see “Counteracting High Schedule Growth” on page 184.

You set a position’s application experience in reference to the project as a whole, not individual tasks.

**To set a position’s application experience**

1. In the Model pane, display the project.
2. Select the position.
   - The position’s properties appear in the Properties pane.
3. Click under Value for the Application Experience property.
4. Select High, Medium, or Low.

**Linking Milestones, Tasks, and Positions**

In this section, you link milestones and tasks with Successor links, positions to each other with supervision links, and positions to tasks with assignment links. First, you should understand something about each type of SimVision link.
Understanding Links

A link shows a relationship between two objects and any dependencies one object has on the other. You must join two objects with each link. If the link is not joined at one end, the arrow at that end turns red. SimVision uses the following ten types of links:

**Project Successor**—Links a project to a succeeding project. You create and view these links on the Program page of the Model pane. Project Successor links are solid black curved lines with an arrow at the subproject. See “Linking Projects within Programs” on page 253.

**Organization Assignment**—Links an organization to a project within a program. You create and view these links on the Program page of the Model pane. Organization Assignment links are solid pink curved lines with an arrow at the project. See “Assigning Organizations to Projects” on page 262.

**Subdepartment**—Links a department to a subdepartment. You create and view these links on Organization tabs of the Model pane. Subdepartment links are solid pink angled lines with an arrow at the subdepartment. See “Defining a Department” on page 113.

**Successor**—Links milestones and tasks in such a way that a successor task cannot start until the predecessor task or milestone is complete, or for a specified time (time lag) after the predecessor task or milestone starts. Successor links are solid black curved lines with an arrow at the successor milestone or task. See “Linking Tasks and Milestones” on page 56.

**Primary Assignment**—Links a position to a task for which it has primary responsibility. Any exceptions generated by the task must be handled by the primary responsible position. Primary Assignment links are solid blue curved lines with an arrow at the task end. See “Assigning Positions to Tasks” on page 59.

**Secondary Assignment**—Links a position to a task for which it has secondary responsibility. There must already be a primary responsible position, who handles exceptions generated by the task. Secondary Assignment links are dashed blue curved lines with an arrow at the task end. See “Assigning Positions to Tasks” on page 59.

**Supervision**—Links a supervisory position to its supervised position. Supervision links are solid black angled lines with an arrow at the supervised position. See “Assigning Position Supervision Links” on page 58.

**Rework**—Links a task to a dependent task that will need rework if the driver task fails. Rework links are dashed red curved lines with an arrow at the dependent task. See “Modeling Rework” on page 68.

**Communications**—Links two tasks, indicating that the position responsible for the first task must communicate with the other position at the completion of the first task. Communications links are dashed green curved lines with an arrow at both ends. See “Adding Communications Links” on page 75.

**Meeting Participant**—Links a position to a meeting, indicating that the position (or some or all of its staffing FTEs) must attend the meeting. Meeting Participant links are dashed grey curved lines with an arrow at the meeting end. See “Assigning a Participant to a Meeting” on page 79.
Using the Right-Click Menu to Add Links

SimVision provides a quick and easy method for adding links by right-clicking on the object you are linking. The right-click menu lists all the possible link types you can add to that object. When you select a link type, a dialog box lists all the possible objects in the project to which you can link the object. When you select an object or objects and click OK, the links are created.
For example, suppose you create a new task. When you right-click the task, the right-click menu lists all the links you can add to a task, as shown next.

Suppose you want to add a successor to the task. When you click New Successor To on the right-click menu, you see a list of all possible successors to the task. In this case, because the object you're linking is a task, the possible successors are the project’s milestones and any tasks that are not yet linked to a position with a primary assignment link.
The dialog box for creating links also allows you to set link properties, such as a successor link’s lag or the strength of a rework link.

## Linking Tasks and Milestones

The next step in constructing your model is to connect the tasks and milestones in order of precedence. You define this order—which tasks and milestones follow one another, and in what manner—using successor links. Each successor link connects a task to another task or to a milestone. In each of these shape-to-shape relationships, one shape is the predecessor, or precedes the other, and one is the successor, or succeeds the other. Therefore, except for the Start and Finish milestones, every task and milestone must have both a predecessor and a successor.

Successor links define an order in which tasks and milestones occur in a model, but they do not constrain these events to occur in strict sequence. Tasks can also occur in parallel, or simultaneously. You set when a successor starts relative to its predecessor by selecting a value for the link’s Type property. You can also set the successor to start a certain period of time, or lag, after its predecessor starts or finishes. The default lag for all successor links is 0.

The successor link types and their relationship to the lag are:

- **Finish-Start**—Sets the successor to start when or after its predecessor finishes. For a successor to start after its predecessor finishes, you must set a lag. Finish-Start is the default setting for all successor links.
- **Start-Start**—Sets the successor to start when or after its predecessor starts. For a successor to start after and not at the same time as its predecessor, you must set a lag.
- **Finish-Finish**—Sets a supervisory task to finish at the same time as or after the last of the supervised tasks. For a supervisory task to finish after the last of the supervised tasks, you must set a lag. Supervisory tasks must terminate with a Finish-Finish successor link from another task or milestone or simulation will terminate with an error.

---

**Note:** Each task, milestone, and project must originate at least one Finish-Start successor link. Otherwise, the model simulation will fail. The exception to this rule is the Finish milestone.

Besides minutes, hours, days, weeks, and months, you can specify the lag’s unit of length as a percentage of the predecessor’s completeness. In a Start-Start link, entering a number and choosing % Complete for the units in the Lag property sets the successor to start after that percentage of the predecessor task is complete. For example, setting the Successor link’s type as Start-Start and its lag...
as 50% directs the successor to start when the CPM duration of predecessor is halfway through. Using a percentage for a lag in a Finish-Start Successor link directs the successor to start that length of time after the CPM duration of the predecessor has finished.

In connecting tasks and milestones with successor links, a helpful convention is to link the right side of the predecessor to the left side of the successor for Finish-Start links and the left side of the predecessor to the left side of the successor for Start-Start links, as shown in the following example.

![Diagram showing Finish-Start and Start-Start successor links]

**Note:** If you add successor links using the right-click menu, links are always added right side to left side so there is no visual distinction between Finish-Start and Start-Start links. If you want to follow the convention described above, use the Link tool.

**To connect milestones and tasks with successor links**

1. In the Model pane, click the Project tab of the project in which you wish to assign supervision links.
2. Right-click the task or milestone to link from.
3. Click New Successor To.
4. In the New Successor To dialog box, select the task or milestone to link to and click OK.

The link joins the two shapes, its arrow attached to and pointing at the successor task or milestone.

**Setting Successor Link Properties**

Successor links have the following properties:
• **Type**—Specifies how the successor (task or milestone) starts in relation to the predecessor.

• **Lag**—Specifies the amount of time after a predecessor starts or finishes that the successor starts. You can specify the lag in minutes, hours, days, weeks, months, or in terms of the percentage that the predecessor task is complete.

• **Connected From**—The predecessor task’s name.

• **Connected To**—The successor task’s name.

**To set a time lag for a successor link**

1. In the Model pane, select the successor link.
   
   The Properties pane displays the link’s properties.

2. Specify when the successor starts relative to the predecessor as follows:
   
   • To make the successor start at the same time as the predecessor, select **Start-Start** as the link type and leave the lag as zero.
   
   • To make the successor start some time after the predecessor starts, select **Start-Start** as the link type and enter a lag time, choosing Minutes, Hours, Days, Weeks, or Months as the time unit.
   
   • To make the successor start as soon as the predecessor ends, select **Finish-Start** as the link type and leave the lag as zero.
   
   • To make the successor start some time after the predecessor ends, select **Finish-Start** as the link type and set the lag.
   
   • To make a supervisory task end at the same time as the last of the supervised tasks, select **Finish-Finish** and leave the lag as zero.
   
   • To make a supervisory task end after the last of the supervised tasks, select **Finish-Finish** and set the lag.

3. Click elsewhere to apply the successor link properties.

**Assigning Position Supervision Links**

In SimVision, the supervision structure represents a hierarchy of positions, defining which position a position would go to for information or to report an exception. The supervision structure is also called the *exception-handling hierarchy*. A supervision link between two positions shows which position supervises the
other. The position at the originating end of a supervision link gives information to or handles exceptions for the position at the arrow end, as shown in the following example.

When you select a supervision link, the Properties pane displays the supervising and supervised position names in the link’s Connected From and Connected To properties.

**To assign a supervision link between positions**
1. In the Model pane, click the Project tab of the project in which you wish to assign supervision links.
2. Right-click either the supervisory or the subordinate position.
   The right-click menu shows all the links you can add to a position.
3. Click New Supervisor Of or New Subordinate Of.
   The New Link dialog box lists all the positions you can link the selected position to as supervisor or subordinate, depending on which option you selected.
4. Select the position to link to and click OK.
   The positions are linked with a supervision link.

**Assigning Positions to Tasks**
Tasks must have one and only one primary responsible position. Positions, in contrast, can be assigned to one or more primary tasks. A primary task assignment link is represented by a solid blue line between the position and the task.

A task can have any number of secondary responsible positions, indicated by dashed blue lines. The difference between primary and secondary responsible positions is that only the primary responsible position handles exceptions arising from the task. It’s advisable to limit the number of secondary task assignments, because positions do not give priority to their primary tasks over their secondary tasks, and secondary tasks can contribute significantly to backlog for the primary responsible position. However, in some cases, secondary task assignments can help reduce backlog. See “Using Secondary Task Assignments” on page 200.
The convention in SimVision is to link from the bottom of a position to the top of a linked task. Before you assign positions to the tasks in your project, it might help to create a table of tasks and the positions responsible for them, as in the following example.

### Example of Primary and Secondary Task Assignments

The following example shows primary and secondary task assignments for two positions in a chip development project.

<table>
<thead>
<tr>
<th>Tasks</th>
<th>Positions responsible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop specification</td>
<td>Project manager</td>
</tr>
<tr>
<td>Partition chip and floor planning</td>
<td>Chip architect</td>
</tr>
<tr>
<td>Write, verify, synthesize RTL</td>
<td>Logic design team</td>
</tr>
<tr>
<td>Assemble and verify RTL</td>
<td>Verification team</td>
</tr>
<tr>
<td>Synthesize full chip</td>
<td>Foundry lead</td>
</tr>
<tr>
<td>Simulate gates</td>
<td>Foundry layout</td>
</tr>
<tr>
<td>Engineering layout physical verification</td>
<td>Foundry test</td>
</tr>
<tr>
<td>Generate test vectors</td>
<td>Foundry test</td>
</tr>
<tr>
<td>Design coordination</td>
<td>Project manager</td>
</tr>
</tbody>
</table>

To do this, you can use the “Project Information Form” on page 395.

The Foundry Layout position can help the Foundry Test position with the Engineering layout physical verification. This task is a secondary assignment for Foundry Layout, but a primary assignment for Foundry Test. Note that any exceptions generated by the task will be the responsibility of the Foundry Test position, as the primary responsible position.
For information on how secondary assignment links can help reduce person backlog, see “Using Secondary Task Assignments” on page 200.

**Setting Task Allocation Values**

When you assign a position to a task, whether with a primary or secondary assignment link, you can also set the task allocation. This is the percentage of time that the position’s FTEs can devote to that task. For the baseline model, leave each task allocation set to the default 100%. Later, you can set more granular task allocation percentages. Task allocation is represented by the Allocation property for the assignment link. The link also has Connected From and Connected To properties that show the names of the position and task respectively.

For information on setting more granular task allocation percentages, see “Refining Task Allocation” on page 61. For information on how changing task allocation values can help backlogged positions, see “Counteracting High Position Backlog” on page 207.

**Refining Task Allocation**

In theory, a position responsible for a task is available full-time to complete it. However, such a condition rarely occurs in reality. Positions must frequently act on multiple simultaneous tasks and may experience other distractions, such as meetings, failed tasks that require rework, unresolved decisions, and telephone calls. In SimVision, you can express the amount of time a position can devote to a task as a percentage of the position’s total available time. You can set this percentage via the Allocation property of the assignment link that connects the position and the task. Setting this property helps you further refine your model, letting you more accurately reflect a position’s availability.

For example, if a position is responsible for two tasks that are occurring simultaneously, you can set the task allocation values of the assignment links between the position and the tasks to 50% each. If this position has four FTEs, setting a 50% allocation for each task assigns two FTEs to work on each task.

However, you also need to be very careful about setting Assignment allocations, because very low allocations can result in many more exceptions, which affect rework levels and quality. For more information, see “Example of Low Task Allocation Affecting Exception Levels” on page 62. This effect is compounded if the task is also assigned as a secondary task to positions. If the position responsible for the task attends to the work only part of the time, the resulting task-switching will have an adverse effect on productivity and performance.

**To change task allocation percentages**

1. In the Model pane, select the task.
2. To see a list of responsible positions, right-click the task and click Positions.
3. Check the availability of responsible positions during the task’s tomfooleries.
4. To change an allocation percentage, select the assignment link.
The link’s properties appear in the Properties pane.

5 Change the Allocation property’s value.

**Example of Low Task Allocation Affecting Exception Levels**

In this example, a project contains a task called Integrate Systems that is linked with a rework link to a task called Full Chip Synth.

![Integrate Systems task linked to Full Chip Synth task with rework link](image)

Simulation results show that the simulator predicts a very large amount of rework in the Full Chip Synth task. Investigation shows the rework assignments are coming from the Integrate Systems task, which has a relatively large number of exceptions. The Primary Assignment link for this task has a 20% allocation value.

If you change the value to 100%, the number of exceptions drops considerably for both tasks, and the rework assigned to Full Chip Synth also drops to a fraction of the assigned work.

Here are the actual numbers involved:

Integrate Systems task volume = 20 days  
Primary position FTEs = 1  
Project exception prob. = 0.2  
Project exceptions at 20% task allocation = 10  
Project exceptions at 100% task allocation = 2

The reason there so many exceptions for a 20-day task with an exception probability of 0.1 is that the simulator breaks work into sub-units called work items that you can assume to be 1 day. Therefore, since the Integrate Systems task has a work volume of 20 days and the primary responsible position has an FTE of 1.0, the task should take 20 days and on average there should be 2 exceptions. But with a 20% allocation, the position has to visit each work item a minimum of 5 times to complete it before another work item can be assigned. This results in 5 times as many chances for an exception to occur. Therefore, on average there will be 10 exceptions generated for this 20% allocation.

**To assign a primary task to a position**

1 In the Model pane, right-click the position to assign the task to.

   The right-click menu lists all the link types you can assign to a position.
2 Click New Assignment To.
   The New Link dialog box lists all the tasks you can link the position to.

3 Select the appropriate task, leaving the Allocation at 100% for now, and click OK.
   The position and task are joined by a solid blue line with an arrow at the task.

You can also add primary task assignment links using the Primary Assignment tool in the Project Shapes toolbar.

To assign a secondary task to a position
1 In the Model pane, right-click the position to assign the task to.
   The right-click menu lists all the link types you can assign to a position.

2 Click New Sec. Assignment To.
   The New Link dialog box lists all the tasks you can link the position to.

3 Select the appropriate task, leaving the Allocation at 100% for now, and click OK.

4 The position and task are joined by a dashed blue line with an arrow at the task.

   You can also add secondary task assignment links using the Secondary Assignment tool in the Project Shapes toolbar.

Adding Skills
When you added positions and tasks to the model, you left each position with the default Generic skill at Medium level, and each task with the default Generic skill requirement. With these settings, all tasks are performed as though it took a position with the capacity of a single FTE exactly one day to complete one day’s worth of work volume. In practice, positions are often assigned to tasks for which they have less than perfect skills. Or you might want to model the fact that a position has a high level in one skill but a low level in another; or a task requires only a high or low level of skill. To help model these realities, you can add what is called a master skill set to a project. From this skill set, you can assign required skills to tasks and skill lists to positions.
Defining the Master Skill List

The master skill list is the program’s set of skills. Each position can have one or more skills in its skill set, at one of three levels: Low, Medium, or High. Each task has one required skill. In a staffed model, persons can also have skill sets. To avoid schedule delay and risk to the project, it’s important to match the skills required by tasks with the skills of their responsible positions (or in a staffed model, persons).

When you add a master skill list to the program, the skills are then available to all positions, tasks, and persons in the program. You can delete skills from the master skill list, but only if the skill is not in use anywhere in the program.

Defining a Position’s Skill Set and Skill Levels

The Skill Set displays the skills that a position has available and the position’s skill level in each of these skills. For the baseline model, you can define a basic set of skills. Part of refining a model involves refining the positions’ skill sets to better match the task requirements. See “Editing a Position’s Skill Set” on page 65. Note that once you staff a position, the person, and not the position’s skill set is used. The position’s skill set is ignored.

To add a new skill to the program

2. In the Skills dialog box, click Add. A blank line appears for the new skill.
3. Type a name for the skill, and a description if required.
4. Click OK in the Skills dialog box.
5. In the Skill Set dialog box, click the check box by the skill to add it to the position’s skill set.
6. Under Level, select Low, Medium, or High for the skill level.
7. Click OK.

To add a skill to a position’s skill set

1. In the Model pane, select the position icon.
2. In the Properties pane, click Edit beside Skill Set. The Skill Set dialog box lists the skills currently in the position’s skill set.
3. Click the check box by the skill to add it to the position’s skill set.
4. Under Level, select Low, Medium, or High for the skill level.
5. Click OK.

To change the level of a position’s skill

1. In the Model pane, select the position icon.
Modeling a Project

To delete a skill from the master skill list

2. In the Skills dialog box, select the skill to delete.
3. Click Delete.
4. If the skill is in use anywhere in the program, a message indicates that you cannot delete the skill.
5. Click OK.

Tip: The skill set and skill levels of a position directly affect the duration of its tasks. A common error is to assign a skill requirement to a task but forget to assign that skill to the responsible position. This results in tasks taking much longer than they should. If a task duration is much too long in the Gantt chart, check that the responsible position has the skill set and skill levels that match the task requirements.

To edit a project’s skill set

1. On the Model pane’s program page, select the project.
2. On the Model menu, click Skills.
To edit a position’s skill set

1. On the project page of the Model pane, select the position. The position’s properties appear in the Properties pane.
2. In the Properties pane, click Edit by the Skill Set property. The Skill Set dialog box appears, showing the position’s skills.

3. In the Skills dialog box, click Add. A new blank line appears for the skill.
4. Under Skill, type a name for the skill.
5. Under Description, type a description for the skill if desired.
6. To delete a skill from the skill set, select the skill number and click Delete.
7. Click OK.
3 Under Skill, click the appropriate skill’s check box.
4 Under Level, select High, Medium, or Low for the skill level.
5 To add a skill, click Add a Skill and follow the previous procedure.
6 To delete a skill from the position’s skill set, clear the skill’s check box.
7 Click OK.
About Task Interdependence

Usually, baseline models assume that parallel tasks are independent of one another and therefore have no effect on each other’s performance. However, in fast-track projects, parallel tasks tend to be highly interdependent. SimVision allows you to model two kinds of interdependence between tasks: failure dependency and information exchange.

Modeling Failure Dependency

Failure in tasks causes rework. The concept of rework is a vital one and deserves much attention because modeling rework allows you to capture the realities of work processes and environments. You model failure dependency, or rework, by adding rework links between tasks.

Modeling Information Exchange

You model information exchange by adding communications links between tasks and by adding meetings to the project.

Modeling Rework

Rework means redoing a task that has failed. You model rework by linking two tasks with a rework link. A rework link is similar to a successor link because it connects one task (called the driver task) with another (called the dependent task). However, a rework link also indicates that the dependent task depends on the success of the driver task, and that the project’s success is also in some way dependent on this. If the driver task fails, some rework time has to be added to all dependent tasks linked to the driver task by rework links.

Rework is closely linked with the functional and project error probability settings. For an understanding of these interdependencies, see “Setting Functional Error Probability” on page 101 and “Setting Project Error Probability” on page 102.

Understanding Rework

In general, rework occurs when an exception in one task (the driver task) requires work already completed on another task (the dependent task) to be redone. The driver task is usually upstream of, or roughly parallel with the dependent task in the chain of task precedence. When project exceptions arise in a driver task, a certain volume of rework can be scheduled in the dependent task. The exact volume depends on the rework link strength, as explained in “Setting Rework Link Strength” on page 75.
The Verification Failure Probability (VFP) of a dependent task also changes when project exceptions arise in the driver task. How the VFP is adjusted depends on the response to the exception—ignore, quick-fix, or rework. The VFP increases if the exception is ignored and decreases if it is reworked. For more information on VFP, see “Understanding the Verification Failure Probability” on page 70.

Example of Rework

A good example of a situation where a rework link would be required is between a testing task and the task that created what is being tested. For example, in a project to create an integrated circuit chip, the Systems Integration Test task might be linked with a rework link to the Integrate Systems task, as shown:

![Diagram showing rework link between tasks]

The rework link between these two tasks models the fact that if the testing task fails, some rework will be required in the Integrate Systems task. The other rework links in this example link a task to develop a spec with the implementation tasks arising from the spec. If there are problems implementing the spec, some rework will be required in the spec writing task.

Understanding Forward Rework

Sometimes it is necessary to model a relationship between tasks where problems in an upstream task have an effect on the quality of the work in downstream tasks that might not yet have been started. You can connect a task with a rework link to a task that occurs later in the work flow. When project exceptions arise in the driver task, rework is assigned to the dependent task. This is called forward rework.
The dependent task’s VFP is adjusted in the case of forward rework just as it is for regular rework. Since the dependent task hasn’t yet started, no work has been done so no work needs to be redone. No rework volume is generated for the task, and the modeler is alerted to this fact by a noncritical warning when a simulation is run.

However, the VFP adjustment does have an effect. For example, if the position responsible for the driver task is a PM position, the decision will probably be to rework a majority of the exceptions. Remembering that the VFP increases if exceptions are ignored and decreases if they are reworked, this will result in decreased VFP in the dependent task. If the position’s role was ST, the VFP would increase due to the usual decision by subteam roles to ignore exceptions.

Understanding the Verification Failure Probability

Every program, project, and task has associated with it a Verification Failure Probability (VFP). Since the VFP is a probability of failure, it’s important to remember that a high VFP is bad and a low VFP is good. The program VFP is initially set when you set the functional and project error probabilities. For example, if you set a functional error probability of 0.1, that means there is a 10% chance of functional errors occurring in the program. For more information on these probabilities, see “Setting Probability Rates” on page 99.

During the first validation run of the simulator, each task is evaluated for the likelihood of it generating errors. Three factors affect this likelihood.

• **Skill mismatches**—This means that the position responsible for a task does not have the skill required by the task, doesn’t have it at the right level, or has a lower application experience setting than required by the task. Skill mismatches have the most damaging effect on a task’s VFP.

• **Decision type**—This means the type of decisions that are made about errors in the task. Decision types are ignore, quick-fix, or rework.

• **Simultaneous meetings**—This is when the position responsible for a task is assigned to simultaneous meetings. The meetings might be in different projects, which makes this problem hard to detect.

As the individual VFP for each task is adjusted according to these three factors, the global probability of failure is set for the program. For example, if there are no skill mismatches, ignored exceptions, or simultaneous meetings, the program’s VFP will stay the same as the functional error probability setting. However, if a skill mismatch is discovered, the task’s VFP might be adjusted up from 10% (the initial VFP setting for the program) to 15%. This adjustment reflects the fact that as a project progresses, tasks with high VFPs tend to generate more errors in a
sort of vicious circle. This can lead to the functional or project error probability of an individual task reaching or exceeding the VFP limit that has been set for the program in the behavior file, which results in a critical simulation warning.

### Correcting a VFP Limit Problem

If a task’s VFP has reached the limit set for the program, you can do the following:

- Check for and fix skill mismatches—See “Fixing Skill Mismatches” on page 133.
- Consider whether the starting functional error probability is set too high—See “Setting Functional Error Probability” on page 101.
- Consider whether the application experience of the responsible position is set too low—See “Setting a Position’s Application Experience” on page 49.
- Check for simultaneous meetings—Look at the meeting risk on the Position Statistics chart for the unstaffed position, or the Person Statistics charts for the persons assigned to the staffed position. If there is significant meeting risk (more than 0.5, or 50% chance of their missing the meeting), it’s likely that they are assigned to simultaneous meetings. You can also check the Meeting Statistics chart for each meeting to assess the risk. Remember that positions or persons can be assigned to simultaneous meetings that occur in different projects. To correct the problem, reassign similarly skilled positions to one of the meetings or change the meeting time. See “Setting Meeting Properties” on page 80.

### Understanding Failure Dependency

For any complex project, there are certain fundamental components that determine the overall performance of the project. Any change to those primary components can require corresponding changes to the properties or features of a set of interdependent support systems within the project. In SimVision, you show this kind of interdependency by adding a rework link between the driver task and the dependent task.

For example, a process plant produces gasoline from crude oil. The quantity and quality of the crude oil results in the selection and sizing of the catalytic cracker. Any change to the size or type of catalytic cracker might trigger corresponding changes in the design of pipelines, pumps, motors, and electricity supply. When modeling this project, you would link the catalytic cracker selection task with rework links to all tasks involved with pipelines, pumps, motors, and electricity supply. If an exception were detected in the catalytic cracker selection task, this would cause rework in all the tasks the selection task was linked to by rework links.

### Understanding Functional and Project Exceptions

There are two kinds of exceptions.
• **Functional Exceptions**—These are errors that are localized to a task and cause rework only in that task. Rework can arise from functional exceptions whether or not rework links are connected to the task. You can add contingency for functional exceptions in a project by setting the project functional error probability. See “Setting Functional Error Probability” on page 101.

• **Project Exceptions**—These are errors that cause rework in a task and in all dependent tasks to which it is linked with rework links. You can add contingency for project exceptions by setting the project error probability. It’s important to understand that rework can only arise from project error probability in the presence of rework links. Furthermore, rework only occurs in a task that has a rework link originating from it. See “Setting Project Error Probability” on page 102.

Exceptions can be generated for any task, and the likelihood that they will be is based on the VFP. Remember that VFP is affected by skill mismatches, the types of decisions made about task exceptions, and non-attendance of communications.

Whether an exception is a functional or a project exception, the way it is dealt with depends on the level of project centralization. Centralization influences which positions make the decisions in a project. If centralization is low, rework decisions can be evaluated by the responsible positions. If centralization is higher, the decision is more likely to be escalated to a supervisor somewhere in the hierarchy—a subteam leader if centralization is medium, and a project manager if centralization is high. For more information on setting project centralization, see “Setting Project Centralization” on page 96.

### Responding to Exceptions

There are three ways a decision maker can respond to an exception.

• **Rework the exception**—This means that the driver task has 100% of the current work item volume added to it. (This is 1 day or 1/20 of the tasks’ CPM duration, whichever is less.) Dependent tasks have a volume of rework added to them that is determined by the strength of the rework link. See “Setting Rework Link Strength” on page 75.

• **Execute a workaround, or quick fix**—The driver task has 50% of the current work item volume added to it. Dependent tasks have a volume of rework added to them that is determined by the strength of the rework link. See “Setting Rework Link Strength” on page 75.

• **Ignore the exception**—No rework is added to any tasks.
How a position responds to an error depends in part on the role of that position—PM (project manager), SL (subteam leader), or ST (subteam). If the position is a PM, decisions are generally quickly made in favor of rework. ST positions tend to take longer to make or receive decisions, which generates more coordination work. They also typically ignore errors.

Understanding Types of Work
In a project, positions are assigned responsibility for tasks. Based on this assignment, the simulation engine explicitly generates four streams of work for positions. These are:

- **Direct work**—Consumes a position’s time and reflects the match of that position’s skills and experience to activity requirements. Direct work, along with rework, is also the source of functional and project exceptions.

- **Rework**—Work that has to be redone on a task due to exceptions that occur in a task that is linked to it by a rework link. Rework occurs in the dependent task, or the task at the arrow end of the rework link.

- **Coordination**—Models information flow among positions. Coordination volume is measured as the sum of two different types of communication: one-to-one information exchange between positions or persons, and group meetings. Coordination is influenced by organization culture in terms of matrix strength. See “Setting Matrix Strength” on page 98.

- **Decision wait time**—Involves positions reporting exceptions to supervisors and supervisors making decisions on how to deal with the exceptions. The project team’s structure, functional organization structure, and the decision-making policy have direct impact on the reporting and decision-making behaviors. The time a position waits for a response from the supervisor about how to handle an exception, plus any time the position waits for exception resolution before making the decision by default. See “About Decision Wait Time and Decision Wait Volume” on page 51.

Connecting Tasks with a Rework Link
Rework links are red dashed lines with an arrow at the dependent task. This does not have to be the task that occurs first in time. Nor do the tasks have to be directly connected by a successor link, or even in the same project. However, they must be indirectly connected through another task or tasks, or by ghosts. For more information on connecting tasks in different projects, see “Connecting Projects with Ghost Tasks and Milestones” on page 257. The following procedure assumes that the tasks are in the same project.

If a rework link lies over or under another link, you can view the properties of each link by bringing it forward in the object order. For more information on the order of objects, see “Ordering Objects” on page 389. Alternatively, you can
select and reshape the link so that no two links lie along the same path. The following example shows rework links between directly and indirectly linked tasks. The rework links share space with communications links.

To connect tasks with a rework link

1. In the Model pane, right-click the task to link from.
   The right-click menu lists all the link types you can add to a task.

2. Click New Rework To.
   The New Link dialog box lists all the tasks you can add a rework link to.

3. Select the task to link to and click OK.
   The two tasks are linked with a rework (red dashed) link.

You can also add rework links using the Rework link shape, which allows you to choose where on the task shapes to attach the link. If you are adding multiple rework links between the same two tasks, you can help prevent confusion by adding the links between different shape targets.

To connect tasks with a rework link using the rework link shape

1. In the Model pane, display the project that contains the tasks.
2. On the Project Shapes toolbar, click Rework.
3. Click the driver task near any of its targets.
4. Click the dependent task near any of its targets.
   The tasks are joined by a dashed red rework link with an arrow at the dependent task.
Setting Rework Link Strength

The strength of a rework link determines how dependent the dependent task is on the driver task, and thus how much work is needed to rework the task. You can set rework link strength as an absolute volume of rework or as the percentage of the CPM volume of the dependent task that must be redone for each exception that occurs in the driver task. Thus, rework link strength has no effect on the driver task. If the dependent task is highly sensitive to changes in the driver task, you should assign a high strength to their rework link.

The default strength of a rework link is 10%, which means that 10% of each dependent task that is linked to the driver task with a rework link must be redone. This can work out to be quite a high value. For example, if the dependent task is a 200-day task, a rework link strength of 10% would generate 20 extra days of work for each exception reworked. You need to estimate the required strength based on the task volumes, the sensitivity of the work in the dependent task, and the Project Error Probability value.

To set the strength of a rework link
1. In the Model pane, select the rework (red dashed) link. The link’s properties appear in the Properties pane.
2. Under Units, select either % (to specify the strength as a percentage of the CPM volume of the dependent task that must be redone for each exception), or Minutes, Hours, Days, Weeks, or Months (to specify the strength as an absolute volume of rework).
3. Under Value, enter a percentage or absolute value for the rework link strength.

Adding Communications Links

When you add a communications link between two tasks, you are specifying that there is significant interdependence due to the activities involved in the tasks, and this leads to information exchange. A communications link indicates that the positions responsible for these tasks must communicate with each other to ensure that the choices made for each task are compatible. The position responsible for each task sends information to the other position throughout their task. The amount of communication between the positions is determined by the information exchange probability. So communications links define paths for the flow of communications, and the information exchange probability controls the flow of communications along those paths.

All tasks need some information exchange, but you only need to add communications links between tasks that have a significant need—for example, if the information exchange is required for successful completion of the project. In a typical project, this is 25-33% of task pairs.
Connecting Tasks with Communications Links

Communications links in SimVision are green dashed lines with a black arrowhead at either end. When you select a communications link, the Properties pane displays the names of the connected tasks in the Connected From and Connected To properties.

Tasks linked by communications links do not have to be in the same project. For more information on connecting tasks in different projects, see “Connecting Projects with Ghost Tasks and Milestones” on page 257. The following procedure assumes that the tasks are in the same project.

**Note:** As information exchange is increased, the duration of tasks linked by communications links also increases, and the project coordination volume goes up.

**To add a communications link between tasks**

1. In the Model pane, right-click the task to link from.
   - The right-click menu lists all the link types you can add to a task.
2. Click New Communications With.
   - The New Link dialog box lists all the tasks you can add a communications link to.
3. Select the task to link to and click OK.
   - The two tasks are linked with a communications (green dashed) link.

You can also add communications links using the Communications link shape, which allows you to choose where on the task shapes to attach the link. If you are adding multiple communications links between the same two tasks, you can help prevent confusion by adding the links between different shape targets.

**To add a communications link between tasks using the communications link shape**

1. In the Model pane, display the project that contains the tasks.
2. On the Project Shapes toolbar, click Communications.
3. Click the first task near the midpoint of a side.
4. Click the task that requires communication near the midpoint of a side.
   - The tasks are joined by a dashed green communications link with an arrow at both ends.
Setting Task Uncertainty Levels

Task uncertainty represents the extent to which information needed to complete a task is available at the time that the task starts. Uncertainty is affected by the level of communication required between positions about tasks that are linked with communications (green) links. You only need to set an uncertainty level for tasks that are connected by communications links.

Set the uncertainty level of a task to High if much of the important information needed for completion is unavailable when the task starts. For example, the missing information could be the output of a concurrent activity. Alternatively, the user might not yet have made a final decision about some key project properties. Or the missing information might relate to an unknown state of nature, such as geological or market conditions. Conversely, set a task’s uncertainty level to Low if most of the required information is available at the start of the task.

To set task uncertainty level

1. In the Model pane, select the tab of the project containing the task.
2. In the project, select the task.
3. In the Properties pane, set the task’s Uncertainty property to High, Medium, or Low.

Defining Meetings

Meetings are gatherings of positions to communicate about the project and project tasks. Generally, project meetings are regularly scheduled throughout the project’s life. Each meeting must have at least one participating position. A meeting can be triggered by a project milestone. You can specify a time lag, which is the amount of time after the milestone occurs that the meeting starts.

SimVision allows you to capture both the positive and negative effects of meetings. On the positive side, meetings allow specialists from different subteams to get together and coordinate their decision-making. This lowers the number of errors made by the meeting participants in their future work. On the negative side, meetings consume a lot of time for busy project participants. Also, if some participants miss a meeting, the value of the meeting is reduced both for the attending positions and for other positions that cannot properly coordinate with them. Thus, project and functional exception rates increase on subsequent work for participating positions that miss meetings.

Too many meetings can clutter up a model. It might help to add meetings between the two blue annotation bars so they are visually separated from the positions above and the milestones and tasks below. To further reduce model clutter, you
can add meetings and their participant links to a layer, then hide the layer and only show it when you need to. For more information, see “Using Layers in a Model” on page 324.

**Adding a Meeting to a Project**

You add meetings to the project tabs in the Model pane. Meetings are linked to positions by Meeting Participant links, which are gray dashed lines with an arrow at the meeting end. To best use Model pane space, it helps if you add all project meetings at one side of the model and at the same level as the positions they are connected to, as shown in the following example.

This section also covers renaming, moving, and deleting meetings. When you physically move a meeting shape, it remains linked to its participating positions. When you delete a meeting, you also need to delete any Meeting Participant links attached to it, unless you are moving the links to another meeting.

**To add a meeting to a project**

1. In the Model pane, click the tab for the project to which you want to add a meeting.
2. On the Project Shapes toolbar, click Meeting.
3. Click in the Model pane to place the meeting.
4. Use the positioning and alignment tools to accurately position the meeting. See “Positioning and Aligning Objects” on page 385.

**To rename a meeting**

1. Double-click the meeting to rename.
To move a meeting

• Drag the meeting to a new location in the Model pane.

Any links to the meeting stay connected and follow the meeting to its new location.

To delete a meeting

1 In the Model pane, select the meeting to delete.
2 Move any links associated with the meeting that you want to keep as links.
3 Press DELETE.

Assigning a Participant to a Meeting

To assign a position to a meeting, you link the position to the meeting with a Meeting Participant link. If the position is staffed and represents multiple persons, you can choose what percentage of the position’s FTEs attend the meeting. You specify this by assigning a number between 1 and 100 to the Allocation property of the Meeting Participant link. The default allocation of a meeting participant link is 100%, which means that all FTEs will attend the meeting. If the allocation is less than 100%, other team members are selected randomly for invitations. Over many trials in a simulation, this has the effect that each person attends some meetings. If the allocation strength does not evenly divide the staff, the fraction is ignored and a noncritical warning is issued at simulation time.

For example, suppose a position is staffed with 5 persons, the Meeting Assignment link’s allocation property is 75%, and there are 20 recurring meetings. For each meeting, the team leader is invited and two other members are randomly selected for invitation. The remaining (15%) fraction is ignored and a noncritical warning is issued on simulation. Over 25 trials, the leader gets 20 invitations and the other members get 9 or 10 each.

To assign a position to a meeting

1 In the Model pane, right-click the position to assign to the meeting.

The right-click menu lists all the link types you can add to a position.

2 Click New GoTo Meeting To.

The New Link dialog box lists all the meetings in the project.

3 Select the meeting to link to and click OK.

The position is assigned to the meeting with a Meeting Participant (grey dashed) link.
To set the level of meeting attendance for a position

1. In the Model pane, select the Meeting Participant (grey dashed) link. The link’s properties appear in the Properties pane.

2. Set a value for the Allocation property. To have all the position’s FTEs attend the meeting, leave the Allocation property set to 100. To have the team leader and a random selection of other team members attend, enter a number between 1 and 100.

Setting Meeting Properties

Meetings have the following properties:

- **Name**—Meeting names can contain any combination of text, numbers, and punctuation.

- **Description**—A more complete explanation of what a meeting is for. The description displays in the Meeting Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.

- **Priority**—Indicates how important this meeting is to the overall project. Meeting priority helps to define where the participating position will put its attention first, although this is also somewhat probabilistic. For example, positions and their staffing persons typically attend to work items, such as meetings, by priority about 50% of the time. At other times, they attend to a work item according to whether it was last or first in their inbox, or randomly. If a meeting has a high priority, it’s likely that the position will attend this meeting before doing other tasks, for example, communication and tasks with lower priority. The default meeting priority is medium.

- **Duration**—Indicates how long the meeting is scheduled to last in terms of minutes, hours, or days.

- **Repeating**—Indicates whether the meeting occurs more than once.

- **Meet Every**—The frequency with which the meeting occurs in terms of hours, days, weeks, or months.

- **Start Time**—The time of day the meeting starts, expressed as an absolute time.

- **First Meeting**—The date of the initial meeting in a series of scheduled meetings. You can specify this date as an absolute date or a date relative to a milestone or ghost milestone. It’s better to set relative meeting dates unless you have a compelling reason to set absolute dates. This allows for flexibility in the schedule.

- **Start Lag**—The time after the milestone or ghost milestone specified in the First Meeting property that the meeting starts. The start lag can be expressed in terms of minutes, hours, days, weeks, or months.
• **Schedule Till**—Used for meetings that are scheduled regularly throughout a project to specify whether the meetings will occur until the end of the project or until the date specified by the Last Meeting property.

• **Last Meeting**—The date of the last meeting in a series of scheduled meetings. Use this property if the value of the Schedule Till property is Till Date. You can specify the date as an absolute date or a date relative to a project milestone.

• **End Lag**—The time after the milestone or ghost milestone specified in the Last Meeting property that the last meeting starts. The last lag can be expressed in terms of minutes, hours, days, weeks, or months.

• **Chart Color**—The color that represents this meeting in the simulation charts. You can change the default color of each meeting.

• **Categories**—The category, if any, to which the meeting belongs. For more information, see “Using Categories” on page 271.

• **Hyperlinks**—You can add one or more hyperlinks to a meeting to link it to a URL or a file. For example, you might link to some documents pertaining to the meeting, or to a participant’s website. For more information, see “Adding Hyperlinks to Objects” on page 369.

### Example of Creating a Meeting

The following sample meeting is a sales meeting for the Eastern region sales reps that occurs every two weeks for three hours from 1-4pm. The first meeting occurs five days after the Ship milestone. (This is indicated by the First Meeting and Start Lag properties.) The meetings continue until the date of the Finish milestone. (This is indicated by the Last Meeting and End Lag properties.)

<table>
<thead>
<tr>
<th>Meeting</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Sales</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Eastern Region sales</td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>3</td>
<td>Hours</td>
</tr>
<tr>
<td>Repeating</td>
<td>yes</td>
<td></td>
</tr>
<tr>
<td>Meet Every</td>
<td>2</td>
<td>Weeks</td>
</tr>
<tr>
<td>Start Time</td>
<td>01:00 PM</td>
<td></td>
</tr>
<tr>
<td>First Meeting</td>
<td>Ship</td>
<td>Relative</td>
</tr>
<tr>
<td>Start Lag</td>
<td>6</td>
<td>Days</td>
</tr>
<tr>
<td>Schedule Till</td>
<td>Till Date</td>
<td></td>
</tr>
<tr>
<td>Last Meeting</td>
<td>Finish</td>
<td>Relative</td>
</tr>
<tr>
<td>End Lag</td>
<td>0</td>
<td>Days</td>
</tr>
<tr>
<td>Chart Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**To set meeting properties**

1. In the Model pane, select the meeting for the project.
The meeting’s properties display in the Properties pane.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Meeting</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>1</td>
<td>Hours</td>
</tr>
<tr>
<td>Repeating</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Meet Every</td>
<td>1</td>
<td>Weeks</td>
</tr>
<tr>
<td>Start Time</td>
<td>08:00 AM</td>
<td></td>
</tr>
<tr>
<td>First Meeting</td>
<td>Start</td>
<td>Relative</td>
</tr>
<tr>
<td>Start Lag</td>
<td>0</td>
<td>Days</td>
</tr>
<tr>
<td>Schedule Till</td>
<td>Till End</td>
<td></td>
</tr>
<tr>
<td>Last Meeting</td>
<td>Start</td>
<td>Relative</td>
</tr>
<tr>
<td>End Lag</td>
<td>0</td>
<td>Days</td>
</tr>
<tr>
<td>Default Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. To change the name, click in the Name property, select the old name and type a new one. To see the new name in the Model pane, click the renamed meeting.

3. To add a description, click in the Description property and type a brief description of the meeting.

4. To set the meeting priority, select Low, Medium, or High from the list.

5. To set a meeting duration, select a time unit from the Duration property’s Units list and type a number of time units in the Value box.

6. To set whether the meeting occurs more than once, select Yes or No for the Repeating property.

7. To set how often the meeting occurs, select a time unit from the Meet Every property’s Units list and type a number of time units in the Value box.

8. To set the start time of each meeting, type a time in the Start Time property’s Value box.

9. If the meeting is to be scheduled at regular intervals throughout the project, first select whether the first meeting starts on an absolute or relative date by doing one of the following:
   - To start the meetings on an absolute date, select Absolute from the First Meeting property’s Units list. Then click in the Value field and type the date.
   - To start the meetings on a date relative to a project milestone or ghost milestone, select Relative from the First Meeting property’s Units list. Then select the milestone from the list in the Value field.

10. If a regularly scheduled meeting starts a certain time after its relative milestone, use the Start Lag property to specify this time. Select the unit of time under Units, then select the number of units from the Value field.

11. For a regularly scheduled meeting, use the Schedule Till property to specify when the meetings end by doing one of the following:
   - To end the meetings at the end of the project, select Till End under Value for the Schedule Till property.
   - To end the meetings on a certain date, select Till Date.
12 If a regularly scheduled meeting ends on a certain date, use the Last Meeting property to specify that date. First select whether the meetings end on an absolute or relative date by doing one of the following:
   • To end the meetings on an absolute date, select Absolute from the Last Meeting property’s Units list. Then click in the Value field and type the date.
   • To end the meetings on a date relative to a project milestone or ghost milestone, select Relative from the Last Meeting property’s Units list. Then select the milestone from the list in the Value field.

13 If a regularly scheduled meeting ends a certain time after its relative milestone or ghost milestone, use the End Lag property to specify this time. Select the unit of time under Units, then select the number of units from the Value field.

14 To change the color that identifies the meeting in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.

15 To assign a category to a meeting, or change its category, click the lock by the Categories property to open it and indicate that the meeting category overrides the project category. Then click Edit by the Categories property, select a category in the Categories dialog box, and click OK.

16 To add a hyperlink to a meeting, click Edit by the Hyperlink property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.

17 To delete a hyperlink from a meeting, click Edit by the Hyperlink property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.
You can set a number of properties for each project in your model. These properties determine such factors as the priority of the project in relation to other projects and the number of hours in the project’s normal work day and week. Depending on the complexity of your model, you may need to change all of the project properties or only a few. You can set the following properties:

• Project name, description, priority, and other general properties.
• Organizational culture properties, such as centralization and matrix strength.
• Probability rates, such as the probabilities of information exchange and noise.
• Financial properties that track project costs and revenues.
About Project Properties

For most projects, you set a number of general properties such as the project’s name, description, priority, WBS, and chart color. You can also add one or more hyperlinks to the project object and assign it to one or more categories.

The remaining project properties fall into one of three distinct groups: organizational culture properties, probabilities, and financial properties. Organizational culture properties indicate how the organization that is performing the project tends to operate. You can use these properties to express how members of the organization tend to communicate with one another. Probabilities indicate the likelihood of certain types of errors occurring within the project. Financial properties track the costs and revenues associated with the project.

About Property Locks

Projects share a number of properties with programs. For example, you can set the centralization value at either the program or the individual project level. Such properties have a lock associated with them. A closed lock indicates that the property’s value has been set at the highest level, that is, the program level. An open lock indicates a property value override at a more granular level, such as the project, organization, or department level. For example, the following illustration
shows the project’s shared, or lockable properties. The Work Week property has been set at this level, overriding its value at the program level. This is indicated by the open lock beside the property.

For more information on overriding property locks, see “Using Property Locks” on page 248.

**Setting General Project Properties**

Project’s have the following general properties:

- **Project name, description, and priority**—See “Setting the Project Name, Description, and Priority” on page 88.
- **Work day**—See “Setting the Normal Work Day” on page 88.
- **Work week**—See “Setting the Normal Work Week” on page 89.
- **WBS** (Work Breakdown Structure)—See “Setting a Project’s WBS” on page 89.
- **Chart color**—See “Setting Project Chart Color” on page 89.
- **Categories**—See “Using Categories” on page 271.
- **Business drivers**—See “Adding Business Drivers to a Project” on page 90.
- **Revisions**—See “Tracking Project Revisions” on page 91.
- **Escalators**—See “Setting Project Salary Escalators” on page 93.
Setting the Project Name, Description, and Priority

Project names can contain any combination of text, numbers, and punctuation. If you change the name in the Properties pane and click in the Model pane, the project’s name changes on the project object and the project’s tab beneath the Model pane. The name also changes in the Tree pane.

The project’s description is a more complete explanation of the project than the name provides. The description displays in the Project Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.

Project priority indicates how important this project is to the overall program. The default priority is medium, but you can also set priority to high or low.

To set the project name, description, and priority

1. On the Model pane’s program page, select the project.
   - The project’s properties appear in the Properties pane.
2. Enter a project name in the Name property’s Value field.
3. Enter a project description in the Description property’s Value field.
4. Click under Value for the Priority property and select Low, Medium, or High.

Setting the Normal Work Day

You can set the number of hours in a normal work day. For example, on a fast-track project, you might need to set the work day to nine hours instead of the default eight. Or you might set the number to seven to allow for lunch breaks in an eight-hour day.

The Work Day property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set the normal work day for a project

1. On the Model pane’s program page, select the project.
   - The project’s properties appear in the Properties pane.
2. Under Units, open the Work Day lock by clicking it.
3. Click under Value for the Work Day property.
4. Type the number of hours in the normal work day.
Setting the Normal Work Week

You can set the number of days in a normal work week. For example, on a fast-track project, you might need to set the work week to six days instead of the default five.

The Work Week property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set the normal work week for a project
1. On the Model pane’s program page, select the project. The project’s properties appear in the Properties pane.
2. Under Units, open the Work Week lock by clicking it.
3. Click under Value for the Work Week property.
4. Type the number of days in the normal work week.

Setting a Project’s WBS

The Work Breakdown Structure is a scheme for naming projects, milestones, and tasks in a program. You can sort these objects by WBS in the Gantt and statistics charts and in Table View. To allow for sorting, you cannot mix alphabetic and numeric characters within a single field of the WBS. For example, “17.25.BD” is a valid WBS but “17A.1B” is not. The default field separator is a period, but you can choose a custom separator for your scheme, for example commas or colons, at the program level. See “Setting Program Properties” on page 249.

To set a project’s WBS
1. In the Model pane, select the project whose WBS you want to set.
2. In the Properties pane, enter the WBS, separating the fields with a period (the default separator) or with the separator you selected for the program.

Setting Project Chart Color

Chart color is the color that represents this project in the simulation charts. You can change the default color of each project. For example, if you are comparing project durations in the Program Gantt chart and two of the projects have similar colors, you might want to change one project’s color to better distinguish them.

To set a project’s chart color
1. In the Model pane, select the project whose chart color you want to change.
2. In the Properties pane, click the Chart Color property’s color swatch.
3. In the Color dialog box, select a color under Basic Colors and click OK.
Adding Business Drivers to a Project

A business driver is a factor that influences the project in some respect, such as a limitation on its duration. For example, a pharmaceutical project to develop a new cancer drug might be driven by the imminent release of a competitor’s drug. You could capture this factor as a business driver called Competitor Drug Release. Business drivers are text fields that you associate with projects; they have no effect on the simulation data. You track them in the Executive Dashboard, where you can sort projects within a portfolio by business driver. See “Using the Executive Dashboard” on page 308.

There are two steps to associating a business driver with a project. First, you create the business driver; then, you associate it with the project.

To create a business driver for a project

1. On the Program tab of the Model pane, select the project.
2. In the Properties pane, click Edit by the Business Drivers property.
   The Business Drivers dialog box lists any business drivers that have already been created for the project.
3. Click Add a Business Driver.
   The Business Driver List dialog box appears.
4. Click Add.
   A row is added for the new business driver.
5. Enter a name for the business driver, and a description if necessary.
6. Click OK.
To associate a business driver with a project

1. On the Program tab of the Model pane, select the project.
2. In the Properties pane, click Edit by the Business Drivers property.
   The Business Drivers dialog box displays the business drivers that have been created for the project.
3. Select the checkbox beside the appropriate business driver so it’s checked.
4. Click OK.
   The business driver is associated with the project.

Tracking Project Revisions

You can keep track of revisions made to a project and generate a Revision Report that lists all revisions, their dates, author, and details about them.

<table>
<thead>
<tr>
<th>Date</th>
<th>Author</th>
<th>Title</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/3/2004</td>
<td>Christopher Sayers</td>
<td>FTE increase</td>
<td>PM had 200 day backlog</td>
</tr>
<tr>
<td>12/3/2004</td>
<td>Jim Berryman</td>
<td>Added IT mg</td>
<td>Meeting required by John</td>
</tr>
<tr>
<td>12/3/2004</td>
<td>Alex Brewer</td>
<td>Salary change</td>
<td>Increased IT salaries</td>
</tr>
<tr>
<td>12/3/2004</td>
<td>Christopher Sayers</td>
<td>Work volumes</td>
<td>Added supervisory task to PM</td>
</tr>
</tbody>
</table>

You can also display revisions in a revision block, which you add as an annotation to a model and can print with the model. See “Adding Revision Blocks” on page 381. Revision reports are more comprehensive than revision blocks because they show more details about each revision and because you can generate them.
for organizations and for programs. Program revision reports list revisions made
to each project and organization within the program. See “Generating a Revision
Report” on page 384.

**To add or delete a project revision**

1. Below the Model pane, click the tabs for the appropriate case and project.
2. In the Properties pane, click the Revisions property’s Edit button.

   The Revision List dialog box appears, listing any existing revisions to the
   project.

3. To delete an existing revision, select it and click Delete Revision.
4. To add a revision, click Add Revision.

   A row is added for the new revision with the current date.

5. Enter a contact (for example, the model owner).
6. To change the date of the revision, click in the date field and use the up and
down arrows.
7. Enter an author, title, and description of the revision.
8. Click OK.

   The revision is stored with the project, though you don’t see it until you
   generate a Revision Report for the program or project.

**To generate a Project Revision Report**

1. Below the Model pane, click the tabs for the appropriate case and project.
2. Click anywhere in the project model.
3. On the Results menu, click Revision Report.

   The Revision Report lists all revisions to the project with their date, author,
title, and any notes detailing the changes made.
Setting Project Salary Escalators

Salary escalators allow you to vary salary rates over the lifetime of a project. They are thus particularly useful for long projects where payscales are likely to change. You set salary escalators as a factor of the salary, so you can reduce salaries as well as increasing them by setting a factor of less than 1 instead of greater than 1. You can also specify whether the escalation should occur annually or as a single escalation for the life of the project. For example, if the rate of inflation is 4% per year and you want all salaries in a 7-year project to rise accordingly, you would set the salary escalator for the project to 1.04 and have the escalator applied annually. If you just want salaries to rise by 10% over the life of the project, you would set the salary escalator to 1.1 and leave the Repeat Annually box unchecked.

Like salaries, salary escalators are expressed in generic currency units. You can set them for individual projects, organizations, departments, positions, or persons. The usual object hierarchies prevail. For example, when you set a position’s salary escalator, you are overriding any escalators set at the project or program level, so overrides to the escalator property locks apply at the upper levels and are indicated by open locks beside those properties. When you set a person's salary escalator, you are overriding any escalators set at the department or organization level. A project’s escalators affect only its unstaffed positions. Once positions are staffed, their persons use their own salary escalators or those of their department or organization, depending on whether overrides exist.

For more information on property overrides, see “About Property Locks” on page 86. The easiest way to see if there are escalator overrides in a program is to use Table View. Here, the Escalators column for each object will mark any overrides with open locks. See “Using Table View” on page 328.

To set a salary escalator for a project

1. On the Program tab of the Model pane, select the project.
2. In the Properties pane, click the lock by the Escalators property to open it and indicate that the project escalator overrides any escalator set for the program.
3. Click Edit by the Escalators property.
   The Escalators dialog box displays.
4. In the Escalators dialog box, click Add.
A new row appears for the escalator, with an escalation factor of 1, the current date, and annual repetition set as defaults.

5 Enter a unique name for the escalator.
6 Enter a description for the escalator.
7 Enter the escalation factor. For example, to increase the project’s salaries by ten percent per year, enter 1.1. To decrease it by five percent, enter 0.95.
8 Enter the date at which the escalation should be initiated.
9 Leave Repeat Annually selected if the escalation should occur per year. Deselect this option if the escalation is a one-time increase over the life of the project.
10 Click OK

Setting Organizational Culture Properties

Certain aspects of an organization’s culture tend to determine how it performs as a unit. In SimVision projects, four properties reflect this culture:

• **Team Experience**—The relative degree to which this project team has successfully performed related projects.

• **Centralization**—The qualitative degree to which decision-making and exception-handling responsibilities are decentralized to individual responsible positions (Low) or centralized to senior project managers (High).

• **Formalization**—The relative degree to which communication among positions takes place informally (Low) or through formal meetings and memos (High).
• **Matrix Strength**—The extent to which positions are located in skill-based functional departments and supervised directly by functional managers (Low) or co-located with other skill specialists in dedicated project teams and have project supervision from a project manager (High).

These properties affect project quality and duration. They are interrelated with the levels of communication links and meetings, numbers of exceptions generated, and the resulting levels of coordination and rework. You should keep the values of these properties the same for the project and the organizations involved. However, there can be business or historical reasons for them to differ.

**Setting Team Experience**

Team experience is a measure of how successfully the team has performed related projects. The team experience value contributes to the way a position’s information processing speed is calculated. Other factors are the position’s own application experience, skill set, skill levels, and the task’s requirement complexity.

For more information on these related properties, see “Setting Position Properties” on page 47 and “Setting Task Properties” on page 36.

Team experience also affects the amount of information exchange on the project. If an organization has previous experience with this kind of project, there is less need for communication, and you should set the team experience to High. If the organization does not have previous related experience, more coordination is needed and more communication will be generated in the simulation. In this case, set the team experience to Low.

The Team Experience property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information on locks, see “Using Property Locks” on page 248.

**To set project team experience**

1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   
   The project’s properties appear in the Properties pane.
3. Under Units, open the Team Experience lock by clicking it.
4. Under Value by the Team Experience property, select High, Medium, or Low.
Setting Project Centralization

Centralization reflects whether decisions are made by senior project positions or decentralized to individual responsible positions. High project centralization means decisions are made by high-level positions. With low centralization, responsible positions tend to make their own decisions and there is thus less communication required.

High centralization tends to increase project duration because there is more rework requested by managers. However, high centralization also tends to improve project quality. Conversely, low centralization speeds up a project but reduces quality due to a high level of decisions to ignore exceptions.

Another factor that interrelates with high centralization is the backlog that applies to high-level positions. For example, if the project manager's backlog is very high, the response to exceptions will be delayed. In a highly centralized organization, this will slow performance of tasks as individual positions wait for the backlogged manager's response. For more information on checking position backlog, see “Analyzing Position Backlog in a Project” on page 203.

The Centralization property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set project centralization

1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project's properties appear in the Properties pane.
3. Under Units, open the Centralization lock by clicking it.
4. Under Value by the Centralization property, select High, Medium, or Low.

Setting Project Formalization

Formalization is a measure of how formal the communication is in an organization. High formalization means communication tends to occur in formal meetings. With low formalization, it’s more common for communication to occur informally between positions. Combined with the information exchange probability, the formalization setting affects the probability that a communication will be generated across a communications link. The probability is calculated as follows:

\[
1 - e^{-\lambda T}
\]

In the Model pane, display the program by clicking the program tab.

Select the project icon.

The project's properties appear in the Properties pane.

Under Units, open the Centralization lock by clicking it.

Under Value by the Centralization property, select High, Medium, or Low.
• **High formalization**—This means that only half of the exchanges predicted by the information exchange probability will occur. For example, suppose the Info Exchange Probability setting is 0.3, meaning that on any given day there is a 30% chance that workers will need to communicate about their tasks linked with communications links. A high Formalization setting will decrease the probability of such communications to 15%.

• **Medium formalization**—This means that the level of communication predicted by the information exchange probability will occur. For example, if the Info Exchange Probability setting is 0.3, then there remains a 30% chance that on any day, workers will communicate about their tasks linked with communications links.

• **Low formalization**—This means that double the number of exchanges predicted by the information exchange probability will occur. For example, if the Info Exchange Probability setting is 0.3, a low Formalization setting will increase the probability of communications to 60%.

The Formalization property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

**To set project formalization**

1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project’s properties appear in the Properties pane.
3. Under Units, open the Formalization lock by clicking it.
4. Under Value by the Formalization property, select High, Medium, or Low.

**Formalization and the VFP**

The VFP (Verification Failure Probability) is the likelihood that an exception will be generated for a task. Therefore, a high VFP is a high probability of failure, which is undesirable. Bearing in mind that formalization measures the formality of an organization’s communications, the Formalization setting affects task VFP as follows:

• **High formalization, successful communications**—Workers communicating informally about a task modestly decreases its VFP, whereas workers attending formal meetings significantly decreases it.

• **High formalization, ignored communications**—Workers ignoring informal communications about a task modestly increases its VFP, whereas workers failing to attend formal meetings significantly increases it.
• **Low formalization, successful communications**—Workers communicating informally about a task significantly decreases its VFP, whereas workers attending formal meetings modestly decreases it.

• **Low formalization, ignored communications**—Workers ignoring informal communications about a task significantly increases its VFP, whereas workers failing to attend formal meetings modestly increases it.

### Setting Matrix Strength

Matrix strength models the “connectedness” of an organization by setting the probability that workers will attend to exchanges of information. The three types of information exchange that SimVision models are meetings, communications about tasks, and noise. Organization connectedness often corresponds to how close the workers are geographically. For example, if everyone is working in one large room, communication will typically be informal with little need for formal meetings. If workers are distributed across the country, there will be a greater need for meetings and fewer communications in the hallways or across the room.

You can set matrix strength to High, Medium, or Low according to the connectedness of the organization, as follows:

• **High matrix strength**—This means workers attend to information exchange and have a lower perceived need to go to meetings. The typical structure of an organization with high matrix strength is skilled positions in dedicated project teams that are supervised at a project level by a project manager. The actual calculations that the simulator makes for high matrix strength is that workers attend 60% of their meetings and take care of 90% of their informal communications.

• **Medium matrix strength**—This means that workers make approximately equal amounts of formal and informal communications. The actual calculations that the simulator makes for medium matrix strength is that workers attend to 70% of both their formal and informal communications.

• **Low matrix strength**—This means workers attend more meetings and tend to ignore information exchange. The typical structure of an organization with low matrix strength is positions in skill-based, functional departments supervised directly by functional managers. The actual calculations that the simulator makes for low matrix strength is that workers attend 90% of their meetings and take care of 60% of their informal communications.

Positions in an organization with high matrix strength tend to engage in more informal communication, so high matrix strength complements low formalization. Where there is low matrix strength, positions tend to have more formal meetings, so low matrix strength complements high formalization. Low matrix strength assumes high meeting quality.
The Matrix Strength property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

**To set project matrix strength**
1. Display the program in the Model pane by clicking the program tab.
2. Select the project icon.
   - The project’s properties appear in the Properties pane.
3. Under Units, open the Matrix Strength lock by clicking it.
4. Under Value by the Matrix Strength property, select High, Medium, or Low.

### Setting Probability Rates

Probability rates specify the likelihood of distractions such as the exchange of information, telephone calls, impromptu meetings, and rework caused by failed tasks. These characteristics of a project are often the hardest to predict, yet they affect the outcome most dramatically. When you simulate the model with probability rates set, the simulator checks for functional errors, project errors, information exchange, and noise each time a position completes a subtask (also known as a work item). A subtask is defined as part of a task’s work volume that takes no longer than a day and no shorter than a minute. If a task is shorter than 20 days and longer than 20 minutes, a subtask represents 5% of the task volume. If the task is longer than 20 days, the simulator divides it into subtasks such that no subtask is longer than a day. Similarly, if the task is shorter than 20 minutes, the simulator divides it into subtasks such that no subtask is shorter than a minute.

### Setting Information Exchange Probability

The information exchange probability measures the level of communication in the project between positions that are responsible for tasks linked by communications (green) links. You set the information exchange probability for the project as a whole. The total volume of communication in a project is a combination of the number of communications links you set up between tasks, the duration of the tasks, and the information exchange probability setting.

For example, if the information exchange probability is set to 0.5 and a 100-day task has one communications link to another task, there will be 50 communications during the task duration.
The information exchange probability is typically set in the range 0.2 to 0.9. Set a low value if the project involves a high level of routine jobs performed by skilled workers. Set a high value if the project involves many highly interdependent tasks that are being performed by less skilled or very busy workers. For example, an information exchange probability of 0.3 means that on any given day there is a 30% chance that the worker will need to communicate something about the work in progress with the position responsible for the linked task.

The setting you choose for this probability should thus take into account the industry, job complexities, and usual rates of communication of this project or other projects like it.

The Information Exchange Probability property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set project information exchange probability

1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project’s properties appear in the Properties pane.
3. Under Units, open the Info. Exchange Prob. lock by clicking it.
4. Type a value for the Info Exchange Prob. property. A recommended starting point is 0.3.

Setting Noise Probability

Noise is a way to measure the effect of interruptions in the ordinary working day that take time away from doing the project tasks. In any real organization, noise can include distractions like a salesperson calling to sell insurance, a request for help from a peer, a discussion of last night’s football game, or work related to another project. The probability of noise is generally in the range 0.01 (low) to 0.10 (significant, but common). If the probability rate is greater than 0.20, more rework will be generated and the project might finish later.

The Noise Probability property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.
To set noise probability
1 In the Model pane, display the program by clicking the program tab.
2 Select the project icon.
   The project’s properties appear in the Properties pane.
3 Under Units, open the Noise Prob. lock by clicking it.
4 Type a value for the Noise Prob. property. A recommended starting point is 0.1.

Setting Functional Error Probability
Functional error probability is the probability that a task will fail and require rework. Functional errors are errors that are localized to a task and cause rework only in that task by the responsible position. Functional error probability can generate rework even if there are no rework links originating from the task.

Functional errors might be discovered by a self-check procedure, a peer review, or a supervisor’s review. When a functional error is detected, an exception is sent to the responsible position or to a supervisor, depending on the level of centralization in the project. The responsible position can take the following actions with functional exceptions:

• Rework
• Quick fix
• Ignore
For more information on these actions, see “Responding to Exceptions” on page 72.

Functional error probability is typically set in the range 0.05 to 0.10. Set a low value if the project involves relatively well-understood technology and standard work processes. Set a high value if the project involves unproven technology or innovative work processes.

The Functional Error Probability property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set functional error probability
1 In the Model pane, display the program by clicking the program tab.
2 Select the project icon.
   The project’s properties appear in the Properties pane.
3 Under Units, open the Functional Error Prob. lock by clicking it.
Project error probability is the probability that a task will fail and generate rework for all dependent tasks connected to it by rework links. It is important to understand that, unlike functional error probability, project error probability only generates rework in the presence of rework links. The more rework links there are in a project, the more rework is generated by the exceptions that occur. Total project error work volume, therefore, depends on both the project error probability and the number of rework links in the project. Even if you set a high project error probability, if there are no rework links originating from a task, it cannot generate project exceptions.

When a project error is detected, an exception is sent to the position responsible for the failed task. The responsible position can take the following actions with project exceptions:

- Rework
- Quick fix
- Ignore

For more information on these actions, see “Responding to Exceptions” on page 72.

Project Error probability is typically set in the range 0.05 (low) to 0.10 (significant but common). Set a low value if the project involves relatively standard tasks and routine work processes. Set a high value for nonstandard tasks and innovative work processes. If the probability is greater than 0.20, rework generated could be substantial enough to prevent the project from ever finishing.

The Project Error Probability property can be set at the program level for all projects in a program. For this reason, the property is locked at the project level, as indicated by the closed lock beside it in the Properties pane. You can override the program setting by unlocking the property and setting it for an individual project. You can also return the property to its program-level value by relocking the property. For more information, see “Using Property Locks” on page 248.

To set project error probability

1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project’s properties appear in the Properties pane.
3. Under Units, open the Project Error Prob. lock by clicking it.

4. Type a value for the Functional Error Prob. property. A recommended starting point is 0.1.
Modeling Project Finances

SimVision tracks and provides detailed breakdowns of the costs and revenues associated with a project. You can capture cost and revenue amounts at several levels:

- **For projects**—See “Tracking Project Costs” on page 103 and “Tracking Project Revenues” on page 104.
- **For individual milestones**—See “Setting Milestone Properties” on page 30.
- **For individual tasks**—See “Setting Task Properties” on page 36.
- **For programs**—See “Setting Program Properties” on page 249.

The financial data that a simulation produces is displayed in the following charts:

- **The Finance charts**—These charts show cost and revenue in a timeline over the life of the program, project, or task. See “Analyzing the Project Financial Charts” on page 216.
- **The Financial Statistics charts**—These charts show financial data for programs and projects. “Reading a Project’s Financial Statistics Chart” on page 229 and “Reading a Program’s Financial Statistics Chart” on page 292.
- **The object Statistics charts**—These charts contain some financial data for the program, project, milestone, or task. See “Reading the Project Statistics Charts” on page 221 and “Reading the Program Statistics Charts” on page 287.

Tracking Project Costs

Costs are broken down into labor costs—that is, salaries—and nonlabor costs incurred by milestones or tasks, such as fees, penalties, materials, or payments. Both kinds of costs are expressed in generic currency units.

Labor costs are calculated as the salaries of positions and persons multiplied by the work volume of the tasks they are assigned. For information on setting salaries, see “Setting Position Properties” on page 47 and “Defining Persons” on page 117. Work, rework, coordination, and decision costs are also considered part of labor costs. See “Understanding Types of Work” on page 73.

You identify nonlabor costs in three ways:

- **Fixed cost**—A fixed costs is a one-time cost associated with the project. For example, a hardware installation project might have as a fixed cost the price of the hardware.
• **Cost rate**—The cost rate represents cumulative costs per specified unit of time. For example, a building construction project might accumulate equipment rental fees over a period of months. Thus, the cost rate of the project might be 10,000 per month for these fees.

• **Actual cost**—A placeholder value for comparing actual to projected costs for the project. This value is ignored by the simulator but appears in the Project Statistics chart, where you can compare it to the Total Cost value for the project.

**To set a project’s cost properties**
1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project’s properties appear in the Properties pane.
3. To apply a fixed cost to the project, enter a value for the Fixed Cost property. The value is measured in currency units, so there is no need to enter a currency symbol. Also, although the fixed cost is a negative amount in terms of project finances, the minus sign is assumed.
4. To apply a cost rate to the project, first select the unit by which the cost will be incurred. For example, if project materials cost $3,300 per week, select Weeks under Units. Then enter the amount incurred per unit of time. For this example, you would enter 3300. Do not use a comma or currency symbol.
5. To be able to compare actual with projected costs in the simulated financial data, enter an actual cost value for the project.

**Tracking Project Revenues**
You identify project revenues in three ways:

• **Fixed revenue**—Fixed revenue is the revenue that projects, tasks, and milestones generate. For example, a housing development project might generate 10 million in revenue when the tract is complete.

• **Revenue rate**—Revenue rates are associated with projects and tasks and represent cumulative revenues per specified unit of time. For example, an oil drilling project might generate revenue for every day that oil is produced. Thus, the revenue rate might be 50,000 currency units per day.

• **Actual Revenue**—A placeholder value for comparing actual to projected revenue for the project. This value is ignored by the simulator but appears in the Project Statistics chart, where you can compare it to the Total Revenue value for the project.

**To set a project’s revenue properties**
1. In the Model pane, display the program by clicking the program tab.
2. Select the project icon.
   The project’s properties appear in the Properties pane.
3 To apply a fixed revenue to the project, enter a value for the Fixed Revenue property. The value is measured in currency units, so there is no need to enter a currency symbol.

4 To apply a revenue rate to the project, first select the unit by which the revenue will be accrued. For example, if a revenue stream is $1,000 per week, select Weeks under Units. Then enter the amount accrued per unit of time. For this example, you would enter 1000. Do not use a comma or currency symbol.

5 To be able to compare actual with projected revenue in the simulated financial data, enter an actual revenue value for the project.
CHAPTER 4

Staffing A Project

Staffing a project means assigning persons, real or generic, to the project’s positions. It is possible, and in some cases preferable, to avoid staffing a project until very late in the modeling process, or to staff partially by assigning person FTEs (full-time equivalents) to the positions but not actual person names. It is even possible not to assign persons to positions at all. This section discusses the advantages and disadvantages of staffing, and explains how to do it.

Before you can staff a project, you must define the persons that belong to the organization. After you have defined the persons, you assign them to positions. This section covers the following areas:

• Staffing pros and cons.
• Defining organizations, departments, subdepartments, and persons.
• Staffing positions with persons.
• Troubleshooting staffing problems using the Staffing Report.
Staffing Pros and Cons

You can avoid staffing a project until very late in the process, staff the project partially, or even avoid staffing altogether. The disadvantage of leaving projects unstaffed is that you can’t move actual people around among positions to make better use of the available staff. The advantage of staffing late in the project is that you can figure out exactly how many FTEs you need in each position and what their skills and experience need to be. This makes it simpler to staff the project.

Another practical consideration when staffing is that it can be politically sensitive to apply skill and experience levels to people in a situation where many people will have access to the model data. For this reason, many project managers prefer to simulate their projects using Medium skill levels for all positions and persons, and refining the levels only when the model requires such an intervention.

Defining Organizations

An organization is a hierarchy of departments, subdepartments, and persons. For the baseline model, this hierarchy should represent as closely as possible the organizational matrix of the project being modeled. However, organization design is more oriented towards function than dependent on the project. As you refine the model, you can work towards designing more function-oriented organizations. Before defining the organizations in SimVision, use the “Organization Form” on page 398 to capture the organization structure you are modeling.

Adding Organizations to a Model

When you create the baseline model, you work with positions, which are virtual sets of persons, and you model a virtual project. As you refine the model, you can add organizations and staff their departments with real persons with their own skills and application experience. See “Staffing the Project” on page 121.

This section covers adding an organization to a project, and renaming, moving, and deleting organizations. You can create multiple organizations easily with the Rubber Stamp tool. See “Adding Multiple Copies of Objects” on page 26. Whether new organizations are empty or contain default departments depends on a setting in the Options dialog box. See “Setting Options for New Models” on page 362.
When you physically move an organization shape, it remains linked to any projects it is connected to. To assign an organization to a different project, you must move the appropriate Organization Assignment link. When you delete an organization, you also need to delete any links attached to it, unless you are moving the links to another organization.

When you have multiple organizations, you can change the order of their tabs beneath the Model pane. Organization tabs are green and are to the right of the program and project tabs.

**To add an organization to a project**
1. In the Model pane, click the Program tab.
2. In the Program Shapes toolbar, click Organization.
3. Click in the Model pane to place the organization. It doesn’t matter where you place it, as you actually define its structure on the Model pane’s Organization page. This page appears as soon as you place the organization icon.
4. Type a new organization name. If the name is too long for the shape, resize the shape by dragging a corner. The text wraps to fill the re-sized shape.

**To rename an organization**
1. Double-click the organization to rename.
2. Type the new name.
3. Click elsewhere to apply the name.

**To move an organization**
- Drag the organization to a new location in the Model pane.
Any links to the organizations stay connected and follow the organization to its new location.

**To delete an organization**

1. In the Model pane, select the organization to delete.
2. Move any links associated with the organization that you want to keep as links.
3. Press CTRL+DELETE to delete the organization and all remaining links.

**To reorder organization tabs**

- Under the Model pane, click and drag the green organization tabs until they are in the desired order.

### Setting Organization Properties

Organizations share three properties with programs: Centralization, Formalization, and Matrix Strength. These properties can be set at either the program or the individual organization level. When you set a property at the organization level, it overrides the program-level setting. An open lock beside the property in the Properties pane indicates that an override exists. When you set a property at the program level, it sets the property for all organizations, unless there is an override at the organization level.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centralization</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Formalization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Matrix Strength</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Chart Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Revisions</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Escalation</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>

Organizations have the following properties:

- **Name**—Organization names can contain any combination of text, numbers, and punctuation.

- **Description**—An explanation of the nature of the organization. The description displays in the Organization Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.
• **Centralization**—The qualitative degree to which decision-making and exception-handling responsibilities are decentralized to individual responsible positions (Low) or centralized to senior project managers (High). See the Formalization property next.

• **Formalization**—How formal communication is. For example, for a contract organization, you would set the formalization to high and the centralization to low. This would give the organization a high level of communication between peers and a small number of top-level positions with the majority of the information.

• **Matrix Strength**—The extent to which positions are located in skill-based functional departments and supervised directly by functional managers (Low) or co-located with other skill specialists in dedicated project teams and have project supervision from a project manager (High). Organization matrix strength is similar to project matrix strength. For more information, see “Setting Matrix Strength” on page 98.

• **Chart Color**—The color that represents this organization in the simulation charts. You can change the default color of each organization.

• **Categories**—The category, if any, to which the organization belongs. For more information, see “Using Categories” on page 271.

• **Revisions**—Tracks changes made to each organization in the program by date, author, title, and any details the modeler wants to record about the changes. You can generate a Revision Report for the organization the same way as for an individual project. See “Tracking Project Revisions” on page 91.

• **Escalators**—A mechanism for varying the organization’s salary rates over the program’s lifetime. You set salary escalators for an organization the same way as for a project. See “Setting Project Salary Escalators” on page 93.

• **Hyperlinks**—You can add one or more hyperlinks to an organization to link it to a URL or a file. For example, you might link to a document that shows the organization’s structure. For more information on adding hyperlinks to shapes, see “Adding Hyperlinks to Objects” on page 369.

**To set organization properties**

1. On the Model pane’s program page, select the organization.
The organization’s properties display in the Properties pane.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Centralization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Formalization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Matrix Strength</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Chart Color</td>
<td></td>
<td>#000000</td>
</tr>
<tr>
<td>Categories</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Revisions</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Escalators</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2 To change the name, click in the Name property, select the old name and type a new one. To see the new name in the Model pane, click the renamed organization.

3 To add a description, click in the Description property and type a brief description of the organization.

4 To set Centralization at the organization level, open the lock by clicking it and select High, Medium, or Low under Value.

5 To set Formalization at the organization level, open the lock by clicking it and select High, Medium, or Low under Value.

6 To set Matrix Strength at the organization level, open the lock by clicking it and select High, Medium, or Low under Value.

7 To change the color that identifies the organization in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.

8 To add the organization to a category or change its category, click Edit by the Categories property, select a category in the Categories dialog box, and click OK.

9 To document a revision to the organization, click Edit by the Revisions property, click Add Revision in the Revisions List dialog box, enter the revision details, and click OK.

10 To set a salary escalator for the organization, click the lock by the Escalators property to open it and indicate that the organization escalator overrides the program escalator. Then click Edit to set the escalator. See “Setting Project Salary Escalators” on page 93.

11 To add a hyperlink to the organization, click Edit by the Hyperlinks property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.

12 To delete a hyperlink from the organization, click Edit by the Hyperlinks property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.
Defining a Department

The department is the major building block of an organization and contains a list of persons. When there is more than one person in a department, there must be a designated department head. This is the supervisor in the department, the person to whom the other persons go for decisions and error resolutions. By default, this is the first person you add, but you can designate a new department head at any time. See “Defining Persons” on page 117.

When you first create an organization, it has a default department. For the baseline model, start by renaming that department, then create more departments using the Rubber Stamp tool. See “Adding Multiple Copies of Objects” on page 26.

This section also covers moving, deleting, and adding a description to departments. The description appears on the Department Statistics chart when you run a simulation. When you physically move a department shape, it remains linked to any other departments or subdepartments. To assign a department to a different subdepartment, or as a subdepartment to a different department, you must move the appropriate subdepartment link. When you delete a department, you also need to delete any links attached to it, unless you are moving the links to another department.

To rename the default department

1. In the Model pane, click the Organization tab.

   The default organization appears, with a default department, Department1.

2. Double-click the department so its name is highlighted.
3. Type a new department name. If the name is too long for the shape, resize the shape by dragging a corner. The text wraps to fill the resized shape.
4. Click elsewhere to apply the name.

To create a new department

1. In the Model pane, click the Organization tab.
2. In the Organization Shapes toolbar, click Department.
3. Click in the Model pane where you want to place the new department.

   The department properties appear in the Properties pane.
4. Double-click the department so its name is highlighted.
5. Type a new department name. You can also do this by replacing the name in the Properties pane.
6. Click elsewhere to apply the name.
To move a department

- Drag the department to a new location in the Model pane.

Any links to the department stay connected and follow the department to its new location.

To delete a department

1. In the Model pane, select the department to delete.
2. On the Edit menu, click Cut.

The department and all its subdepartments are deleted.

To add a department description

1. In the Model pane, select the department.
2. Click in the Description box in the Properties pane.
3. Type the description.

Setting Department Properties

Like all SimVision objects, a department has a set of properties. These properties determine such factors as the color that represents the department in the simulation charts, and the persons in the department.

You can set the following properties for each department in your model:

- **Name**—A short title for the department. Department names can contain any combination of text, numbers, and punctuation.

- **Description**—A further explanation of the function of the department. The description can contain any combination of text, numbers, and punctuation, and displays in the Department Statistics chart when you run a simulation.

- **Chart Color**—The color that represents this department in the simulation charts. You can change the default color of each department.

- **Person List**—The persons in the department.

- **Categories**—The category, if any, to which the department belongs. For more information, see “Using Categories” on page 271.

- **Escalators**—A mechanism for varying salary rates within the department over the program’s lifetime. You set salary escalators for a department the same way as for a project. See “Setting Project Salary Escalators” on page 93.

- **Hyperlinks**—You can add one or more hyperlinks to a department to link it to a URL or a file. For example, you might link to some documents pertaining to the department, or to a vendor’s Web site. For more information on adding hyperlinks to shapes, see “Adding Hyperlinks to Objects” on page 369.
To set department properties

4. In the Model pane, select the department whose properties you want to set. The department’s properties display in the Properties pane.

<table>
<thead>
<tr>
<th>Department</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chart Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Person List</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Categories</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Escalators</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>

5. To change the name, click in the Name property, select the old name and type a new one. To see the new name in the Model pane, click the renamed department.

6. To add a description, click in the Description property and type a brief description of the department.

7. To change the color that identifies the department in the simulation charts, click the color swatch, select a new color in the Color dialog box, and click OK.

8. To add or remove persons from the department, or edit the existing persons’ properties, right-click the department and click Person List. The first person you add is, by default, the department head. For more information, see “Staffing the Project” on page 115.

9. To add the department to a category or change its category, click Edit by the Categories property, select a category in the Categories dialog box, and click OK.

10. To set a salary escalator for the department, click the lock by the Escalators property to open it and indicate that the department escalator overrides any escalators set for the parent organization. Then click Edit to set the escalator. See “Setting Project Salary Escalators” on page 93.

11. To add a hyperlink to the department, click Edit by the Hyperlinks property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.

12. To delete a hyperlink from the department, click Edit by the Hyperlinks property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.
Defining Subdepartments

You define a subdepartment by linking two regular departments with a subdepartment link. Subdepartment links are pink and have an arrow at one end. The department at the arrow end is the subdepartment, as shown in the following example. Subdepartments have the same properties as departments.

To define a subdepartment

13 On the Organization Shapes toolbar, click Subdepartment.

14 In the Model pane, click the top-level department at the midpoint of a side. Notice how the cursor snaps to the midpoint, or target.

15 Click the subdepartment on a target. The cursor should change to a circle with cross hairs when you hover over a target. The departments are joined by a pink line with an arrow at the subdepartment.
Defining Persons

In SimVision, you define a list of persons as part of a department in an organization, using the Person List dialog box. For this reason, persons are not represented graphically in the Model pane like milestones, tasks, and positions, but are listed with their properties in the Person List dialog box, as shown here.

If there are multiple persons in the department, the first person you add to a department is the default department head, denoted by the blue star as shown beside Ethan Holt in the illustration. The department head is the department supervisor. You can make any person department head by double-clicking their row in the Person List dialog box. In a one-person department, you cannot designate a department head because there is no-one to supervise and therefore no need for one. You can sort any column in the Person List dialog box by double-clicking on the column head.

Note: Although persons are represented by real persons in the client organizations, a person is still considered as an object in the SimVision model. For this reason, this Guide refers to a person as “it” and not “he” or “she.”

Setting Person Properties

A person has the following properties:

- **Name**—Names can contain any combination of text, numbers, and punctuation.
- **Description**—An explanation of the person’s role in the project. The description displays in the Person Statistics chart when you run a simulation and can contain any combination of text, numbers, and punctuation.
• **Application Experience**—How experienced the person is with this type of project, expressed as Low, Medium, or High.

• **FTE**—Whether the person works full time or part time. The default is 1, which means full time. A value less than 1 means part time. A person can also represent several FTEs, in which case its FTE value is greater than 1. Note that if you change the number of FTEs assigned to a person, this will have an effect everywhere the person is used to staff a position.

• **Salary**—The person’s hourly wage.

• **Chart Color**—The color that represents the person in the simulation charts. You can change a person’s chart color at any time.

• **Skill Set**—Defines the set of skills the person has and also the level of each skill. See “Defining a Person’s Skill Set and Skill Levels” on page 120.

• **Categories**—The category, if any, to which the person belongs. To apply a category to a person, you must override the category of the department that the person belongs to. You must do this even if the department does not yet have a category applied to it, so that if you later decide to apply a category to the department, the person override persists. For more information, see “Using Categories” on page 271.

• **Inherit Categories**—The lock that shows whether the person’s category is overriding a category set for the department to which the person belongs.

• **Escalators**—A mechanism for varying the person’s salary rates over the program’s lifetime. For more information on escalators and how to set them, see “Setting Project Salary Escalators” on page 93.

• **Inherit Escalators**—The lock that shows whether the person’s salary escalator is overriding a salary escalator set for the department to which the person belongs.

• **Hyperlinks**—You can add one or more hyperlinks to a person to link the person to a URL or a file. For example, you might link a person to a resume. For more information on adding hyperlinks to objects, see “Adding Hyperlinks to Objects” on page 369.

Like all objects, persons have an ID that must be unique. You can see person IDs on the organization’s Person tab in Table View. See “Viewing Properties in Table View” on page 329.

### To add a person to a department

1. In the Model pane, click the tab of the organization to which you want to add a person.
2. Right-click the department to which you want to add the person, and click Person List.
3. In the Person List dialog box, click Add Person.
Staffing A Project

A new person appears in the list. If this is the first person to be added to the department, a blue star indicates that this person is the default department head.

4 To name the person, select the default name and type a new name.
5 Type a description if required. You can use this field for notes about the person, such as special skills or knowledge.
6 Select an application experience level of Low, Medium, or High.
7 To specify the number of FTEs assigned to the person, type a number under FTE. For example, for a half-time person, type 0.5. For a person representing 3 FTEs, type 3.
8 Type an hourly salary in currency units.
9 To change the person’s chart color, click the Chart Color property’s color swatch, select or create a color, and click OK.
10 To edit the person’s skill set, click Edit under Skill Set. See “Defining a Position’s Skill Set and Skill Levels” on page 64.
11 To add the person to a category or change its category, click the lock under Inherit to the right to open it and indicate that the person category overrides the department category. Then click Edit under Categories, select a category in the Categories dialog box, and click OK.
12 To set a salary escalator for the person, click the lock under Inherit to the right to open it and indicate that the person escalator overrides the department escalator. Then click Edit to set the escalator. See “Setting Project Salary Escalators” on page 93.
13 To add a hyperlink to the person, click Edit under Hyperlinks. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename, and add a description if necessary. Click OK.
14 To delete a hyperlink from a person, click Edit under Hyperlinks. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.
15 Click OK in the Person List dialog box.

To delete a person from a department
1 In the Model pane, click the tab of the organization from which you want to delete a person.
2 Right-click the department from which you want to delete the person, and click Person List.
3 In the Person List dialog box, select the row of the person you want to delete.
4 Click Delete Person.
   The person disappears from the dialog box.
5 Click OK.

To change the department head
1 In the Model pane, click the tab of the organization that contains the department to which the person belongs.
Defining a Person’s Skill Set and Skill Levels

The Skill Set displays the skills that this person has available and the skill level or strength in each of these skills. Each program has a set of skills. Each person can have a subset of these skills. Before you staff a project, you can define skill sets for positions. Because persons are not represented as components in the model, but are part of departments, you edit a person’s skill set by editing the appropriate department. To check which department a person belongs to, you can use the Find Person. See “Searching for a Person” on page 135.

**To edit a person’s skill set**

1. In the Model pane, select the tab for the organization that contains the person’s department.
2. Right-click the person’s department, and click Person List.
3. In the Person List dialog box, click Edit under Skill Set for the person.
   - The Skill Set dialog box lists the project’s skill set with check marks beside the skills that are currently in the person’s skill set.
4. To add a skill to the person’s skill set, click the skill’s check box.
5. Under Level, select High, Medium, or Low.
6. To remove a skill from the person’s skill set, clear the skill’s check box.
7. Click OK in the person’s Skill Set dialog box and in the Person List dialog box.

Moving Persons Between Departments

At any time, you can move a person from one department or subdepartment to another department or subdepartment. Moving a person affects the department and organization statistics. For information on viewing these statistics, see “Reading the Project Statistics Charts” on page 221.

Moving persons also affects the decision-making flow in the organization if the persons are staffing positions. Decision-making is determined by the supervision structure of a project’s position. When one position supervises another (that is, they are linked in the model by a supervision link), the supervisory position often gives information to or makes decisions for the subordinate position. If the person staffing the supervisory position is moved to a new department, the
Staffing the Project

To move a person between departments
1. At the bottom of the Model pane, click the tab for the organization that contains the person’s department.
2. On the Organization page, right-click the appropriate department, and click Person List.
3. In the Person List dialog box, select the person and click Move.
   - The Move to New Department dialog box appears, listing all the other departments in the project.
4. Select a department and click Move.
   - The person disappears from the person list dialog box. If you select the new department on its organization’s page and open the Person List dialog box, you’ll see the person listed in the new department.

Staffing the Project

Once you have added the appropriate organizations, departments, and persons to the program, you can staff it by assigning persons to the program’s positions. Remember that persons are not graphically represented as shapes in the model, but are defined using a department’s Person List. Also, because you can staff a single position with multiple persons, persons do not have to correspond to real people’s names. You can use team names or placeholder names.

Before you start staffing a project, it’s important to examine the skills requirements of the positions and their tasks.

Balancing Person Skills with Position Skills

When you create unstaffed positions for the baseline model, you set the positions’ skills and skill levels. As you staff the position with persons, you need to pay attention to the position requirements, which in turn should be matched with the task requirements of the tasks assigned to the position. Match the persons’ skill sets and skill levels carefully with the requirements of the positions they staff. The simulator takes into account only the skills of staffing persons, not the positions they staff. Skill mismatches between tasks and their responsible position or persons can cause considerable delay and risk in a project.

The Staffing dialog box displays three pieces of information to help you avoid skill mismatches:

- The skills required by the task assigned to the position being staffed.
- Each person’s skills.
• The number of skills each person has that match the required skills.

Remember that a person’s application experience also affects skill level, and that the application experience of a person in a staffed position overrides the application experience of the unstaffed position. For more information, see “Setting a Position’s Application Experience” on page 49.
Staffing A Project

Staffing Positions

Once you staff a position, its FTE value, application experience, and salary are ignored in favor of the properties of the staffing persons. To remind you of this, these properties are colored pale purple for staffed positions in the Properties pane and in Table View.

If you understaff a position, that position’s tasks will take longer to accomplish. For this reason, it is important to match the FTEs (full-time equivalent, or amount of work the position can do) of the staffing persons with the position’s requirements. A fully staffed project meets the FTE requirements for each position.

The position’s FTE requirements are displayed in the Staffing dialog box, along with the number of person FTEs currently staffing the position, and several other details about the staffing persons.

When a position is staffed with multiple persons, the persons are known collectively as a subteam, and the first person assigned to the position is the default subteam leader for that position. The subteam leader is indicated in the Staffing dialog box by a blue star. Exceptions are generally reported to the subteam leader, and this person makes the decisions about how to handle exceptions. Team leaders also attend meetings, along with some subteam members, depending on the Meeting Assignment link strength. See “Assigning a Participant to a Meeting” on page 79. You can change the subteam leader at any time.

A position’s FTE value does not necessarily match the collective FTE values of the staffing persons. If the collective FTE value is greater than the position requires, only some of the staffing persons’ FTEs need to be applied to the position’s work. You specify the amount as an FTE value (for example, 3) or as a percentage of each person’s FTE value (for example, 75%). This is known as the allocation percentage.
**Example of Staffing by Full Time Equivalent Value**
Suppose four testers, each with an FTE value of 1.0, are staffing a testing subteam with an FTE value of 3.0. To fully staff this position using FTE values, you could assign two testers at an FTE value of 1 and two at an FTE value of 0.5. The two testers assigned at 0.5 FTEs would then still have half their FTE value available for other tasks.

**Example of Staffing by Allocation Percentage**
To fully staff the position in the example above using percentage allocations, you could assign two testers at 100% and two testers at 50%.

**To staff a position**
1. In the Model pane, click the tab for the project that contains the position to staff.
   The project appears in the pane.
2. Click the position to staff.
   The position’s properties appear in the Properties pane.
3. Click Edit beside the Staffing property.
   The Staffing dialog box appears, listing the persons that have been defined for the project with their FTE value, and several other details. Check the position’s FTE requirement in the top-left corner of the dialog box and use this number to guide you in staffing the position. The dialog box also lists the skills required by the tasks assigned to the position being staffed. The # Matching column shows how many skills each person has that match the required skills. You can also double-click on the header of the Skills column (off the right of the following illustration) to sort that column by skill and see which persons have the required skills.
4. Click the name of the person that will staff the position.
   The whole row for that person is highlighted.
5. Click <<ADD.
That person is added to the list of names staffing the position, at the left of the dialog box. The blue star indicates that this person is the subteam leader. The number under Value indicates the number of FTEs the person represents. The # sign under Unit indicates you are staffing by FTE value rather than % of the person’s FTEs.

6. To staff by percentage of the person’s FTEs, click under Unit and select %. Type a percentage under Value. For example, to assign half the person’s FTEs to the position, select % and type 50, as shown next.

7. Continue adding staff to the position as necessary. The Staffed FTEs value updates accordingly. Compare this value to the Position FTEs value to see how fully the position is staffed.

8. To change the subteam leader, double-click the box to the left of the name in the Name list. The blue star moves to that person.

9. To delete a person from the position, click in the grey box to the left of the person’s name in the staffing list, and click Delete. If you delete the subteam leader, the first person on the remaining list becomes subteam leader.

10. When the position is fully staffed, click OK.
Troubleshooting Staffing Problems

Schedules can suffer significantly from accidentally unstaffed or understaffed positions. Another key cause for schedule growth is skill mismatches—that is, when a position or its staffed person does not have the required skill for an assigned task, or has the skill but at the wrong level. SimVision provides the Staffing Report to help you troubleshoot staffing problems quickly and easily.

Reading the Staffing Report

Because a schedule can suffer so badly from unintentionally unstaffed or understaffed positions, SimVision provides a Staffing Report with which you can pinpoint and correct staffing problems. The report shows two lists for the selected program, project, organization, or department: first, a list of the persons with details about the positions they staff and the tasks assigned to those positions; second, a list of the positions with details about their staffing persons and assigned tasks.

For example, the following Staffing Report shows the persons for the entire ASIC program. Notice that missing skills and those at inadequate levels are flagged with pink and yellow. For more information, see “Fixing Skill Mismatches” on page 133. As Adlai Smith in the illustration shows, all persons display along with the percent at which they are allocated to the positions they staff, regardless of whether those positions have any tasks assigned. Note that, for consistency, the
allocation always displays in the Staffing Report as a percentage. If the allocation was entered as an FTE value, SimVision recalculates and displays it as a percentage.

The next illustration shows the positions for the same program. Notice that only fully staffed positions are shown by default, but you can show all positions by unchecking the Show Fully Staffed option at the top of the dialog box. The report shows both the required and the staffing FTEs, along with the assigned task and its required skills and skill levels.

You can filter data in the Staffing Report by category or by task category. If you filter by category, only persons or positions with the specified categories are listed.
in the report. If you filter by task category, only persons or position responsible for tasks with the specified categories are listed. For more information on categories, see “Using Categories” on page 271.

**To generate a Staffing Report**

1. In the Model pane, select the project, organization, or department to generate a Staffing Report for. To generate a report for the entire program, leave nothing selected.

2. On the Results menu, click Staffing Report.

The Staffing Report for the program or selected object appears.

---

**Fixing Unstaffed or Understaffed Positions**

The Staffing Report indicates required and staffed FTEs for each position, so you can use it to see a list of positions whose FTE requirements are not met by their staffing persons. For example, the following report shows that the Construction Contractor position has an FTE requirement of 25 but is only staffed with 22 FTEs.

![Staffing Report Example](image)

You can jump directly from a person in the report to that person in the Person List, or from a position in the report to that position in the Staffing dialog. These dialogs allow you to view and modify properties for the person or position, so you can correct the staffing problem immediately without having to search the model for the appropriate position or person.

**To check for unstaffed or understaffed positions**

1. At the bottom of the Model pane, select the tab for the project you want to check. (You could also leave the program selected to see a report for the whole program, or select a department to view a report for the positions in that department.)

2. On the Results menu, click Staffing Report.
The Staffing Report appears, listing the persons and information such as the number of FTEs associated with the person and their skills. In an unstaffed program, nothing is listed here.

3 Click the Positions button at the top left.

The report lists the project’s positions and information such as their FTE requirements and the number of FTEs currently staffing them.

4 By default, all the project’s positions are listed. To list only unstaffed or understaffed positions, click Show Fully Staffed so it’s not checked.

The report lists any positions that need more FTEs to be fully staffed.

5 To filter persons or positions by category, click Set Filter, select the categories in the Filters dialog box, then select Filter by Category in the Staffing Report. Only persons or positions with the specified categories assigned are listed in the report.

6 To filter persons or positions by task category, click Set Filter, select the categories in the Filters dialog box, then select Filter by Task Category in the Staffing Report. Only persons or positions responsible for tasks with the specified categories assigned are listed in the report.

To fix an unstaffed or understaffed position

1 Once you have identified an unstaffed or understaffed position in the Staffing Report, select that position in the report.

2 Click Goto.

The Staffing dialog box opens, listing the positions in the current project and showing the persons, if any, staffing the selected position.

3 To staff the position fully, select persons under Name that have the required skills and click Add.

4 Continue to staff the position until the Staffed FTEs number matches the Position FTEs number at the top right of the dialog box.

5 Click OK in both the Staffing dialog box and the Staffing Report.

Example of Fixing an Understaffing Problem

In the following example, the Mfg Rep position in the Plant 1 project is only 25% staffed. It requires four FTEs and is staffed with only one. The example shows how you can use the Staffing Report and Staffing dialog box to identify and fix the staffing problem.

To identify the problem in the Plant 1 project, you make that project current by clicking its tab at the bottom of the Model pane. Then open the Staffing Report by clicking Staffing Report on the Results menu. The report opens, showing the
project’s persons by default. Click the Positions button at the top left of the report to display the positions. Again by default, the report shows all positions, whether or not they are fully staffed.

Notice that positions are listed multiple times if they are responsible for multiple tasks. For example, the Construction Contractor and the Manufacturing Rep positions are each responsible for three tasks. To make the display a little less...
Troubleshooting Staffing Problems

Staffing A Project

busy, you can deselect the Fill All Cells option so that each position name displays only once. However, it is useful to leave all cells filled if you plan to export the staffing report to a spreadsheet application, such as Microsoft® Excel.

To view unstaffed or understaffed positions, deselect the Show Fully Staffed option. Now, only the unstaffed or understaffed positions display. The Construction Contractor position is understaffed by 3 FTEs. There are three rows for the position, one for each task it is assigned to.

To fix the understaffing problem select the Construction Contractor position by clicking in its name and click Goto at the bottom of the report. The Staffing dialog box opens, showing the staffing of the position. By checking the Position FTEs and Staffed FTEs numbers at the top left of the dialog box, you can immediately see the understaffing problem.
The position is staffed by Construction Team, which has an FTE value of 22 and is 100% allocated to the position. The staffing person has the skill required by the position, which is Generic Construction. By looking at the #Matching column, you can quickly see if any other persons have the skills required for the position. In this case, five other persons have: the three Ops Rep persons and two testers (not visible until you scroll down the list). If it was appropriate to staff the position with one of the Ops Reps persons (for example, if you knew that none of them...
were backlogged at the times they were required for the tasks assigned to the Construction Contractor position), you could select each in turn and click Add until the position had the required 25 FTEs.

Fixing Skill Mismatches
Skill mismatches occur when a task’s responsible position, or the persons staffing the position, do not have the skills required by the task, or have the skill but not at the required level. A skill mismatch can cause backlog, high task growth risk, or other schedule problems in a project. The Staffing Report helps you locate skill mismatches by highlighting missing skills in pink and insufficient skill levels in
yellow. For example, the following Staffing Report indicates that Ahmed Medea is lacking the DFT Engineering skill required for the Full Chip Synth task and Akela Banning has a lower than required level of the API Programming skill.

Using the Goto button in the report, you can quickly add the required skill to the position or the staffing persons if that is the appropriate action to take.

**To find and fix person skill mismatches in a project**

1. At the bottom of the Model pane, select the tab for the project you want to check.
2. On the Results menu, click Staffing Report.
   
   The Staffing Report appears, listing the project’s persons by default. If a person is missing a required skill, “Skill Not Present” displays in the Level column with a red background. If a person has the correct skills but at an insufficient level, the skill level has a yellow background.
3. To add the skill to the person or change the skill level, select the person in the report and click Goto.
   
   The Person dialog box opens, listing the persons in the current project.
4. Click Edit under Skill Set for the person, add the skill at the appropriate level in the Skill Set dialog box, and click OK in all open dialog boxes.

**To find and fix position skill mismatches in a project**

1. At the bottom of the Model pane, select the tab for the project you want to check.
2 On the Results menu, click Staffing Report.

The Staffing Report appears, listing the project’s persons by default.

3 Click Positions at the top left of the report.

The report lists the positions in the current project. If a position is missing a required skill, “Skill Not Present” displays in the Level column with a red background. If a position has the correct skills but at an insufficient level, the skill level has a yellow background.

4 To add the skill to the position or change the skill level, select the position and click Goto.

The Staffing dialog box displays the positions in the current project so that you can reassign qualified staff to the position.

5 To reassign staff to a position, select the existing staff person by person under Name on the left side of the dialog and click Delete for each one. Then select new staff under Name on the right side of the dialog and click Add for each one.

6 Click OK in all open dialog boxes.

Searching for a Person

Use the Find Person dialog box to find people and to see which department and organization they belong to. The Find Person dialog box lists all persons in all organizations alphabetically by name (that is, alphanumerically from left to right). Using the Go to Person button in the dialog box, you can select a person and view all their properties in the Person List. This allows you to change properties such as a person’s application experience or skill set, or to add hyperlinks to the person.

To find a person

1 Open the program that contains the person.

2 On the Navigate menu, click Find Person.

The Find Person dialog box lists all persons in that program alphabetically by name.

3 To enlarge the window and see more names, click the Maximize button at the top-right of the window.

4 To see a person’s properties in the Person List dialog box, select the person in the Find Person dialog box and click Go to Person.

The Person List dialog box for that person’s department opens, allowing you to view and edit their properties.

5 Click OK.
Running Simulations

Before you simulate the baseline case of a model, you should check task durations, position FTE allocations and so on. Getting these factors right in the initial model helps avoid creating an invalid baseline. You can address model errors or anomalies using the Fix Simulator Errors pane, and view an analysis report of simulation data.

Simulation charts are displayed in the Chart Window. There are many ways you can view and customize the simulation data in this window. This section covers the following topics:

- Checking the baseline model.
- Running a simulation.
- Fixing simulation errors.
- Working with the simulation charts.
- Understanding key concepts in simulation data.
- Viewing a post-simulation analysis.
Checking the Baseline Model

Before you run the initial simulation, make some simple checks on the baseline model, such as checking task durations, milestone dates, and FTE allocations in positions.

Checking Task Durations and Responsible Positions

Task durations provide a basis for the critical path task duration estimates, assuming that all the FTEs assigned to each task are available when needed. Check each task for duration and work volume. Check the responsible position’s FTEs and skills to make sure the position has the skill required by the task. For the baseline case, we suggest setting position and task skills to Generic unless you have a compelling reason to do otherwise.

If a task feels like it should have two responsible positions, it is probably too large in scope. Break it up into two or more tasks and assign the tasks to a single position. Alternatively, consider assigning tasks as secondary tasks to positions if they have the required skills and are not backlogged at the time of the task. See “Using Secondary Task Assignments” on page 200.

To check a task’s duration

1. On the appropriate project page of the Model pane, select the task.
   The task properties appear in the Properties pane.
2. Check that the Skills value for the task is Generic.
3. Check the task’s Work Volume or duration to see if it seems reasonable for the task.
4. If the task seems too short or too long, do one of the following:
   • Change the Work Volume value.
   • Change the responsible position’s FTE value by selecting the position and changing the value of its FTE property in the Properties pane.

To check a task’s responsible position

1. In the Model pane, right-click the task and click Positions.
   The position responsible for the task is listed.
2. Click this position.
   The position is highlighted in the model and its properties appear in the Properties pane.
3. Check that this is the right position for the task.
4. To check that the position’s skill set contains only the default Generic skill at Medium level, click the Edit button by the position’s Skill Set property.
   The Skill Set dialog box lists the position’s skills.
Checking Milestone Dates

After checking and validating the planned task durations, check to see that the planned milestone dates (including project completion) occur at about the right times relative to the CPM dates. If milestone dates seem to be off in spite of correct task durations, check precedence relationships, which are represented by the successor links between milestones and tasks.

For more information on setting milestone dates, see “Setting Milestone Properties” on page 30.

To check milestone dates

1. On the project page of the Model pane, select the milestone. The milestone properties appear in the Properties pane.

2. Do one of the following:
   - If the milestone is absolute, check that the Planned Date value is correct.
   - If the milestone is relative, check that the Planned Date property has the correct value for the preceding milestone.

To check milestone precedence relationships

1. In the Model pane, right-click the milestone. The linked milestones and tasks are listed, and there is a list of successor links.

2. Check that the linked milestones or tasks have the correct link type.

Checking Position FTEs and Allocations

If project time is more critical than project cost, you should check that position FTEs are as large as possible given available staffing, because projects complete faster with more FTEs. If project cost is more critical than time, check that FTEs are reasonable given the available staffing, and then plan a series of scenarios to find the minimum number of FTEs that still meet schedule objectives.

The default position allocation is 100%. Lower allocations normally cause higher position backlogs and thus require more time. However, lower allocations also allow time for positions to handle communications and are therefore often advantageous. For this reason, consider an allocation of 90%, balancing the higher backlog with the lower communications risk.

Running Simulations

The simulator results include the following information:

- The predicted time to complete a project.
- The total effort to do the project.
- Several measures of process quality.
Using the charts that result from the simulation, you can identify risks in the project, organization, and performance.

**Setting the Number of Simulation Trials**

By default, the simulator runs 25 simulation trials and displays an average of the results. You can set how many simulations you want the simulator to run by changing the value of the program’s Trials property. For example, to get some quick simulation results from a highly complex case, you might want to run fewer trials. A good rule of thumb is to run a small number of trials—say, 10—while developing the model, so that even complex models simulate relatively quickly. Then, examine the standard deviations of results, for example on the Summary Statistics charts. If the deviations seem large—more than 10%—increase the number of trials to sharpen the statistical variance.

**Note:** The simulation can take a long time to run when the model has some conditions that cause extremely high schedule growth and backlog conditions. A progress bar helps indicate that the simulation is occurring. If the simulation is taking too long for you, cancel it and lower the number of trials.

**To change the number of simulation trials**

1. Make sure the program is selected. (Select the program’s tab beneath the Model pane and click in blank space somewhere in the model).
2. In the Properties pane, change the value of the Trials property.

**Running the Simulation**

Before you run a simulation, make sure the Model pane is active by clicking in it. If the Tree or Properties panes are active, the simulation tool will not be available.

**To run a simulation**

1. Below the Model pane, select the tab for the case to simulate.
2. On the Simulate menu, click Run Simulation.

   The simulator validates the case and then runs the number of simulations specified by the program’s Trials property.

3. If there are errors or missing links, you must fix them before continuing with the simulation. See “Fixing Simulation Errors” on page 141 and “Simulation Errors” on page 400.
4. If there are warnings, you can either fix the problems, or make a note of the warnings and click Continue to continue the simulation. Critical warnings appear for conditions that should really be rectified before continuing. Noncritical warnings appear for unusual model situations. See “Simulation Warnings” on page 404.
Running Simulations

When the simulation has successfully run, the Chart Window appears displaying the program’s Gantt chart and a Tree pane containing a list of projects and their elements.

Fixing Simulation Errors

When the simulator encounters errors such as a missing link, the simulation halts and you must fix the errors before continuing. If there are critical warnings, such as a meeting that lacks participants, you can choose to fix the problem or continue with the simulation.
Errors and warnings are listed in the Simulator Verification window. You can print the error list from this window and choose to continue or cancel the simulation. After the simulation, you can use the Fix Simulator Errors tool to list the errors and navigate to the place in the program where the error occurs. You can dock the Fix Simulator Errors window below the model pane, as shown here.

This tool can also list noncritical errors, which arise for unusual model situations such as a position being assigned to multiple simultaneous meetings. You can sort the errors by object type, object name, or the error message itself. For example, if you double-click in the Message column header, error messages are listed alphabetically and you can see all the positions assigned to simultaneous meetings.
You can jump directly to the object causing the error by double-clicking the error’s object name in the Fix Simulator Errors pane. For example, if you double-click the first error in the previous illustration, the Model pane displays the project that contains the offending task, and the task is highlighted in the center of the Model pane.

For a list of possible errors and suggested solutions, see “Simulation Errors” on page 400.

**To locate simulation errors**

1. After running a simulation, click Fix Simulation Warnings and Errors on the Simulate menu.
   
   The Fix Simulator Errors window lists the simulation errors and critical warnings. For easier visibility, drag the window down and dock it as a pane below the Model pane.

2. To locate an error in the program, double-click the error’s object name.
   
   The Model pane displays the project or organization page where the error occurs, with the object that is causing the error highlighted.

3. To view noncritical warnings, click Show Non-Critical Warnings.

4. To sort errors, double-click in the column heading.

**Correcting Baseline Problems**

The following is a summary of the problems you might encounter in the Baseline model simulation, and a summary of possible solutions.

**Problem:** A task’s CPM duration is shorter than its simulated duration.
Solution: The responsible position might have more than its total number of FTEs assigned to two or more concurrent tasks. Reallocate task to another similarly skilled position, or add FTEs to the responsible position.

Problem: Task CPM duration is too long or short.

Solutions: Check that the task’s work volume is correct and that its required skill is Generic. Check that its responsible position’s FTE value is appropriate and that its skill is set to Generic with a value of Medium.

Problem: Planned completion date is off.

Solutions: Check that other milestone dates are correct, and that the successor link from the previous task or milestone is correct. Also check for long time lags between tasks. Lag is defined as the time after which a predecessor tasks begins or ends after which a successor task starts. Lag applies when the predecessor and successor tasks are joined by a successor link. The lag is a property of the link.

Working with the Simulation Charts

There are numerous ways you can view the information in the simulation charts. For example, you can show or hide CPM and standard deviation data. You can filter the results, or just view critical path data. Each chart has its own set of tools for customizing the particular data shown on the chart. For example, in the Breakdown chart, you can switch between viewing work breakdown and cost breakdown. These tools are covered in the section on each chart. See “The Project Charts” on page 163 and “The Program Charts” on page 276.

This section covers the general controls that allow you to view and analyze simulation data.

Using the Chart Window

The Chart Window displays the simulation charts and contains a variety of controls that allow you to customize your view of the charts and the data displayed in them. For example, you can increase the display size of the simulation charts by hiding the Tree pane and the Chart Bar. In charts that show graphical data, you can choose the number of objects to show data for, such as how many positions to show backlog for in the Backlog charts.
The following illustration shows the features of the Chart Window that display when you run a simulation and the Program Gantt chart is showing.

You can maximize or minimize the current chart within the Chart Window, and resize the Chart Window. You can also customize the window’s toolbars. For more information, see “Customizing Workspace Toolbars” on page 358.

**To resize the charts and viewing area**
1. To maximize a chart within the Chart Window, click its Maximize button.
2. To maximize the Chart Window, click its Maximize button.
3. To hide the Tree pane, click the Hide Tree Pane icon.
4. To hide the chart list, click the Hide Chart List icon.
Viewing Simulation Charts

The Chart Window has a Tree pane that is very similar to the main SimVision Tree pane. If a program has multiple projects, these are listed by name directly under the program’s Start milestone in the Chart Window’s Tree pane. Below the projects are listed the program’s Finish milestone and any other milestones. Lastly, the program’s organizations are listed.

Initially, the program’s charts are displayed. To view the charts for a specific project, select that project in the Chart Window’s Tree pane.
You can view a project’s elements by clicking the plus sign beside the project. The project elements display and you can select an element to see its simulation charts.
Keeping Track of Charts

When numerous charts from different cases are displayed, you can keep track of which chart you are looking at by reading the Chart Window’s title bar, and by seeing what is selected in the Chart Window’s Tree pane.

Filtering Data in Simulation Charts

Many of the risk metric charts show data for the top 5 objects by default. For example, the Position Backlog chart shows the five most backlogged positions in the project. You can filter the data shown by selecting a different number of objects to show data for, or by choosing specific objects or categories to view data for. For example, in the Position Backlog chart, you can choose to view the top...
1, 2, 3, 4, 5, or 10 backlogged positions. You can view backlog for all positions, or you can choose specific positions to view backlog for. You can also filter the positions by category. For more information, see “Filtering Simulation Results by Category” on page 273.

The collective statistics charts show data for all appropriate objects—for example, the program’s Projects Statistics chart shows data for all projects in the program. You can filter this data by object or category. For example, you can select specific projects to view statistics for, or select a category and see only data for projects that have this category assigned to them.

To filter data in simulation charts
1. In the Chart Window, select the chart to filter data in.
2. Select a value from the filter list at the top of the chart.

The chart displays data for only the objects you select.

Matching Data Between Charts
There are various settings you can alter on charts that you might want to use across multiple charts. For example, if you set a time period over which to view project position backlog, you might also want to view person, organization, and department backlog over the same time period. You can avoid having to set the time period separately on each chart by setting it on the Position Backlog chart and matching the other charts’ settings to this chart.

You can specify that a chart’s settings be the defaults, and then set other charts to those defaults. For example, you might want to filter all charts by the same categories. You can also reset any chart’s settings to the original defaults.
To match a chart’s settings to another chart
1. In the Chart Window, open the chart whose settings you want to match to.
2. Open the chart whose settings you want matched to the first chart.
3. On the second chart, click Match To on the right-click menu.
4. Select the appropriate chart on the submenu.
   The second chart’s settings change to match the first.

To make a chart’s settings the default
1. In the Chart Window, open the chart whose settings you want as defaults.
2. On the right-click menu, click Match To>Save Settings as Default.

To reset a chart’s settings to the original defaults
1. In the Chart Window, open the chart whose settings you want changed.
2. On the right-click menu, click Match To>Set to Defaults.

Viewing the Time and Date in Charts
If a simulation chart shows the date, you can display the time with the date by clicking Show Time on the Chart Window’s toolbar or the right-click menu.

Key Simulation Data Concepts
There are several concepts it’s important to understand when analyzing simulation data; for example, the critical path, CPM (Critical Path Method) simulation results, resource-constrained simulations, and the various risk metrics.

Understanding the Critical Path
A program’s critical path is the set of projects that determine the total program duration. A project’s critical path is the set of tasks that determine the total project duration. Lengthening or delaying any of the items on the critical path lengthens the program or project duration. Critical path projects and tasks are shown in red
and noncritical path projects and tasks in blue. For example, the following illustration shows a program with two projects, one of which, Plant 2, is on the critical path.

Once you have run a simulation in a model, you can view the critical path in each project or in the program as highlighted successor links between the critical-path tasks or projects, as shown in the following illustration.

If the successor links have custom colors and widths, these are restored when you reverse the critical path highlighting. For information on customizing links, see “Changing Object Appearance” on page 389.

**To view the critical path in a program or project**

1. Make sure you have run a simulation of at least one case of the program.
2. With the program or project page displayed, click Highlight Critical Path on the View menu.

The successor links between the critical-path projects (in a program) or tasks (in a project) are highlighted in red.
Simulated vs. Critical Path Method Results

The simulator produces two main kinds of results: simulated and CPM (critical path method). There are also planned results, such as planned milestone dates, but these reflect only the planned dates that you assign to milestones. Planned dates are run through the simulator only to allow for comparison against the simulated and CPM dates. Unlike simulated and CPM data, planned dates are unaffected by changes to the model such as added resources or reduced task duration.

The principal difference between simulated and CPM results is that simulated results take into account all the real-world factors you have modeled, whereas CPM results reflect an optimistic scenario where all positions are fully available to work all the time on all their tasks unless the tasks overlap. For example, simulated results factor in time for communications between positions about tasks, exceptions in tasks, and the resulting rework and possible backlog for the responsible positions. CPM results ignore all these factors. It also ignores the effects of skills, experience, role, and decision wait time. However, it does account for resource contention for direct work. For these reasons, simulated results are more realistic and, in most cases, show later end dates, higher backlogs, and more quality risk than CPM results.

About Product Risk Metrics

The simulation charts feature eight measurements of risk to program and project quality. Several of these measurements occur on multiple charts, depending on whether you are examining simulation data for a program or a project. For example, growth risk is measured for tasks on the Project Schedule Growth chart, and for projects on the Program Schedule Growth chart. The eight risk metrics are:

Schedule Growth—Schedule growth risk is calculated by default as the simulated duration of a project or task minus the CPM duration (Sim Duration - CPM Duration). You can also display growth risk as a percentage of the project or task’s CPM duration. This risk is reported for projects on the Program Schedule Growth chart and for tasks on the Project Schedule Growth chart. For more information, see “Analyzing Project Schedule Growth” on page 181.

Communication Risk—Communication risk is calculated as the number of missed communications divided by the number of requested communications (Missed Communications / Requested Communications). This risk is reported for projects on the Project Summary Statistics charts, for tasks on the Project Communications Risk chart, and for tasks, projects, and the program on the appropriate statistics charts. For more information, see “Analyzing Project Risk” on page 189, “Reading the Project Statistics Charts” on page 221, and “Reading the Program Statistics Charts” on page 287.
**Meeting Risk**—Meeting risk is calculated as the number of meetings missed divided by the number of meetings requested (Missed Meetings / Requested Meetings). Each time a person misses a meeting, it counts as one meeting missed. For example, if two meetings are scheduled for four persons each, and one person misses one meeting, then the meeting risk is $1/8 = 0.125$. Statistics are accumulated per position, so a one-time meeting with 3 attendees out of 4 assigned would have a risk of 0.25. Meeting risk is reported for all meetings on the Meeting Statistics chart, and for positions on the Position Statistics chart. See “Reading the Project Statistics Charts” on page 221.

**Coordination Risk**—Coordination risk is calculated as the sum of the Communication Risk and the Meeting Risk divided by two ($\frac{\text{Communication Risk} + \text{Meeting Risk}}{2}$). This risk is reported for projects on the Project Coordination Risk chart. For more information, see “Analyzing Coordination Risk” on page 195.

**FRI and PRI**—These measurements reflect the quality risk arising from functional (one task only) or project (interacting tasks) exceptions over the lifetime of the program or project. See “Understanding FRI and PRI Measurements” on page 153.

**Product Quality Risk**—An average of the FRI and PRI.

**Project Quality Risk**—A risk calculated by considering the number of exceptions generated for a project, and the number of those exceptions that are ignored or given “quick fixes,” or workarounds. The risk metric is calculated as follows:

\[
\frac{(\text{ignored exceptions} + (0.5 \times \text{quick fixed exceptions}))}{\text{total exceptions}}
\]

**Understanding FRI and PRI Measurements**

FRI, or Functional Risk Index (also known as the Component Quality Index or CQI), measures the risk to quality arising from functional exceptions. Functional exceptions are problems that affect only the task from which they arise. Any rework incurred applies only to that task. Rework links have no interaction with functional exceptions. In project work terms, FRI represents the likelihood that components produced by this project have defects based on rework and exception handling.

PRI stands for Project Risk Index and measures the risk to quality arising from project exceptions. Project exceptions are problems that arise in one task that may have an effect on work in another task linked to the first task with a rework link. In the absence of rework links, project exceptions have no meaning. In project work terms, PRI represents the likelihood that the components produced by this
project will not be integrated at the end of the project, or that the integration will have defects based on rework and exception handling. PRI is thus a measurement of the success of system integration.

Together, FRI and PRI are a measure of the impact of factors such as team experience, backlog, and the match between position skills and task requirements. The FRI and PRI calculations separate the influence of functional exceptions from project exceptions and calculate a representative ratio of work risk. In general:

FRI = Fraction of effort it would take to process ignored functional failures normalized by the total effort to rework all predicted functional failures.

PRI = Fraction of effort it would take to process ignored project failures normalized by the total effort to rework all predicted project failures.

For a single exception, the FRI and PRI values range from 0.33 to 0.66. For typical exception probabilities, risk values above ~0.4 mean that a lot of failures are going unreworked, and values above ~0.7 are probably an unacceptable level of risk. The risk can never equal 1.0, and can only equal 0.0 if no exceptions occur.

To mitigate both functional and project risk (that is, lower the FRI or PRI values), you should increase the supervisory responsibility of the positions whose tasks have high functional or project risk. You can do this by changing the position’s Role property from ST (subteam) to SL (subteam leader) or PM (project manager); or from SL to PM.

**Viewing a Post Simulation Analysis**

SimVision provides a text report analyzing each simulation in terms of the tasks that are at most risk. The report lists the tasks that show high growth in work volume and high risk. The growth and risks are broken down into constituent parts. For example, task growth is analyzed in terms of direct work, rework, coordination, and decision wait time. The analysis suggests steps to take to reduce these growth factors. You can print the analysis, or copy and paste it into a word processing application.
To view a post simulation analysis

1. Select the case to simulate and run the simulation.
   The Program Gantt chart displays in the Chart Window.

2. On the Tools menu, click Analyze.
   The post simulation analysis appears in a window.

3. To print the analysis, click Print at the bottom of the window.
4. To copy and paste text from the analysis, select the text and press CTRL+C to copy and CTRL+V to paste in another application.
CHAPTER 6

Analyzing and Using Simulation Data

In any program, you run the first simulation on the baseline case. When you have analyzed the results of the baseline case simulation, you make changes and refinements to the model that match the information you have, such as adding rework links and staffing positions. Then you run simulations on the refined model, using different cases to make interventions that improve the model and lead to a project execution that matches the business objectives. You continue the iterative process of simulating and refining until the model has shown you as much about the potential success or failure of the project as you need to know.

This section covers the following areas:

- Finding the information you need in the simulation charts
- Analyzing the project, milestone, meeting, task, and position charts. (For information on the program, organization, department, and person charts, see “Analyzing Program Simulation Data” on page 275.)
- Making interventions in the model.
Finding Information in the Simulation Charts

There are many simulation charts, some of which have quite similar names, so it can be confusing trying to find the exact information you need. This section provides a kind of roadmap of the charts by grouping them into the sections listed below, and highlighting the differences between charts with similar names; for example, the Program Person Backlog chart (tracks backlog for all persons in the program), the Project Person Backlog Chart (tracks backlog for all persons in the selected project), and the Person Backlog Chart (tracks backlog for the selected person).

For more information, see:
The Gantt Charts
The Summary Statistics Charts
The Schedule Growth Charts
The Breakdown Charts
The Quality Risk Charts
The Backlog Charts
The Resource Charts
The Finance Charts
The Statistics Charts

The Gantt Charts
Gantt charts show both columns and graphs of data about the selected object. They are some of the most useful charts because they predict a completion date and show extensive information about how that date was arrived at. You can view Gantt charts for programs, projects, positions, organizations, departments, and persons.

For more information, see:
Analyzing the Program Gantt Chart
Analyzing the Project Gantt Chart
Analyzing the Position Gantt Chart
Analyzing the Organization Gantt Chart
Analyzing the Department Gantt Chart

Analyzing the Person Gantt Chart

**The Summary Statistics Charts**
There are Summary Statistics charts for both the program and individual projects. These charts show statistics about duration, finances, and risks.

*For more information, see:*
Reading the Program Summary Statistics

Reading the Project Summary Statistics

**The Schedule Growth Charts**
There are Schedule Growth charts for both the program and individual projects. These charts show the projects or tasks (respectively) at risk of taking longer than planned.

*For more information, see:*
Analyzing Program Schedule Growth

Analyzing Project Schedule Growth

**The Breakdown Charts**
The Breakdown Charts break down the cost or work in terms of direct work, rework, coordination time, and decision wait time. For example, the Program Breakdown Chart shows cost or work data for the program’s projects. The Project Breakdown Chart shows cost or work data for the project’s tasks.

*For more information, see:*
Analyzing Program Cost and Work Breakdown

Analyzing Project Cost and Work Breakdown

**The Quality Risk Charts**
The Quality Risk charts show data pertaining to the seven risk metrics for either a program or project.

*For more information, see:*
Analyzing Program Risk

Analyzing Project Risk

About Product Risk Metrics
The Backlog Charts
Backlog is defined as the number of days’ work outstanding for a position or person. Backlog is measured for both persons and positions. For positions, you can analyze backlog per project or per position. Person backlog is tracked per program, project, organization, department, and person.

For more information, see:
Analyzing Position Backlog in a Project
Analyzing Individual Position Backlog
Analyzing Person Backlog in a Program
Analyzing Person Backlog in a Project
Analyzing Organization Backlog
Analyzing Department Backlog
Analyzing Individual Person Backlog
Comparing Person and Position Backlog

The Resource Charts
The Resource Charts show resource demand, utilization, and availability data. You can view Resource charts for the program or for individual projects, positions, organizations, departments, and persons.

For more information, see:
Analyzing the Program Resource Charts
Analyzing the Project Resource Charts
Analyzing the Organization Resource Charts
Analyzing the Department Resource Charts
Analyzing the Position Resource Charts
Analyzing the Person Resource Charts

The Finance Charts
The Finance Charts show cost and revenue data for the entire program or for individual projects and tasks.

For more information, see:
Analyzing Program Financial Data
Analyzing the Project Financial Charts

Analyzing the Task Finance Chart

**The Statistics Charts**

The statistics charts form the largest group of simulation charts. You can view statistics charts for the entire program, or for individual projects, milestones, tasks, positions, meetings, organizations, departments, and persons. For projects, you can view statistics for the entire project, or for the project’s tasks, milestones, positions, meetings, and financial situation. For an organization, you can view statistics charts for the entire organization, or for the organization’s departments and persons.

In general, it makes sense to view statistics for an umbrella object, such as a project, and then drill down to the individual objects. For example, you might want to see summarized statistics for all departments in an organization (the Organization’s Department Statistics chart for that organization) and then look at detailed statistics for a single department (the Department Statistics chart for that department).

**For more information, see:**

Reading the Program Statistics Charts
Reading the Project Statistics Charts
Reading a Milestone’s Statistics Chart
Reading a Task’s Statistics Chart
Reading a Meeting’s Statistics Chart
Reading a Position’s Statistics Chart
Reading an Organization’s Statistics Chart
Reading an Organization’s Department Statistics Chart
Reading an Organization’s Person Statistics Chart
Reading a Department’s Statistics Chart
Reading a Department’s Person Statistics Chart
Reading a Person’s Statistics Chart
The Person Work Charts
Person Work Reports display the number of hours each person works on the program’s projects and tasks. You can view Person Work Reports for all persons in the programs, or for persons in a specific organization or department.

For more information, see:
Reading a Program’s Persons Work Report
Reading an Organization’s Persons Work Report
Reading a Department’s Persons Work Report
The Project Charts

The SimVision project charts include information such as the predicted time to complete a project, the total effort to do the project, and several measures of process quality. Once you add indirect work to the project model, you can use the charts to identify specific risks to tasks, positions, and project quality.

When you run a simulation, the simulator initially displays charts for the program, rather than a project. This is because you simulate the whole program and not individual projects, even if there is only a single project in the program. The program charts differ slightly from the project charts. To view charts for a project, you must select the project in the Tree pane of the Chart Window. For information on program simulation charts, see “The Program Charts” on page 276.

The project charts are:

- **Project Gantt Chart**—Shows how simulated task durations and milestone dates differ from CPM dates. See “Analyzing the Project Gantt Chart” on page 164.

- **Project Summary Statistics Chart**—Displays projections for five key project factors when you compare two cases of a project, with their standard deviation from the mean of all trials run. See “Reading the Project Summary Statistics” on page 177.

- **Project Schedule Growth Chart**—Shows the pressures on the duration of the project. See “Analyzing Project Schedule Growth” on page 181.

- **Project Breakdown Charts**—Depending on your selection, shows either the cost or the work breakdown of each task into direct work, rework, coordination, and decision wait time. See “Analyzing Project Cost and Work Breakdown” on page 186.

- **Project Project Risk Charts**—Indicates the tasks with the greatest potential for being at risk. See “Analyzing Project Risk” on page 189.

- **Project Person Backlog Chart**—In a staffed project, shows the overload on persons over time. See “Analyzing Person Backlog in a Project” on page 197.

- **Project Position Backlog Chart**—Shows the predicted overload on positions over time. See “Analyzing Position Backlog in a Project” on page 203.

- **Project Resource Charts**—Depending on your selection, shows either the usage of or the demand on project resources. See “Analyzing the Project Resource Charts” on page 208.

- **Project Finance Chart**—Shows the cost and the revenue values for the selected project. See “Analyzing the Project Financial Charts” on page 216.

- **Project Statistics Charts**—Displays statistics for the project and for its objects. See “Reading the Project Statistics Charts” on page 221.
Chart Color Coding

The color coding in charts is determined by the Chart Color property of SimVision objects. For example, the colors of positions in the Project’s Position Backlog Chart is determined by each position’s Chart Color property. You can change this color coding by changing the value of the object’s Chart Color property in the Properties pane.

It can be particularly important to change an object’s chart color if its default color conflicts with a default color used in a chart. For example, the Finance charts use red and green to show total cost and revenue in the graphs. If an object, such as a task, also has these colors, it can be confusing. In this case, you could change the chart color of the task to avoid the confusion.

To change an object’s chart color

1. In the Model pane, select the object.
2. In the Properties pane, click the color swatch under Value for the Chart Color property.

   The color dialog box displays.

   ![Color Dialog Box]

3. Select a color for the object under Basic Colors, and click OK.

   The object is represented by that color in the simulation charts.

Analyzing the Project Gantt Chart

The Project Gantt chart is one of the most important SimVision charts because it predicts a project completion date. It can also show CPM noncritical tasks that become critical due to coordination load. You use the baseline model’s Gantt chart to evaluate the model’s validity.
When a simulation is complete, the program Gantt chart displays by default. To view the project Gantt chart, you need to select the project and click its Gantt chart icon. For more information on the Program Gantt chart, see “Analyzing the Program Gantt Chart” on page 277.

There are many ways you can customize the data you see in the Gantt chart to better analyze the results you want to focus on. The sections below explain how to view and manipulate the data, and how to analyze and work with what you see.

### Understanding the Gantt Chart Columns

The Gantt chart's columns list data for the project's tasks, milestones, and meetings. Here, you can see the exact dates that are represented by the Gantt’s bars on the graphical side of the chart. Some columns show multiple kinds of information, depending on the object. The top three rows of the chart show the data that each column is displaying for each object: the top row is task data, the middle row is milestone data, and the bottom row is meeting data. For example, the column that shows task durations also shows milestone simulated dates and meeting durations. The column that shows tasks' responsible positions is necessarily blank for milestones and meetings.

<table>
<thead>
<tr>
<th>Task/Milestone/Meeting</th>
<th>Top three rows of chart show what each column is displaying</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This column shows tasks’ responsible positions, so it is blank for milestones and meetings</td>
</tr>
<tr>
<td></td>
<td>This column shows task durations, milestone simulated dates, and meeting durations</td>
</tr>
</tbody>
</table>

CPM dates and project/task float data are hidden by default, but you can turn them on. See “Viewing CPM and Float Data” on page 167.

The following is a detailed explanation of the data shown in each column:

- **Task/Milestone/Meeting**—The name of the project, task, milestone, or meeting. Projects and tasks are in regular font, milestones are in bold type, and meetings are in italics.
• **WBS/WBS**—The Work Breakdown Structure, or object naming scheme, for the project, task, or milestone. In the example, the ASIC Hardware project has a WBS of A.S.1 and the ASIC Software project has A.S.2. See “Setting a Project’s WBS” on page 89.

• **Resp. Position**—The position assigned to a task. Projects, milestones, and meetings have no values in this column.

• **Resp. Persons**—The person or persons staffing the position assigned to a task. Again, projects, milestones, and meetings have no values in this column.

• **Parent**—The parent object. For example, a project’s parent is the program; a milestone’s parent is the project.

• **Duration/Sim. Date/Duration**—This column shows the following:
  • **Projects/Tasks**: The durations in days.
  • **Milestones**: The date on which the simulator predicts the milestone will occur.
  • **Meetings**: The duration in days.

  Simulated dates and durations include all realistic factors such as rework, coordination, and communication. See “Simulated vs. Critical Path Method Results” on page 152.

• **Start/Planned Date/Start Date**—This column shows the following:
  • **Projects/Tasks**: The start date.
  • **Milestones**: The date on which the modeler expects the milestone to occur. Planned dates are ignored by the simulator but you can use them to compare intended results with simulated and CPM results. For more information on planned dates, see “Relative and Absolute Milestones” on page 29.
  • **Meetings**: The date on which the first meeting of a series starts.

• **Finish/CPM Date/Meeting Risk**—This column shows the following:
  • **Projects/Tasks**: The finish date.
  • **Milestones**: The Critical Path Method date on which the milestone occurs. CPM dates reflect an optimistic scenario where all positions are fully available to work all the time on all their tasks unless the tasks overlap. See “Simulated vs. Critical Path Method Results” on page 152.
  • **Meetings**: Meeting risk, which is defined as the number of meetings missed divided by the number of meetings requested. Each time a person misses a meeting, it counts as one meeting missed. A meeting risk of 0.5 means there’s a 50% chance of some participant missing the meeting.

• **Float/Compare Date/Interval**—This column shows the following:
• **Projects/Tasks:** Float time, which means the period of time a noncritical path project/task could be delayed or lengthened without affecting program/project duration.

• **Milestones:** The date of the milestone in the compared case. If cases are not being compared, this cell is empty for the milestone.

• **Meetings:** The interval at which recurring meetings occur. For example, 2.00 weeks means a bi-weekly meeting.

• **Criticality/Criticality/# of Meetings**—This column shows the following:
  
  • **Projects/Tasks:** A measurement of criticality. Criticality is expressed as a number between 0 and 1, where 0 means the project or task is not on the critical path for any of the simulation trials and 1 means it’s on the critical path for every trial. For example, a criticality of 0.5 means the project or task is on the critical path for half the trials run.

  • **Milestones:** A measurement of milestone criticality.

  • **Meetings:** The number of times a recurring meeting occurs over the life of the project.

**Understanding the Gantt Chart Graph**

The graphical side of the Gantt chart shows colored bars for task durations, colored diamonds for milestone dates, and vertical blue lines for meetings. CPM dates and project/task float data are hidden by default, but you can turn them on. See “Viewing CPM and Float Data” on page 167.

In a very basic example, the following Project Gantt chart shows a simple project with a single 10-month task running from June 2004 to April 2005. The black diamonds show the simulated project start and end dates, the green diamonds planned dates.

**Viewing CPM and Float Data**

If you turn on the CPM and float data in the Gantt chart, the data side shows extra rows for CPM dates, and the graph side shows paler colored diamonds and bars for the CPM milestones and tasks, and grey in projects or tasks that have float time.
For example, the following illustration shows the extra rows displayed in the Gantt data for CPM task dates.

<table>
<thead>
<tr>
<th>Task</th>
<th>Milestone</th>
<th>WBS</th>
<th>Resp. Position</th>
<th>Resp. Parties</th>
<th>Parent</th>
<th>Sim. Date</th>
<th>Planned Date</th>
<th>CPM Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start</td>
<td>ASIC</td>
<td>Hardware</td>
<td>11/01/04</td>
<td>11/30/04</td>
<td>11/01/04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weekly Coordination</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>2.00 hours</td>
<td>11/04/04</td>
<td>11/01/04</td>
<td>11/23/04</td>
<td></td>
</tr>
<tr>
<td>Chip Spec</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>21.0</td>
<td>11/01/04</td>
<td>11/23/04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HW Spec Complete</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>11/22/04</td>
<td>11/22/04</td>
<td>11/22/04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Partition Chip &amp; Flopmap</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>42.0</td>
<td>11/22/04</td>
<td>11/01/05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HW Design Coordination</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>141.1</td>
<td>11/22/04</td>
<td>04/12/05</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White-Verify-Synth BIRT</td>
<td></td>
<td>ASIC</td>
<td>Hardware</td>
<td>141.2</td>
<td>11/22/04</td>
<td>04/12/05</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following illustration shows the extra bars and diamonds displayed in the Gantt graph for CPM and float information. The Gantt’s graphical data is explained in detail below the illustration. Note that the data side of the chart has been turned off here (to do this, deselect Show Data on the chart’s right-click menu).
Analyzing and Using Simulation Data

- **Green diamonds** — User-defined, or planned, milestones.
- **Black diamonds** — Simulated milestones.
- **Gray diamonds** — CPM milestones.
- **Dark blue and dark red bars** — The simulation’s prediction for task duration, dark blue for noncritical path tasks and dark red for critical path tasks.
- **Light blue and light red bars** — CPM calculations of task duration, light blue for noncritical path tasks and light red for critical path tasks
- **Gray bar** — Float, or period of time a noncritical path task could be delayed or lengthened without affecting project duration.
- **Blue bar** — Meeting regularity and duration over project life.

For more information on planned milestones, see “Relative and Absolute Milestones” on page 29.
The Gantt chart shows each task’s simulated duration compared graphically to its CPM duration.

**To view CPM and float data**
1. Run the simulation.
2. In the Chart Window’s Tree pane, click the project you want to review. The Project Gantt chart appears, showing all the project tasks between its start and finish dates.
3. To view the Critical Path Method (CPM) duration for each task, click Show CPM on the right-click menu. A light blue or red bar appears for each task.
4. To view the float time for each task, click Show Float on the right-click menu. Grey bars indicate the float time in noncritical path tasks.

**Customizing the Gantt Chart**
You can view the data in the Gantt chart in a variety of ways. For example, you can sort the data by start date, priority, or WBS, and you can expand or collapse the data columns, or view the graphical data only.

The following is a list of ways you can customize the Gantt data:

- **Copy data and paste it into a spreadsheet**—See “Copying Gantt Chart Data into a Spreadsheet File” on page 342.
- **Compare cases**—See “Comparing Case Simulation Data” on page 270.
- **View different time periods**—You can set various timescales for the graph, for example, Year/Quarter or Month/Day. See the steps next.
- **Sort**—Sort the data by start date, priority, or WBS. See the steps next.
- **Show CPM and float data**—See “Viewing CPM and Float Data” on page 167.
- **Show chart color**—View task bars in the task chart colors with borders of red or blue according to criticality. See the steps next.
- **Show critical path, meetings, or the data fields only**—See the steps next.
- **Show time**—View or hide the time in date fields. See the steps next.
- **Set scales**—Change the project start or end dates. See the steps next.
- **Match to**—Set the current chart’s settings as defaults, or match them to existing defaults or to the settings of another chart. See “Matching Data Between Charts” on page 149.
You can control the project start and end dates by changing the scale of the X axis, for example, to make one project’s Gantt chart match another’s. You can also look at different time periods and compare cases. For more information on case comparisons, see “Comparing Case Simulation Data” on page 270.

**Note:** You can view and manipulate the Gantt chart using the chart toolbar, the right-click menu, or the Controls menu. The following instructions use the right-click menu and show the toolbar buttons. The Controls menu method is assumed.

**To customize the Project Gantt chart**

1. Run the simulation.
2. In the Chart Window’s Tree pane, click the project you want to review.
   
   The Project Gantt chart appears, showing all the project tasks between its start and finish dates.

3. To view different time intervals in the chart, select a time interval from the list at the top of the Chart Window, or click Time Scale on the right-click menu. You can view years and quarters, years and months, months and days, weeks and days, or days and hours.

4. To sort objects by start date, priority, or WBS, click Sort By on the right-click menu and select a property to sort by, or select a sort option from the sort list.

5. To have the task bars show task colors with a border of red or blue according to criticality, click Show Chart Color on the right-click menu.

6. To view critical-path tasks only, click Critical Path Only on the right-click menu.

7. To view meetings only, click Meetings Only on the right-click menu.

8. To switch between showing just dates or dates and times, click Show Time on the right-click menu.

9. To view or hide the data columns, click Show Data on the right-click menu. (The object name column remains displayed.)
10. To view the project start and end dates, click Set Scales on the right-click menu.

11. To change the start or end date, click User Defined. Change the dates by typing over the existing ones, or by clicking the down-arrow and selecting a new date from the calendar. Then click OK in the Set X and Y Scales dialog box.

12. To filter objects in the chart by category, click Category Filter in the Chart Window. In the Filters dialog box, select the categories to filter by and click OK.

**Analyzing the Completion Date**

In most strategic projects, the completion time indicated by the SimVision simulation baseline model is unacceptably late, so your remaining effort focuses on finding ways to shorten the project schedule without unduly compromising quality and cost objectives. If the baseline Gantt chart simulation results indicate that completion occurs on time, this is good news, and you should focus further improvements on any identified quality risks.

**Analyzing Task Durations**

Once you refine the model, you can expect simulated task durations and CPM durations to differ, sometimes widely. These differences are best tracked in the Gantt chart. CPM tasks usually have no float, or margin for error, so if a task on the critical path slips, the project end date usually slips too. Emphasis should be placed on understanding the reasons for high task growth risk and backlogs.
Task duration is the estimated number of days it will take to complete the task. This is calculated by dividing the number of work days (that is, person days) by the FTEs in the responsible positions. Thus, if a task has a work volume of 5 days, a primary responsible position with 0.5 FTEs assigned to the task, and a secondary responsible position with 1.0 FTEs assigned, the duration is calculated as

$$5 / (0.5 + 1.0) = 3.33 \text{ days}$$

If CPM duration is longer than simulated task duration, it is because the simulator takes into account work done by both primary and secondary responsible positions (that is, positions linked to the task by primary and secondary assignment links), whereas the CPM calculation does not. If either of these positions has slack time, the simulator can feed work faster and the work gets done faster. Secondary responsible positions will work the task only when they are available. For example, if the secondary responsible position in the above example is available only about one-third of the time for the task, the calculation would be adjusted to

$$5 / (0.5 + 0.3) = 6.25 \text{ days}$$

If simulated task duration is longer than CPM duration, as shown in the following illustration, one possibility is that a position has more than its total number of FTEs assigned to two or more concurrent tasks.

When tasks are at risk of taking longer than planned, this is called growth risk. The Schedule Growth chart shows which tasks have the greatest growth risk. See “Analyzing Project Schedule Growth” on page 181.

**Reducing the Project Schedule**

There are various ways you can reduce the project duration, for example, by reallocating FTEs or coordinating parallel tasks.
Reducing Slack Time

When personnel are initially assigned to tasks, they are assigned according to their skills and availability. However, the Gantt chart shows tasks that have too many or too few resources. Tasks with too many resources will show slack time.

Identifying the tasks on and off the critical path is the first step to optimizing your resource allocation. All tasks highlighted in red are on the critical path. Blue tasks are noncritical path tasks. The gray section at the end of the task bars represents the slack time, or margin for error, of the task. The slack or margin on the task is the amount of time the task can slip before the end date of the project is affected.

Note: By definition, critical path (red) tasks cannot have slack, since slack is extra time in the schedule that the task has before it needs to be completed. However, occasionally you will see critical path tasks with slack, as in the following illustration. This is because the critical path shown in the Gantt chart is the average critical path, or the critical path identified in the majority of simulator runs. For some models, the critical path will vary from trial to trial. In these cases, tasks not on the critical path may have slack that is recorded and averaged by the simulator. Thus, the results may show a critical path task with slack that is recorded in trials when that task was not on the critical path.

Eliminating slack time can free up resources to work on critical activities and thus shorten project duration. To do this, identify the blue tasks with gray bars on the Gantt chart and do one of the following:

- Take away FTEs from the responsible position.
- Decrease the percentage of FTEs that are allocated to the task.

Run the simulation again and notice the effect on the Gantt chart. If the task bar is red, the task is now on the critical path and its length directly affects project duration. Reexamine your allocation—did you reallocate too heavily away from the task? Test a few scenarios to determine the optimal allocation.
To remove FTEs from a task’s responsible position
1 In the Gantt chart, identify the task whose slack time you want to eliminate.
2 In the Model pane, locate the task on its project page.
3 Right-click the task and click Positions.
   The responsible position is listed.
4 Locate and select the responsible position.
   The position’s properties appear in the Properties pane.
5 Reduce the value of the FTE property.

To decrease the percentage of a task’s allocated FTEs
1 In the Gantt chart, locate the task.
2 In the Model pane, locate the task on its project page.
3 Select the primary assignment (blue) link that links the task to its responsible position.
   The Primary Assignment link’s properties appear in the Properties pane.
4 Reduce the value of the Allocation property.

Reallocating FTEs
You should carefully examine the positions that are responsible for parallel tasks and the allocation of FTEs between the parallel tasks. If a particular position is responsible for a task on the critical path, the position’s FTEs should be allocated to the tasks on the critical path. It’s best if positions working on critical path tasks are only 2-4 days backlogged at most. For an explanation of why this is so, see “Analyzing Position Backlog in a Project” on page 203.

Coordinating Parallel Tasks
When product development schedules are shortened to meet corporate objectives, product development tasks that are usually performed sequentially must be performed in parallel. Coordinating parallel interdependent tasks is more difficult and costly than coordinating the same tasks performed sequentially because there is more rework and coordination required. SimVision uses project cases and analysis methods that realistically consider the coordination and rework that arise from parallel activities.

SimVision can also manage product development programs that include multiple parallel projects. This allows you to consider the tasks and the organization concurrently. You can thus convert sequential development plans to plans that conduct appropriate tasks in parallel, thereby pulling in the schedule. This is known as fast-tracking. See the next section.
Fast-tracking Sequential Tasks

Fast-tracking tasks means making linked sequential tasks parallel to reduce the project schedule. You do this by changing Finish-Start Successor link between the tasks to a Start-Start link, either with or without a lag. This change says that the successor task no longer has to wait until the predecessor is finished to begin, but can begin either at the same time as, or the lag time later than the predecessor.

You should only fast-track tasks if doing so does not significantly increase the responsible positions’ backlog, and if the positions are not too backlogged to begin with. Also remember that tasks must have at least one outgoing Finish-Start successor link, so if you change their only outgoing link from Finish-Start to Start-Start, you must add a Finish-Start link that connects to another task or milestone.

To help remind yourself you have made tasks parallel, you can physically move the tasks in the model pane so that they look like they occur in parallel, rather than sequentially. Another reminder is the convention of adding Start-Start successor links from the left side of the predecessor to the left side of the successor. Following this convention makes it visually obvious if the task has no outgoing Finish-Start link from its right side.

For example, a spec writing task has been modeled sequentially with a UI design task, such that the UI design does not begin until the spec is fully written.

However, as UI design could theoretically begin as soon as the UI portion of the spec was written, you can recommend fast-tracking these tasks and changing the Successor link type to Start-Start, perhaps with a lag of a couple of weeks to allow for the UI portion of the spec to be written.

To fast-track sequential tasks

1. On the project page of the Model pane, select the Successor link that joins the tasks.
The link’s properties appear in the Properties pane.

2 Change the value of the Type property from Finish-Start to Start-Start.

3 Set a lag if appropriate. You can specify the lag in terms of minutes, hours, days, weeks, months, or a percentage of the predecessor task’s duration.

4 In the Model pane, drag the tasks so that they are fully parallel if there is no lag, or partially parallel to mirror a lag time.

5 Move the origin of the link from the right side to the left side of the predecessor task.

**Reading the Project Summary Statistics**

The Summary Statistics chart displays a summary bar graph for the current project’s financial and risk statistics. This chart is generally used for comparing two cases in a project. It also shows the standard deviation, which indicates the statistical quality of the simulation by showing how the results deviate from the mean of the summary statistics over all trials. By default, there are 25 trials, though you can change that number. For more information, see “Setting the Number of Simulation Trials” on page 140.
A small standard deviation is desirable, but it takes more trials, and therefore more time to compute. The standard deviation displays as a black bar at the end of each variable.

For each case of the project, the Summary Statistics chart reports the following:

- **Simulated project duration**—The time that the project is expected to take.
- **Total revenues**—The predicted overall project revenues in thousands of currency units based on the simulation.
- **Total costs**—The predicted overall project cost, including salaries and nonlabor costs, in thousands of currency units based on the simulation.
- **Nonlabor costs**—All predicted costs apart from salaries incurred by milestones or tasks, such as fees, penalties, materials, or payments.
- **Total work cost**—The predicted cost of labor for the project in salaries. Total work, as indicated on the Work Breakdown chart, includes direct work, rework, coordination, and decision wait time.
• **Process quality risk**—A risk metric defined as the sum of ignored exceptions and half the quick-fixed exceptions, divided by the total number of exceptions:

\[
\text{Process quality risk} = \frac{\text{ignored exceptions} + (0.5 \times \text{quick fixed exceptions})}{\text{total exceptions}}.
\]

For more information on exceptions, see “Responding to Exceptions” on page 72.

• **Product quality risk**—An average of the FRI and PRI (see below).

• **Project risk index (PRI)**—The likelihood that the components produced by this project will not be integrated at the end of the project, or that the integration will have defects based on rework and exception handling. PRI is thus a measurement of the success of system integration. See “Understanding FRI and PRI Measurements” on page 153.

• **Functional risk index (FRI)**—The likelihood that components produced by this project have defects based on rework and exception handling. See “Understanding FRI and PRI Measurements” on page 153.

• **Communication risk**—The number of missed communications divided by the number of requested communications (Missed Communications / Requested Communications).

• **Meeting risk**—The number of meetings missed divided by the number of meetings requested (Missed Meetings / Requested Meetings). Each time a person misses a meeting, it counts as one meeting missed.

You can view only financial statistics or only risk statistics for the project by turning off areas of the chart.

**To view the summary statistics chart for a project**

1 Run the simulation for the first case.
2 In the Chart Window’s Tree pane, select the project. (If the program is selected, you will see the Summary Statistics chart for the program instead of the project.)
3 Click the Summary Statistics chart.
4 Select the second case from the Compare list above the chart icons, or by clicking Compare on the right-click menu.

The simulator runs the compared case if it hasn’t already been run, and the case statistics show as crosshatched bars.

5 To turn off the display of the standard deviation, click Standard Deviation on the right-click menu.
6 To turn off the financial statistics, click Show Financial on the right-click menu so it’s not checked.
7 To turn off the risk statistics, click Show Risk on the right-click menu so it’s not checked.
8 To copy and paste the chart into another application, click Copy on the right-click menu.
Comparing Case Summary Statistics

The following illustration shows a comparison of two cases of a project in the Summary Statistics chart. The statistics for the current case (Baseline) are solid colors. Those for the compared case (Reuse Info) are crosshatched.

Notice that the simulated duration of the more refined Reuse Info case is 12 weeks longer than the Baseline case. This is appropriate, given that the later case has probably factored in real-world issues such as exceptions and risk, as shown by the risk factors for the Reuse Info case in the lower half of the chart.
Analyzing Project Schedule Growth

The Project Schedule Growth chart shows the tasks at greatest risk of taking longer than planned. By default, the growth risk is calculated as the difference between CPM and simulated task duration, that is, the number of days a task takes when simulated minus the number of days the task takes in CPM calculation. You can also view the growth risk as a percentage of the CPM duration, which means the risk is calculated as follows:

\[
\frac{\text{Simulated Duration} - \text{CPM Duration}}{\text{CPM Duration}}.
\]

Schedule growth measures the potential growth in task duration (not the actual task duration) in terms of working days. Task growth reflects the amount of indirect work that has been added to the task through communication, rework, and wait time, and properly accounts for resource allocations.

Reading the Project Schedule Growth Chart

Red bars in the Schedule Growth chart represent critical path tasks and blue bars represent noncritical path tasks. For example, in the following illustration, the Fully Refined Model case of the program shows that the critical path (red) task Long Lead Purchasing is at risk of taking 17 working days longer than initially
planned. In the compared Fix Skill Mismatch case, the same task is only at risk of taking 1.5 days longer than planned, and in this case it is no longer on the critical path (it’s blue).

![Graph showing project schedule growth](image)

Depending on the project, a few days of risk for noncritical tasks is normally acceptable. Any risk for critical tasks is worthy of careful attention because it directly affects the project end date. Thus, the color-coding of tasks in this chart helps you to distinguish between tasks that need immediate attention (red), and tasks that might pose quality risks but do not necessarily pose an immediate threat to project or program duration (blue).
For example, in the following illustration, the task with the greatest growth risk is a noncritical path task. A project manager might choose to examine the red critical path tasks first, even though their growth risk is smaller.

You can view critical-path tasks only on this chart. You can also view the normalized schedule growth risk. This means that instead of showing the schedule growth risk as the simulated task duration minus the CPM duration, risk is shown as a percentage of the CPM duration, as follows:

\[
\frac{\text{Simulated Duration} - \text{CPM Duration}}{\text{CPM Duration}}
\]

**To view the project schedule growth chart**

1. Run the simulation.
2. In the Chart Window’s Tree pane, click the project.
3. Click the Schedule Growth chart icon.

   The chart shows the top five tasks at risk of taking longer than planned.

4. To view a different number of tasks, select the number from the list at the top of the Chart Window, or click Filters on the right-click menu and select an option to filter by.

5. To view the task growth risk as a percentage of the CPM duration (normalized), click Normalize on the right-click menu.

6. To show only tasks on the critical path, click Show Critical Path Only on the right-click menu.
Counteracting High Schedule Growth

The following are four common reasons why a task can be at risk of growth, with suggested solutions to each problem.

**Backlogged Position**
The responsible position is backlogged, either from performing other tasks simultaneously or from dealing with exceptions in a managerial role.

**Solution**
Examine the position responsible for the task at risk. Determine if this position is responsible for other tasks at the same time and if there is resulting backlog. You can check the position’s backlog during the task’s timeframe by looking at the Position Backlog chart. See “Analyzing Position Backlog in a Project” on page 203. If the position is backlogged at this time, try allocating the task to less backlogged positions with similar skills, or staffing the position with a person that has appropriate levels of the required skills.

**High Exception Rate and Link Volume**
Many exceptions occur in the task, and there are many communications and rework links between the task and other tasks.

**Solution**
Try applying some secondary responsible positions with the appropriate skills to the task. These positions can focus any slack time on the task. Be aware that applying secondary responsible positions that do not have the appropriate skills at the appropriate levels to the task can worsen the growth risk. An alternative is to assign a more highly skilled position to the task. This can reduce communications and the potential for errors that require rework. In fact, if you apply a position that has high Application Experience to a task with only a medium Requirement Complexity, and the skills are matched, the task will be processed 50% faster. The same applies to increasing a skill level to High for a task that requires only Medium skill level.
High Task Complexity and Uncertainty
The project contains tasks with high task complexity and uncertainty, and many exceptions occur. Routine tasks with low uncertainty and complexity take less time to complete than tasks with high uncertainty and complexity.

Solution
If possible, break the tasks into smaller, more discrete tasks. See “Splitting Tasks” on page 200.

Skill Mismatch
A task has a skill mismatch, which means the responsible position either does not have the skill required by the task, or has the skill but at an insufficient level, or has the skill at the required level but has low application experience. Another cause can be that the position is staffed with persons whose skills do not match the task requirements. A large growth risk can result for the task from any of these factors.

Solution
Either add the skill as a requirement to the unstaffed position, or assign a position that has the skill to complete the task. If the position is staffed, try replacing some or all of the staff with persons that have appropriate levels of the required skills. Another alternative is to recommend that the position’s staff be trained before or during the project so that they have the required skills by the time the task occurs.

To check the position responsible for a task
1 In the Model pane, right-click the task.
2 Click Positions.
   The position responsible for the task is listed.

To check a task’s communications and rework links
1 In the Model pane, right-click the task.
2 Click Communications.
   The Communications links are listed.
3 Click Reworks.
   The Rework links are listed.

To check a task’s complexity and uncertainty
1 In the Model pane, select the task.
   The task’s properties appear in the Properties pane.
2 Look at the value of the Requirement Complexity, Solution Complexity, and Uncertainty properties in the Properties pane.
To check for a skill mismatch in an unstaffed position

1. Activate the project that contains the task by clicking its tab at the bottom of the Model pane.
2. Click Staffing Report on the Results menu.

   The Staffing Report displays the persons in the current project.

3. To view the positions, click Positions at the top left of the report.

   The report displays the positions in the current project. Any skill mismatches are indicated by the words “Skill Not Present” with a red background, or the insufficient skill level with a yellow background.

4. To display only unstaffed or partially staffed positions, click Show Fully Staffed at the top of the report so it’s unchecked. This makes it easier to locate the staffing problems.
5. To correct a skill mismatch, see “Fixing Skill Mismatches” on page 133.

To check for a skill mismatch in a staffed position

1. Activate the project that contains the task by clicking its tab at the bottom of the Model pane.
2. Click Staffing Report on the Results menu.

   The Staffing Report lists the persons in the current project. Any skill mismatches are indicated by the words “Skill Not Present” with a red background, or the insufficient skill level with a yellow background. In the Position column, you can see which persons are staffing the position, and can then tell whether there is a skill mismatch for the position’s staffing persons.

3. To correct a skill mismatch, see “Fixing Skill Mismatches” on page 133.

Analyzing Project Cost and Work Breakdown

The Project Breakdown Charts show the simulated detailed cost or work breakdown for tasks. The charts break the cost and work down into direct work, rework, coordination and decision wait time. You can switch between displaying the cost and work breakdown. These are two important charts to examine even if you are not concerned with the simulated cost of the project, because they can tell you a lot about the indirect work involved in high-risk tasks.

Tip: To see the exact number of days that each bar represents in the Breakdown Charts, hover your cursor over the bar. After a couple of seconds, the exact number of days displays in a ToolTip.
Reading the Breakdown Charts

Work is expressed in terms of work days. The SimVision calendar assumes that weekends will be included for tasks of 5 days or longer that start on Mondays. If a task starts on another day of the week, the weekend is included if appropriate. For example, a task of 3 days’ duration starting on Thursday would be calculated to take 5 days, including the two weekend days.

Cost is expressed in terms of generic currency units x 1000. For example, if the currency is United States dollars, a cost of 50 means US$50,000. Cost considers work volumes and average cost per FTE of responsible positions. The cost is calculated as the time expended by the responsible position (with either a primary or secondary responsibility for the task) multiplied by the salary for that position if the position is unstaffed, or by the salary of the person doing the work if the position is staffed.

For example, if a task of 10 days’ duration (1 working day = 8 hours) is performed by a position with 4 FTEs, each earning 50 currency units per hour, the cost is calculated as follows:

10 x 8 x 4 x 50 = 16,000 currency units.

To view the cost and work breakdown charts

1 Run the simulation.
2 In the Chart Window’s Tree pane, click the project.
3 Click the Breakdown Charts icon.
   The chart shows the work breakdown for the five longest tasks.
4 To view the cost breakdown rather than the work breakdown of tasks, select Cost from the list at the top left of the Chart Window, or on the chart’s right-click menu.
Counteracting High Task Cost

The typical way to reduce the cost of a task is to reduce its scope. Work volumes are set based on task scope. For example, you could break a task into two subtasks and assign one of the subtasks to a less backlogged position with appropriate skills, or to a less costly position (one with a lower hourly wage). See “Splitting Tasks” on page 200.

Decision wait time is generated when a position refers an exception to a superior and has to wait for a response. A substantial amount of wait time indicates that the position’s superior is backlogged. Assigning the task to a less backlogged supervisor with similar skills can reduce the decision wait time. You could also add more FTEs to the supervisory position.

Rework can be caused by low position skill levels, high task uncertainty, or a mismatch between the position’s skills and application experience. For information on counteracting these conditions, see “Counteracting High Schedule Growth” on page 184.
Analyzing Project Risk

The Project Risk charts show your choice of seven risk metrics for the project. By default, the chart shows the Functional Risk Index (FRI), but you can switch between viewing the other six metrics by selecting them from the menu at the top of the chart, or on the chart’s right-click menu.

The following sections explain how to analyze project risks using the data in the risk charts, and, in some cases, how to counteract or reduce the risk.

Reading the Quality Risk Charts

Regardless of which risk metric you are analyzing, you view all seven quality risk charts the same way and can make the same customizations to the data.

To view the project quality risk charts

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the project. If the program is selected, you will see the Quality Risk chart for the program instead of the project.
3. Click the Quality Risk chart icon.
4. To switch between the other risk metrics, select the metric from the list at the top of the chart or on the right-click menu.
5. To view a different number of tasks, select the number from the list at the top of the Chart Window.
6. To view the standard deviation from the mean of the quality risk over all trials, click Standard Deviation on the right-click menu.

The standard deviations show as black horizontal bars.

7. If you have multiple cases in your program, compare cases by selecting a second case from the Compare list at the top left of the Chart Window.

The compared case statistics show as crosshatched bars.

8. To show only tasks on the critical path, click Show Critical Path Only on the right-click menu.
9. To copy and paste the chart into another application, click Copy on the right-click menu.
10. To filter the tasks by category, click Category Filter on the right-click menu. See “Filtering Simulation Results by Category” on page 273.
11. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Analyzing and Counteracting Functional and Project Risk

The Project Functional Risk Index (FRI) chart shows the tasks that pose the greatest risk to the quality of the project because they have the greatest risk of exception-handling failures.

The Project Project Risk Index (PRI) chart shows the tasks that pose the greatest risk to the quality of the project because they have the greatest risk of exception-handling failures.

Any quality risk below 0.2 is probably acceptable. Risk greater than 0.5 indicates high project quality risk.

For more information on FRI and PRI metrics, see “Understanding FRI and PRI Measurements” on page 153.

Counteracting High Functional or Project Quality Risk

There are two common causes of high functional or project quality risk.

- Positions ignore or only partially rework exceptions.
Since subteams tend to ignore more exceptions than project managers, a common cause of high verification risk in a project is that subteams are making too many of the decisions about how to handle exceptions. One way to lower verification risk is to provide more supervision links from subteams to the Project Manager. You can also reallocate the task to the Project Manager, but this is less desirable because Project Manager’s are frequently backlogged.

- Low centralization, meaning decisions are decentralized to the subteam.

Raising the centralization level of the project can help reduce quality risk. See “Setting Project Centralization” on page 96.

**Analyzing Product Quality Risk**

The Project Product Quality Risk chart shows an average of FRI and PRI for at-risk tasks. For example, in the following Product Quality Risk chart, the Sim Gates task has an average FRI and PRI risk of just under 0.5. Any quality risk below 0.2 is probably acceptable. Risk greater than 0.5 indicates high project quality risk.

For information on customizing the data in the Product Quality Risk chart, for example filtering it, see “Reading the Quality Risk Charts” on page 189. For information on FRI and PRI risk metrics, see “Understanding FRI and PRI Measurements” on page 153.
Analyzing Process Quality Risk

The Project Process Quality Risk chart shows tasks that pose a quality risk to the project because exceptions arising from the task were ignored or only partially fixed. Process quality risk is calculated as follows:

\[
\frac{\text{ignored exceptions} + (0.5 \times \text{quick fixed exceptions})}{\text{total exceptions}}
\]

For example, the following Process Quality Risk chart shows that the Partition Chip & Floorplanning task is generating a process quality risk of 0.517 (you can see the exact risk by hovering the cursor over the task). Any quality risk below 0.2 is probably acceptable. Risk greater than 0.5 indicates high project quality risk.

For information on customizing the data in the Process Quality Risk chart, for example filtering it, see “Reading the Quality Risk Charts” on page 189.

Analyzing and Counteracting Communications Risk

Project communication involves the flow of information between positions about the tasks for which they are responsible. Do not confuse communication risk with coordination risk, which is the sum of the communication and meeting risk. The principal cause of high communication risk is a high level of ignored communications among tasks that are linked with communications links.
The Project Communications Risk chart measures the risk that positions will handle communications about their tasks improperly. This process risk suggests possible product quality risk. By default, the chart shows the top five tasks that pose a communication risk to the project. You can choose the number of tasks to view risk for, or select specific tasks to see their associated risk.

The formula for calculating communication risk is:

\[
\text{Communication Risk} = \frac{\text{Missed (ignored) Communications}}{\text{Requested Communications}}
\]

Communication risk is calculated for every task. Risk greater than 0.2 indicates high process risk and high subsequent product quality risk.

You can compare two cases in the Communications Risk chart. The compared case’s risk shows in crosshatched bars. For example, the illustration shows the Baseline case of a program (solid bars) compared to a case called Outsource Software Development (crosshatched bars).

For information on customizing the data in the Project Communications Risk chart, for example filtering it, see “Reading the Quality Risk Charts” on page 189.

**Counteracting High Communications Risk**

There are three common conditions that cause high communications risk.

> Analyzing Project Risk 193
• Backlogged positions that fail to respond to requests.
  For information on counteracting this problem, see “Counteracting High Position Backlog” on page 207.

• How the organization communicates during the project, which is captured in the Centralization and Formalization settings for the case. With low centralization, responsible positions tend to make their own decisions and there is thus less communication required. Similarly, high formalization means the communication takes place more formally in meetings.
  For information on balancing these settings, see “Setting Project Centralization” on page 96 and “Setting Project Formalization” on page 96.

Analyzing Meeting Risk

The Project Meeting Risk chart shows tasks whose primary responsible positions are generating meeting risk. Meeting risk is calculated as the number of meetings missed divided by the number of meetings requested (Missed Meetings / Requested Meetings). Each time a person misses a meeting, it counts as one meeting missed. For example, if two meetings are scheduled for four persons each, and one person misses one meeting, then the meeting risk is 1/8 = 0.125. Statistics are accumulated per position, so a one-time meeting with 3 attendees out of 4 assigned would have a risk of 0.25.

The Meeting Risk chart is useful for pinpointing the positions responsible for risk associated with a meeting, as long as these positions have primary responsibility for a task. So it’s a useful chart for seeing which positions pose risk to a project because they are assigned to too many meetings, rather than for any other reason.

If a meeting has risk associated with it, you can see from the model or the meeting’s statistics who the attendees are, but not which of them are generating the risk. The Project Meeting Risk chart shows tasks assigned to the positions generating the risk. All you have to do is find out the primary responsible position for these tasks (from the Task Statistics chart), and you know that these positions are the ones generating the meeting risk.
For example, the ASIC Hardware project has one meeting, the Weekly Coordination meeting, which generates a risk of 0.34. This meeting has three attendees: HW Project Manager, Chip Architect, and Foundry Lead. The project’s Meeting Risk chart shows that three tasks have meeting risk associated with their responsible positions.

By viewing the Task Statistics chart for the tasks, you can see that their responsible positions are HW Project Manager for the first two and Chip Architect for the third. These positions, then, are the ones responsible for the Weekly Coordination meeting’s risk.

Any meeting risk below 0.2 is probably acceptable. Risk greater than 0.5 indicates high project quality risk. For information on customizing the data in the Project Meeting Risk chart, for example filtering it, see “Reading the Quality Risk Charts” on page 189.

**Analyzing Coordination Risk**

Project Coordination Risk is calculated as the average of the Communications Risk and the Meeting Risk for a task, that is \((\text{Communication Risk} + \text{Meeting Risk}) / 2\).
The Project Coordination Chart shows the tasks that are generating the greatest coordination risk. A task only generates coordination risk if there is communication risk associated with the task itself and meeting risk associated with its primary responsible position.

Any coordination risk below 0.2 is probably acceptable. Risk greater than 0.5 indicates high project quality risk. For information on customizing the data in the Project Coordination Risk chart, for example filtering it, see “Reading the Quality Risk Charts” on page 189.

**Analyzing Backlog**

Backlog means the number of days of work in a position or person’s in-tray. The optimal backlog is thus one day, which means the person is fully occupied but is not behind in the work. However, this rarely happens in the real world. Usually, people have several days of work accumulated. Sometimes, a person has so much work accumulated that there is a risk to the schedule and project quality. In general, a backlog of 2-4 days for a person will not pose any threat to the project. Higher backlogs need attention.

Backlog is measured for both positions and persons in a project. See “Analyzing Person Backlog in a Project” on page 197 and “Analyzing Position Backlog in a Project” on page 203.
Analyzing Person Backlog in a Project

The person backlog charts show overloads on persons in the project over time. The Person Backlog chart helps you to understand the root cause of backlogs by identifying periods in which backlog occurs. You can also view the person backlog for an organization, a department, or an individual person.

Reading the Person Backlog Charts

By default, the Project Person Backlog chart shows the five most backlogged persons, but you can specify the number of persons to view backlogs for. For example, you can view the ten most backlogged persons, or just the top two. You can also select only certain persons to view backlog for.

Tip: If you are having trouble distinguishing the graphs for two persons because of color similarities, you can change one person’s color. In the model, right-click the person’s department and click Person List to view the person properties. Change the appropriate persons’ Chart Color property and rerun the simulation.
You can compare person backlog across cases of the project. Backlog data in the compared case displays as dotted lines.

Use the Backlog charts with the Position Backlog and Breakdown Charts to identify the extent to which backlog follows from direct work or coordination and rework. The best way to do this is by following these steps:

- On the project’s Position Backlog chart, identify backlogged positions and their most backlogged times.
- On the Gantt chart, identify the tasks that these positions are responsible for during their most backlogged times.
- Examine those tasks in the Breakdown Charts. If there is a high proportion of rework, coordination, or wait time, intervene to address those problems. Otherwise, the position might need more resources or more skilled staff.
- View the persons staffing that position by selecting the position in the Chart Window Tree pane and viewing its statistics.
- Check the staffing persons’ backlog on the Person Backlog chart.

To view a project, organization, department, or person’s person backlog chart

1 Run the simulation.
2 In the Chart Window’s Tree pane, select the project, organization, department, or person.
3 Click the Person Backlog chart icon.
   The chart shows the top five backlogged persons in the project, organization, or department, or just the person you selected the backlog chart for.
4 To view a different number of person backlogs, select the number from the list at the top of the Chart Window.
5 To filter the backlogs so only backlog for certain persons display, select Custom from the list at the top of the Chart Window.
Analyzing and Using Simulation Data

Comparing Person and Position Backlog
The major difference between a person and a position is that a person can be working on multiple tasks at once. If a person is highly backlogged, but the staffed position is not as backlogged, then the person must be responsible for another task, possibly in another project, and the two projects are competing for the resource. The overloaded person could cause problems in both tasks.

Comparing position backlog and person backlog is important to determine whether backlog problems are due to project-level concerns or competition between projects for resources.

Counteracting High Person Backlog
There are only two ways to counteract high person backlog.

- Add resources, such as contractors.

The Backlog Filter dialog box appears, showing a list of persons in the project, organization, or department.

6 Select the check boxes beside the persons whose backlogs you want to view.
7 Click OK.
8 To copy and paste the chart into another application, click Copy on the right-click menu.
9 To compare person backlog in the current case with another case, click Compare on the right-click menu and select the case to compare with.
10 To filter the persons by category, click Category Filter on the right-click menu. See “Filtering Simulation Results by Category” on page 273.
11 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
• Take work away from the backlogged person.

Try assigning tasks to a different person, but make sure the new person has the skills required by the task at the appropriate level. You can do this by adding a person to the responsible position. You can also split tasks, or use secondary links to help out on critical tasks.

**Splitting Tasks**

Splitting tasks can help take work away from a backlogged person or position. For example, you could split a two-month task into two one-month-long tasks that could be done in parallel by two persons. Another alternative is to split a task into two tasks that require different skills. For example, a project manager might be severely backlogged and no-one else is equipped to do the job. However, if an administrative assistant were hired to do the paperwork, the manager would have more time to handle exceptions, which would alleviate backlog and increase quality.

However, adding new positions that report to the Project Manager will probably also increase the communication and supervisory tasks of the manager, and this might cancel out the benefit of having the extra resource.

**Using Secondary Task Assignments**

Secondary task assignments mean that the responsible position or person works on these tasks as well as their primary assignments. If a specific task is causing high backlog, one way to alleviate this is to identify positions within the organization that have free time during the task’s duration and the skill set required by the task, and assign a secondary task assignment link from the position to the task. Assigning several such links to critical tasks can help reduce backlog around those tasks. However, be aware of the potential for increased exceptions and backlog when multiple secondary assignments are used thus.
Workers give no priority to their primary over their secondary tasks, and only the primary responsible position handles exceptions arising from a secondary task assignment.

**Note:** Assigning a secondary task to a position that does not have the required skills at the required levels can have no effect, or worse, an adverse effect on the task duration. You must match skills and skill levels with the task requirements when assigning secondary tasks.

It is very important to set a high allocation percentage for positions assigned with secondary assignment links. (The allocation percentage is a property of the link.) If a position is “helping” another position, but has only a low secondary assignment allocation percentage, such as 10%, this results in frequent, short work periods on the secondary task. In this situation, the primary position will suffer increased backlog due to the increase in communications and rework required. Set the allocation percentage of secondary task assignments to at least 70%, preferably 100%, so that the secondary position will only help out on the task when they have reasonable amounts of time to devote to it.

Similarly, if the primary position has a low assignment allocation and the secondary position has high allocation, the primary position will need to keep the secondary position waiting a lot for answers to questions and other information. This will result in high decision wait time and decreased efficiency on the part of the secondary position in carrying out the task. Thus, if you are using secondary assignment links, make sure both the primary and secondary positions have a high allocation percentage in their assignment links to the task.
Examples of Using Secondary Task Assignments

In the following example, a backlogged HW Project Manager position that is solely responsible for the HW Design Coordination task gets some relief when you add a secondary task assignment link from the Logic Design team position to the task.

The key facts in this example are:

- The HW Design Coordination task has a skill requirement of SC Design Management at a Medium level.
- The HW Project Manager and the members of the Logic Design Team all have the skill SC Design Management at a Medium level in their skill sets. It’s important that all the members of the Logic Design Team have this skill. When you assign a task to a position with multiple FTEs, any of the FTEs can end up working on the task, depending on which person is free at the appropriate time, so you can’t assume that the one person on the team with the required skills will end up working the task.
In the following example, two coordination assistants have been allocated secondary responsibility for the task. The assistants have been linked to the Project Manager with supervision links, indicating that the Project Manager is supervising their work on this task.

These assistant positions can focus entirely on design coordination because they do not have any primary tasks. (Positions must have at least one task assigned, but it doesn’t matter whether it’s a primary or a secondary task.) The trade-off here is that the Project Manager will have some additional supervisory work with two extra positions to take care of. This extra work could cancel out the benefits of the help the assistants can provide.

Again, the key facts in this example are:

- The Design Coordination task has a skill requirement of SC Design Management at a Medium level.
- Both coordination assistant positions have the skill SC Design Management at a Medium level in their skill set.

**Analyzing Position Backlog in a Project**

The Project Position Backlog chart is one of the most important charts, showing predicted overload of all positions in the project over time. If a position’s predicted backlog is close to zero for a period, it can probably be given responsibility for more work in that period. If the backlog for any or all positions is zero there will only be a single line visible at zero since all the data overlaps.
Reading the Project Position Backlog Chart

The Project Position Backlog expresses position overload as a graph in terms of days for each of the positions in the project. The positions are color-coded, according to the Chart Color property for each position.

The default is to view the five most overloaded positions, but you can specify a different number. For example, you can view the ten most backlogged positions, or just the top two. You can also select specific positions to view backlog for, and you can compare backlog across cases. Backlog in compared cases shows up as dotted lines.

You can view position backlog over different time periods throughout the project, or compared to a different maximum number of FTEs. You do this by changing the scale of the chart’s X or Y axes. For more information, see “Rescaling the Backlog Charts” on page 206.

Tip: If you are having trouble distinguishing the backlog graphs for two positions because of color similarities, you can change one position’s chart color. In the model, select the position, change its Chart Color property, and rerun the simulation.

To view the position backlog chart

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the project. (If the program is selected, you will only see the Person Backlog chart.)
3. Click the Position Backlog chart icon.
The chart shows the five most backlogged positions.

4. To view a different number of position backlogs, select the number from the list that says Top 5 at the top of the Chart Window, or click Filters on the right-click menu.

5. To filter the chart so only backlog for certain positions displays, select Custom from the list at the top of the Chart Window or the Filters submenu.
Rescaling the Backlog Charts

The Backlog Charts’ X axes measure time and their Y axes measure FTEs. You can change the scale of both axes, for example, to facilitate chart comparisons across cases.

You change the start and end dates of the chart by changing the scale of the X axis, so that backlog is shown over a different time period than the duration of the project, which is the default time period.

You change the maximum number of FTEs shown by changing the scale of the Y axis from the default, which is 5% more than the highest backlog. The scale of the backlog data changes accordingly when you rescale the Y axis. For example,
you might want to show how person backlog in Case 1 covers most of the chart with the maximum FTEs set to 20, whereas in Case 2, backlog covers only a small area of the chart with maximum FTEs set to 20.

To change the time period of the Backlog Charts

1. Click Set Scales on the chart’s right-click menu.
2. In the Set X and Y Scales dialog box, click User Defined above the start and end dates.
3. Type new dates over the existing ones, or click the down-arrow and select new dates from the calendar.
4. Click OK.

The Backlog Chart shows backlog over the time period you specified.

To set the number of FTEs on the Backlog Chart’s Y axis

1. Click Set Scales on the chart’s right-click menu.
2. In the Set X and Y Scales dialog box, click User Defined above Max Y Value.
3. Enter a new maximum value for the number of FTEs shown on the Y axis.
4. Click OK.

The scale of the Y axis and the backlog data adjusts accordingly.

Counteracting High Position Backlog

High backlog indicates a risk of schedule delay and the possibility that the position will take shortcuts and compromise product quality. Where a position has high backlog, check the other tasks the position is responsible for during this period. You might need to add extra resources to these tasks, or reallocate work to less backlogged positions with the same skills.

Pay particular attention to positions with a lot of subordinates reporting to them, such as Project Managers. These positions need slack time to answer subordinates’ questions and perform other managerial duties that are not counted as direct work. Make sure supervisory positions do not have their full FTE.
capacity allocated to tasks. If possible, allow 0.05-0.1 FTE of slack time for each subordinate. For example, if a manager has 10 positions reporting to her, assign all but 1 FTE of the manager position’s available FTE to tasks. You do this by setting the task allocation percentages of the position’s tasks such that the total allocation is 90-95%, rather than 100%.

To check the tasks a position is responsible for
• In the Model pane, right-click the position and click Tasks.
  All tasks for which the position is responsible are listed.

To set task allocation allowing for slack time
1. On the project page in the Model pane, right-click the position you want to set task allocation for.
2. Click Tasks to see a list of tasks assigned to this position.
3. In the Model pane, select each assignment link that links that position to a task and make a note of the allocation percentage.
4. If the total task allocations add up to more than 90-95%, reduce the allocation percentage on one or more assignment links so that the total allocation allows 5-10% slack time for the position.

Analyzing the Project Resource Charts
The Project Resource Demand chart shows the amount of work to be done by the project’s positions. The Resource Utilization chart shows the speed with which the positions are doing the work. The Resource Demand chart shows where backlog occurs (the spikes in the chart). Troughs in the Utilization chart are a good indication of where resources have free time and can be more effectively used. Utilization tends to taper off towards the end of the project. In general, the Demand and Utilization charts will look quite similar for a project.

You can also look at FTE availability on the Resource charts. Availability shows as an aggregate availability percentage for all positions in the project.

Viewing and Manipulating the Resource Charts
You can customize the data shown in the Project Resource Charts as described in the following steps.

To view the Project Resource charts
1. Run the simulation.
2. In the Chart Window’s Tree pane, select the project to view resource information for.
3. Click the Resource Charts icon in the chart bar.
  The Resource Chart shows the resource utilization of the project’s positions.
4 To view resource demand or availability rather than utilization, select Demand or Availability where it says Utilization in the chart’s toolbar, or on the right-click menu.

5 To view a line chart rather than the default area chart, click Line Chart on the right-click menu. See “Viewing Line Instead of Area Charts” on page 215.

6 To view the number of available FTEs, click Show FTEs on the right-click menu. See “Viewing the Number of FTEs Available” on page 213.

7 To view data for a different number of resources, select the number from the filter list in the chart’s toolbar, or click Filter on the right-click menu and select a number. To select specific resources, choose Custom and select the resources from the supplied list.

8 To filter the data by category, click Category Filter on the right-click menu, select the categories, and click OK.

9 To view only staffed or unstaffed positions, click Staffed or Unstaffed on the right-click menu or the list in the chart’s toolbar. The default is to display data for both staffed and unstaffed positions. See “Viewing Staffed and Unstaffed Positions” on page 210.

10 To copy and paste the chart into another application, click Copy on the right-click menu.

11 To change the timescale or maximum number of FTEs shown on the chart, click Set Scale on the right-click menu. See “Rescaling the Resource Chart Axes” on page 215.

12 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Example of Resource Demand Analysis

In the following Project Resource Demand chart, the Testing Engineer position (purple) is not used for the first three months or the last two months of the project.

![Resource Demand Chart]

If this position is available for the entire project, it is significantly underused. If its skill set is appropriate for other areas of work, especially areas that are currently backlogged, it might be possible to pull in the project’s schedule and cost by using this position elsewhere. You could go back to the model, track areas where the position could be used with its skill set and experience, and see if you could assign more work to the position to reduce backlog elsewhere.

Viewing Staffed and Unstaffed Positions

By default, the Resource Charts display demand and utilization information for both staffed and unstaffed positions in the project. You can filter the information so you view data for only staffed positions or only unstaffed positions. An unstaffed position displays as a hatched version of the staffed position’s color, as shown in the following illustrations.
The first illustration shows a project Resource Chart for both staffed and unstaffed positions in the ASIC Hardware project.

The next illustration shows just the unstaffed positions, which is what displays when you click Unstaffed on the right-click menu in the Chart Window. Only the Technology Manager and System Architect positions are unstaffed.
Viewing the Number of FTEs Available

You can view the number of FTEs assigned to the project, or to the number of resources you are viewing data for. Do this by clicking Show FTEs on the chart’s right-click menu. The available FTEs display as a black line across the chart. For example, in the following illustration, there are 15 FTEs available across the five positions.

FTE availability changes when you filter the data in the chart. For example, if you view Resource Utilization for the three most used positions, you see the total FTEs assigned to those three positions.

Resource Demand can spike above the FTE line, which should be cause for concern if the demand exceeds available FTEs by too much. Naturally, Resource Utilization will never exceed FTE availability.

Viewing Aggregate FTE Availability

You can view the availability of resources throughout the project as an aggregate percentage. Do this by clicking Availability on the chart’s right-click menu. This is actually the inverse of viewing resource utilization. Resource availability shows as a percentage of all FTEs available at any one time and is a useful snapshot of...
periods when resources in general are underused. For example, the following Project Availability chart shows a significant dip in resource usage during the second month of the project.
Viewing Line Instead of Area Charts

You can view the resource data as line charts instead of stacked area charts, as shown next. Do this by clicking Line Chart on the chart’s right-click menu.

![Resource Chart](image)

For example, you might want to view line graphs if the area graphs obscure each other. The lines for staffed resources are solid, and the lines for unstaffed are dotted.

Rescaling the Resource Chart Axes

The Resource Chart’s X axis measures time and its Y axis measures FTEs. You can change the scale of both axes, for example, to facilitate chart comparisons across cases.

You change the start and end dates of the chart by changing the scale of the X axis, so that resource demand or utilization is shown over a different time period than the duration of the project, which is the default time period.

You change the maximum number of FTEs shown by changing the scale of the Y axis from the default, which is 5% more than the highest resource usage or demand. The scale of the demand and utilization data changes accordingly when you rescale the Y axis. For example, you might want to show how resource usage
in Case 1 covers most of the chart with the maximum FTEs set to 20, whereas in Case 2, resource usage covers only a small area of the chart with maximum FTEs set to 20.

**Note:** If the Show FTEs setting is turned on, the chart’s Y axis is automatically scaled to display the available FTEs line, overriding any smaller scale that you set. Turn off Show FTEs to revert to your custom Y-axis scale.

### To change the time period of the Resource Charts

1. Click Set Scales on the chart the right-click menu.
2. In the Set X and Y Scales dialog box, click User Defined above the start and end dates so it is checked.
3. Type new dates over the existing ones, or click the down-arrow and select new dates from the calendar.
4. Click OK.

The Resource Chart shows resource utilization or demand over the time period you specified.

### To set a different number of FTEs on the Resource Charts’ Y axis

1. Click Set Scales on the chart the right-click menu.
2. In the Set X and Y Scales dialog box, click User Defined above Max Y Value.
3. Enter a new maximum value for the number of FTEs shown on the Y axis.
4. Click OK.

The scale of the Y axis and the chart data adjusts accordingly.

### Analyzing the Project Financial Charts

Project financial data is displayed on three charts, the Project Finance chart, the Task Finance Chart, and the Project Financial Statistics chart.
• **Project Finance Chart**—Displays cost and revenue data graphically for the selected project and its tasks. See “Analyzing the Project Finance Chart” on page 217.

• **Task Finance Chart**—Displays cost and revenue data graphically for the selected task over the lifetime of its project. See “Reading a Task’s Statistics Chart” on page 235.

• **Project Financial Statistics Chart**—A spreadsheet-like chart that lists cumulative and net costs and revenues for the project and its tasks and milestones. See “Reading a Project’s Financial Statistics Chart” on page 229.

**Analyzing the Project Finance Chart**

The Project Finance Chart shows you the cost and the revenue values for the selected project. The values are shown over time for the duration of the project (the X-axis) in currency units x 1000 (the Y-axis). Both cost and revenue represent rolled-up values for the milestones and tasks in the project.

**Note:** Because task data is shown in the chart color of the task, you might want to ensure that no tasks in the project have a chart color of red or green. This avoids confusing task data with the red cost and green revenue data for the project. For information on setting task chart color, see “Setting Task Properties” on page 36.
You can view just cost or just revenue data for the project and you can compare the financial data in any two project cases. You can also view financial data for all tasks in the project, switching between task costs and revenues and filtering the tasks by number or category. For example, the following chart shows task costs for the Reduce FCS Growth case of the ASIC Hardware project. You would view this information by clicking Show Members on the chart's right-click menu, and then clicking Show Revenues to turn revenues off and just show costs. Task chart.
colors are used to distinguish the tasks, so you can see how important it is that no task has a chart color of the same red or green used to show total costs and revenues.

![Project Finance Chart](image)

You can view financial data for a specific time period of the project, and change the currency scale shown on the chart. See “Changing the Time Period or Currency Scales of the Finance Charts” on page 220.

**To view the Project Finance chart**

1. In the Chart Window’s Tree pane, select the project to view financial data for.
2. Click the Finance Chart icon (you’ll have to scroll down the chart bar to see this).

   The Project Finance Chart shows cost and revenue for the project.

3. To display only cost data, click Show Revenues on the chart toolbar to turn off the display of revenue data.
4. To display only revenue data, click Show Costs on the chart toolbar to turn off the display of cost data.
5. To view cost or revenue data for the project’s tasks, click Show Members on the chart the right-click menu.

   The task filter, category filter, member cost, and member revenue options become available.
Changing the Time Period or Currency Scales of the Finance Charts

You can change the timescale on the X-axis of the finance charts or the scale of the currency shown on the Y-axis. For example, you might want to view costs during a specific period of the project, in which case you would change the start and end dates shown on the chart to reflect that period.

To change the time period or currency scale of the Finance charts

1. Click Set Scales on the chart’s right-click menu.

The Set X and Y Scales dialog box appears.

2. To change the time period (the scale of the chart’s X-axis), click User Defined under X Scale.

3. Type new dates over the existing ones, or click the down-arrow and select new dates from the calendar

4. To change the maximum currency value (the scale of the chart’s Y-axis), click User Defined under Y Scale and enter a new maximum value.

5. Click OK.

The chart’s axes show the new values you set.
Reading the Project Statistics Charts

You can view statistics for any object that displays in the Tree pane of the Chart Window. Objects that contain other objects—programs, projects, and organizations—have statistics charts that show collective data. For example, the project’s Position Statistics chart shows data about all positions in the project. This is useful for seeing information like communications risk or percent staffing across all positions in the project.

When a statistics chart displays multiple objects of the same type, for example, the list of tasks in the program’s Project Statistics chart, you can sort the columns by double-clicking on the column heading.

This section covers the project statistics charts. For information on the statistics charts for other objects, see the section for that object’s charts.

The project’s statistics charts are:

- **Project Statistics**—See “Reading the Project Statistics Chart” on page 222.
- **Project’s Task Statistics**—See “Reading a Project’s Task Statistics Chart” on page 224.
- **Project's Milestone Statistics**—See “Reading a Project’s Milestone Statistics Chart” on page 225.
- **Project's Position Statistics**—See “Reading a Project’s Position Statistics Chart” on page 226.
- **Project's Meeting Statistics**—See “Reading a Project’s Meeting Statistics Chart” on page 227.
- **Project's Financial Statistics**—See “Reading a Project’s Financial Statistics Chart” on page 229.
Reading the Project Statistics Chart

For each project, the Project Statistics chart reports the statistics shown in the following illustration. Note that the “k” values mean thousands of currency units.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>ASC Hardware</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>User WBS</td>
<td></td>
</tr>
<tr>
<td>Simulated Duration</td>
<td>150.1</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>CPM Duration</td>
<td>141.5</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Simulated Start Date</td>
<td>11/1/2004</td>
</tr>
<tr>
<td>Simulated Finish Date</td>
<td>5/30/2005</td>
</tr>
<tr>
<td>Total Volume</td>
<td>527.6</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Work Volume</td>
<td>430.5</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Rework Volume</td>
<td>0.0</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Coordination Volume</td>
<td>27.1</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Decision Wait Volume</td>
<td>0.0</td>
</tr>
<tr>
<td>(days)</td>
<td></td>
</tr>
<tr>
<td>Fixed Cost (k)</td>
<td>260</td>
</tr>
<tr>
<td>Non Labor Cost (k)</td>
<td>250</td>
</tr>
<tr>
<td>Actual Cost</td>
<td>230</td>
</tr>
<tr>
<td>Fixed Revenue (k)</td>
<td>350</td>
</tr>
<tr>
<td>Total Revenue (k)</td>
<td>350</td>
</tr>
<tr>
<td>Actual Revenue</td>
<td>350</td>
</tr>
<tr>
<td>RPI</td>
<td>0</td>
</tr>
<tr>
<td>PRS</td>
<td>0</td>
</tr>
<tr>
<td>Coordination Risk</td>
<td>0.123</td>
</tr>
<tr>
<td>Communications Risk</td>
<td>0.00</td>
</tr>
<tr>
<td>Meeting Risk</td>
<td>0.40</td>
</tr>
<tr>
<td>Criticality</td>
<td>0</td>
</tr>
<tr>
<td>Percent Staffing</td>
<td>100</td>
</tr>
<tr>
<td>Code</td>
<td>EsoFire</td>
</tr>
<tr>
<td>Program</td>
<td>ASC</td>
</tr>
</tbody>
</table>

For more information on project WBS, see “Setting a Project’s WBS” on page 89.

Total Volume is the sum of direct work, rework, coordination, and decision wait time. See “Understanding Types of Work” on page 73.

For more information on project cost and revenue statistics, see “Modeling Project Finances” on page 103.

For more information on Project Risk Index and Functional Risk Index, see “About Product Risk Metrics” on page 152.

Criticality is between 0 and 1, depending on the percentage of trials for which the project is on the critical path.

For more information on percent staffing, see “Staffing Positions” on page 123.

To view a project’s statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Project Stats chart icon in the Chart Bar.

The project’s statistics display in the Chart Window.
To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.

To view the standard deviation of project statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.

To view the time as well as the date in statistics, click Show Time on the right-click menu.

To copy and paste the chart into another application, click Copy on the right-click menu.

To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading a Project’s Task Statistics Chart

A project’s Task Statistics chart summarizes the tasks in the selected project and, for each task, displays the same information as the task’s Statistics Chart. You can filter the chart by task or category. The project’s Task chart is useful for comparing tasks and their durations, cost, revenue, and associated risks.

To view a project’s Task Statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Task Stats chart icon in the Chart Bar.
   - The Project’s Task Statistics chart displays in the Chart Window.
3. To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.
4. To view the standard deviation of task statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.
5. To view the time as well as the date in statistics, click Show Time on the right-click menu.
To view a subset of the project’s tasks, click Custom instead of All on the Filters list in the chart toolbar, or Filters>Custom on the right-click menu, and select the tasks from the Filter dialog box.

To filter the tasks by category, click Category Filter on the right-click menu and select the categories.

To copy and paste the chart into another application, click Copy on the right-click menu.

To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

### Reading a Project’s Milestone Statistics Chart

A project’s Milestone Statistics chart summarizes the milestones in the selected project and, for each milestone, displays the same information as the milestone’s Statistics Chart. The project’s Milestone Statistics chart is useful for comparing milestones and their dates, cost, revenue, and associated risks.

#### To view a project’s Milestone Statistics chart
1. In the Chart Window’s Tree pane, select the project.
2. Click the Milestone Stats chart icon in the Chart Bar.

   The Project’s Milestone Statistics chart displays in the Chart Window.

3. To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.

4. To view the standard deviation of milestone statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.

5. To view the time as well as the date in statistics, click Show Time on the right-click menu.
Reading a Project’s Position Statistics Chart

A project’s Position Statistics chart summarizes the positions in the selected project and, for each position, displays most of the information that displays on the position’s Statistics Chart. The Position chart is useful for checking project staffing levels, and for comparing position backlogs over time.

To view a project’s Position Statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Position Stats chart icon in the Chart Bar.

The Project’s Position Statistics chart displays in the Chart Window.

3. To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.
Reading a Project’s Meeting Statistics Chart

The Meeting chart summarizes the meetings in the selected project and, for each meeting, displays the same information as the meeting’s Statistics Chart. See “Reading a Meeting’s Statistics Chart” on page 237. The project’s Meeting chart is useful for comparing meeting risk and checking for attendee positions that might be assigned to simultaneous meetings. Meeting risk is defined as the number of meetings missed divided by the number of meetings requested. Each time a person misses a meeting, it counts as one meeting missed. For example, in the illustrated program, the Design meeting shows a fairly high meeting risk of 0.53 because just over half of the 152 meeting invitations were missed.

To view a project’s Meeting Statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Meeting Stats chart icon in the Chart Bar.

    The Project’s Meeting Statistics chart displays in the Chart Window.
Reading a Project’s Resource Statistics Chart

For each project, the Project Resource Statistics chart shows the usage and demand statistics per task for the project’s positions.

Note: This chart only shows data if you turn on the Simulator - Calculate Usage Stats by Task option on the General tab of the Options dialog box. Turning on this option can increase the processing time for simulations.

The chart lists the tasks with their WBS, descriptions, and the name of the responsible position. Resource usage or demand on the task is shown in hours. For example, the following Project Resource Statistics chart shows that the HW Project Manager spent 122.2 hours on the Chip Spec task in October 2005.

<table>
<thead>
<tr>
<th>WBS</th>
<th>Task Name</th>
<th>Description</th>
<th>Position Name</th>
<th>Oct 2005</th>
<th>Nov 2005</th>
<th>Dec 2005</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip Spec</td>
<td>HW Project Manager</td>
<td></td>
<td></td>
<td>122.20</td>
<td>10.78</td>
<td>0.00</td>
</tr>
<tr>
<td>Partition Chip &amp; F</td>
<td>Chip Architect</td>
<td></td>
<td></td>
<td>0.00</td>
<td>243.03</td>
<td>400.00</td>
</tr>
<tr>
<td>HW Design Coord</td>
<td>HW Project Manager</td>
<td></td>
<td></td>
<td>0.00</td>
<td>113.45</td>
<td>242.12</td>
</tr>
<tr>
<td>Write-Verify-Syn</td>
<td>Logic Design Team</td>
<td></td>
<td></td>
<td>0.00</td>
<td>341.51</td>
<td>372.06</td>
</tr>
<tr>
<td>Assemble &amp; Verif</td>
<td>Verification Team</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Full Chip Synth</td>
<td>Logic Design Team</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>385.42</td>
</tr>
<tr>
<td>Eng. Layout &amp; Phy</td>
<td>Foundry Layout Engineer</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Sim Gates</td>
<td>Foundry Test Engineer</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Generate Test Vc</td>
<td>Foundry Test Engineer</td>
<td></td>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

You can view the statistics by month, quarter, or year and filter the data by task or category. In a staffed project, you can display the persons staffing each position and see how many hours each person worked on their tasks. You can also display all duplicate task and position names. You might want to fill all cells like this for sorting purposes if you are pasting the data into a spreadsheet application, such as Microsoft Excel.

To view a project’s Resource Statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Resource Stats chart icon in the Chart Bar.
Reading a Project’s Financial Statistics Chart

For each project, the Project’s Financial Statistics chart shows cost and revenue data for the project itself and for each of its milestones and tasks. Negative values are in red and positive cumulative values are in green. All values are in thousands of currency units. You can view finances per month (the default), quarter, or year and you can filter the data, for example to view only cost statistics or only cumulative revenues.

3 To view a subset of tasks, click Custom instead of All on the Filter list at the top of the chart window and select the tasks and milestones from the list.

4 To filter the data by category, click Category Filter on the chart right-click menu and select the categories from the list.

5 To view the data by year or quarter instead of the default month, select Year or Quarter from the list on the chart toolbar.

6 To show persons in a staffed project, click Show Persons on the right-click menu.

7 To display all instances of duplicate task or position names, click Fill All Cells on the right-click menu.

8 To copy and paste the chart into another application, click Copy on the right-click menu.

9 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
For example, the following Financial Statistics chart for the Plant 1 project shows a total project cost of 13,890 currency units. The ISBL Scope Definition task costs 2,050 and doesn’t bring in any revenue, so its net value is negative 2,050 currency units.

To view a project’s Financial Statistics chart

1. In the Chart Window’s Tree pane, select the project.
2. Click the Financial Stats chart icon in the Chart Bar.

The Project Financial Statistics chart displays in the Chart Window.

3. To view a subset of tasks or milestones, click Custom instead of All on the Filter list at the top of the chart window and select the tasks and milestones from the list.
4 To filter the data by category, click Categories on the chart right-click menu and select the categories from the list.
5 To view the data by year or quarter instead of the default month, select Year or Quarter from the list on the chart toolbar.
6 To view just one kind of data, for example just costs or just revenues, select an option from the list on the chart toolbar. (The default is All.)
7 To copy and paste the chart into another application, click Copy on the right-click menu.
8 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading a Milestone’s Statistics Chart

For each milestone, the Statistics Chart reports the statistics shown in the following illustration. You can switch between viewing work volume and cost statistics for the milestone, as shown in the illustration.

The Planned Date is the estimated date for the milestone, based on known contingencies such as staff availability. Unless the client requests otherwise, the planned date is usually relative to another milestone. The planned date can be an absolute date if requested by the client. For example, Marketing might want the product to ship before an important trade show.

The Cost and Revenue to Date statistics show how much the parent project has cost and generated up to the point of the milestone. The Predecessor statistics show how much just the tasks on the milestone’s work process have cost and generated up to the point of the milestone. These statistics are useful if a model has a number of highly parallel work processes and you want to see financial data for just one of the processes at a specific milestone. For example, in a model with...
parallel work processes for building oil tankers and an oil refinery, you might want to see how much just the construction of the refinery has cost at the point that it moves into production. Note that a task’s financial data might be included in more than one milestone’s predecessor values, but no data is summed more than once for a given milestone.

**To view a milestone’s statistics chart**

1. In the Chart Window’s Tree pane, click the plus sign by the project that contains the milestone.
2. Select the milestone.
3. Click the Milestone Statistics chart icon.
   - The milestone’s statistics display in the Chart Window.
4. To view work cost instead of volume statistics, switch between Work and Cost at the top of the chart window.
5. To view the standard deviation of milestone statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.
6. To view the time as well as the date in statistics, click Show Time on the right-click menu.
7. To copy and paste the chart into another application, click Copy on the right-click menu.
8. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

**The Task Charts**

Tasks have the following charts:

- **Task Finance Chart**—See “Analyzing the Task Finance Chart” on page 233
- **Task Statistics Chart**—See “Reading a Task’s Statistics Chart” on page 235.

**Analyzing the Task Finance Chart**

Each task has its own Finance Chart, showing total costs and revenues for the task over the life of the project, or over a specific period of time that you set. For information on changing the time period or currency scale of the chart, see “Changing the Time Period or Currency Scales of the Finance Charts” on page 220.

**To view the Task Finance chart**

1. In the Chart Window’s Tree pane, select the task to view financial data for.
2. Click the Finance Chart icon.
   - The Task Finance Chart shows cost and revenue for the task.
3 To display only cost data, click Show Revenues on the chart toolbar to turn off the display of revenue data.

4 To display only revenue data, click Show Costs on the chart toolbar to turn off the display of cost data.
Reading a Task’s Statistics Chart

For each task, the Statistics Chart reports the statistics shown in the following illustration. You can switch between viewing work volume and cost statistics for the task, as shown in the illustration.
Task work type shows whether the task is a Work Volume, Work Duration, Max Duration, or Supervisory task. For the first three types of task, the work value and units, see below and "Setting Task Work Type" on page 39. For more information on task work types, value, and units, see below and "Setting Task Work Type" on page 39.

For more information, see "Understanding FRI and PRI Measurements" on page 153.

For more information, see "Understanding Functional and Project Exceptions" on page 71.

Three ways to respond to exceptions. For more information, see "Responding to Exceptions" on page 72.

For more information on these risk metrics, see "Understanding FRI and PRI Measurements" on page 153.

------

For more information on task WBS, see "Setting Task Properties" on page 36.

------

For more information on task work types, value, and units, see below and "Setting Task Work Type" on page 39.

------

you can switch between task work volume and task cost statistics

this is where you can compare actual with predicted cost and revenue for the task

For more information on these risk metrics, see "Understanding FRI and PRI Measurements" on page 153.

------

For more information, see "Understanding Functional and Project Exceptions" on page 71.

------

Three ways to respond to exceptions. For more information, see "Responding to Exceptions" on page 72.

------

For more information on these risk metrics, see "Understanding FRI and PRI Measurements" on page 153.
units show the task duration. For supervisory tasks, these properties show the number of FTEs used by the task.

The Communications Risk value is calculated as the number of communications missed or ignored divided by the number of communications requested. The Corrected Excepts value corresponds to the number of exceptions that were responded to by a quick-fix. The other two ways to respond to exceptions are to rework or ignore them. The number of times these two responses occurred during the task is also summarized in this chart. For more information, see “Responding to Exceptions” on page 72. This section also contains more information on functional and project exceptions.

To view a task’s statistics chart
1. In the Chart Window’s Tree pane, click the plus sign by the project that contains the task.
2. Select the task.
3. Click the Task Statistics chart icon.
   The task’s statistics display in the Chart Window.
4. To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.
5. To view the standard deviation of task statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.
6. To view the time as well as the date in statistics, click Show Time on the right-click menu.
7. To copy and paste the chart into another application, click Copy on the right-click menu.
8. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

Reading a Meeting’s Statistics Chart
For each meeting, the Statistics Chart reports the statistics for the meeting as a whole and for each meeting participant, broken down by position and staffing persons. For example, the following Meetings Statistics chart shows that the 30 Weekly Coordination meetings generated 180 meeting invitations to six participants staffing three separate positions. Meeting risk (that is, the number of meetings missed divided by the number of meetings requested) for the meeting as a whole was 0.42. The participant generating the greatest meeting risk was
Ethan Holt, meaning that he missed the greatest proportion of the meetings he was invited to. For more information on meeting risk, see “About Product Risk Metrics” on page 152.

### The Position Charts

Positions have the following charts:

- **Position Gantt Chart**—See “Analyzing the Position Gantt Chart” on page 239.
- **Position Resource Charts**—See “Analyzing the Position Resource Charts” on page 239.

#### To view a meeting’s statistics chart

1. In the Chart Window’s Tree pane, click the plus sign by the project that contains the meeting.
2. Select the meeting.
3. Click the Meeting Statistics chart icon.
   
   The meeting’s statistics display in the Chart Window.
4. To copy and paste the chart into another application, click Copy on the right-click menu.
5. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
• **Position Statistics Chart**—See “Reading a Position’s Statistics Chart” on page 240.

**Analyzing the Position Gantt Chart**

Positions have their own Gantt charts that show data and duration for tasks assigned to the positions and meetings they attend. You view, analyze, and customize data in the Position Gantt chart in the same way as the Project Gantt chart. See “Analyzing the Project Gantt Chart” on page 164, and “Customizing the Gantt Chart” on page 170.

Analyzing the Position Resource Charts

For positions, the Resource charts show FTE usage and demand by project for that position.

If required FTEs exceed the total available, you know that you need to get some more FTEs or resources, or redistribute workload during the time identified.

**To view the Position Resource charts**

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the position to view resource information for.
3. Click the Resource Charts icon in the chart bar.
   
   The chart shows FTE usage by project for that position.
4. To view resource demand or availability instead of usage, select Demand or Availability % from the list at the top left of the chart or the chart’s right-click menu.
5. For more information on customizing the Resource Charts data, see “Analyzing the Project Resource Charts” on page 208.
Analyzing Individual Position Backlog

The Position Backlog chart shows overloads on positions in the project over time. It’s a way of looking at individual position backlog rather than backlog for all project positions. You can analyze the data the same way as for the project’s Position Backlog chart. See “Analyzing Position Backlog in a Project” on page 203.

Reading a Position’s Statistics Chart

For each position, the Statistics Chart reports the statistics shown in the following illustration.

<table>
<thead>
<tr>
<th>Position Statistics: Construction Control</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>Position Name</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Communications Risk</td>
</tr>
<tr>
<td>Meeting Risk</td>
</tr>
<tr>
<td>Max Backlog (days)</td>
</tr>
<tr>
<td>Worst Backlog Date</td>
</tr>
<tr>
<td>Worst Task</td>
</tr>
<tr>
<td>Percent Staffing</td>
</tr>
<tr>
<td>Position FTEs</td>
</tr>
<tr>
<td>Total Volume (days)</td>
</tr>
<tr>
<td>Work Volume (days)</td>
</tr>
<tr>
<td>Rework Volume (days)</td>
</tr>
<tr>
<td>Coordination Volume (days)</td>
</tr>
<tr>
<td>Decision What Volume (days)</td>
</tr>
</tbody>
</table>

Case: Project 1

For more information, see “About Product Risk Metrics” on page 152

For more information, see “Understanding Types of Work” on page 73

1. In the Chart Window’s Tree pane, click the plus sign by the project that contains the position.
2. Select the position.

The Worst Task field in this statistics chart can be blank even if the position is heavily backlogged. This indicates that the position is not performing a task when their worst backlog is generated. For example, the backlog could arise from communications.
Balancing Factors

A large part of refining a model in SimVision involves balancing factors that affect each other. For example, project centralization has an effect on the amount of communication required, and position skill level affects task duration and exception rates. The following sections give some guidelines on how to balance factors to match the realities of your project.

Balancing Task Allocation with Position FTE

A task’s allocation value is the percentage of time that the position’s FTEs can devote to that task. Allocation is stored as a property of the assignment link between the task and its responsible position. Task allocation directly affects task duration. A position’s FTE value is the number of full-time equivalents available for tasks assigned to that position. The FTE is divided among the tasks assigned to that position at any given time.

You can sometimes reduce task duration by setting the task allocation at 5-20% less than the position FTE, if you can afford this margin for error. Tasks usually complete most rapidly when their responsible positions have some slack. An allocation that includes some slack will allow the position to process communications with less likelihood of backlog. For example, to leave 5% slack for a position that is responsible for three tasks, the sum of the allocations for all three assignment links should be 95%.

A position that has responsibilities for tasks that are subject to information dependencies or rework will benefit from more slack than a position whose only responsibility is direct work. However, reducing the allocation percentage means that it will take longer to accomplish the direct work. You must make a trade-off between increasing the time to do the direct work and reducing the backlog from coordination work.

3. Click the Position Statistics chart icon.
   The position’s statistics display in the Chart Window.

4. To switch between work statistics and cost statistics, select Cost from the list in the chart’s toolbar.

5. To view the time as well as the date in position statistics, click Show Time on the right-click menu.

6. To copy and paste the chart into another application, click Copy on the right-click menu.

7. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Balancing Position Skills with Task Requirements

How quickly a position completes, reworks, or coordinates a task depends significantly on how well the position's skills and application experience are matched with the task skill requirements. The project and functional exception rates are also affected by this match.

A good rule of thumb is that if the skills required by the task and possessed by the position are at Medium level, and the values for Application Experience, Requirement Complexity, and Solution Complexity are all Medium, one FTE resource will do one day’s work volume in one day.

For more information on setting these properties, see “Editing a Position’s Skill Set” on page 65 and “Setting Task Properties” on page 36.

Balancing Resources and Project Cost

The exception-handling hierarchy is very important to the simulation. When exceptions are generated and passed up the chain, it is important that the supervisor has time to respond to the position promptly and does not allow the position to delegate by default. If several positions are reporting to a single backlogged Project Manager, adding middle management will relieve the project manager and have a positive effect on quality and duration. However, middle management is an added resource and is an extra expense if an existing position cannot fill the position. Also, remember that in many industries, Project Managers make the decision to rework exceptions more often than Subteam Leaders, so if the positions report directly to the Project Manager, duration might increase due to the extra rework, but quality risks should drop. Naturally, there are industries where this paradigm is reversed. For example, in the software industry, Project Managers are often under greater pressure to get a product to market by a certain time than to produce an error-free product.
Chapter 7

Working with Programs

When you model complex programs, you frequently need to create multiple interdependent projects. SimVision allows you to create a program of interlinked projects that share resources. In fact, to create a project, you must create a program to contain the project. By linking projects within a program, you can clarify interdependencies between tasks and the roles and responsibilities of all project participants.

When working with programs, you can:

- Create programs of linked projects.
- Add products and associate tasks with them.
- Connect objects across projects with ghost tasks and milestones.
- Assign organizations to projects within a program.
- Create and work with different cases of the program.
- Filter objects in the program by category.
Understanding Programs

A program is a set of related projects that share dependencies and can share resources to form a product or system. Programs represent a business initiative and the supporting projects to make the initiative happen and achieve the desired goals. For example, a telecommunications chip manufacturing program might include two projects, one for developing the chip hardware and the other for developing the chip software.

One way programs can be used is for a program manager to model and analyze the program based on the cases received from all project managers in the program. After simulating and analyzing the entire program and the inputs from each project, the program manager can understand the changes required for each project to achieve the program’s goals. To do this, project managers can send the workspace files for their projects to the program manager.

Benefits of Programs

Programs allow you to create a hierarchical set of linked projects, which provides the following benefits:

- The ability to allocate scarce resources across projects, and to examine the impact of multiple overlapping projects.
- The ability to make informed decisions about the real impact of adding proposed projects.
- The potential for benchmarking project inputs and outputs across projects in an organization.
- The possibility of reusing skill profiles, task names, and other aspects of models to reduce modeling time on subsequent models.
Program Elements in the Tree Pane

The Tree pane shows all open programs and their projects and organizations, using a structure similar to the Windows Explorer. If you click the plus sign beside a program in the Tree pane, you see its cases. If you click the plus sign beside a case, you see its projects and organizations.

Program Element Tabs

Each time you add a project or an organization to a program, it appears as a tab along the bottom of the Model pane, so you can easily switch between the program and its projects and organizations. When they are not selected, program tabs are red, project tabs are yellow and organization tabs are green. You can reorder tabs within their group by dragging them.

Case tabs appear below the program element tabs. For more information on cases, see “Comparing Case Simulation Data” on page 270.
Creating Programs

You can have multiple programs open in one session of SimVision. When you create a new program, you can either start with a blank workspace or with a default program model called the startup model, depending on which option you have set. For more information, see “Setting Options for New Models” on page 362.

To switch between open programs

- Select the program name on the Window menu.

Saving and Naming Programs

There are two places where you need to name a program. Saving the program on the File menu saves and names a .vpm workspace file. Changing the program’s Name property changes the name of the program as it appears in the application title bar and simulation charts. You can make these names the same, or you can make multiple copies of the same program using differently named workspace files. You might want to do this if your program file is very large and you want to use different workspace files for different versions of the same model, rather than adding a large number of cases to the same file. To do this, you would use the File menu Save As option to create the differently named workspace files, then in each workspace file you would make the program’s Name property the same.

To create, save, and name a program

1. Launch SimVision.
   A new startup model opens, or a new blank workspace, depending on which option you have set.

2. On the File menu, click Save.

3. In the Save As dialog box, type a name for the program’s .vpm Workspace file. The default location for storing programs is ePM\SimVision\Models.

4. Click Save.
   The program name appears in the Tree pane and on the Window menu.

5. To make the same name appear in the application title bar and on the simulation charts, rename the program’s Name property in the Properties pane. If you don’t rename this property, the program will be called “Program” on the title bar and in the charts.

Defining Program Milestones

When you create a new SimVision model, the program’s Start and Finish milestones are created by default and are visible in the Model pane. A milestone indicates where a subset of a program is completed, or a key event has occurred. Use each milestone to identify a specific business event in the program. For
example, you could add a milestone for the planned completion date of each project in the program. Milestones are determined by your business objectives and provide the anchors for the process and organization models.

You can rename the Start and Finish milestones with labels that make sense for the program. Keep a note of any externally required or currently planned dates for these milestones. These dates provide benchmarks against which to validate the initial program plan.

You link program milestones to the program’s projects and to each other with Project Successor links. As with milestones and tasks in a project, you can make a successor start at the same time as or later than its predecessor, or you can specify that the successor not start until the predecessor is finished. You do this by choosing either Start-Start or Finish-Start for the link type, and setting a lag for the link. For more information, see “Linking Tasks and Milestones” on page 56.

To add a milestone to a program
1 In the Model pane, display the program by clicking the Program tab.
2 In the Program Shapes toolbar, click Program Milestone.
3 Click in the Model pane to place the milestone.
4 Double-click the milestone icon and type a name for it.

The milestone name appears as a label in the Model and Tree panes and in the Properties pane.

To link program milestones to projects and to each other
1 In the Model pane, right-click the program milestone.

The right-click menu lists the possible links you can add to a program milestone.

2 Click either New Successor To or New Successor From.

The New Link dialog box lists the projects and milestones you can link to or from.

3 Select the project or milestone.
4 To specify when the successor starts relative to the predecessor, do the following:

- To make the successor start at the same time as the predecessor, select Start-Start as the link type and leave the lag as zero.
- To make the successor start some time after the predecessor starts, select Start-Start as the link type and set the lag, choosing Minutes, Hours, Days, Weeks, or Months as the time unit.
- To make the successor start as soon as the predecessor ends, select Finish-Start as the link type and leave the lag as zero.
- To make the successor start some time after the predecessor ends, select Finish-Start as the link type and set the lag.

5 Click OK.

The program milestone is linked to the project or other milestone with a Project Successor (solid black) link.

You can also link milestones and projects using the Project Successor link tool in the Program Shapes toolbar.

### Using Property Locks

SimVision uses a locking system for properties that can be set at either the program level or a more granular level, such as for a project, organization, department, or position. When you set a property at a more granular level, it overrides the program level setting. An open lock beside the property in the Properties pane indicates that an override exists. When you set a property at the program level, that setting applies at all sublevels unless there is an override.

For example, the Centralization property is common to programs, projects, and organizations. For a program in which the decision-making is typically done at a high level, you could set the Centralization property to High at the program level. In this case, the Centralization property would be locked for all the program’s projects and organizations. If the program was generally highly centralized but one of its organizations used a decentralized method of information flow, you could set a high centralization value for the program and a low one for that
organization. In this case, the Centralization property for that organization would be unlocked to show that the low centralization was an override of the program’s centralization setting.

Table View is an excellent way of determining if property overrides exist. For more information, see “Using Table View” on page 328. You can also use locks to return properties with overrides to their program values, as described below.

**To set property overrides**

1. In the Model pane, click the appropriate project or organization tab. To set a property override for a position, task, meeting, or department, select that object. To set a property override for a person, right-click the person’s department and click Person List.

   The object’s properties appear in the Properties pane (or the Person List dialog box in the case of persons).

2. Click the appropriate property’s lock.

   The lock opens.

3. Change the property’s value.

   The lock stays open, indicating a property value override.

**To return properties with overrides to their program values**

1. In the Model pane, select the project or organization tab, or the object whose property has an override.

   The object’s properties appear in the Properties pane.

2. Click the open lock of the appropriate property.

   The lock closes and the property value returns to the value set at the program level.

**Setting Program Properties**

A program has the following properties:
• **Name**—By default, the program name always appears as Program. You can rename the program using any combination of text, numbers, and punctuation.

• **Description**—An explanation that distinguishes the program from other programs. The description can contain any combination of text, numbers, and punctuation.

• **Start Date**—The date the modeler assumes that the program starts. This date might be actual for a started or completed project, or it might be projected. The default is 8am on the date the program was created.

• **Trials**—The number of runs or trials the simulator should run for this program. Increasing the number of trials increases the stability of predicted results, that is, it reduces the standard deviation of predicted statistical results. With fewer than 10 trials, there can be unpredictable ordering of activities by coordination and verification risk. The default number of trials is 25. To shorten the time required to stabilize the structure of new models, it is usually helpful to set the number of trials to 5 or 10.

• **Seed**—An integer that indicates how the simulator will randomize aspects of the simulation. This value determines where the random number generator that drives the simulation starts generating values.

• **WBS Separator**—The character that separates fields in the Work Breakdown Structure for projects, tasks, and milestones in the program. For more information on work breakdown structures, see “Setting a Project’s WBS” on page 89.

• **WBS**—The Work Breakdown Structure for the program. You can sort by WBS in the Gantt and statistics charts and in Table View. To allow for sorting, you cannot mix alphabetic and numeric characters within a single field of the WBS. For example, “17.25.BD” is a valid WBS but “17A.1B” is not.

• **Work Day**—The number of hours in a normal work day for the program. The default is 8.

• **Work Week**—The number of days in a normal work week for the program. The default is 5.

• **Team Experience**—How successfully the team for this program has performed related programs. See “Setting Team Experience” on page 95.

• **Centralization**—The qualitative degree to which decision-making and exception-handling responsibilities are decentralized to individual responsible positions (Low) or centralized to senior project managers (High). See “Setting Project Centralization” on page 96.

• **Formalization**—The relative degree to which communication among positions takes place informally (Low) or through formal meetings and memos (High). See “Setting Project Formalization” on page 96.
• **Matrix Strength**—The extent to which positions are located in skill-based functional departments and supervised directly by functional managers (Low) or co-located with other skill specialists in dedicated project teams and have project supervision from a project manager (High). See “Setting Matrix Strength” on page 98.

• **Info Exchange Prob.**—The level of communication in the program between positions that are responsible for tasks linked by communications links. This probability is typically set in the range 0.2 to 0.9.

• **Noise Prob.**—The level of interruptions in the ordinary working day that take time away from direct work on project tasks. The probability of noise is generally in the range 0.01 (low) to 0.10 (significant but common).

• **Functional Error Prob.**—The probability that a particular work item will fail and require rework. This probability is typically set in the range 0.05 to 0.10.

• **Project Error Prob.**—The probability that a particular work item will fail and generate rework for itself and all failure-dependent tasks. This probability is typically set in the range 0.05 (low) to 0.10 (significant but common).

• **Behavior File**—Specifies the simulator’s default behavior, for example, how much rework to add to tasks with exceptions.

• **Revisions**—Tracks changes made to each project in the program by date, author, title, and any details the modeler wants to record about the changes. You can generate a Revision Report for the program the same way as for an individual project. See “Tracking Project Revisions” on page 91.

• **Escalators**—Reflects changes in salary rates across the life of the program. The change is expressed as a factor, which allows you to decrease as well as increase salaries. You set program salary escalators the same way as project salary escalators. See “Setting Project Salary Escalators” on page 93.

• **Hyperlinks**—You can add one or more hyperlinks to a program to link it to a URL. For example, you might link a program to some background documents, or to a client’s Web site. For more information, see “Adding Hyperlinks to Objects” on page 369.

**To set program properties**

1. In the Model pane, select the program tab.
SimVision User Guide

2. Make sure nothing is selected in the Model pane. When nothing is selected, the Properties pane shows the properties for the selected program.

<table>
<thead>
<tr>
<th>Program</th>
<th>Value</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Program</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>5/20/2040</td>
<td></td>
</tr>
<tr>
<td>Trials</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Seed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>WBS Separator</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>WBS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work Day</td>
<td>8</td>
<td>Hours</td>
</tr>
<tr>
<td>Work Week</td>
<td>5</td>
<td>Days</td>
</tr>
<tr>
<td>Team Experience</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Centralization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Formalization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Matrix Strength</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Info Exchange Prob.</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Idle Prob.</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Functional Error Prob</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Project Error Prob.</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Behavior File</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>Routines</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Procedures</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Hypotheses</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>

3. Set the program properties as follows:
   - To change the name, click in the Name property, select the old name, and type a new one.
   - To add a description, click in the Description property and type a brief description of the program.
   - To change the start date, click in the Value field for the Start Date property, select a date component (month, day, or year) and use the arrows to change the date.
   - To change the number of trials that the simulation runs each time, type a new value for the Trials property.
   - To set the seed, type an integer to indicate where the random number generator that drives the simulation starts generating values.
   - To choose a separator for the program’s WBS, click in the Value field for the WBS Separator property and select a character from the list.
   - To set the program’s WBS, enter alphanumeric characters separated by the separator you chose. You cannot mix alphabetic and numeric characters within a single field of the WBS.
   - To change the number of hours in a normal work day, type a new value for the Work Day property.
   - To change the number of days in a normal work week, type a new value for the Work Week property.
   - To set the level of team experience with this type of project, select High, Medium, or Low for the Team Experience property.
   - To set the organizational level at which decisions are made, select High, Medium, or Low for the Centralization property. For example, if most decisions are made at the top managerial level, select High.
To set the level of formal meetings and decision-making, select High, Medium, or Low for the Formalization property.

To set the level of direct supervision of specialized individuals, select High, Medium, or Low for the Matrix Strength property. For example, if skilled positions are organized into dedicated project teams and supervised at a project level by a project manager, set Matrix Strength to High.

To set the level of communication among positions whose tasks are linked by communications links, set a value for the Info. Exchange Prob. property. This probability is typically set in the range 0.2 to 0.9.

To set the level of interruptions, set a value for the Noise Prob. property. The probability of noise is generally in the range 0.01 (low) to 0.10 (significant, but common).

To set the probability of errors requiring rework, set a value for the Functional Error Prob. property. This probability is typically set in the range 0.05 to 0.10.

To set the probability of errors with their failure-dependent tasks requiring rework, set a value for the Project Error Prob. property. This probability is typically set in the range 0.05 (low) to 0.10 (significant but common).

To change the file that specifies the simulator’s default behavior, click in the Value field for the Behavior File property and select a new file from the list.

To document a revision to the program, click Edit by the Revisions property, click Add Revision in the Revisions List dialog box, enter the revision details, and click OK.

To add a salary escalator to the program, click Edit by the Escalator property, click Add, enter the escalator name, description, factor, first date, and whether or not it should be repeated annually, and click OK.

To add a hyperlink to a program, click Edit by the Hyperlink property. In the Hyperlinks dialog box, click Add Hyperlink. Enter the URL under Hyperlinks or browse for a filename. Enter a description if necessary (if you enter no description, the URL appears in the task’s right-click menu instead of the description), and click OK.

To delete a hyperlink from a program, click Edit by the Hyperlink property. In the Hyperlinks dialog box, select the hyperlink and click Delete Hyperlink. Click OK.

**Linking Projects within Programs**

Just as you link tasks and milestones in a project with successor links, you can link projects in a program with project successor links. These links connect a predecessor project to a successor project, and indicate that the successor project starts with or after the predecessor.
Defining Project Precedence
You use the project successor link to define when a predecessor project starts relative to its successors. There are two types of project successor link:

- **Finish-Start**—The successor project starts as soon as the predecessor is finished, or a defined time after. This time is called the lag time and the default is zero, which means that the successor project starts as soon as the predecessor ends. For example, if a project is to start five weeks after another project ends, you would link the two projects with a project successor link of type Finish-Start with a lag of five weeks.

- **Start-Start**—The successor project starts a defined time after the predecessor starts. This time is called the lag time and the default is zero, which means that predecessor and successor projects start simultaneously. For example, if a project is to start two months after another project starts, you would link the two projects with a project successor link of type Start-Start with a lag of two months.

To link projects with a successor link
1. In the Model pane, click the program tab.
2. Right-click the project shape.
   The right-click menu lists the types of links you can add to a project.
3. Click New Successor To or New Successor From.
   The New Link dialog box lists the projects you can link from or to.
4. Select a project and click OK.
   The projects are linked by a solid black line with an arrow at the successor project.

You can also link projects with the Project Successor Link tool, by manually dragging the link between the project shapes.

To switch between projects in a program
- Click the tab for the project at the bottom of the Model pane.

Setting Project Successor Link Properties
Project successor links have the following properties:

- **Type**—Shows the link type name, Finish-Start or Start-Start.
- **Lag**—Determines the amount of time after the predecessor project starts or finishes that the successor project starts. You can measure the lag in terms of minutes, hours, days, weeks, months, or as a percentage of the predecessor project’s duration.
- **Connected From**—Shows the name of the predecessor project.
• **Connected To**—Shows the name of the successor project.

**To set the time lag for a successor project**

1. In the Model pane, select the project successor (black solid) link that links the successor project with its predecessor. The link’s properties appear in the Properties pane.

2. From the Lag property’s Units list, select the units in which to measure the lag.

3. Under Value, type a length of time. For example, for a Finish-Start link, a lag time of 1 day signifies the successor project starts 1 day after the predecessor finishes. For a Start-Start link, a lag of 1 day signifies that the successor project starts 1 day after the predecessor starts.

**Implementing Products**

A program or project can have a list of products, which you associate with tasks and milestones in the program’s projects. Although products’ tasks and milestones belong to projects, the list of products belongs to the program. Like persons, products have no iconic representation in the model and are accessible only through the Product List, a dialog box interface through which you can add and delete products and associate them with tasks. Also like persons, and because they are owned by the program and not individual projects, each product can be used in multiple projects.

For example, suppose a product is a schedule of mechanics. This schedule might be required in every project where the mechanics are assigned tasks.

You can calculate the work volume associated with a product, and break the work volume down into the product’s individual task and milestones using the Product Stats chart.

**About Product Completion Phases**

Like tasks, products have phases of completion. A product’s four completion phases are Formulate, Support, Approve, and Concur.

- **Formulate**—The task or milestone and, by extension, the position or person that creates the product. All products have a Formulate task or milestone. For example, a Launch Vehicle Plan product might be associated with an Assemble Vehicle Components task.

- **Support**—A task or milestone that supports in the formulation of the product. This relationship type is typically used less frequently.

- **Approve**—A task or milestone, and by extension a position or person, responsible for approving the product. Most products have an Approve task or milestone associated, representing who ‘owns’ the product.
• **Concur**—A task or milestone, and by extension a position or person, responsible for concurring with the product approval. This relationship type is typically used less frequently than Approve.

Each time you associate a product with a task or milestone, you decide which of these phases the task or milestone falls into and select the appropriate phase in the Product List. For example, if you were associating the mechanics’ schedule product with an Approve Schedule task, you would select an Approve relationship for the association. When you associate a product with a task, by logical extension you are associating it with the position responsible for the task.

Because they have distinct completion phases, products are often associated with milestones. For example, a Quarterly Review product might be associated with the quarterly milestones Q1, Q2, Q3, and Q4.

### Adding Products to a Program

You add products using the Product List dialog box. Tasks and milestones that have products associated with them have a small P in the top-left corner of their icons to designate the association.

#### To add a product to a program

1. In the Model pane, click Product List on the Model menu.

   The Product List dialog box appears.

2. Click Add.

   A blank line appears for the new product.

3. Under Name, enter a name for the product.

4. Under Description, enter a product description if required.

5. Select Formulate, Support, Approve, or Concur as the type of relationship between the product and the task or milestone.
A list of the program’s projects and their tasks and milestones appears.

6 Select the task or milestone with which to associate the product.
7 To list positions and persons also, click Show Positions and Show Persons. You can then select a position or person to associate a product with.
8 Click OK.

The task, milestone, or position has a small P in the top-left corner to indicate that it has a product associated with it.

---

**Setting Product Relationships for Existing Tasks**

You can associate a product with an existing task or milestone in a project.

**To add a product to a program**

1 In the Model pane, right-click the task or milestone and click Product.

   The Set Product Relationship dialog box appears. The Formulate relationship is selected by default, but if a different relationship already exists, this is indicated by its button. Only one relationship can be assigned between a product and a task or milestone at a time.

   2 From the Product list, select the product to associate with this task or milestone.
3 Select whether the relationship is to be a Formulate, Support, Approve, or Concur relationship.
4 Click OK.

---

**Connecting Projects with Ghost Tasks and Milestones**

Ghost tasks and milestones provide a way of modeling connections or constraints between projects by mimicking tasks and milestones from one project in another. For example, Task 5 in Project A might not be able to start until Milestone 2 in Project B has been met. You would model this by adding a ghost Milestone 2 to
Project A and linking it to Task 5 with a successor link. The advantage of ghost milestones and tasks over the connectors you could create with previous versions of SimVision is that a ghost can be linked to multiple milestones and tasks. (SimVision recognizes and correctly handles connectors in existing models, but you can no longer create them.)

Projects that are linked by one or more ghosts are connected by a red ghost link in the program view.

Like other links, ghost links belong to a separate layer in the model so you can turn them on or off when viewing and printing. This is also true of ghost tasks and milestones. See “Using Layers in a Model” on page 324. You can also run a report of the dependencies between projects.

**Example of Using a Ghost Milestone**

Suppose you have a program with two projects. The Write Spec task in Project 2 cannot occur until the Requirements Approved milestone in Project 1 is reached. To model this, you could add a ghost milestone called Ghost Requirements Approved to Project 2 and link it to the Write Spec task with a successor link. You would then connect the ghost milestone to its reference milestone, which is the Requirements Approved milestone in Project 1.
You can connect a ghost task or milestone to one or more real tasks or milestones with successor, rework, and communications links. The following illustration shows the real Requirements Approved milestone in Project 1, and the Ghost Requirements Approved milestone in Project 2 linked with a successor link to the Write Spec task.

Example of Linking a Ghost Task to Multiple Tasks
Suppose there is a task called Test Rivets in Project 1. Two tasks in Project 2, Add Wings and Add Tail, are dependent on the Test Rivets task being completed successfully. A third task in Project 2, Strengthen Rivets, will require rework if the Test Rivets task fails. To model this connection between the projects, you could...
add a ghost task, Ghost Test Rivets, to Project 2 and link it with successor links to the Add Wings and Add Tail tasks, and with a rework link to the Strengthen Rivets task.

Adding Ghost Tasks and Milestones
There are two steps to connecting projects with ghost tasks and milestones:

• Add the ghost task or milestone.
• Connect the ghost task or milestone to its reference task or milestone in the other project.

If you don’t connect the ghost task or milestone to a reference task or milestone, the simulation will fail with an error. Tasks and milestones that are referenced by ghosts have grayed-out names in the Properties pane and Table View.

To link two projects with a ghost task or milestone

1 At the bottom of the Model pane, click the tab for the project where you want to add the ghost task or milestone.
2 On the Project Shapes toolbar, click Ghost Task or Ghost Milestone.
3 Place the ghost task or milestone close to the tasks you will link it to.
4 Double-click the ghost and rename it appropriately.
5 Right-click the ghost and select the type of link to add.
6 In the New Link dialog box, select the task or milestone to link to, and click OK.

The ghost is linked to a real task or milestone with the link type you specified.
7 Select the ghost task or milestone.

The ghost’s properties appear in the Properties pane.
8 Click Change Ref beside the Ref. Task or Ref. Milestone property.
The Choose Reference Object dialog box lists the program’s projects apart from the current one.

9 Click the plus sign beside the name of the project that contains the reference task or milestone.

The projects tasks or milestones are listed, depending on whether you created a ghost task or milestone.

10 Select the reference task or milestone, and click OK.

11 Continue adding links between the ghost and real tasks or milestones, and assigning reference objects as appropriate.

**Viewing Project Dependency Reports**

You can generate a report of interproject dependencies in a program, that is, how the projects are linked by ghost tasks and milestones or connectors (obsolete, but supported in legacy models). You generate a Dependency Report for a specific case, and it lists the projects that contain dependencies in that case. For each project, the report shows the names of the dependent objects and whether they are ghost tasks, ghost milestones, or connectors. It shows the type of link used (ghosts can be linked by successor, rework, or communications links). It also shows the project and name of each reference object, that is, the object that the ghost or connector is linked to. It doesn’t show the reference object type, as this is always a task for a ghost task and a milestone for a ghost milestone.
For example, the following report shows that the ASIC Hardware project contains a ghost task called Ghost SW Design Coordination that is linked with a Communications link to the SW Design Coordination task in the ASIC Software project.

<table>
<thead>
<tr>
<th>Dep. Project</th>
<th>Dep. Type</th>
<th>Dep. Name</th>
<th>Link Type</th>
<th>Ref. Project</th>
<th>Ref. Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASIC Hardware</td>
<td>Ghost Task</td>
<td>Ghost SW Design Coordination</td>
<td>Communications</td>
<td>ASIC Software</td>
<td>SW Design Coordination</td>
</tr>
<tr>
<td></td>
<td>Ghost Milestone</td>
<td>Ghost HW Spec Complete</td>
<td>Successor</td>
<td>ASIC Hardware</td>
<td>HW Spec Complete</td>
</tr>
<tr>
<td></td>
<td>Ghost Task</td>
<td>Ghost Full Chip Synth</td>
<td>Rework</td>
<td>ASIC Hardware</td>
<td>Full Chip Synth</td>
</tr>
</tbody>
</table>

**To generate a project dependency report**

1. Under the Model pane, select the case to generate the report for.
2. On the Results menu, click Dependency Report.
   
The Dependency Report displays.
3. To list the object name and type in every cell, click Fill All Cells. For example, if a project has numerous dependencies, selecting this option lists the project name in every cell of the Dep. Project column. You might want to fill all cells for sorting purposes if you are pasting this data into a spreadsheet application.
4. Click OK.

**Assigning Organizations to Projects**

An organization is a hierarchy of departments, subdepartments, and persons. This hierarchy should represent as closely as possible the organizational matrix of the program being modeled. You assign organizations to projects on the program page of the Model pane. Assigning an organization to a single project makes the persons in the organization’s departments available only to that project. You can assign an organization to multiple projects, but if you want the organization’s staff to be available to all projects, do not assign the organization to any specific project.

It is recommended that you limit the number of organizations in a program to 15 or less. This allows you to evaluate each task in terms of whether it is at the right level of detail to assign to one of these organizations.
Adding Organization Assignment Links

The convention in SimVision is to place the organizations above the projects and program milestones on the program page. Thus, you link from an organization to the top of a project. Each organization has three link targets, to allow you to link each organization to multiple projects without too much visual confusion, as shown in the following illustration.

Organization assignment links are pink, with an arrow at the project end. When you select them, the Properties pane displays the name of the organization (Connected From property) and the project it is connected to (Connected To property).

To assign an existing organization to a project

1. In the Model pane, click the program tab.
2. Right-click the organization.
3. On the right-click menu, click New Organization Dedicated To.
4. In the New Link dialog box, select the project to link the organization to and click OK.

   The organization and project are linked by a solid pink organization assignment link.

   You can also assign organizations to projects with the Organization Assignment link tool, by dragging the link between the shapes.

Using Cases

A case is an instance of a model. The purpose of creating multiple cases of a model is to track the effect of making changes in the model, however minor. Each case is a replica of the case it is derived from (the previous case by default) so when you create a new case, you can make a subtle change and then simulate both cases and compare the simulation data. If you are copying and pasting elements from one case to another, it’s important to ensure that all objects have unique object IDs to prevent the simulator terminating with a duplicate ID error.
You can modify properties across multiple cases, using the Multi-Case Edit dialog box. You can also generate a Case Difference Report for any two cases of a model. This report shows every difference between the cases, including objects that are in one case but not the other.

**Creating, Renaming, and Deleting Cases**

You derive new cases from existing cases, so the second case is initially a copy of the baseline case. Then you make changes to distinguish the cases and run simulations so you can compare cases. Comparing your second case simulation results against your baseline case allows you to analyze the difference your refinements have made to projections such as cost and project duration.

When you create a new case, it appears as a tab in the Model pane and as a case under the program in the Tree pane. You can reorder case tabs under the Model pane by dragging them.

By default, each case is derived from the previous case, but you can choose a case to derive a new case from. You can also rename or delete cases.

**To create a new case**

1. In the Model pane, select the case from which to derive the new case.
2. Click in the Model or Tree pane.

The New Case dialog box appears, listing the existing cases with their simulation data if they have been simulated and the case from which each was derived.
Notice that the case you chose to derive the new case from is highlighted. In the illustration, the new case will be derived from the Baseline case. You can select a different case here to derive the new case from.

4 Enter a case name. You might want to just number cases, but it can be useful to name them according to the intervention involved, for example, "Reduce PM Backlog." If you don’t name a case, it is named Case $N$, where $N$ is the number of cases in the program.

5 Type a description for the case. This description displays in this dialog box and in the Case Filter dialog box for the Executive Dashboard. Use the description to summarize what distinguishes this case from others.

6 Click OK.

The new case appears as a case tab in the Model pane and as a case under the program in the Tree pane. The case page contains the same components as the case from which it is derived.

To rename a case or change its description
1 In the Model pane, select the case tab.
2 On the Model menu, click Rename Case.
3 In the Rename Case dialog box, type the new name and a changed description if required.
4 Click OK.

To delete a case
1 In the Model pane, select the case tab.
2 On the Model menu, click Delete Case.
3 Confirm the deletion by clicking OK.

To switch between cases
• In the Model pane, select the case tab, or on the Navigate menu, click Cases and select a case from the list.

Ensuring All Objects Have Unique IDs
Every SimVision object has a unique object ID, which you can view and modify. When you copy and paste objects between pages or cases of a model, you must give the copied object a unique object ID. Otherwise, the simulation will terminate with a duplicate ID error.

To view and modify object IDs
1 In the Model pane, select the object.
2 On the Model menu, click Set Unique IDs.
3 In the Set Unique ID for Selected Object dialog box, give the object a unique object ID.
4 Click OK.
Modifying Properties Across Multiple Cases

You can set properties across multiple cases of a program using the Multi-Case Edit dialog box. This editing tool lists the program’s cases and shows the selected object and property name and type. If the property is not locked, you can change its value and select the cases in which you want the change to occur. For more information on locked properties, see “About Property Locks” on page 86.

To set properties across multiple cases

1. In the Model pane, select the object whose property you want to change.
2. In the Property pane, select the property and modify its value appropriately.

The Multi-Case Edit dialog box appears, listing the program’s cases with the current case checked, and showing the selected object and property type and name.

4. Click the Apply checkbox for the cases you want to make the change in.
5. Click OK

Generating a Case Difference Report

The Case Difference Report shows tree views for the two cases you choose, with line-by-line comparisons of the objects in the case. Objects that have different properties in each case are marked with yellow and green icons; object groups (such as projects) that contain differing objects have a plus sign indicating that you can expand them to see their differing objects; new objects in a case have red cross icons; and the corresponding gaps in compared cases have red circular icons. By default, only differences are called out in the report, so object groups that do not differ between the cases are not expanded in the tree view.
To generate a Case Difference Report, you select the two cases to compare in the Case Difference Choice dialog box. You must select two cases or the report cannot be generated.

For example, the following Case Difference Report shows differences between the Baseline and Reduce CC Backlog cases of a program. The differences are listed below the illustration.

- There are differences in the program object, the Plant 1 project object, and the Finish milestone object, indicated by their green and yellow icons.
- There are differences in objects contains in the Plant 1 project object, indicated by the plus sign, so you can expand the project and see the objects that differ.
- There are differences in objects contained in the Plant 2 project, but not in the Plant 2 project object itself. The project object has no green and yellow icon but it does have a plus sign.
- The Reduce CC Backlog case has two new organizations, Plant Team and ISBL Team.
- The absence of these organizations from the Baseline case is indicated by the two red circles under Organizations.
- There are no differences in links between the cases, so the Links object group is not expanded.
You can view details about the differences in the report grid. For example, clicking on the Program in either case here shows that the differences lie in the start date, the number of simulation trials run, and the probability rates.

Clicking on the Plant 1 project shows that there are a number of project positions with differences. Clicking on the Construction Contractor position displays details of the differences here: the FTE was increased from 20 to 25 in the Reduce CC Backlog case, and the position was staffed by Construction Team.

Clicking on the Project Team Meeting in the Reduce CC Backlog case tree displays “No Matching Item” in the report grid. This shows that the meeting was new in the Reduce CC Backlog case.
You can change the size of the report grid with the Grid Size buttons. You can also choose to see all objects in the cases, rather than just the objects with differences, and to display the objects linked to by links in the tree view, as shown next.

Show Differences Only is unchecked so all objects are displayed, including those with no differences between cases, such as Links here. Show Link Ends is checked so linked objects are listed with links.

To generate a case difference report for two cases

1. On the Results menu, click Case Difference Report.

The Case Difference Choice dialog box lists the cases in the program.

2. Select the two cases to generate a report for. If the Baseline is not one of them, or to change a choice you make, click Clear and reselect two cases.

3. To change the report grid size, click the up or down arrow by Size Grid.

4. To list all objects in the program, and not just those with differences, uncheck Show Differences Only.

5. To list linked objects as well as links, click Show Link Ends so it’s checked.

6. To view details of differences, select an object in the tree view. Use the plus and minus signs to expand and contract object groups.

7. Click OK.
Comparing Case Simulation Data

Once you have created more than one case in a model, you can run simulations of multiple cases and then compare the simulation results of two cases in the Chart Window.

Comparing cases allows you to dynamically view the results of changes in the model, however minor. For example, you could create a new case and change only the FTE value of a single position by 1 FTE. By simulating the first case, you could compare two cases that differ only in this slight way, thereby determining the effect of adding 1 FTE on the project cost and duration.

Note: When you make topological changes between cases—for example, adding or removing shapes or links—use the Case Difference Report to compare the cases, as this report shows where objects have been added or removed. See “Generating a Case Difference Report” on page 266.

You can view key data for all cases simultaneously in the Executive Dashboard. For more information, see “Making a Detailed Case Comparison” on page 316.

To compare two cases in the Chart Window

1. With any case selected, click Run Simulation on the Simulate menu.
2. In the Chart Window, click the down-arrow beside None. The cases are listed.
3. Select the case to compare against the current case.
   
   If it has not already been simulated, the simulator runs the selected case. The data for the compared case is displayed as crosshatched bars.
Using Categories

Models can be extremely complex representations of innumerable milestones, tasks, positions, and staffing persons. To help organize and filter a model’s data, you can assign categories to objects and then filter the simulation data by category when you simulate the model. For example, in a project whose staff are located in different geographical locations, you could set up a category for each location and apply a location category to each of the project’s persons. When you run a simulation, you could then filter the simulation data to view results only for staff in a specific location.

Overriding Locked Categories

An object’s category is a property of the object. Categories do not have to adhere to the hierarchy of objects in a model. For example, a project can be in one category and its tasks in another. However, categories behave similarly to other hierarchical properties, such as the probability properties. If you apply one category to an organization and another category to one of its departments, the
department’s category overrides the organization category at the department level. An open lock by the department’s category property indicates that an override exists.

For more information on property locks and overrides, see “Using Property Locks” on page 248.

Adding Categories to a Program

Each program has a master list of categories. The categories on the master list are available for use in every project. Once you add a category to the master list, you can apply that category to objects across the program. You can then filter simulation data by category in the charts that allow such filtering, for example, the backlog and risk charts.

You can delete categories from the master list, but only if the category is not in use anywhere in the program.

To add categories to a program

1  On the Model menu, click Categories.

   The Category List dialog box appears.

2  Click Add.

   A new line appears for the category.

3  Type the category name and a description if necessary.

4  Click OK.

To apply a category to an object

1  Select the object in the Model pane.

2  To apply the category as an override to a previous category assignment, click the lock beside the Categories property to open it.

3  Click the Edit button for the Categories property.

   The Categories dialog box appears.

4  Select a category and click OK.
To delete a category from the master category list

1. On the Model menu, click Categories.
2. In the Category List dialog box, select the category to delete.
3. Click Delete.
   
   If the category is in use anywhere in the program, a message indicates that you cannot delete it.
4. Click OK.

Filtering Simulation Results by Category

In the charts that allow filtering, you can select one or more categories so that the chart displays data only for objects that have those categories assigned. For example, suppose a program has positions based in five different cities, so you have created a category for each city and assigned the appropriate city category to each position. When you view the Position Backlog chart, you can filter the positions by one or more cities to view only backlog for positions in those cities.

To filter simulation data by category

1. In the appropriate simulation chart, click Category Filter on the right-click menu.
   
   The Filters dialog box lists the categories in the program.
2. Select the categories to filter by.
3. Click OK.
The chart displays simulation data only for objects that have the selected categories assigned.
When you have a suite of projects in a program, you can analyze simulation data across all projects in the program, viewing trends and collective data for the program and its organizations, departments, and persons. You can also use the Executive Dashboard to analyze program performance, risk measures, and how results compare with program goals.

This section covers the following:

- Simulating programs and analyzing simulation results.
- Comparing case results against program goals with the Executive Dashboard.
The Program Charts

Programs have a slightly different set of charts than projects. You see the Program Gantt chart by default the first time you run a simulation. The other program charts are listed as icons in the chart bar. Some program charts are unique to the program, and some have the same name and function as the corresponding project charts. The difference is that program charts give information about the program as a collection of projects, so you can see trends, averages, and risks that are general across projects.

The following simulation charts display for the program:

- **Gantt Chart**—See “Analyzing the Program Gantt Chart” on page 277
- **Summary Statistics**—See “Reading the Program Summary Statistics” on page 278.
- **Schedule Growth**—See “Analyzing Program Schedule Growth” on page 279.
- **Breakdown Charts**—See “Analyzing Program Cost and Work Breakdown” on page 281.
- **Risk Charts**—See “Analyzing Program Risk” on page 282.
- **Person Backlog**—See “Analyzing Person Backlog in a Program” on page 283.
- **Resource Charts**—See “Analyzing the Program Resource Charts” on page 283.
- **Statistics Charts**—See “Reading the Program Statistics Charts” on page 287.
Analyzing the Program Gantt Chart

The Program Gantt chart shows the program’s milestones and the duration of the program’s projects. Project bars are red for critical-path projects and blue for noncritical-path projects.

You can view and manipulate the Program Gantt chart in the same ways as the Project Gantt chart. See “Analyzing the Project Gantt Chart” on page 164, and “Customizing the Gantt Chart” on page 170. In the Program Gantt chart, you can also expand and collapse the data so that you view all project milestones and tasks or just the project durations and their milestone dates.

To expand and collapse the Program Gantt chart

1. Run a simulation and leave the Program Gantt chart visible.
2. To expand all projects so you can see their tasks, milestones, and meetings, click Expand All on the Controls menu.
Reading the Program Summary Statistics

The Summary Statistics chart displays a summary bar graph for the program’s statistics. This chart is generally used for comparing two cases of a program. It also shows the standard deviation, which indicates the statistical quality of the simulation by showing how the results deviate from the mean of the summary statistics over all trials. By default, there are 25 trials.

For each case, the Summary Statistics chart reports the following:

- **Simulated program duration**—The time that the entire program, including all its projects, is expected to take.
- **Total revenues**—The predicted overall program revenues in thousands of currency units based on the simulation.
- **Total costs**—The predicted overall program cost, including salaries and nonlabor costs, in thousands of currency units based on the simulation.
- **Nonlabor costs**—All predicted costs apart from salaries incurred by milestones or tasks, such as fees, penalties, materials, or payments.
- **Total work cost**—The predicted cost of labor for the program in salaries. Total work, as indicated on the Work Breakdown chart, includes direct work, rework, coordination, and decision wait time.
- **Process quality risk**—A risk metric defined as the sum of ignored exceptions and half the quick-fixed exceptions, divided by the total number of exceptions:
  \[
  \frac{(\text{ignored exceptions} + 0.5 \times \text{quick fixed exceptions})}{\text{total exceptions}}
  \]
  For more information on exceptions, see “Responding to Exceptions” on page 72.
- **Product quality risk**—An average of the FRI and PRI (see below).
- **Project risk index (PRI)**—The likelihood that the components produced by this program will not be integrated at the end of the program, or that the integration will have defects based on rework and exception handling. PRI is thus a measurement of the success of system integration. See “Understanding FRI and PRI Measurements” on page 153.
- **Functional risk index (FRI)**—The likelihood that components produced by this project have defects based on rework and exception handling. See “Understanding FRI and PRI Measurements” on page 153.
Analyzing Program Simulation Data

- **Communication risk** — The number of missed communications divided by the number of requested communications (Missed Communications / Requested Communications).

- **Meeting risk** — The number of meetings missed divided by the number of meetings requested (Missed Meetings / Requested Meetings). Each time a person misses a meeting, it counts as one meeting missed.

You can view only financial statistics or only risk statistics for the program by turning off areas of the chart.

**To view the summary statistics chart for a program**

1. Run the simulation for the first case.
2. In the Chart Window’s Tree pane, make sure the program is selected.
3. Click the Summary Statistics chart icon.
4. Select the second case from the Compare list above the chart icons.
   - The simulator runs the compared case if it hasn’t already been run, and the case statistics show as yellow crosshatched bars.
5. To view the standard deviation click Standard Deviation on the Controls menu.
6. To turn off the financial statistics, click Show Financial on the right-click menu so it’s not checked.
7. To turn off the risk statistics, click Show Risk on the right-click menu so it’s not checked.
8. To copy and paste the chart into another application, click Copy on the right-click menu.
9. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

**Analyzing Program Schedule Growth**

The Program Schedule Growth chart shows the projects at greatest risk of taking longer than planned. The growth risk is calculated as the difference between CPM and simulated project duration, that is, the number of days a project takes when simulated minus the number of days the project takes in CPM calculation. Schedule growth measures the potential growth in project duration (not the actual project duration) in terms of working days.

As in the Project’s Schedule Growth chart, red bars in the Program Schedule Growth chart represent critical path projects and blue bars represent noncritical path projects. For example, in the following illustration, the current case of the program shows that the critical path (red) ASIC Software project is at risk of
taking about 35 working days longer than initially planned. In the compared Reduce PM Backlog case, the same project is at risk of taking about 40 days longer than planned, but in this case it is not on the critical path (it’s blue).

You can view critical-path projects only. You can also view the normalized schedule growth risk. This means that instead of showing the schedule growth risk as the simulated project duration minus the CPM duration, risk is shown as a percentage of the CPM duration, as follows:

\[
\text{(Simulated Duration - CPM Duration) / CPM Duration.}
\]

**To view the program schedule growth chart**

1. Run the simulation.
2. In the Chart Window’s Tree pane, make sure the program is selected.
3. Click the Schedule Growth chart icon.
   
   The chart shows the top five projects at risk of taking longer than planned.

4. To view a different number of projects, select the number from the list at the top of the Chart Window.
5. To view the project growth risk as a percentage of the CPM duration (normalized), click Normalize on the right-click menu.
Analyzing Program Simulation Data

Analyzing Program Cost and Work Breakdown

The Program Breakdown Charts show the simulated detailed cost or work breakdown for projects. The charts break the cost and work down into direct work, rework, coordination, and decision wait time. You can switch between displaying the cost and work breakdown. These are two important charts to examine even if you are not concerned with the simulated cost of the program, because they can tell you a lot about the indirect work involved in high-risk projects.

The way that work and cost are broken down for projects is similar to the way they are for tasks. For more information on reading and analyzing the Breakdown Charts, see “Reading the Breakdown Charts” on page 187.

To view the program cost and work breakdown charts

1. Run the simulation.
2. In the Chart Window’s Tree pane, make sure the program is selected.
3. Click the Breakdown Charts icon.
   The chart shows the work breakdown for the five longest projects.
4. To view a different number of projects, select the number from the list at the top of the Chart Window.
5. To view the cost breakdown rather than the work breakdown of tasks, select Cost from the list at the top left of the Chart Window, or on the right-click menu.
6. To filter the projects by category, click Category Filter on the right-click menu.
7. To view critical-path projects only, click Critical Path Only on the right-click menu.
8. To copy and paste the chart into another application, click Copy on the right-click menu.
Analyzing Program Risk

The Program Risk charts show your choice of seven risk metrics for the program. By default, the chart shows the Functional Risk Index (FRI), but you can switch between viewing the other six metrics by selecting them from the menu at the top of the chart, or on the chart’s right-click menu.

Program risk is an aggregate of the risk to all projects in the program. With this in mind, you analyze the risk to program quality in much the same way as risk to individual project quality. The following sections explain how to analyze program risks using the data in the risk charts, and, in some cases, how to counteract or reduce the risk.

To view the program quality risk charts
1 Run the simulation.
2 In the Chart Window’s Tree pane, select the program.
3 In the list of charts, click the Coordination Risk chart icon.
   The chart shows a summary of coordination risk for the program.
4 To switch between the other risk metrics, select the metric from the list at the top of the chart or on the right-click menu.
5 To view a different number of projects, select the number from the list at the top of the Chart Window.
6 To view the standard deviation from the mean of the quality risk over all trials, click Standard Deviation on the right-click menu.
   The standard deviations show as black horizontal bars.
7 If you have multiple cases in your program, compare cases by selecting a second case from the Compare list at the top left of the Chart Window.
   The compared case statistics show as crosshatched bars.
8 To show only projects on the critical path, click Show Critical Path Only on the right-click menu.
9 To copy and paste the chart into another application, click Copy on the right-click menu.
10 To filter the projects by category, click Category Filter on the right-click menu. See “Filtering Simulation Results by Category” on page 273.
Analyzing Person Backlog in a Program

The program’s Person Backlog chart shows overloads on persons in the program over time. This chart shows the most backlogged persons over the whole program. Otherwise, it is similar to the individual projects’ Person Backlog charts, which show the most backlogged persons in each project. Organizations, departments, and persons also have Person Backlog charts showing the most backlogged persons in the organization or department, or simply backlog for the selected person. These charts are also similar to the individual projects’ Person Backlog charts.

For more information on analyzing and counteracting person backlog, see “Analyzing Person Backlog in a Project” on page 197.

Analyzing the Program Resource Charts

The Resource Charts for a program show a summary of staffed and unstaffed resource demand and utilization across all projects during the specified time period. The Resource Utilization chart shows the speed with which the positions are doing the work. The Resource Demand chart shows where backlog occurs (the spikes in the chart). Troughs in the Utilization chart are a good indication of where resources have free time and can be more effectively used. If your program contains multiple projects, each project’s demand or utilization graph is a different color.

You can also look at FTE availability on the Resource charts. Availability shows as an aggregate availability percentage for all positions in the program.
For example, the following Resource Demand chart for the ASIC program shows that the ASIC Software project is particularly backlogged during late November 2006.

Demand and utilization tend to taper off towards the end of the program, as you see in the illustration. In general, the Demand and Utilization charts will look quite similar for a program.

The resource charts can help you understand how effectively you are leveling program staffing, and keeping staff requirements relatively constant throughout the life of the program.

You can customize the data shown in the Program Resource charts in the same way as the Project Resource charts. See “Analyzing the Project Resource Charts” on page 208.

**To view the Program Resource charts**

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the program.
3. Click the Resource Charts icon in the chart bar.
The Resource Chart shows the resource utilization of the program’s positions.

4 To view resource demand or availability instead of usage, select Demand or Availability % from the list at the top left of the chart or the chart’s right-click menu.

5 For more information on customizing the Resource Charts data, see “Analyzing the Project Resource Charts” on page 208.

**Analyzing Program Financial Data**

The Program Financial chart shows accumulated cost and revenue values for the program. The values are shown over time for the duration of the program (the X-axis) in currency units x 1000 (the Y-axis). Both cost and revenue represent rolled-up values for all projects in the program.
For example, the following chart shows cost and revenue for the two projects (Plant 1 and Plant 2) in the Reduce CC Backlog case of the Power Plant program.

Note: Because project data is shown in the chart color of the project, you might want to ensure that no projects in the program have a chart color of red or green. This avoids confusing project data with the red cost and green revenue data for the program. For information on setting project chart color, see "Setting Project Chart Color" on page 89.

You view and manipulate the data in the Program Finance chart the same way as in the Project Finance chart. See “Analyzing the Project Financial Charts” on page 216. For example, you can view just cost or just revenue data for the program and you can compare the financial data in any two program cases. You can also view financial data for the projects in the program, switching between project costs and revenues and filtering the projects by number or category. You can change the timescale on the X-axis of the chart or the scale of the currency shown on the Y-axis. For example, you might want to view costs during a specific period of the program, in which case you would change the start and end dates shown on the chart to reflect that period.
Reading the Program Statistics Charts

Programs have the following statistics charts:

- **Program Statistics Chart**—See “Reading a Program’s Statistics Chart” on page 288.
- **Program’s Project Statistics Chart**—See “Reading a Program’s Project Statistics Chart” on page 289.
- **Program’s Organization Statistics Chart**—See “Reading a Program’s Organization Statistics Chart” on page 290.
- **Program’s Milestone Statistics Chart**—See “Reading a Program’s Milestone Statistics Chart” on page 290.
- **Program Persons Work Report**—See “Reading a Program’s Persons Work Report” on page 291.
- **Program Resource Statistics Chart**—See “Reading a Program’s Resource Statistics Chart” on page 292.
- **Program Financial Statistics**—See “Reading a Program’s Financial Statistics Chart” on page 292.
Reading a Program’s Statistics Chart

For each program, the Program Statistics chart displays the information shown in the following illustration. You can switch between work and cost data as in other statistics charts. All financial data is expressed in thousands of currency units.

To view a program’s statistics chart
1. In the Chart Window’s Tree pane, select the program.
2. Click the Program Stats chart icon.

The statistics display in the Chart Window.

3. To switch between work and cost statistics, select Work or Cost from the list in the chart’s toolbar or on the right-click menu.

4. To view the standard deviation of program statistics from the mean of the summary statistics over all trials, click Standard Deviation on the Controls menu.

For more information on program financial statistics, see “Analyzing Program Financial Data” on page 285
Reading a Program’s Project Statistics Chart

The Project Statistics chart gives you a summary of all the projects in the program, with their names, descriptions, simulated durations, CPM durations, cost and product FRI and PRI, and more. For more information on product FRI and PRI values, see “About Product Risk Metrics” on page 152.

You can filter the programs shown by selecting specific projects or project categories. For more information about categories, see “Using Categories” on page 271.

To view the program’s Project Statistics chart

1. In the Chart Window’s Tree pane, click the program.
2. Click the Project Stats chart icon.
   The statistics display in the Chart Window.
3. To switch between work and cost statistics, select Work or Cost from the list in the chart’s toolbar or on the right-click menu.
4. To view the standard deviation of project statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.
5. To view the time as well as the date in statistics, click Show Time on the right-click menu.
6. To view a subset of the program’s projects, click Custom on the Filters list in the chart toolbar, or Filters>Custom on the right-click menu, and select the projects from the Filter dialog box.
7. To filter the projects by category, click Category Filter on the right-click menu and select the categories.
8. To copy and paste the chart into another application, click Copy on the right-click menu.
9. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading a Program’s Organization Statistics Chart

The Organization Statistics chart gives you a summary of all the organizations in the program, with their names, the number of people in each, the case being simulated, and the program name. Also listed are the Communications and Meeting Risks. Communications Risk is a measure of the risk throughout the program that communications will be ignored or improperly handled by positions responsible for tasks that are linked with communications links. Meeting risk is calculated as the number of meetings missed divided by the number of meetings requested (Missed Meetings / Requested Meetings).

You can filter the organizations shown by selecting specific projects or project categories. For more information about categories, see “Using Categories” on page 271.

To view the program’s Organization Statistics chart

1. In the Chart Window’s Tree pane, click the program.
2. Click the Organization Stats chart icon.
   
   The statistics display in the Chart Window.

3. To view a subset of the program’s organizations, click Custom instead of All on the Filters list in the chart toolbar, or Filters>Custom on the right-click menu, and select the organizations from the Filter dialog box.

4. To filter the organizations by category, click Category Filter on the right-click menu and select the categories.

Reading a Program’s Milestone Statistics Chart

The Milestones Statistics chart gives you a summary of the program’s milestones, with their names, dates, associated risks, financial and other data. You can immediately see milestones that are on the critical path.

To view the program’s Milestones Statistics chart

1. In the Chart Window’s Tree pane, click the program.
2. Click the Milestones Stats chart icon.
Analyzing Program Simulation Data

Reading a Program’s Persons Work Report

The program’s Persons Work Report shows the total number of hours each person works on each of the program’s projects and tasks. You can switch between work hours, demand, utilization, and availability statistics. For more information, see “Reading a Department’s Persons Work Report” on page 304.

To view the program’s Persons Work Report

1. In the Chart Window’s Tree pane, click the program.
2. Click the Person Work chart icon.

The persons’ work statistics display in the Chart Window.

<table>
<thead>
<tr>
<th>Program Persons Work Report: ToyTown</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task / Person</td>
</tr>
<tr>
<td>Warehouse</td>
</tr>
<tr>
<td>Define Scope</td>
</tr>
<tr>
<td>Project Coordination</td>
</tr>
<tr>
<td>Design Coordination</td>
</tr>
<tr>
<td>Arch. Program</td>
</tr>
<tr>
<td>Choose Struct. System</td>
</tr>
<tr>
<td>Choose Facade Materials</td>
</tr>
<tr>
<td>Seek Zoning Variances</td>
</tr>
<tr>
<td>Estimate Time</td>
</tr>
<tr>
<td>Estimate Cost</td>
</tr>
<tr>
<td>Provide GMP</td>
</tr>
<tr>
<td>Apply Exc. Permit</td>
</tr>
<tr>
<td>Select Subconsultants</td>
</tr>
<tr>
<td>Long Lead Purchasing</td>
</tr>
<tr>
<td>Select Key Subs</td>
</tr>
<tr>
<td>Hours</td>
</tr>
</tbody>
</table>

The statistics display in the Chart Window.

3. To switch between work and cost statistics, select Work or Cost from the list in the chart’s toolbar or on the right-click menu.

4. To view the standard deviation of milestone statistics from the mean of the summary statistics over all trials, click Standard Deviation on the right-click menu.

5. To view the time as well as the date in statistics, click Show Time on the right-click menu.

6. To view a subset of the program’s milestones, click Custom on the Filters list in the chart toolbar, or Filters>Custom on the right-click menu, and select the milestones from the Filter dialog box.

7. To filter the milestones by category, click Category Filter on the right-click menu and select the categories.
To switch between work hours, demand, utilization, and availability statistics, select the option from the menu in the chart’s toolbar, or from the right-click menu.

**Reading a Program’s Resource Statistics Chart**

The Program’s Resource Statistics chart shows usage and demand per task for each position in each of the program’s projects. This chart functions the same as the Project’s Resource Statistics chart, except it shows all positions in the program instead of just in the selected project. For information on how to read and manipulate the data in the chart, see “Reading a Project’s Resource Statistics Chart” on page 228.

**Note:** This chart only shows data if you turn on the Simulator - Calculate Usage Stats by Task option on the General tab of the Options dialog box. Turning on this option can increase the processing time for simulations.

**Reading a Program’s Financial Statistics Chart**

The program’s Financial Statistics chart shows cost and revenue data for the program itself and for each of its milestones and projects. Negative values are in red and positive cumulative values are in green. All values are in thousands of currency units. You can view finances per month (the default), quarter, or year and you can filter the data, for example to view only cost statistics or only cumulative revenues.
For example, the following Program Financial Statistics chart shows that the ASIC program costs 10,439,000 currency units in November 2004 and that the ASIC Hardware project is responsible for about 60% of that, costing 6,183,000.

If you roll the data up to annual statistics (by clicking Year instead of Month on the list in the chart toolbar), you can see that the program generates a cumulative revenue in 2004 of 17,700,000 currency units, a shortfall of 8,871,000 from cumulative costs. The cumulative net value is thus in red.

To view a program’s Financial Statistics chart
1  In the Chart Window’s Tree pane, select the program.
2  Click the Financial Stats chart icon.

The program’s financial statistics display in the Chart Window.
3 To view a subset of milestones or projects, click Custom on the Filter list at the top of the chart window and select the milestones and projects from the list.

4 To filter the data by category, click Categories on the chart right-click menu and select the categories from the list.

5 To view the data by year or quarter instead of the default month, select Year or Quarter from the list on the chart toolbar.

6 To view just one kind of data, for example just costs or just revenues, select an option from the list on the chart toolbar. (The default is All.)

7 To copy and paste the chart into another application, click Copy on the right-click menu.

8 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

The Organization Charts

Organizations have the following charts:

• **Organization Gantt Chart**—See “Analyzing the Organization Gantt Chart” on page 295.

• **Organization Backlog Chart**—See “Analyzing Organization Backlog” on page 295.

• **Organization Resource Charts**—See “Analyzing the Organization Resource Charts” on page 295.

• **Organization Statistics Chart**—See “Reading an Organization’s Statistics Chart” on page 296.

• **Organization’s Department Statistics**—See “Reading an Organization’s Department Statistics Chart” on page 297.

• **Organization’s Person Statistics**—See “Reading an Organization’s Person Statistics Chart” on page 297.

• **Organization’s Person Work Report**—See “Reading an Organization’s Persons Work Report” on page 299.
Analyzing the Organization Gantt Chart

Organizations have their own Gantt charts that show data and duration for tasks assigned to members of the organization. You view data in the Organization Gantt chart in the same way as Program and Project Gantt charts. See “Analyzing the Project Gantt Chart” on page 164, and “Customizing the Gantt Chart” on page 170.

<table>
<thead>
<tr>
<th>Task</th>
<th>Float</th>
<th>Criticality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chip Spec</td>
<td>11/22/04</td>
<td>1</td>
</tr>
<tr>
<td>Partition Chip &amp; Floor</td>
<td>01/03/05</td>
<td>1</td>
</tr>
<tr>
<td>HW Design Coordination</td>
<td>05/30/05</td>
<td>0</td>
</tr>
<tr>
<td>Write/Verify-Synth BIST</td>
<td>12/22/04</td>
<td>1</td>
</tr>
<tr>
<td>Assemble &amp; Verify RTL</td>
<td>01/04/05</td>
<td>1</td>
</tr>
<tr>
<td>Full Chip Synth</td>
<td>02/21/05</td>
<td>1</td>
</tr>
<tr>
<td>Eng. Layout &amp; Phys. Ver</td>
<td>05/02/05</td>
<td>0</td>
</tr>
<tr>
<td>Sim Gates</td>
<td>05/02/05</td>
<td>1</td>
</tr>
<tr>
<td>Generate Test Vectors</td>
<td>05/30/05</td>
<td>1</td>
</tr>
<tr>
<td>Weekly Coordination</td>
<td>1.00 weeks</td>
<td>30</td>
</tr>
</tbody>
</table>

Analyzing Organization Backlog

The Organization Backlog chart shows overloads on persons in the organization over time. It's a way of looking at person backlog by organization rather than by project. You can analyze the data the same way as for the project's Person Backlog chart. See “Analyzing Person Backlog in a Project” on page 197.

Analyzing the Organization Resource Charts

For organizations, the Resource charts show total FTEs required by the assigned workload for each project that the organization is assigned to. If the organization is not assigned to any specific projects, the charts show FTE demand, utilization, and availability across all projects.

If required FTEs exceed the total available, you know that you need to get some more FTEs or resources, or redistribute workload during the time identified.

To view the Organization Resource charts

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the organization to view resource information for.
3. Click the Resource Charts icon in the chart bar.
The chart shows FTE usage for the projects that the organization is assigned to, or for all projects if the organization is not assigned to any specific project.

4. To view resource demand or availability instead of usage, select Demand or Availability % from the list at the top left of the chart or the chart’s right-click menu.

5. For more information on customizing the Resource Charts data, see “Analyzing the Project Resource Charts” on page 208.

Reading an Organization’s Statistics Chart

For each organization, the Organization Statistics chart reports the statistics shown in the following illustration.

Total number of positions in all departments
Total FTEs across all positions
For more information, see “About Product Risk Metrics” on page 152
Work cost is expressed in thousands of currency units

To view an organization’s Statistics chart

1. In the Chart Window’s Tree pane, select the organization.

2. Click the Organization Stats chart icon.

   The organization’s statistics display in the Chart Window.

3. To copy and paste the chart into another application, click Copy on the right-click menu.

4. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading an Organization’s Department Statistics Chart

An organization’s Department Statistics chart summarizes the departments in the selected organization and, for each department, displays most of the information that displays on the individual department’s statistics chart. The Department Statistics chart is useful for checking communications risk across an organization, or just for seeing all the details for an organization’s departments together in one place.

To view an organization’s Department Statistics chart

1. In the Chart Window’s Tree pane, select the organization.
2. Click the Department Stats chart icon.

   The organization’s department statistics display in the Chart Window.
3. To view data for a different number of departments, click Custom on the filter list in the chart’s toolbar, or click Filters>Custom on the right-click menu and select the departments.
4. To filter the departments by category, click Category Filter on the right-click menu, select the categories, and click OK.
5. To copy and paste the chart into another application, click Copy on the right-click menu.
6. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

Reading an Organization’s Person Statistics Chart

An organization’s Person Statistics chart summarizes data for all the persons in the selected organization’s departments. For each person, the chart displays most of the information that displays on the individual person’s statistics chart. The
Person Statistics chart is useful for checking backlogs across all the persons in an organization, or just for seeing all the details for an organization’s persons together in one place. You can switch between work and cost statistics on this chart.

To view an organization’s Person Statistics chart

1. In the Chart Window’s Tree pane, select the organization.
2. Click the Person Stats chart icon.

   The organization’s person statistics display in the Chart Window.

3. To view the time as well as the date in person statistics, click Show Time on the right-click menu.
4. To switch between work and cost statistics, select Work or Cost from the menu in the chart’s toolbar, or on the right-click menu.
5. To view data for a different number of persons, click Custom on the filter list in the chart’s toolbar, or click Filters>Custom on the right-click menu and select the persons.
6. To filter the persons by category, click Category Filter on the right-click menu, select the categories, and click OK.
7. To copy and paste the chart into another application, click Copy on the right-click menu.
8. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading an Organization’s Persons Work Report

An organization’s Persons Work Report lists the projects and tasks that persons in the organization are responsible for and the number of hours each person is spending on each task and project.

<table>
<thead>
<tr>
<th>Task / Person</th>
<th>Ethan Holt</th>
<th>Anil Patel</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASIC Hardware</td>
<td>920.00</td>
<td>234.67</td>
</tr>
<tr>
<td>Chip Spec</td>
<td>120.00</td>
<td>234.67</td>
</tr>
<tr>
<td>Partition Chip &amp; Floorplanning</td>
<td>800.00</td>
<td></td>
</tr>
<tr>
<td>HW Design Coordination</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Write-Verify-Synth &amp; RTL</td>
<td>0.00</td>
<td></td>
</tr>
<tr>
<td>Assemble &amp; Verify RTL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Chip Synth</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Eng Layout &amp; Phys. Ver</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sys Cfgs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Generate Test Vectors</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also view demand, utilization, and availability statistics for each person, measured in FTEs. The value shown is the maximum demand or utilization for this person over the life of the project. In the following example, both Ethan Holt and Anil Patel are fully used during the ASIC Hardware project.

To view an organization’s Person Work Report

1. In the Chart Window’s Tree pane, select the organization.
2. Click the Person Work icon.

   The organization’s person work statistics display in the Chart Window.

3. To switch between work hours, demand, utilization, and availability, select from the list in the chart’s toolbar or the options on the right-click menu.

4. To view data for a different number of persons, click Custom on the filter list in the chart’s toolbar, or click Filters>Custom on the right-click menu and select the persons.

5. To filter the persons by category, click Category Filter on the right-click menu, select the categories, and click OK.

6. To copy and paste the chart into another application, click Copy on the right-click menu.
The Department Charts

Departments have the following charts:

- **Department Gantt Chart**—See “Analyzing the Department Gantt Chart” on page 301.
- **Department Backlog Chart**—“Analyzing Department Backlog” on page 301.
- **Department Resource Charts**—See “Analyzing the Department Resource Charts” on page 301.
- **Department Statistics Chart**—See “Reading a Department’s Statistics Chart” on page 302.
- **Department’s Person Statistics Chart**—See “Reading a Department’s Person Statistics Chart” on page 303.
- **Department’s Person Work Report**—See “Reading a Department’s Persons Work Report” on page 304.

To make defaults of this chart's settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Analyzing the Department Gantt Chart

Departments have their own Gantt charts that show data and duration for tasks assigned to members of the department. You view data in the Department Gantt chart in the same way as Program and Project Gantt charts. See “Analyzing the Project Gantt Chart” on page 164, and “Customizing the Gantt Chart” on page 170.

```
<table>
<thead>
<tr>
<th>Department Gantt: Design: Hardware: ASIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Milestone</td>
</tr>
<tr>
<td>Chip Spec</td>
</tr>
<tr>
<td>Partition Chip &amp; Floorplan</td>
</tr>
<tr>
<td>HW Design Coordination</td>
</tr>
<tr>
<td>Write/Verify Synth B1RT</td>
</tr>
<tr>
<td>Assemble &amp; Verify RTL</td>
</tr>
<tr>
<td>Full Chip Synth</td>
</tr>
<tr>
<td>Weekly Coordination</td>
</tr>
</tbody>
</table>
```

Analyzing Department Backlog

The Department Backlog chart shows overloads on persons in the department over time. It’s a way of looking at person backlog by department rather than by organization or project. You can analyze the data the same way as for the project’s Person Backlog chart. See “Analyzing Person Backlog in a Project” on page 197.

Analyzing the Department Resource Charts

For departments, the Resource charts show total FTEs required by the assigned workload for each project that the department’s organization is assigned to. If the department’s organization is not assigned to any specific projects, the charts show FTE demand, utilization, and availability across all projects.

If a department has subdepartments, you can look at resource demand and utilization across the department’s subdepartments. When you show subdepartment data, the resource charts simply add the FTEs of the subdepartments to those of the department.

If required FTEs exceed the total available, you know that you need to get some more FTEs or resources, or redistribute workload during the time identified.

To view the Department Resource charts

1. Run the simulation.
Reading a Department’s Statistics Chart

For each department or subdepartment, the Department Statistics chart reports the statistics shown in the following illustration.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department Name</td>
<td>Design</td>
</tr>
<tr>
<td>Department Head</td>
<td>John H.</td>
</tr>
<tr>
<td>Number of People</td>
<td>10</td>
</tr>
<tr>
<td>Total FTEs</td>
<td>10</td>
</tr>
<tr>
<td>Communications Risk</td>
<td>0.43</td>
</tr>
<tr>
<td>Meeting Risk</td>
<td>0.38</td>
</tr>
<tr>
<td>Case</td>
<td>Reduce RM Backlog</td>
</tr>
<tr>
<td>Program</td>
<td>ASIC</td>
</tr>
<tr>
<td>Organization</td>
<td>Hardware</td>
</tr>
</tbody>
</table>

To view a department’s or subdepartment’s Statistics chart

1. In the Chart Window’s Tree pane, click the plus sign by the organization that contains the department.
2. Select the department, and if necessary the subdepartment.
3. Click the Department Stats chart icon.
   The department’s statistics display in the Chart Window.
4. To copy and paste the chart into another application, click Copy on the right-click menu.
5. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.
Reading a Department’s Person Statistics Chart

A department’s or subdepartment’s Person Statistics chart lists the persons in the department with data such as each person’s communication risk, worst backlog date, and availability percentage.

The availability percentage indicates how much of the person’s available FTEs are used over the life of the program. The number shown is actually the difference between the total FTE value and the average FTE used expressed as a percentage of the total. You can see a more representative indication of person availability over time in the Person Resource Usage chart. This data is more representative because the person’s Availability % value can be skewed by the duration of the tasks. For example, a person might be used 100% for two tasks, but if the tasks only span half the life of the program, the Availability % value is 50%.

For more information on the Person Resource chart, see “Analyzing the Person Resource Charts” on page 306.

To view a department’s or subdepartment’s Person Statistics chart:

1. In the Chart Window’s Tree pane, click the plus sign by the organization that contains the department.
2. Select the department, and if necessary the subdepartment.
3. Click the Person Stats chart icon.
   The department’s person statistics display in the Chart Window.
4. To view the time as well as the date in person statistics, click Show Time on the right-click menu.
5. To view a subset of the department’s persons, click Custom on the Filters list in the chart toolbar, or Filters>Custom on the right-click menu, and select the persons from the Filter dialog box.
6. To filter the persons by category, click Category on the right-click menu and select the categories.

7. To copy and paste the chart into another application, click Copy on the right-click menu.

8. To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

**Reading a Department’s Persons Work Report**

A department’s or subdepartment’s Persons Work Report lists the projects and tasks that persons in the department are responsible for and the number of hours each person is spending on each task and on each project in total.

<table>
<thead>
<tr>
<th>Task / Person</th>
<th>Mark Hastings</th>
<th>Aldai Smith</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASIC Hardware</td>
<td>5.45</td>
<td>0.00</td>
</tr>
<tr>
<td>Site Gates</td>
<td>3.45</td>
<td></td>
</tr>
<tr>
<td>Generate Test Vectors</td>
<td>0.45</td>
<td></td>
</tr>
<tr>
<td>Eng. Layout &amp; Phys. Ver</td>
<td>1.55</td>
<td></td>
</tr>
<tr>
<td>ASIC Software</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

You can view demand and utilization statistics for each person, measured in FTEs. The value shown is the maximum demand or utilization for this person over the life of the project. In the following example, Mark Hastings’ maximum utilization during the ASIC Hardware project is only 0.04 FTEs.

<table>
<thead>
<tr>
<th>Task / Person</th>
<th>Mark Hastings</th>
<th>Aldai Smith</th>
<th>Larry Pennant</th>
<th>Joe Gough</th>
<th>Laura Jennings</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASIC Hardware</td>
<td>0.04</td>
<td>0.05</td>
<td>0.75</td>
<td>0.75</td>
<td>1.00</td>
</tr>
<tr>
<td>ASIC Software</td>
<td>0.04</td>
<td>0.05</td>
<td>0.76</td>
<td>0.79</td>
<td>1.00</td>
</tr>
</tbody>
</table>

You can also view person availability, measured as a percentage. To correlate with Mark Hastings’ minimal utilization in the ASIC Hardware project, you can see here that his availability over the life of the project is 99.4%.

<table>
<thead>
<tr>
<th>Task / Person</th>
<th>Mark Hastings</th>
<th>Aldai Smith</th>
<th>Larry Pennant</th>
<th>Joe Gough</th>
<th>Laura Jennings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability %</td>
<td>95.4%</td>
<td>99.8%</td>
<td>94.1%</td>
<td>95.3%</td>
<td>47.2%</td>
</tr>
</tbody>
</table>

**To view a department’s or subdepartment’s Person Work Report**

1. In the Chart Window’s Tree pane, click the plus sign by the organization that contains the department.

2. Select the department, and if necessary the subdepartment.

3. Click the Person Work icon.
The department’s work hour statistics display in the Chart Window.

4 To switch between work hours, demand, utilization, and availability, select from the list in the chart’s toolbar.

5 To view data for a different number of persons, click Custom on the filter list in the chart’s toolbar, or click Filters>Custom on the right-click menu and select the persons.

6 To copy and paste the chart into another application, click Copy on the right-click menu.

7 To make defaults of this chart’s settings, or to match settings to the defaults already set or to settings on another chart, click Match To on the right-click menu. See “Matching Data Between Charts” on page 149.

The Person Charts

Persons have the following charts:

- **Person Gantt Chart**—See “Analyzing the Person Gantt Chart” on page 306.
- **Person Resource Charts**—See “Analyzing the Person Resource Charts” on page 306.
- **Person Backlog Chart**—See “Analyzing Individual Person Backlog” on page 306.
- **Person Statistics Chart**—See “Reading a Person’s Statistics Chart” on page 307.
Analyzing the Person Gantt Chart

Persons have their own Gantt charts that show data and duration for tasks assigned to the person. You view data in the Person Gantt chart in the same way as Program and Project Gantt charts. See “Analyzing the Project Gantt Chart” on page 164, and “Customizing the Gantt Chart” on page 170.

Analyzing the Person Resource Charts

For persons, the Resource charts show FTE usage and demand by project for that person.

If required FTEs exceed the total available, you know that you need to get some more FTEs or resources, or redistribute workload during the time identified.

To view the Person Resource charts

1. Run the simulation.
2. In the Chart Window’s Tree pane, select the person to view resource information for.
3. Click the Resource Charts icon in the chart bar.
   The chart shows FTE usage by project for that person.
4. To view resource demand or availability instead of usage, select Demand or Availability % from the list at the top left of the chart or the chart’s right-click menu.
5. For more information on customizing the Resource Charts data, see “Analyzing the Project Resource Charts” on page 208.

Analyzing Individual Person Backlog

The Person Backlog chart shows overloads on an individual person over time. It’s a way of looking at person backlog by individually rather than by department, organization, or project. You can analyze the data the same way as for the project’s Person Backlog chart. See “Analyzing Person Backlog in a Project” on page 197.
Reading a Person’s Statistics Chart

For each person in a department, the Person Statistics chart reports the statistics shown in the following illustration.

The Worst Task field in this statistics chart can be blank even if the person is heavily backlogged. This indicates that the person is not performing a task when their worst backlog is generated. For example, the backlog could arise from communications.

You can switch between work and cost statistics on this chart, as shown next.

To display a person’s Statistics chart

1. In the Chart Window’s Tree pane, click the plus sign by the organization that contains the department the person belongs to.
2. Click the plus sign by the department name.
3. Select the person.
4. Click the Person Stats chart icon.

The person’s statistics display in the Chart Window.
Using the Executive Dashboard

The Executive Dashboard allows you to compare and analyze multiple cases with respect to program goals you have set. First, you set the program goals. Next, you filter the cases of your program that you want to simulate and compare with respect to the goals. The Executive Dashboard simulation creates two charts that show how your program is performing with regard to the program goals: the Executive Multi-Project Report and the Program Performance chart. It also creates a risk measurement chart and a detailed case comparison chart that allows you to compare numerous statistics across cases in a program.

Setting Program Goals

There are five goals you can use to measure a program against:

- **Completion date**—A date by which the program must be complete.
- **Minimum revenue**—The minimum amount of revenue, in thousands of currency units, that the program should generate.
- **Maximum cost**—The maximum amount, in thousands of currency units, that the program should cost.
- **Maximum quality risk**—The quality risk you specify (as a percentage) is measured against the highest of three risk metrics that the simulation charts track: functional risk (FRI), product risk (PRI), and coordination risk. For more information on these risk factors, see “About Product Risk Metrics” on page 152.
- **Peak backlog on the critical path**—The highest backlog in days over the life of the program of any resource as it works on a critical-path task. This is not necessarily the peak backlog in the life of the program, because that might occur for a resource who is not working a critical-path task at the time. The critical-path peak backlog figure is useful as a sort of temperature gauge for backlog in the program. For example, if the value is 5 days, you're probably in good shape. If it's 80 days, you have a problem.

Program goals are stored in the workspace, so there is one set of goals across all cases in a program file.
You can make a goal a required goal, which means that the goal must be met for the case to be considered successful when you simulate the program in the Executive Dashboard.

**Note:** It’s important to remember to check the Required box in the Program Goals window for required goals. Otherwise, you might interpret a case as meeting all required goals and miss the fact that it actually fails to meet a nonrequired goal.

To set program goals

1. Open the program you want to set goals for.
2. On the Results menu, click Executive Dashboard Goals.
   
   The Program Goals window displays.

3. To set a completion date, type the date, use the arrows to scroll to the date, or click the down-arrow to select a date from a calendar.
4. To set a minimum revenue for the program, enter an amount in thousands of currency units.
5. To set a maximum cost for the program, enter an amount in thousands of currency units.
6. To set a maximum quality risk, enter a percentage risk.
7. To set a maximum number of days for the peak backlog on the critical path, enter the number of days.
8. To make any goal a required goal, click the Required box to the right of the goal so it’s checked.
9. Select a goal to sort projects by in the Executive Dashboard.
10. Click OK.
Selecting the Cases to Compare

You don’t have to view all program cases in the Executive Dashboard. Using the Case Filter, you can select a subset of the program cases to compare, and you can choose whether to simulate the cases before comparing them. The Case Filter shows you whether each case has already been simulated, and lets you choose to view the current simulation results or resimulate.

To filter cases for the Executive Dashboard simulation

1. On the Results menu, click Executive Dashboard Window.

   The Case Filter window lists the program cases, showing which ones will be displayed in the Dashboard, which have already been simulated, and which will be resimulated when you click OK.

   - To remove a case from the Dashboard, click under Show on Dashboard so it’s no longer checked.
   - To simulate a case before displaying the Dashboard, click under Run Simulation for the case.
   - Click OK.

   SimVision simulates any cases you specified and displays the Executive Dashboard with the cases you selected to view.

Analyzing Executive Dashboard Charts

The Executive Dashboard has four charts:

- **Program Performance**—See “Analyzing Program Performance” on page 313.
Analyzing Program Simulation Data

• **Detailed Case Comparison**—See “Making a Detailed Case Comparison” on page 316.

**Analyzing the Executive Multi-Project Report**

The Executive Multi-Project Report in the Executive Dashboard lists the cases you selected in the Case Filter with a color-coded indication of how they meet the program goals. The program goals are displayed above the case results: red for required goals, blue for nonrequired goals. For information on setting program goals, see “Setting Program Goals” on page 308. Financial data is shown in thousands of currency units.

<table>
<thead>
<tr>
<th>Case No.</th>
<th>Name</th>
<th>Description</th>
<th>Projects</th>
<th>Completion Date</th>
<th>Revenue (k)</th>
<th>Cost (k)</th>
<th>Highest Risk</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Baseline</td>
<td></td>
<td>2</td>
<td>04 May 05</td>
<td>4000</td>
<td>1650</td>
<td>25%</td>
</tr>
<tr>
<td>2</td>
<td>Probs Set</td>
<td></td>
<td>2</td>
<td>25 Feb 05</td>
<td>4500</td>
<td>1455</td>
<td>0%</td>
</tr>
<tr>
<td>3</td>
<td>Reduce CC Backlog</td>
<td>Add SFTPs to Construction Contractors</td>
<td>2</td>
<td>10 Jun 05</td>
<td>4500</td>
<td>1669</td>
<td>53%</td>
</tr>
<tr>
<td>4</td>
<td>Reuse Info</td>
<td>Reuse SQL scope extended from Part 1/1 Jan 05</td>
<td>2</td>
<td>03 May 05</td>
<td>4700</td>
<td>1686</td>
<td>55%</td>
</tr>
</tbody>
</table>

The case name background color indicates whether the case meets the program goals, as follows:

• **Green background**—The case meets all goals, both required and nonrequired, as in the Baseline case above.

• **Yellow background**—The case meets all required goals but fails to meet at least one nonrequired goal, as in the Reduce CC Backlog case.

• **Red background**—The case fails to meet at least one required goal, as in the Probs Set and Reuse Info cases.

Case results are broken down by individual goal and the color coding indicates whether the case results meets each goal. The same coding is used as for the overall cases.
For example, in the previous illustration, only the Baseline case meets all goals. The Reduce CC Backlog case comes close by meeting all required goals but failing to meet the nonrequired quality risk goal, so it has a yellow background for the case name. The Probs Set and Reuse Info cases each fail to meet a required goal, so they have red backgrounds for the case names.

If you leave a goal set to the default (the program start date or zero), each case will show up green for that goal on the assumption that it is not important for the program.

The Executive Multi-Project Report also displays the number of FTE months used for each program case. An FTE, or full-time equivalent, is a measure of position or person availability to perform a task. For example, a position with an FTE value of 3 has the equivalent of 3 full-time employees to perform tasks. The FTE months value is based on 22 days of 8 hours each. If the program is unstaffed, the report shows the number of unstaffed FTE months used for each case. For example, in the following illustration the Baseline case is unstaffed, so it shows 162.3 unstaffed FTE months. The other three cases are staffed and show the FTE months used in each case. (The Dashboard’s columns have been truncated here to show just the case name and FTE month columns.)

You can jump to related charts in the Chart Window by double-clicking in the Completion Date, Cost, or Highest Risk columns. For example, double-clicking in the Completion Date column takes you to the program’s Gantt chart.
You can also view any business drivers that are associated with the projects in the program, and sort the projects by business drivers. Business drivers display in columns at the right of the Executive Multi-Project Report.

To see data for each project in a case, double-click the case name.

**Analyzing Program Performance**

The Program Performance chart in the Executive Dashboard displays a bar graph for each case selected in the Case Filter. A dark blue, horizontal line indicates the 100% mark for all program goals. For each case, a bar is displayed for the five program goals, if you set them: the Schedule bar is yellow, Revenue is green, Cost is red, Risk is blue, and Peak Backlog is brown. Crosshatched bars indicate a nonrequired goal. The Program Goals box on the right displays the goals set for the program.
If a goal has been met or exceeded by the case, the goal’s bar displays at or a proportional height below the 100% line. If the goal has not been met, the bar extends to a proportional height above the 100% line.

For example, in the previous illustration, the Baseline case meets the schedule, cost, and backlog goals, but fails to meet the revenue goal by about 15%. There is no risk in this case so no blue bar. The other three cases don’t do too badly on the schedule, revenue, cost, and backlog goals, but have significantly higher quality risk (the blue bars) than the program goal specifies. The blue risk bars are hatched because risk is a nonrequired goal for this program. All the other bars are solid colors, indicating they represent required goals.

**To view the Program Performance chart**

1. Run the Executive Dashboard by clicking Executive Dashboard Window on the Results menu.
2. In the Case Filter dialog box, select the cases you want to compare and whether to simulate them, and click OK.
3. At the bottom of the Executive Dashboard window, click the Program Performance tab.

The program performance statistics display.
Analyzing Risk Measures
The Risk Measures chart in the Executive Dashboard breaks the risk analysis down into five kinds of risk: Coordination risk, Project risk, Functional risk, Process risk, and Product risk. For more information on these risk factors, see “About Product Risk Metrics” on page 152.
You should expect to see low or no risk in a Baseline case because it is a high level, simplified view of a program. You usually see higher risk in later cases, where factors such as coordination and errors are modeled. In the following example, the maximum risk goal is set at 25% and all three non baseline cases show significantly greater risk than this goal.

Making a Detailed Case Comparison

The Detailed Case Comparison chart in the Executive Dashboard allows you to compare numerous statistics across all selected program cases, and the projects in each program. You can expand the view to see statistics for each project in each case. You can also view the time for any date statistics. For example, you can see that a case is calculated to finish at 6pm on the simulated end date.
Analyzing Program Simulation Data

Using the Executive Dashboard

1. Run the Executive Dashboard by clicking Executive Dashboard Window on the Results menu.
2. In the Case Filter dialog box, select the cases you want to compare, and click OK.
3. At the bottom of the Executive Dashboard window, click the Detailed Case Comparison tab.
   The case statistics display in the Executive Dashboard window. Scroll right to see more statistics.
4. To view project statistics for a case, click the plus sign beside the case name.
5. To view statistics for all projects in all cases, click Expand All. To hide the project statistics, click Collapse All.
6. To view times as well as dates, click Show Time.

To view the Detailed Case Comparison chart

Working with the Executive Dashboard Charts

You can print the Executive Dashboard charts, and save them in various formats for display or import to other products. For example, you could save the Risk Measures chart as a JPEG (.jpg file) or bitmap (.bmp file) and use it in a Microsoft® PowerPoint presentation. You can also copy charts to the Windows Clipboard and paste them into other applications. The Detailed Case Comparison chart copies as a CSV (comma separated) file that can be used in Microsoft Excel. The other three charts copy as images.

If you delete, rename, or simulate a program case while the Executive Dashboard is displayed, you can refresh the data without rerunning the Executive Dashboard simulation. You can also change the selection of cases displayed and modify program goals from inside the Executive Dashboard.

To print an Executive Dashboard chart

1. Run the Executive Dashboard by clicking Executive Dashboard Window on the Results menu.
2 To set the size and orientation of the chart on the printed page, click Page Setup on the File menu. By default, the chart prints as large as possible on the computer’s default page size.

![Page Setup dialog box]

3 To print the chart on a different paper size, click Use Max Size so it's checked. The paper size list becomes available.

4 Select a size from the list. If you choose a landscape page size and the Print Properties dialog specifies a portrait page orientation, the chart will print across two pages.

5 Click OK.

6 On the File menu, click Print.

**To save an Executive Dashboard chart for use in another application**

1 Select the chart to save.

2 On the File menu, click Save As.

The Save As dialog box appears.

3 Type, select, or navigate to the location where you want to save the chart.

4 Under Save As Type, select a file type to save the chart as. By default, the chart is saved as a text file with tab separated fields that you can import into Microsoft Excel.

5 For the Program Performance and Risk Measures charts, under Image Size, select a size for the saved chart. (You cannot save grid charts as images, so these options are not available for the other two charts.) To specify a custom size, enter the number of pixels along the X and Y axes.

6 Click OK.

**To copy an Executive Dashboard chart to the Clipboard**

1 In the Executive Dashboard window, select the tab for the chart to copy.

2 On the Edit menu, click Copy.

The chart is copied to the clipboard and you can paste it into another application.
To refresh the Executive Dashboard display

• In the Executive Dashboard window, click Refresh on the View menu.

To filter cases from within the Executive Dashboard

1. In the Executive Dashboard window, click Filter on the View menu.

   The Case Filter dialog box appears.

2. Under Show on Dashboard, select the case you want to add or remove from the Dashboard display.

3. Click OK.

To modify program goals from within the Executive Dashboard

1. In the Executive Dashboard window, click Goals on the View menu.

   The Program Goals dialog box appears.

2. Modify the goals as appropriate.

3. Click OK.
CHAPTER 9

Viewing, Sharing, and Printing Model Data

SimVision provides a variety of tools to help you view, manipulate, and share the data in models. You can do the following:

• Navigate complex models by zooming the view or moving to specific elements.
• Visually re-layout a model.
• Show and hide layers of a model for viewing and printing.
• Select model elements by type.
• View and edit properties throughout the program with Table View.
• Share SimVision information with other applications.
• Print models and set print options.
Navigating Complex Models

Models can involve hundreds of milestones, tasks, positions, and meetings. You can navigate complex models in a variety of ways.

- **Change the view**—See “Changing the Model View” on page 322.
- **Use the object right-click menus**—See “Navigating with Object Right-Click Menus” on page 322.
- **Right-click objects in the Tree Pane**—See “Viewing the Startup Model in the Tree Pane” on page 24.

You can also simplify models by turning layers off when viewing or printing. See “Using Layers in a Model” on page 324.

Changing the Model View

You can magnify the view in the Model pane by zooming in and out by increments, or by specifying a magnification percentage. You can fit the whole model in the pane, zoom to a selection, or pan across the view. Panning the view is like panning with a camera—the view moves with cursor movement.

**To change the model view**

1. To zoom to a selection of objects, click Zoom Window on the View menu and draw a selection window in the Model pane. You can keep drawing selection windows to zoom further in, or you can zoom back out in increments by right-clicking. To stop zooming, click ESC.
2. To view the model at full size, click Zoom 100% on the View menu.
3. To view the model at 50%, 75%, 100%, or 200%, click Zoom Percent on the View menu and then select the required size.
4. To specify a percentage reduction or enlargement, click Custom on the View menu, enter the percentage, and click OK.
5. To fit all objects in the Model pane, click Zoom to Fit on the View menu.
6. To enlarge the view by 20%, click Zoom In on the View menu.
7. To reduce the view by 20%, click Zoom Out on the View menu.
8. To zoom to selected objects, select the objects and click Zoom to Selection on the View menu.
9. To pan across the Model pane, click Pan on the View menu and move the cursor in the direction you want to pan.

Navigating with Object Right-Click Menus

You can use object right-click menus to move between linked objects unless the objects are on a layer that is turned off. For example, the following illustration shows how the Write Spec task’s right-click menu allows you to navigate to linked tasks, milestones, ghost milestones, and positions. The menu also lists any ghost
tasks that reference this task in another project and lets you navigate to any links attached to the task, in this case, three successor links, a primary assignment link, and a rework link.

Model Re-layout

You can re-layout a model so that the objects are displayed in a standard way that makes the model easier to read. For example, the following illustration shows a model before and after re-layout. Notice that in the reorganized model, the placement of the tasks more clearly represents whether they are sequential or simultaneous. Also, in a standard model, the meetings are at the top left.
To re-layout a model

   
   A message warns you that you cannot undo the re-layout.

2. Click OK.
   
   The model is laid out in a standard way.

Using Layers in a Model

In complicated models, there can be too much information to view at once. SimVision divides information into layers, which you can turn on and off. This allows you to view or print only the information you want to see. For example, rework and communications links are on separate layers. In models where these links overlay one another, you can turn one type of link off to more clearly see the
other type. When a layer is turned off, you can’t see its objects or select them for graphical manipulation, but you can edit their properties using Table View. See “Using Table View” on page 328.

Layers can also help you to troubleshoot simulation errors or make corrections in the model after analyzing the data on the simulation charts. For example, if a position is backlogged and you want to see the tasks assigned to that position, you can turn off all links except assignment links.

SimVision uses a separate layer for each type of shape and each type of link in a model. This gives you fine control over what you view and print because you can isolate each type of shape and each type of link. SimVision also distinguishes between objects that pertain to the organization, the process, and task assignments.
Using the Layers dialog box, you can filter the objects you view or print as follows (Ghost Links are the red information-only links between projects that have interdependencies modeled with ghosts):

<table>
<thead>
<tr>
<th>Filter</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Projects</td>
</tr>
<tr>
<td></td>
<td>Project Successors</td>
</tr>
<tr>
<td></td>
<td>Organizations</td>
</tr>
<tr>
<td></td>
<td>Organization Assignments</td>
</tr>
<tr>
<td></td>
<td>Departments</td>
</tr>
<tr>
<td></td>
<td>Subdepartment Links</td>
</tr>
<tr>
<td></td>
<td>Positions</td>
</tr>
<tr>
<td></td>
<td>Supervision Links</td>
</tr>
<tr>
<td></td>
<td>Meetings</td>
</tr>
<tr>
<td></td>
<td>Participant Links</td>
</tr>
<tr>
<td></td>
<td>Annotations</td>
</tr>
<tr>
<td></td>
<td>Revision blocks</td>
</tr>
<tr>
<td></td>
<td>Ghost Links</td>
</tr>
<tr>
<td>Process</td>
<td>Projects</td>
</tr>
<tr>
<td></td>
<td>Project Successors</td>
</tr>
<tr>
<td></td>
<td>Organizations</td>
</tr>
<tr>
<td></td>
<td>Organization Assignments</td>
</tr>
<tr>
<td></td>
<td>Departments</td>
</tr>
<tr>
<td></td>
<td>Subdepartment Links</td>
</tr>
<tr>
<td></td>
<td>Milestones</td>
</tr>
<tr>
<td></td>
<td>Tasks</td>
</tr>
<tr>
<td></td>
<td>Ghost Task</td>
</tr>
<tr>
<td></td>
<td>Ghost Milestone</td>
</tr>
<tr>
<td></td>
<td>Successors Links</td>
</tr>
<tr>
<td></td>
<td>Rework Links</td>
</tr>
<tr>
<td></td>
<td>Communications Links</td>
</tr>
<tr>
<td></td>
<td>Annotations</td>
</tr>
<tr>
<td></td>
<td>Revision blocks</td>
</tr>
<tr>
<td></td>
<td>Ghost Links</td>
</tr>
<tr>
<td>Assignment</td>
<td>Projects</td>
</tr>
<tr>
<td></td>
<td>Project Successors</td>
</tr>
<tr>
<td></td>
<td>Organizations</td>
</tr>
<tr>
<td></td>
<td>Organization Assignments</td>
</tr>
<tr>
<td></td>
<td>Departments</td>
</tr>
<tr>
<td></td>
<td>Subdepartment Links</td>
</tr>
<tr>
<td></td>
<td>Tasks</td>
</tr>
<tr>
<td></td>
<td>Ghost Tasks</td>
</tr>
<tr>
<td></td>
<td>Positions</td>
</tr>
<tr>
<td></td>
<td>Primary Assignment Links</td>
</tr>
<tr>
<td></td>
<td>Secondary Assignment Links</td>
</tr>
<tr>
<td></td>
<td>Annotations</td>
</tr>
<tr>
<td></td>
<td>Revision blocks</td>
</tr>
<tr>
<td></td>
<td>Ghost Links</td>
</tr>
</tbody>
</table>
To turn layers on and off

1. On the View menu, click Layers.

   The Layers dialog box appears.

2. Turn the following layers on or off:
   - To hide objects in the Model pane, deselect the objects under View.
   - To hide objects in a printout, deselect the objects under Print.
   - To print the objects you chose to view, click Copy to Print.
   - To view the objects you chose to print, click Copy to View.
   - To view or print all objects, click Select All under All.
   - To hide all object for viewing or printing, click Select None under All.
   - To view or print all shapes, such as tasks and positions, click Select All under Shapes.
   - To hide all shapes for viewing or printing, click Select None under Shapes.
   - To view or print all links, click Select All under Links.
   - To hide all links for viewing or printing, click Select None under Links.
   - To view or print only objects pertaining to organizations, click the Set buttons under Organization.
   - To view or print only objects pertaining to the process, click the Set buttons under Process.
• To view or print only objects pertaining to assignments, click the Set buttons under Assignment.

3 Click OK

**Selecting Model Elements by Type**

You can select model elements by type, for example, all links, all assignment links, or all annotations. This could be useful if you wanted to color-code a complex model for easier reading. For example, you could color all secondary assignment links pale blue instead of the default dark blue for primary task assignments.

**To select model elements by type**

1 On the Edit menu, click Select by Type.
2 On the submenu, click the element to select.

The Tree pane displays those elements, expanding any folders as necessary, and the elements are selected in the Model pane.

**Using Table View**

When you are working with extensive programs, it can be very difficult to keep track of object properties. Which successor links in Project A are Start-Start? What is the application experience of persons in Organization X? What are the roles of Project B’s positions? Table View lets you view and edit properties across a project or organization. For example, you can view all the successor links in Project A and tell at a glance which ones are Start-Start. This provides comprehensive control over properties by object type instead of per object, as in the Properties pane.

You can sort objects by parameter in the Table View, and select objects in the model according to how they are listed in the Table View. You can also set multiple object properties simultaneously by matching properties to the current selection. This set of features is useful when you want to manipulate all objects that have a certain parameter value. For example, suppose you want to make all tasks that have a high Uncertainty value into high priority tasks. You could sort the tasks by their Uncertainty parameter, change the priority of the top task in that list to High, then match all the tasks below it to that value.

Table View also allows you to edit the properties of objects on hidden layers. These objects are not visible in the model, but they are listed with their properties in Table View. For further flexibility, you can export the data in Table View to another application, such as an Excel spreadsheet.

With this degree of control over objects and their properties, Table View is an invaluable tool and we highly recommend its use.
Viewing Properties in Table View

Table View displays the properties for the current program, project, or organization. When you switch between projects and organizations by clicking their tabs below the Model pane, Table View updates dynamically with the properties for the object you select.

Within Table View, there are tabs for the shapes and links in the current object. For example, if you open Table View for a project, there are tabs for the Tasks, Milestones, Positions, and so on. Table View for an organization has tabs for departments, subdepartment links, and persons (where you can view and modify person IDs). Table View for the program has tabs for the projects, organizations, program milestones, project successor links, and organization assignment links. Each tab displays all the properties for all the shapes or links in the container object.

For example, here is the Table View showing all the positions in a project.

To display Table View

1. Under the Model pane, click the tab of the program, project, or organization whose properties you want to view.
2. On the View menu, click Table View.

Table View displays the properties of the selected program, project, or organization.

3. To view properties for another shape or link, click its tab at the bottom of the Table View window. Use the arrows to scroll between tabs.
To make changes to properties in Table View

1. Under the Model pane, click the tab of the program, project, or organization whose properties you want to edit.

2. On the View menu, click Table View.

   Table View displays the properties of the selected program, project, or organization.

3. Click in the cell for the property you want to change.

4. Enter a new value for the property, or select a value from the list that drops down.

5. Press ENTER to apply the new value.

Sorting and Selecting Objects with Table View

You can sort the data in Table View by double-clicking in a parameter column header. Data sorts appropriately according to the parameter. For example, object and skill names sort alphabetically, task priority sorts from low to high. You can sort in the opposite direction by double-clicking the column heading again.

If you only want to sort a subset of objects, you can make your selection in the model, using a selection box or the click-select method, and then operate on the selection in Table View. For example, to sort a subset of positions alphabetically, you would first sort all positions alphabetically in Table View, then select just the positions you want in the model and click Sort Select on the Table View’s right-
click menu. The following illustration shows a subset of five positions sorted alphabetically at the top of the list of positions in Table View. The rest of the positions are sorted alphabetically below the subset.

In complex models, it’s very helpful to be able to quickly identify objects that have similar properties. You can sort objects by parameter in Table View, then select all objects that have a specific parameter value in common by selecting up or down from an object in the list. For example, suppose you want to select all ST positions in a project. You would navigate to the project, click the Position tab in Table View, and double-click on the Role parameter column header. The position’s roles sort from low (ST) to high (PM), showing all the ST positions at the top of the list. Now you can make changes to all ST positions by selecting the bottom one and choosing Select Up on the right-click menu.

To sort data in Table View
1. Navigate to the program, project, or organization in the Model Pane.
2. Navigate to the appropriate tab in Table View.
3. Double-click the column heading for the parameter you want to sort. You might need to scroll right to see the parameter column.
To sort the data in the opposite direction, double-click in the column header again.

**To sort a subset of objects in Table View**

1. In Table View, double-click the column header of the parameter you want to sort by.
   
   All objects are sorted by that parameter.

2. In the Model Pane, select the objects using a selection box or the Shift-Select method.

3. Right-click in the Table View and click Sort Select.
   
   The subset of objects you selected in the model are listed at the top, sorted by that parameter. The remaining objects are listed below, also sorted by that parameter.

**To select data above or below a specific object in Table View**

1. Right-click the object in Table View.

2. On the right-click menu, choose the appropriate selection option:
   
   - To select just that object in the model, click Select this Row.
   - To select all objects above that object in the Table View list, click Select Up.
   - To select all objects below that object in the Table View list, click Select Down.
   - To select all objects of that type in the model, click Select All.

**Setting Multiple Object Properties with Table View**

Table View provides a quick and easy way to set the properties of multiple objects simultaneously. First, you can view all objects that have a specific parameter setting by sorting them in Table View by that parameter. Then, you can change that parameter setting in a single step, using the Match options on the Table View right-click menu.

To continue the example in the previous section, suppose you want to increase the salary of all positions in a project that have the role of ST. First, you would sort the positions by role. See “Sorting and Selecting Objects with Table View” on page 330. Then you would change the salary of the Senior Project position, the
last ST position listed in the illustration below. Finally, you would right-click the Senior Project position’s salary parameter and click Match Up. All ST position salaries would change to 60.

<table>
<thead>
<tr>
<th>Position</th>
<th>Name</th>
<th>Description</th>
<th>Role</th>
<th>Application Experience</th>
<th>FTE</th>
<th>Salary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Contracts</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Cost</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>HSE</td>
<td>ST</td>
<td>Medium</td>
<td>4</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Project</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Regulatory</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Construction</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Construction</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Discipline</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Document</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Operations</td>
<td>ST</td>
<td>Medium</td>
<td>2</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Planning and</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Project</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>QA/QC</td>
<td>ST</td>
<td>Medium</td>
<td>4</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Senior Project</td>
<td>ST</td>
<td>Medium</td>
<td>1</td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Business Unit Manager</td>
<td>FM</td>
<td>Medium</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Project Manager</td>
<td>FM</td>
<td>Medium</td>
<td>3</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

To set multiple properties simultaneously in Table View

1. Sort the objects so that you are viewing all the objects whose properties you want to set.
2. Select either the top or bottom object of the objects you want to modify, depending on whether the other objects you want to modify are listed above or below it.
3. Change the appropriate parameter for that object and press Enter.
4. Right-click the parameter you just changed and click Match Up or Match Down.

All objects either above or below that object have the appropriate parameter changed to match the parameter you modified.

Exporting Table View Data to a Spreadsheet File

You can copy Table View data and paste it into a spreadsheet application, where you can manipulate it with the application’s controls. The data in the spreadsheet application is then independent of the SimVision data. You must have a spreadsheet open in the destination application to paste the SimVision data into.
The following illustration shows a project's position data exported to an Excel spreadsheet.

To export Table View data into a spreadsheet file
1. Right-click in Table View.
2. On the right-click menu, click Copy Data.
   The data in the current Table View tab is copied onto the Clipboard.
3. Open the spreadsheet application.
4. Click Paste.
   The SimVision data is pasted into the spreadsheet.

Example of Using Table View to Change a Single Property
Suppose a simulation is showing that your unstaffed project is behind schedule because of the Manufacturing position’s backlog. You want to make alterations to that position’s application experience and FTE assignment to reduce the backlog. Navigate in the Model Pane to the project that contains the Manufacturing
Using Table View

Viewing, Sharing, and Printing Model Data

position, then view the Position tab for that project in Table View. You can then change the Application Experience and FTE property values for that position on the fly.

Re-run the simulation with Table View still displayed. If the position backlog is not satisfactorily reduced, you can make further changes, and so on.

Example of Using Table View to Change Multiple Properties

Suppose a project is about to lose its only position with business skills. In response to this, you want to flag all tasks that have the Business skill associated with them as high-risk tasks, by changing their Uncertainty property to High. To do this, you would take the following steps.

To change the Uncertainty property of all Business skill tasks

1. Open Table View for the appropriate project.
2. On the Tasks tab, double-click twice in the Skills column header to sort the skills in ascending alphabetical order and put the Business skill tasks at or near the top of the list, as shown in the following illustration.
3 Scroll right until you see the Uncertainty property, and select High as an Uncertainty property value for the bottom task in the group of tasks with Business skills. This is the Evaluate Business Case in the following illustration (note that columns have been truncated to view the Skills and Uncertainty columns side-by-side). Press Enter to accept the new property value.

<table>
<thead>
<tr>
<th>Task</th>
<th>Name</th>
<th>Skills</th>
<th>Uncertainty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluate Business Case</td>
<td>Business</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Prepare AFE Approval</td>
<td>Business</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Prepare AFE Approval</td>
<td>Business</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>AFE Approval Cycle (60 days)</td>
<td>Business</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>AFE Approval Cycle (90 days)</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Preliminary Project Plans</td>
<td>Generic</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Optimize and Define Engineering</td>
<td>Generic</td>
<td>Medium</td>
<td></td>
</tr>
</tbody>
</table>

4 Right-click the High field you just set.
5 Click Match Up.

SimVision changes the Uncertainty property for the other four tasks to High.

<table>
<thead>
<tr>
<th>Task</th>
<th>Name</th>
<th>Skills</th>
<th>Uncertainty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluate Business Case</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Prepare AFE Approval</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Prepare AFE Approval</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>AFE Approval Cycle (60 days)</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>AFE Approval Cycle (90 days)</td>
<td>Business</td>
<td>High</td>
<td></td>
</tr>
<tr>
<td>Preliminary Project Plans</td>
<td>Generic</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Optimize and Define Engineering</td>
<td>Generic</td>
<td>Medium</td>
<td></td>
</tr>
</tbody>
</table>

Sharing SimVision Information

You can share SimVision case and simulation information in the following ways:

- Save charts as Web sites.
- Import models from older versions of SimVision.
- View simulation results in spreadsheets—View simulation results in text files that you can open in spreadsheet applications, such as Microsoft Excel.
- View cases in Microsoft® Project—Save individual cases as Microsoft Project files.
- View simulation charts in presentation applications—Copy and paste simulation charts into presentation applications such as Microsoft PowerPoint.
- View simulation charts as XML data—Save charts as Results XML files that a browser can display.
Saving Charts as Web Sites

You can save all open charts as a Web site with a page for each open chart and an index that lists the pages. Graphical charts, such as the Gantt and Backlog charts, are saved as images. You can specify whether to save them as JPEGs (.jpg files, the default), Windows Bitmaps (.bmp files), Targa (.tga) files, or pixel image (.pcx) files. Text charts, such as the statistics charts, are saved as tables, each on its own Web page. For example, the following illustration shows a project’s Position Statistics chart saved as a table on a Web page.

To save open charts as a Web site
1. Run a simulation and open all the charts you want to include in the site.
2. On the Chart Window’s File menu, click Save All.
3. In the Save All Charts dialog box, select an image size.
4. Select an image type if you want BMP, TGA, or PCX rather than the default JPEG.
5. Leave Create Web Index selected if you want an index of Web pages in the site.
6 Enter or browse for a folder to store the Web site in. If you click the Browse button, you can select the folder in the Browse For Folder dialog box.

7 Click OK in the Save All Charts dialog box.

The Web site is created as a file called index.html in the location you specified. If you click on the index file, the site contents are listed in your Web browser. Click on a link to see the page containing that chart.
Importing Models from Older Versions of SimVision

If you need to use information from older versions of SimVision whose workspace file formats may be incompatible with the current version, you can save these workspaces as SimVision XML (VPX) files. You can then import the VPX files into the current SimVision workspace.

**To save a workspace as a VPX file**

1. On the File menu, click Export VPX.
   - The Save As dialog box appears.
2. Type, browse for, or select the filename to save.
3. Click OK.
   - The program with all its cases is saved as a file with a VPX extension that you can open in SimVision.

**To open VPX files in SimVision**

1. On the File menu, click Import VPX.
   - The Open dialog box appears.
2. Type, select, or browse for the VPX file to open.
3. Click Open.
   - The VPX file opens as a program with all its cases in the current workspace.

Sharing Information with Spreadsheet Files

You can save statistical case data in a comma-separated text data (CSV) file that you can open in any spreadsheet application. You can also merge data from an existing CSV file back into a program.

You can copy the contents of any Gantt chart and paste it into a spreadsheet file.
Saving Case Data as a Comma-Separated Text Data File

In the CSV file, the case data is organized into a matrix where the top row contains labels of elements of the model and the leftmost column contains labels of all property and statistical data present, as shown in the following example.

When you save simulation data as a CSV file, you can choose to save backlog and demand data as well as statistical data. Backlog and demand are shown in minutes at regular time intervals throughout the program duration, which naturally...
increases the size of the CSV file considerably. The time intervals are specified in
the program’s behavior file. The following example shows a CSV file that includes
time-stepped data for the program and its objects.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>(units)</td>
<td>program-stats</td>
<td>start-stats</td>
</tr>
<tr>
<td>2</td>
<td>IDs:</td>
<td>0</td>
<td>312213266</td>
</tr>
<tr>
<td>3</td>
<td>time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>communication-prob</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>5</td>
<td>communication-risk</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>6</td>
<td>completed</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>7</td>
<td>functional-except-prob</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>8</td>
<td>primary-position-id</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>9</td>
<td>project-except-prob</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>10</td>
<td>te-staffed</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>11</td>
<td>te-unstaffed</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>12</td>
<td>maximum-backlog</td>
<td>(null)</td>
<td>(null)</td>
</tr>
<tr>
<td>13</td>
<td>maximum-backlog-time</td>
<td>(null)</td>
<td>(null)</td>
</tr>
</tbody>
</table>

You can choose whether to save simulation data for a whole program, a single
project, or a single organization. If you select a whole program, the CSV file
contains data for all the program’s projects and organizations. If you select a
single project or organization, the file displays data for all the contents of the
project or organization, such as positions, tasks, and departments.

**To save simulation results as a CSV file**

1. Run the simulation.
2. In the Chart Window, select the program, project, or organization whose
   simulation data you want to view in the CSV file.
3. Click Save As.
   The Save As dialog box appears.
4. Type a name for the chart file.
5. To save the chart somewhere other than the default SimVision folder
   location, press the Browse button and navigate to the target location.
6. Under Type, select CSV.
7. To save backlog and demand simulation data at each simulator time step,
   select Time Step Data.
8. Click OK.
9. To open the CSV file in Microsoft Excel, double-click the chart file in
   Windows Explorer. Alternatively, click Open on the Excel File menu, select
   Text Files from the Files of Type list, select the CSV file, and click Open.
Merging Data from an Existing CSV File
You can incorporate simulation data from an existing CSV file into the current program. The projects and organizations from the CSV file are added as new tabs in the current program.

To merge data from an existing CSV file
1. Open the program you want to merge the data into.
2. On the File menu, click Merge Data from CSV.
   The Open dialog box appears.
3. Type, select, or navigate for the CSV file.
4. Click Open.
   The projects and organizations from the CSV file are added as new tabs at the bottom of the Model pane.

Copying Gantt Chart Data into a Spreadsheet File
You can export Gantt chart data columns into any spreadsheet file. The following illustration shows how a project’s Gantt chart data looks when pasted into an Excel spreadsheet. Notice that some resizing of columns is necessary within Excel. Fields where the data does not fit often show hash marks (#####). You can resize these fields by double-clicking on the vertical bar between header columns.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Milestone</td>
<td>WBS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Task Name</td>
<td>WBS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Meeting Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Start</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Weekly Coordination</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Chip Spec.</td>
<td>HW Project</td>
<td>Ethan</td>
<td>Holt</td>
<td>ASIC</td>
<td>Hard</td>
<td>21</td>
<td>11/1/2004</td>
<td>#</td>
</tr>
<tr>
<td>7</td>
<td>HW Spec Complete</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Partition Chip &amp; Floor Chip</td>
<td>Arch</td>
<td>Anil</td>
<td>Patel</td>
<td>ASIC</td>
<td>Hard</td>
<td>42</td>
<td>11/1/2004</td>
<td>#</td>
</tr>
<tr>
<td>9</td>
<td>HW Design Coord : HW Design</td>
<td>Project</td>
<td>Ethan</td>
<td>Holt</td>
<td>ASIC</td>
<td>Hard</td>
<td>141</td>
<td>1/12/2005</td>
<td>#</td>
</tr>
<tr>
<td>10</td>
<td>Write-Verify Synth 5 Logic</td>
<td>Test</td>
<td>Dest</td>
<td>Paul</td>
<td>Voss</td>
<td>ASIC</td>
<td>Hard</td>
<td>22</td>
<td>5/20/2005</td>
</tr>
<tr>
<td>11</td>
<td>Assembly &amp; Verify Vectors</td>
<td>Justron</td>
<td>Justin</td>
<td>Wu</td>
<td>ASIC</td>
<td>Hard</td>
<td>13</td>
<td>1/4/2005</td>
<td>#</td>
</tr>
<tr>
<td>12</td>
<td>Full Chip Synthesis</td>
<td>Logic</td>
<td>Dest</td>
<td>Paul</td>
<td>Voss</td>
<td>ASIC</td>
<td>Hard</td>
<td>47</td>
<td>2/21/2006</td>
</tr>
<tr>
<td>13</td>
<td>Ship Tapes to Foundry</td>
<td>ASIC</td>
<td>Hard</td>
<td>22</td>
<td>1/12/2005</td>
<td>#</td>
<td>#</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Eng. Layout &amp; Phys.</td>
<td>Foundry</td>
<td>Li</td>
<td>Larry</td>
<td>Peer</td>
<td>ASIC</td>
<td>Hard</td>
<td>8</td>
<td>2/21/2005</td>
</tr>
<tr>
<td>15</td>
<td>Sim Gates</td>
<td>Foundry</td>
<td>Ty</td>
<td>Laura</td>
<td>Jen</td>
<td>ASIC</td>
<td>Hard</td>
<td>70</td>
<td>2/21/2005</td>
</tr>
<tr>
<td>16</td>
<td>Generate Test Vector</td>
<td>Foundry</td>
<td>Ty</td>
<td>Laura</td>
<td>Jen</td>
<td>ASIC</td>
<td>Hard</td>
<td>28</td>
<td>5/20/2005</td>
</tr>
<tr>
<td>17</td>
<td>Release for Alpha Test</td>
<td>ASIC</td>
<td>Hard</td>
<td>6/30/2005</td>
<td>11/1/2004</td>
<td>#</td>
<td>#</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Finish</td>
<td>ASIC</td>
<td>Hard</td>
<td>5/30/2005</td>
<td>5/31/2002</td>
<td>#</td>
<td>#</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To copy and paste Gantt chart data into a spreadsheet file
1. Run a simulation.
2. In the Chart Window, display the Gantt chart to export.
3. Open the spreadsheet application.
4. On the right-click menu, click Copy Data.
5  Click in the spreadsheet application where you want to paste the data, for example, in the top-left field of a blank Excel spreadsheet.
6  Click Paste.
   The data pastes into the spreadsheet.
7  Resize columns if necessary.

Sharing Information with Microsoft® Project
You can export an individual case directly to Microsoft Project. All data is exported except meetings, since the primary impact of meetings in SimVision concerns coordination rather than direct work.

You can also import data from Microsoft Project 2000 and create a SimVision model from it. Naturally, the nature of the Microsoft Project data determines the usability of the SimVision model. You can import data from Microsoft Project 98 and earlier versions, but since these versions produce slightly different database formats than Microsoft Project 2000, useful SimVision models cannot be guaranteed in all cases. Contact SimVision technical support (TechSupport@epm.cc) for more current information concerning the compatibility of these file formats.
Exporting Data to Microsoft Project

The following illustrations show a model in SimVision and the resulting exported file in Microsoft Project.
To export a case to Microsoft Project

1. In the Model pane, make sure the tab for the case you want to export is selected.
2. On the File menu, click Export as MS Project.
   The Save As dialog box appears.
3. Specify the name and location of the MPX file you want to save the case as.
4. Click Save.
   A simulation runs and the MPX file is saved in the specified location.
5. To view the results, open the MPX file in Microsoft Project.

Importing Data from Microsoft Project

To import data from Microsoft Project, you must first save the data as a Microsoft® Access Database (*.mdb) file.

To import data from Microsoft Project

1. In Microsoft Project, click Save As on the File menu.
To copy a program
1. Save the project in SimVision.
2. Using Windows Explorer, navigate to the program’s .vpm file. The default location is C:\Program Files\ePM\SimVision\Models.
3. Select the file and copy it.
4. Paste the file in another location on your hard drive or network.

You can also use the Save As menu option in SimVision to rename and relocate the .vpm file.

To share a project model by sending the workspace file
1. Save the project in SimVision.
2. E-mail the .vpm file, or make it available in a network location for others to view and edit.

Copying Charts
You can copy simulation charts and paste them into applications such as Microsoft® Word or Microsoft® PowerPoint. Graphical charts, such as the backlog and bar charts, are copied as images. Text charts, such as the statistics and work hours charts, are copied as text. For example, if you copy a statistics chart and paste it into Microsoft Excel, each cell in the chart occupies a spreadsheet cell.

In the Gantt charts, you can save the data columns as spreadsheet information, or you can save the visible area as an image. Because the Gantt charts are usually so large, you might need to scroll to the area you want copied, as only the area
currently visible in the Chart Window is copied. For information on saving the
data columns as spreadsheet data, see “Copying Gantt Chart Data into a
Spreadsheet File” on page 342.

**To copy charts**
1. Run a simulation.
2. In the Chart Window, open the chart to copy.
3. On the Edit menu, click Copy.

   The chart is copied as an image or text that you can paste into another
   application.

**To copy a Gantt chart**
1. Run a simulation.
2. Open the Gantt chart you want to copy (Program, Project, Organization,
   Department, or Person Gantt).
3. Scroll to the area of the chart you want to copy.
4. On the Edit menu, click Copy.

   The visible area is saved as an image file that you can paste into another
   application.

**Saving Charts in XML Format**
You can save simulation charts as an XML file. This allows you to do detailed data
analysis if you have the requisite analysis tools.

**To save simulation charts as an XML file**
1. Run the simulation.
2. In the Chart Window, click Save As on the File menu.
3. In the Save As dialog box under Save as Type, click Results XML (*.vrx).
4. Click Save.

**Printing Models**
SimVision supports Windows system printers. You can print over multiple pages
and change the paper size, the orientation of the printed model, and other settings
for printing. You can also preview a model before printing to check margins or
other layout issues. Use the Page Setup dialog box to set paper size and source,
orientation, and margins. To set other print options that your printer provides,
such as control over print quality, and number of copies, use the Properties
button in the Page Setup dialog box.
Quick Printing
You can quickly print models, if the default paper size and orientation suit your needs, by simply clicking Print on the Standard toolbar or the File menu and then clicking OK in both the Multi Page Print Scaling and the Print dialog boxes. The default paper size is whatever the default printer uses, and the default paper orientation is Portrait.

Printing on Multiple Pages
By default, the contents of the Model pane print on a single page. You can choose to print a model on multiple pages, specifying either an equal or an unequal number of horizontal and vertical pages. For example, a long narrow model might print best over 2-3 horizontal and 4-6 vertical pages. The model is scaled symmetrically to fit the number of pages. This can lead to blank pages being produced if the model shape does not fit the shape of the pages.

To print a model on multiple pages
1. On the File menu, click Print.
   The Multi Page Print Scaling dialog box appears.
2. To print on an equal number of horizontal and vertical pages, do the following:
   • Select Print on Multiple Pages.
   • Use the arrows to cycle to the number of pages wide (horizontal pages) and pages tall (vertical pages).
3. To print on an unequal number of horizontal and vertical pages, do the following:
   • Select Print on Multiple Pages.
   • Use the arrow to cycle to the number of pages wide (horizontal pages) and a different number of pages tall (vertical pages).
4. Click OK in the Multi Page Print Scaling dialog box.
   The Print dialog box appears.
5. If all print settings are correct, click OK in the Print dialog box.
   The model prints over the specified number of pages.

Changing Paper Size and Source
You can change the size of the paper you print on in the Page Setup dialog box. If a model is too large to fit within the margins of the sheet of paper, the model is tiled over multiple sheets of paper. You can see this tiling when you preview the printout. See “Previewing Model Printouts” on page 351. If the model is smaller than the paper size, it prints flush with the left and top sides or margins, leaving white space at the bottom, the right side, or both.
To set paper size and source
1 On the File menu, click Page Setup.
   The Page Setup dialog box appears.
2 Select a paper size from the list.
3 To print from the printer’s automatic feeder tray, select Paper Tray from the Source list.
4 To manually feed paper, for example, headed notepaper, select Manual Feed from the Source list.
5 Click OK.

Changing Page Orientation
You can print your model with the long edge of the paper either horizontal or vertical. This setting, called page orientation, is often available in the Properties dialog box for your printer as well as in the SimVision Page Setup dialog box. Changing the setting in the Page Setup dialog box overrides the setting in the Properties dialog box.

To change printed page orientation
1 On the File menu, click Page Setup.
   The Page Setup dialog box appears.
2 Under Orientation, click Portrait or Landscape.
3 Click OK.
   This setting is saved with the case.

Viewing Page Boundaries
By default, SimVision marks the boundaries of printed pages with dashed lines in the Model pane. You can turn off these page boundaries.

To turn off page boundaries
• On the View menu, clear Page Boundaries.
   If you scroll down in the Model pane, you can see that there is no longer a dashed line indicating the page boundary.
Setting Margins

Margins affect the amount of white space around a model on the paper. There is a small unprintable area around the edges of a sheet of paper where printers cannot print. You can see how the margins and the paper size affect how a model will print by previewing the model, using Print Preview on the File menu.

Margins create some white space so that objects close to the edge are moved in to the printable area. If the model printout tiles over multiple sheets of paper, margins affect the four sides of every sheet of paper. You can set different margins for the top, bottom, left, and right sides. For example, you might want the following model more centered on the printed pages.

```
1
On the File menu, click Page Setup.

2
Under Margins, enter values for the left, right, top, and bottom margins. The model prints flush with the left and top margins.

3
To see the effect of the margin change, click Print Preview on the File menu.Margins can cause the model to tile over more than one sheet of paper.

4
Click OK.
```
Previewing Model Printouts

You can preview how a model will print. If a model tiles over multiple sheets of paper, you can preview the pages two at a time, switch between the pages, and view pages at two magnifications.

To preview before printing

1. On the File menu, click Print Preview.
   The Multi Page Print Scaling dialog box appears.
2. Set the number of pages to print on. See “Printing on Multiple Pages” on page 348.
3. Click OK in the Multi Page Print Scaling dialog box.
   The Print Preview window displays the pages of the model printout as they were last previewed.
4. To move between pages of a multipage printout, click Next Page or Prev Page.
5. To switch between a one- and two-page display, click One Page or Two Page (the button toggles between the two).
6. To enlarge and reduce the preview, click Zoom In or Zoom Out.
7. To print the model, click Print and click OK in the Print dialog box.
8. To return to the workspace, click Close.

Printing Simulation Charts

When you print a simulation chart from the Chart Window, you see the default Windows Print dialog box with which you can specify the usual options such as printer, printer properties, page range, and number of copies.

To print the chart view

1. Run the simulation.
2. In the Chart Window, click Print.
   The Print dialog box appears.
3. Set print options, as in all Windows applications.
4. Click OK.
5. To preview how a chart looks before you print it, click Print Preview on the Chart Window’s File menu.
CHAPTER 10

Customizing SimVision

Both the SimVision workspace and Chart Window are highly customizable. The workspace contains a variety of tools that help you model, such as the grid and snap tools. You can also customize models by adding hyperlinks and annotations to objects, changing object appearance, and using templates.

To customize SimVision you can:

- Set the size of the model’s canvas.
- Display and hide workspace elements.
- Arrange open windows.
- Use the grid and snap tools.
- Customize workspace toolbars.
- Set options for new workspaces.
- Save versions of the workspace.
- Customize and save views of the Chart Window.
- Add hyperlinks to shapes.
- Use templates.
- Annotate a model with geometry, text, images, legends, and revision blocks.
- Generate a revisions report.
- Position and align objects.
- Change object appearance.
Customizing the Workspace

SimVision has a highly customizable interface. You can customize the display and contents of windows in the workspace. You can also customize toolbars and menus, as you can for any Windows application.

Setting Canvas Size

When you are creating a model, you can specify the size of the canvas, or modeling area, in English or metric units.

To set canvas size

1. On the View menu, click Canvas Size.
   
   The Canvas Size dialog box appears.

   
   Canvas Size dialog box with options for English (Feet, Inches) and Metric (Centimeters, Millimeters), with Canvas Width and Canvas Height set to 19.996 and 13.996 respectively.

2. Click to select either English or Metric units.
3. If using English units, click to select either Feet or Inches.
4. If using Metric units, click to select either Centimeters or Millimeters.
5. Enter values for Canvas Width and Canvas Height, which are measured in the selected units.
6. Click OK.

Displaying Workspace Elements

The SimVision workspace has several default elements that you can hide to increase your working area. These are the Standard toolbar, the Status Bar, the Tree pane and the Properties pane. You can also hide the other toolbars that display by default. See “Customizing Workspace Toolbars” on page 358.

To show and hide workspace elements

1. To show or hide the Standard toolbar, click Standard Toolbar on the View menu.
2. To show or hide the Status Bar, click Status Bar on the View menu.
3. To hide the Tree pane, click the close box at the top of the pane. To show it again, click Tree Pane on the View menu.
Customizing the Workspace

4 To hide the Properties pane, click the close box at the top of the pane. To show it again, click Properties Pane on the View menu.

Arranging Open Model Panes

When you have multiple programs open, you can arrange their Model panes in a tiled or cascading format. Tiling the panes gives each pane equal space in the workspace. Cascading panes means you see the title bars of all open panes and can switch between them.

If you have minimized open Model panes so they appear as icons, you can arrange the icons evenly at the bottom of the workspace. This is useful if you are working in one program but want other open programs easily available. You can restore iconized Model panes to their previous size, or maximize them so they fill the workspace.

You can also switch between open Model panes using the SHIFT+TAB key combination.

To cascade open Model panes

1 On the Window menu, click Cascade.
   All open models appear in the Model pane with the most recently opened model visible and other open models stacked behind it.

2 To switch between windows, click their title bars.
**To tile open Model panes**

1. On the Window menu, click Tile.

   All open models appear in the Model pane with the most recently opened model active.

2. To switch between windows, click their title bars.

**To arrange open Model pane icons**

1. On the Window menu, click Arrange Icons.
Customizing the Workspace

2  All model icons appear at the bottom of the Model pane with the most recently opened model active.

3  To restore a model icon to its previous size, click its Restore icon.
4  To maximize a model icon so it fills the Model pane, click its Maximize button.
5  To close a model icon, click its Close button.

Using the Grid and Snap

You can turn on a grid of dots in the Model pane, and change its properties, such as its density and color. You can also choose whether to show or hide the grid in new models. When you turn the grid on in the current model, it appears only in the current page (program, project, or organization) of the current case. When you turn the default grid on for new models, it appears on all pages of all cases.

Snapping to the grid helps you to position objects in the Model pane and is on by default, though you can turn it off. There is also an angle snap that limits object rotation to increments of fifteen percent.

To turn the grid on
•  On the View menu, click the Grid option so it’s checked.
A grid of dots appears in the current page (program, project, or organization) of the current program.

**To turn the grid on in all new models**

1. On the Tools menu, click Options.
   
   The Options dialog box appears.

2. On the View tab, click Default Show Grid so it's checked.

3. Click OK.
   
   All new models display with a grid on every page.

**To set grid properties**

1. On the View menu, click Grid Properties.
   
   The Grid Properties dialog box appears.

   ![Grid Properties dialog box]

2. To turn the grid off, clear the Grid Visible option.

3. To turn off snapping to the grid, clear the Snap to Grid option.

4. To turn off angle snapping, clear the Angle Snap option.

5. To change the grid color, click the down-arrow by Grid Color and select a color from the palette, or click Other to define your own color.

6. To change grid spacing, enter new values for Horizontal and Vertical. Grid spacing is measured in the current units of measurement.

7. Click OK.

**Customizing Workspace Toolbars**

You can display as many toolbars as you like in the workspace, either floating or docked. If you need more space for modeling, you can hide toolbars. You can also create toolbars and modify them by moving, removing, or adding buttons, removing or adding separators, and resizing edit boxes.
You cannot delete toolbars that SimVision provides, but you can remove tools you have added to them, and you can reset all toolbars to their defaults. You can choose to save changed toolbars immediately or have them saved by default when you exit SimVision.

**To display and hide toolbars**

1. On the Tools menu, click Customize.
   The Customize dialog box appears.
2. On the Toolbars tab, select the toolbars you want to see so they have check marks.
3. Click OK.

**To create a new toolbar**

1. On the Tools menu, click Customize.
   The Customize dialog box appears.
2. On the Toolbars tab, click New.
3. In the Toolbar Name box, enter a name for the new toolbar and click OK.
   The new toolbar appears floating at the top left of the workspace. You can drag it to a side of the workspace to dock it.
4. On the Command tab of the Customize dialog box under Categories, select the category of tools you want. Categories are merely ways of grouping tools—they do not correspond to actual toolbar names.
   All the tools available in that category appear, even if they belong to another toolbar.
5. Drag tools into the new toolbar in the workspace to add them to the toolbar.
6. The toolbar resizes to accommodate the tools you add to it. You can insert tools in any order and move them within the toolbar. If an edit box forces the toolbar to be wider than you want, drag a side of the edit box and resize it. To remove a tool, drag it from the toolbar to the workspace or other blank space (If you drop it on another toolbar, it’s added to that toolbar).
7. To add a separator, move a tool slightly to the left or right. To remove an existing separator, move the tool next to it.
8. To turn on or off the display of tooltips in the new toolbar, use the Show Tooltips option on the Toolbars tab of the Customize dialog box.
9. To turn on or off tool borders, use the Cool Look option (the cool look is borders off).
To customize an existing toolbar

1. On the Tools menu, click Customize.

   The Customize dialog box appears.

2. On the Toolbars tab of the Customize dialog box, click the toolbar you want to customize if it’s not already displayed.

3. Modify the toolbar as described in the previous procedure.

4. Click OK when you are satisfied with the toolbar.

5. To save all customized toolbars, click Save Now on the Tools menu. Otherwise, the toolbars are saved on exit by default. (To prevent this from occurring, clear the Save On Exit option on the Tools menu.

To delete a custom toolbar

1. On the Tools menu, click Customize.

   The Customize dialog box appears.

2. On the Toolbars tab, select the toolbar you created.

3. Click Delete.

To reset toolbars to their defaults

- On the Tools menu, click Reset to Defaults.

Setting General Options

You can choose the number of recently used files to display at the bottom of the SimVision File menu, and the number of hyperlinks to display when you right-click in the workspace. Changes to the number of recently used files do not take effect until you restart SimVision. Setting the number of hyperlinks to display does not affect how many you can define. For more information, see “Adding Hyperlinks to Objects” on page 369.

To set General options for a model

1. On the Tools menu, click Options.

   The Options dialog box appears.

2. On the General tab, set options as follows:

   - Enter a number of most recently used files to display on the File menu.
   - Enter the number of hyperlinks that should display on an object’s right-click menu.
Customizing SimVision

Setting View Options
You can turn the grid of dots on or off for new models. Grids do not print, so you don’t need to turn them off before printing. Setting the grid visibility option controls the grid on all pages of new models and is different from showing or hiding the grid on the current page of the current model, which you do by clicking Grid on the View menu. You can also choose whether objects snap to the grid.

You can highlight the critical path in a program or project (that is, the set of projects or tasks that determine the total program or project duration). By default, the critical path highlight is a red line 3 pixels wide. In very large models, this highlighting might not be clearly visible, so you can change the thickness of the line. You can also choose whether to highlight the assignment links for tasks on a project’s critical path. This helps you to see which positions are responsible for critical-path tasks.

When you select an object in Table View or on the right-click menu, the object is, by default, centered in the Model pane. The advantage of this is that you can quickly view or change the selected object’s properties. However, the centering can be a hindrance in some instances, such as when you are selecting links with Table View to move them. You can turn off this default behavior so that objects are not centered when selected with Table View or the right-click menu.

When you have resized rows and columns in the Properties pane, you can choose to retain the new sizes when you select objects of the same type. You can also make this true for Table View, retaining conditions such as the active tab and its scroll position when you switch between cases.

To change view options for models
1  On the Tools menu, click Options.
   The Options dialog box appears.
2  Click the View tab.
3 Set view options as follows:
   • To turn off the grid of dots in new models, click the Default Show Grid option so it’s not checked.
   • To turn off the default snapping of objects to the grid, click the Default Snap to Grid option so it’s not checked.
   • To change the width of the critical path highlight, enter a new width in pixels beside Set Path Width.
   • To highlight the assignment links for tasks on the critical path, click Highlight Assignments so it’s checked.
   • To turn off the default centering of objects selected using Table View or the right-click menu, click Center on Selection so it’s not checked.
   • To turn off the retention of Properties pane row and column resizing, click Retain Property Pane Sizing so it’s not checked.
   • To turn off the retention of the Table View’s state when moving between cases, click Retain Table View Sizing so it’s not checked.

4 Click OK.

**Setting Options for New Models**

You can specify what you see when you launch SimVision—the last program that was open, no program, or a new program—and what you see when you create a new program, organization, or project. For example, you can choose whether new programs are empty or contain default Start and Finish milestones, a project, and an organization. The advantage of starting with an empty program is that you can paste in other models or model elements.

You can also choose whether to display a model legend and a company logo, and if so, whether to replace the default ePM logo or add additional logos. To replace the ePM logo, you can specify an alternate default logo that appears on every program pane. To add additional logos, you need to add the appropriate graphics files to each pane on which you want the logos to appear. See “Adding Images” on page 379.

**To specify the default startup model**

1 On the Tools menu, click Options.
   The Options dialog box appears.

2 Click the Models tab.

3 Select whether to have SimVision launch with the last file that was open, no file, or a new program.

4 Select whether new programs should be empty or contain default Start and Finish milestones, a project, and an organization.

5 Select whether new organizations should be empty or contain a default department.
6 Select whether new projects should be empty or contain default Start and Finish milestones, a position, a meeting, and a task.

7 To have new models open with a default legend, click Insert Model Legend in New Models so it’s checked.

8 Click OK.

To turn off the company logo display
1 On the Tools menu, click Options.
   The Options dialog box appears.
2 Click the Models tab.
3 Click Insert Default Image in New Models so it’s not checked.
4 Click OK in the Options dialog box.
   New models open with no company logo.

To replace the default logo in new models
1 On the Tools menu, click Options.
   The Options dialog box appears.
2 Click the Models tab.
3 Make sure Insert Default Image in New Models is selected and click Browse beside Default Image File.
   The Open dialog box appears.
4 Select, enter, or browse for the logo’s image file, and click Open.
   The filename replaces ePM_Logo.jpg in the Options dialog box.
5 Click OK in the Options dialog box.
   The specified logo appears at the top left of all new model pages. If the logo is too large, select it and drag a corner to resize it. You will need to do this on each page of the model.

Setting Options for Symbols
Symbols in SimVision comprise object symbols, data blocks and labels.

Object symbols are the icons that represent milestones, tasks, successor links, and so on. You can change the way objects and links appear in the Model pane by changing their line, fill, and font properties. When you make these changes in the Options dialog box, the changes take effect in all objects subsequently added to models. You can also change individual object properties, for example, by using color to distinguish between positions that represent just a single FTE and positions that represent multiple FTEs. For more information on changing object and link appearance, see “Changing Object Appearance” on page 389.
Data blocks are visible pieces of data in a model for particular objects. For example, the data block on a successor link shows the type (Finish-Start or Start-Start) and any lag. Task data blocks can list the work type and amount. You can turn data blocks on and off.

Labels are the text that is included with or that you add to objects. For example, a project has the default label ProjectN. You can change the default text label properties, such as font, size, and color. You can also choose whether label text wraps or gets truncated when it is too long for the label box.

**To change object symbol appearance**

1. On the Tools menu, click Options.
    
    The Options dialog box appears.
2. Click the Symbols tab.
3. Under Default Appearance, click the icon for the object or link whose appearance you want to change.
4. Make changes in the object’s Defaults dialog box. For more information, see “Changing Object Appearance” on page 389.
5. Click OK in both dialog boxes.
6. To return object symbols to the factory defaults, click Reset to Factory Defaults on the Symbols tab of the Options dialog box.

**To turn data blocks off**

1. On the Tools menu, click Options.
    
    The Options dialog box appears.
2. Click the Symbols tab.
3. Click the Data Blocks On by Default option so it’s not selected.
4. Click OK.

**To modify label text properties**

1. On the Tools menu, click Options.
    
    The Options dialog box appears.
2. Click the Symbols tab.
3. Set label text font, font size, color, justification, and line pattern.
4. Choose whether to have label text wrap by default.
5. Click OK.

**Setting Default Object Properties**

Every object has a set of properties that display in the Properties pane when you select the object in the model pane. You can set default properties for objects. For example, you might want every project in the program to have the same
probability values, or every position to have the same salary. You can save your settings as a default properties (SVD) file, which you can then have loaded on startup, or load for any open program.

**To set default object properties**

1. On the Tools menu, click Options.
2. In the Options dialog box, click the Properties tab.
3. Under Default Properties, click the object or link whose properties you want to set defaults for.
4. In the object’s Default Properties dialog box, set the properties.
5. Click OK in the Default Properties dialog box.
6. To reset all properties to factory defaults, click Reset to Factory Defaults on the Default Properties tab of the Options dialog box.
7. To save your settings as a default properties (SVD) file, click Save and enter a filename in the Save dialog box.
8. To load an existing default properties file, click Load and select, enter, or browse for the SVD file of your choice in the Open dialog box.
9. To use the current defaults for all new models, click Use This File At Startup so it’s checked.
10. Click OK.

**Setting Simulation Options**

When you run a simulation, any errors or warnings are displayed in a Fix Simulator Errors and Warnings dialog box. You can choose whether to display non-critical warnings along with critical ones. For more information, see “Fixing Simulation Errors” on page 141.

You can choose to have usage and demand statistics for positions tracked per task in the simulation charts. If you turn this setting on, the hours that each position works on each of its tasks is shown in the Program Resource Statistics and Project Resource Statistics charts. For more information, see “Reading a Project’s Resource Statistics Chart” on page 228.

**To set simulation options**

1. On the Tools menu, click Options.
2. In the Options dialog box, click the Simulator tab.
3. To show non-critical warnings as well as critical ones when simulating, turn on Display Non-Critical Simulator Warnings.
4. To display position usage and demand statistics by task in the simulation charts, select the Show Resource Usage by Task option.
5. Click OK.
Saving Versions of the Workspace
The workspace is the configuration of SimVision modeling windows. You can save different workspace configurations of the same model. For example, you can undock the Tree and Properties panes and the toolbars and use them as floating windows. To increase the size of the Model pane, you can hide panes and toolbars. See “Displaying Workspace Elements” on page 354.

To save a version of the workspace
1. Change the workspace view and settings as required.
2. On the File menu, click Save As.
3. In the Save As dialog box, save the workspace as a VPM file.
4. Click Save.

To undock and dock the panes and toolbars
1. With the mouse, grab the double horizontal line at the top of the pane.
2. Drag the pane away from the edge of the workspace until it floats as a window.
3. To resize the floating window, drag any corner.
4. To dock a floating window, grab the window title and drag to a side of the workspace until the window docks.

Customizing the Chart Window
The Chart Window displays a huge amount of information, so you will probably want to customize the layout to display data you view frequently. For example, you can maximize chart viewing space by hiding the Tree View and Chart Bar and using the Create menu to open and close charts. You can also change the order and size of charts in the Chart Bar, move the Chart Bar to a different location such as beneath the Tree View, and customize the toolbars. When you make changes to the chart view, the changes persist when you close and reopen the Chart Window. You can also save and name customized chart views to use later. You can have multiple Chart Windows open simultaneously, for example if you want to simulate two cases of a program and view a set of charts for each.

Maximizing the Chart Viewing Space
You can hide the Tree View and Chart Bar, which is particularly useful when you are viewing Gantt charts.

To view and hide the Chart Bar
1. Click the X at the top right of the Chart Bar.
2. Use the Create menu to display charts or click Chart Bar on the View menu to display the chart bar again.
Customizing the Chart Window

To view and hide the Tree View
1. To hide the Tree View, click the X at the top right.
2. To redisplay, click Tree View on the Chart Window’s View menu.

Changing Chart Icon Order and Size
You can reorder the charts in the Chart Bar. This makes particular sense for programs and projects, which have enough charts to require scrolling. For example, if you typically look at backlog charts a lot, you might want to move them further up the Chart Bar to avoid scrolling down to see them. You can also make the chart icons larger.

To reorder the chart icons
1. Run a simulation.
2. In the Chart Window, select the object you want to rearrange the chart icons for.
3. Drag and drop the chart icons in the Chart Bar until they are in the required order.

To make chart icons larger
1. Run a simulation.
2. Right-click in the Chart Bar and click Large Icons.

Moving the Chart Bar
You can undock the chart bar and have it floating anywhere in the Chart Window, or dock it on either side of the window, such as above or beneath the Tree View.

To move the Chart Bar
1. Run a simulation.
2. In the Chart Window, grab the two horizontal lines at the top of the Chart Bar and drag it.
   The Chart Bar becomes a floating window.
3. Drop the Chart Bar as a floating window anywhere in the Chart Window, or dock it on either side of the window.

Customizing Chart Window Toolbars
Charts displays with the tools appropriate for the chart’s data. However, you can display all chart toolbars with any chart, using the Customize dialog box.
To customize Chart Window toolbars

1. Run a simulation.
2. In the Chart Window, click Customize on the Tools menu.

   The Customize dialog box lists the chart toolbars you can display.

3. Select the toolbars to display and click OK.

Saving the Chart View

The chart view is the layout of charts, toolbars, and panes in the Chart Window. You can save and name multiple layouts to use in different circumstances.

To save a chart view

1. Run a simulation.
2. Customize the Chart Window as desired.
3. On the File menu, click Save As.

   The Save As dialog box appears.

4. Navigate to where you want the file saved. The default location is the Models folder.
5. Enter a file name. The default is SVCharts.
6. From the Save File As list, select a file type. The options are JPEGs, Bitmaps, Targa files, CSV files, and ePM Results XML files.
Adding Hyperlinks to Objects

You can hyperlink SimVision shapes—such as projects, milestones, and tasks—to documents, Web sites, and to other shapes within the same case of the program. You can also hyperlink annotations—lines, boxes, ellipses, text, images, and revision blocks. Adding a hyperlink to an object allows you to connect that object to pertinent information. For example, you might want to hyperlink a project to the project specification document. You could hyperlink a position to the resumes of the persons staffing the position. Or you could link a company logo annotation to the client’s Web site.

Adding Hyperlinks

The following instructions apply to all shapes—projects, organizations, departments, milestones, tasks, positions, meetings, and ghosts—and to annotations. You can also add hyperlinks to persons, but as they are not graphically represented as shapes in the Model pane, the procedure is slightly different. For more information, see “Defining Persons” on page 117.

To add a hyperlink to a shape or annotation

1. In the Model pane, right-click the shape or annotation to which you want to add a hyperlink, and click Hyperlinks.
2. In the Hyperlinks dialog box, click Add Hyperlink.
A blank row appears for the hyperlink.

3. To hyperlink to a file or Web site, enter a URL or filename under Hyperlinks, or click the Browse (...) button to navigate to the file.

4. To hyperlink to a shape within the same case, click Ref under Local.

5. The Choose Local Object Reference dialog box lists the objects in the current case. Click the plus (+) signs to expand the lists of objects.

6. Select the object to hyperlink to and click OK.

7. If you hyperlink to another shape, the shape name appears as the hyperlink description. To change or enter a description, click in the Description field and type. If you enter no description for a hyperlink to a document or Web site, the filename or URL rather than the description appears in the shape’s right-click menu.

8. To add another hyperlink, repeat steps 2-4.

9. Click OK.

Shapes have solid black targets to indicate the presence of a hyperlink. Annotations show no visual change.
To delete a hyperlink from a shape or annotation

1  In the Model pane, right-click the shape or annotation and click Hyperlinks.
2  In the Hyperlinks dialog box, select the hyperlink to delete by clicking its number. To delete multiple hyperlinks, select their numbers.
3  Click Delete Hyperlinks.
4  Click OK.

Navigating to Hyperlinks
You add hyperlinks to an object using the Hyperlinks dialog box, where you specify the URL, filename, or shape to link to and a description of the destination if necessary. When you right-click an object that has hyperlinks in the Model pane, any hyperlinks on the object are listed at the bottom of the right-click menu. If you enter a description for the hyperlink in the Hyperlinks dialog box, the description appears on the right-click menu. If you leave the hyperlink’s Description field blank, the text of the hyperlink itself appears on the menu, for
example a URL or filename. Clicking a hyperlink on the menu navigates to the hyperlinked object, opens the hyperlinked file, or opens your default web browser to the page specified by the hyperlink.

Using Templates

Template models allow you to derive models easily from other models by cutting and pasting model data, and to build generic models from which you can create customized models. A template is simply a model in which you have flagged certain properties as template properties. When you open a template model and run the Template Wizard, you are prompted for the values of the template properties.

For example, you could create a template model for installing a generic computer server. If you had a specific server to install, you could open the model and set the template properties to the appropriate values for installing that server.
Creating Templates

The objects that have template properties are programs, projects, positions, tasks, and meetings. When you are in Template Mode, checkboxes appear in the Properties pane beside template properties for these objects. For example, the following illustration shows the template properties for a task.

Be aware that if you make template properties out of lockable properties, overrides to the locked template properties will be ignored. You can change the value in the Properties pane but the simulator will use the top-level locked value. It is thus inadvisable to make template properties out of lockable properties. For more information on lockable properties, see “Using Property Locks” on page 248.

You can delete all the template data from a model if you want to start over.

To create a template model

1. Create a new model or open an existing one that has properties you want in the template.
2. On the Model menu, click Template Mode.
The Properties pane displays checkboxes beside the program properties you can make into template properties.

<table>
<thead>
<tr>
<th>Program</th>
<th>Value</th>
<th>Unites</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Date</td>
<td>10/00/2010</td>
<td></td>
</tr>
<tr>
<td>Trials</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WBS Separaor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WBS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Work Day</td>
<td>8</td>
<td>Hours</td>
</tr>
<tr>
<td>Work Week</td>
<td>5</td>
<td>Days</td>
</tr>
<tr>
<td>Team Expereince</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Centralization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Formalization</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Matrix Strength</td>
<td>Medium</td>
<td></td>
</tr>
<tr>
<td>Info Exchange Prob.</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Loss Prob</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Functional Error Prob</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Project Error Prob</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Behavior File</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>Revisions</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Escalators</td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>

3 To add a property to the template, click its check box so it’s checked.

The Description dialog box appears.

4 Type a description for the property so that anyone using the template will know what that property does and how it should be set.

5 Click OK.

6 When you have added all the program template properties, select any projects you want to add properties from and add their properties to the template.

7 Go to each project page and add template properties for the positions, tasks, and meetings.

8 When you have added all the template properties, save and name the template model. It is a .vpm file like any other model, so be sure to use its name to distinguish it as a template.

**To clear template data from a template model**

1 Open the template model.

2 On the Model menu, click Clear Template Data.

3 A message warns you that you cannot undo this action. Click Yes to delete the template data, or No to cancel the deletion.
Creating a Model from a Template

To create a model from a template, you use the Template Wizard, which prompts you for the values of the template properties in a template model. The Template Wizard is only available if the current model has template data in it. Similarly, if you are creating a template in Template Mode, the Template Wizard is not available.

To use a template model

1. On the File menu, click Open Workspace.
2. Select, enter, or navigate for the template model and click Open.

The Template Wizard opens, prompting you for the first template property it detects.

The Wizard indicates the property name and what object it belongs to. The Description is the text that was entered when the property was added to the template.

4. To set the property value, enter data for New Value.
5. To get help on the property, click What is this Object Type?
6. Click Next to cycle through the template properties, or Finish to create the template with just this property set.
7. When you click Next, the Template Wizard prompts you for a value for the next property.
8. When you click Finish, the template model displays. Save and name it immediately to avoid overwriting the template with subsequent changes.
Annotating Models

You can annotate models with text, lines, boxes, ellipses, images from graphics files, revision blocks, and legends. For example, you could use a text annotation to include some explanatory notes at the top of each organization, or use the image annotation to add a client’s logo to a project. Revision blocks allow you to keep track of changes you make to the model. You can also generate Revision Reports from these blocks. See “Generating a Revision Report” on page 384.

Adding Lines, Boxes, and Ellipses

You can change the color, style, and width of lines and you can make them transparent. Note that you can only change the style of a line if the line width is zero. Changing these line properties also affects the borders of boxes and ellipses, but only of those you explicitly change.

To draw a line in a model

2. Click in the Model pane to start the line, then drag and release to end the line.
3. To draw an orthogonal line, hold down the SHIFT key while drawing the line.

To draw a box in a model

1. On the Model menu, click Annotations>Box.
2. Click in the Model pane to start the box, then drag and release to complete the box.
3. To draw a square, hold down the SHIFT key while drawing the box.

To draw an ellipse in a model

2. Click in the Model pane to start the ellipse, then drag and release to complete the ellipse.
3. To draw a circle, hold down the SHIFT key while drawing the ellipse.

To change line properties

1. In the Model pane, right-click the line, box, or ellipse and click Properties.
   The Properties dialog box appears.
2. To make the line transparent, click Transparent so it’s checked and click Apply.
3. To change the line color, click the down-arrow beside Color and select a color from the palette, or click Other to define your own color.
4. To change the line style, make sure the line width is zero and select a style from the list.
5. To change the line width (for solid lines only), select a width from the list. The thinnest line possible has a width of one pixel.
6 To view the position and size of the line, box, or ellipse, click the Position and Size tab of the Properties dialog box.
7 Click OK.

**To fill a box or ellipse**

1 In the Model pane, right-click the box or ellipse and click Properties. The Properties dialog box appears.

2 To fill the box or ellipse with a pattern, use the Fill tab of the Properties dialog box as follows:
   • To add a pattern, select from the Hatch list.
   • To change the color of the pattern’s lines, select a color from the Foreground Color palette.
   • To change the background color, select a color from the Background Color palette.
   • To make the foreground pattern transparent, click Transparent Fill so it’s checked.
   • To make the background color transparent, click Transparent Background so it’s checked.
3 Click OK.
Using the Visual Model Delineators

By default, project models contain horizontal blue bars that visually delineate the positions, meetings, and tasks. These bars are just annotations in the model, and you can move, remove, or modify them. They are useful in complex models for helping to separate the areas of the model. For information on modifying or deleting them, see “Adding Lines, Boxes, and Ellipses” on page 376.

Adding Text

You can give text a border and change properties such as font, size, text color and background color and pattern.

To add and manipulate text

1. On the Model menu, click Annotations>Text.
2. In the Model pane, click where you want to add the text.
   
   A text box appears with the default word Text.
3. Double-click the word Text and start typing. The new text is centered in the text box.
4. To add another line of text, add a second text box.
5. When you have finished typing, click elsewhere in the Model pane to deselect the text box.
6. To move the text box, select it and drag it.
7. To resize the text box, select it and drag a handle. This has no effect on the text size.
8. To delete the text, select the text box and press Delete.
To change text properties
1. Right-click the text and click Properties.
   The Properties dialog box appears.
2. To add a border to the text, clear the Transparent checkbox on the Line tab.
3. To change the border color, click the down-arrow beside Color and select a color from the palette, or click Other to define your own color.
4. To change the border line style, select a style from the list.
5. To change the border width (for solid line borders only), select a width from the list. The thinnest line possible has a width of one pixel.
6. To fill the text box with a pattern, use the Fill tab of the Properties dialog box as follows:
   • To add a pattern, select from the Hatch list.
   • To change the color of the pattern’s lines, select a color from the Foreground Color palette.
   • To change the background color, select a color from the Background Color palette.
   • To make the foreground pattern transparent, click Transparent Fill so it’s checked.
   • To make the background color transparent, click Transparent Background so it’s checked.
7. To change text style, use the Font tab of the Properties dialog box as follows:
   • To change text font, select a font from the list.
   • To make text bold or italic, select Bold, Italic, or Bold Italic from the list.
   • To change text size, select a size from the list.
   • To underline text, click Underline so it’s checked.
   • To strike out text, click Strike-Out so it’s checked.
   • To change text color, click the down-arrow beside Text Color and select a color from the palette, or click Other to define your own color.
8. To view the position and size of the text, click the Position and Size tab.
9. Click OK.

Adding Images
You can add an image from a graphics file on your system, and move and resize the image in the Model pane. Supported graphics file types are: JPEGs (.jpg, .jif, or .jpeg), PC eXchange files (.pcx), Targa files (.tga), Bitmap files (.bmp, .dib), and icon files (.ico). For example, you might want to add the client’s logo to the model below or beside the default ePM logo.

To add an image to a model
   The Open dialog box appears.
2. Type, select, or browse for the image’s file name.
3. Click OK.
The cursor in the Model pane has an image icon attached to it.

4 Click in the Model pane to place the image.
5 To move the image, select it and drag.
6 To resize the image, select it and drag a selection handle.
7 To view the image’s position and size, right-click the image and click Visual Properties.

The Properties dialog box shows the position and size.
Adding Revision Blocks

You can keep track of the revisions you make to a model using revision blocks. A revision block is an annotation that lists the date, author, and title of all revisions made to that program, project, or organization, plus a contact name (usually the creator of the model). For example, you might want to keep track of the date that various projects were added to a program, as shown in the following illustration.

Once you add a revision block to a program, project, or organization, you can keep updating the block with new revisions as you make changes. You can also hyperlink revision blocks to other models, documents, or Web sites and you can customize the font in the block just like any font in a model. See “Adding Text” on page 378.

If modelers have added revisions using the program, project, or organization Revision property, the revision block lists these revisions when you add the block to a model. The advantage of using a revision block is that you can print it with
the model. The advantage of using the Revision property is that you can generate a revision report that lists more detailed information about each revision. See “Generating a Revision Report” on page 384.

**To add a revision block**

1. Below the Model pane, click the tab for the case to add the revision block to.
2. Click the tab for the program, project, or organization to add the revision block to.
3. On the Model menu, click Annotations>Revision Block.

   The cursor has an A attached to show you are about to place a revision block.

4. Click anywhere in the model to place the block. You can move the block by placing the cursor over it and dragging.

   The block is highlighted and its properties appear in the Properties pane.

5. With the revision block still selected, click Edit beside the Revision Block property in the Properties pane.
6. In the Revision List dialog box, click Add Revision.
7. To give the revision a date other than today’s, click in the Date field and enter a new date or use the arrows to scroll to one.
8. Under Title, type the text that describes the revision. This is the text that will appear in the model.
9. Type a description for further identification of the revision if required. This text is for reference only and does not appear in the model.
10. Click OK.

   The revision text and date are added to the revision block.

**To add a revision to an existing revision block**

1. Below the Model pane, click the tab for the case that contains the revision block.
2. Click the tab for the program, project, or organization that contains the revision block.
3. Click to select the revision block.

   The block is highlighted and its properties appear in the Properties pane.
4. Click Edit beside the Revision property.
The Revisions List dialog box lists the revisions in the block.

5 Click Add Revision.
6 To give the revision a date other than today’s, click in the Date field and enter a new date or use the arrows to scroll to one.
7 Enter the revision’s author.
8 Under Title, type the text that describes the revision. This is the text that will appear in the model.
9 Under notes, type a description for further identification of the revision if required. This text does not appear in the model’s revision block, but does appear in the Revisions Report.
10 Click OK.

The revision text and date are added to the revision block.

To add a hyperlink to a revision block

1 Right-click the revision block and click Hyperlinks.
2 In the Hyperlinks dialog box, click Add Hyperlink.

A blank row appears.

3 Enter a URL or filename, or click the Browse button to navigate to a file.
4 To enter a description for the hyperlink, click in the Description field and enter a description. If you enter no description, the URL appears in the revision block’s right-click menu instead of the description.
5 To add another hyperlink, repeat steps 3-5.
6 Click OK.

The revision block shows no visual change, but the hyperlinks are listed on the right-click menu.
Generating a Revision Report

Revision Reports list revision information for the selected project or organization. If nothing is selected in the Model or Tree View, the report lists revisions for the enclosing object—the project if a project pane is displayed, the organization if an organization pane is displayed, and the program and its projects and organizations if the program pane is displayed.

To generate a revision report

1. Below the Model pane, click the tab for the case to generate a revision report for.
2. Click the tab for the program, project, or organization to generate the report for.
3. On the Model menu, click Revision Report. If a revision block is selected, this option will not be available.

The report lists the revision dates and titles for the appropriate objects.

Adding Legends

You can add legends to a model’s program, project, or organization page. You can make the legend small, medium, or large and hyperlink it to information such as a document or Web site.

To add a model legend

1. Below the Model pane, click the program, project, or organization tab for the page where you want to add the legend.
2. On the Model menu, click Annotations>Legend.
3. Click in the Model pane where you want the legend.
4. A blank legend appears.
5. To move the legend, click and drag it.
6. To resize the legend dynamically, drag a grip on the selected legend.
Positioning and Aligning Objects

SimVision provides a variety of tools that allow you to position and align objects in the Model pane so that the model is easier to read. For example, you might want to align all meetings vertically down the right side of the model, or distribute a set of milestones evenly. You can group objects and manipulate them as a single unit, and you can view an object that is obscured by another by moving the obscured object forward in the draw order.

Moving and Resizing Objects

SimVision provides several ways to move an object or a selection of objects. Dragging and dropping provides quick movement without emphasis on accuracy, although if you have Snap to Grid turned on, you can align objects precisely with the grid. The Nudge tools allow you to move objects with single pixel precision.

You can resize objects by selecting them and dragging their selection handles. For example, you might want to enlarge a task to accommodate a long task name, or reshape a link to prevent it from obscuring other objects.

When you physically move an object, it remains linked to any objects it is connected to. To move an object in the sense of moving a position from one task assignment to another, you must move the appropriate links.

**To move an object by dragging**

1. In the Model pane, select the object.
   - Selection handles appear around the object.
2. Drag the object and drop it in a new location.
3. Click elsewhere in the Model pane to deselect the object.

**To resize an object**

1. In the Model pane, select the object.
   - Selection handles appear around the object.
2. Drag a selection handle until the object is the required size.
3. Click elsewhere in the Model pane to deselect the object.

**To reshape a link**

1. In the Model pane, select the link.
   - Selection handles appear along the link.
To move objects a pixel at a time

1. In the Model pane, select the object.
2. On the Nudge toolbar, click Nudge Up to move the object up a pixel.
3. Click Nudge Down to move the object down a pixel.
4. Click Nudge Left to move the object left a pixel.
5. Click Nudge Right to move the object right a pixel.

Aligning Objects

You can align objects along the tops, bottoms, left or right sides, and along their vertical or horizontal centers. You can also align objects with the top, bottom, sides, or center of another object. You must select two or more objects before the Align tools are available.

When you select objects for alignment, SimVision needs a reference object. It uses as reference the last (most recently drawn) object in the draw order. This is also the case if you use a selection window to select objects for aligning. See “Ordering Objects” on page 389.

To align objects horizontally

1. Select the objects to align, either with a selection window or by clicking the first object and SHIFT-CLICKING the others.
2. To align the objects along their tops, click Align Top on the Align toolbar.
3. To align the objects along their horizontal middles, click Align Middle on the Align toolbar.
4. To align the objects along their bottoms, click Align Bottom on the Align toolbar.

To align objects vertically

1. Select the object you want to align with as the reference object. If you use a selection window, the last object in the draw order is used as the reference object.
2. If you clicked to select the reference object, use the SHIFT key to select the other objects to align.
3. To align the objects along their left sides, click Align Left on the Align toolbar.
4. To align the objects along their vertical centers, click Align Center on the Align toolbar.
5. To align the objects along their right sides, click Align Right on the Align toolbar.
Distributing Objects
You can distribute objects so they have equal vertical or horizontal space between them. You must select three or more objects to distribute. You can also make objects the same width, the same height, or exactly the same size.

When you select objects to make them the same width, height, or size, SimVision needs a reference object. It uses as reference the last (most recently drawn) object in the draw order. This is also the case if you use a selection window to select objects for resizing. See “Ordering Objects” on page 389.

To distribute objects horizontally
1. In the Model pane, select the objects (you must select more than two).
2. On the Structure toolbar, click Space Across.
   The selected objects are distributed evenly with equal horizontal space between them.

To distribute objects vertically
1. In the Model pane, select the objects (you must select more than two).
2. On the Structure toolbar, click Space Down.
   The selected objects are distributed evenly with equal vertical space between them.

To give objects equal width
1. In the Model pane, select the objects (you must select more than two).
2. On the Structure toolbar, click Same Width.
   The selected objects are made the same width as the last object in the draw order.

To give objects equal height
1. In the Model pane, select the objects (you must select more than two).
2. On the Structure toolbar, click Same Height.
   The selected objects are made the same height as the last object in the draw order.

To make objects exactly the same size
1. In the Model pane, select the objects (you must select more than two).
2. On the Structure toolbar, click Same Size.
   The selected objects are made the same width and height as the last object in the draw order.
**Grouping Objects**

When you group objects, you can manipulate them as a single unit. When you select a group, its handles appear and you can resize or move the group.

When you group objects, the group becomes a single object in terms of the draw order. You can move the grouped objects as a single unit forward or back in the draw order. See “Ordering Objects” on page 389. For example, it might be useful to group all the meetings in a complex model so you can move them as a unit if they are getting in the way. All their Meeting Participant links move accordingly when you move the grouped meetings, as shown in the following illustrations.

To group objects

1. In the Model pane, select the objects either with a selection window or by clicking the first object, then SHIFT+CLICKING subsequent objects.

The objects appear as a group with a single border and set of handles for moving and resizing the group as a unit.
To ungroup a group

1. In the Model pane, select the group.
2. On the Structure toolbar, click Ungroup.

The objects appear selected, each with their own border and set of handles for moving and resizing.

Ordering Objects

All objects in the Model pane have a place in the draw order. The object that you draw or add first is first in the draw order. The object created or added most recently is last in the draw order and displays on top of objects further back in the draw order. For example, milestones are usually added first and are thus first in the draw order and display behind tasks and positions, which are later in the draw order.

You can change an object’s place in the draw order, moving it forward or back, or to the beginning or end of the draw order. Grouping objects can change the draw order, because the group behaves as a single object in the draw order. See “Grouping Objects” on page 388.

To move an object in the draw order

1. In the Model pane, select the object.
2. On the Structure toolbar, click Front to move the object to last (displays on top) in the draw order.
3. Click Back to move the object to first (displays behind all others) in the draw order.
4. Click Forward to move the object one step forward in the draw order.
5. Click Backward to move the object one step back in the draw order.

Changing Object Appearance

You can change how objects and links appear in the Model pane by changing their properties. For example, when presenting a case to a client, you could make all tasks with critically long durations red instead of yellow. Or you might want to distinguish positions that represent multiple FTEs from those that represent only one. To change the appearance of all objects or links of a certain type, change the symbol icon’s properties on the Symbols tab of the Options dialog box. These changes take effect for all objects of that type subsequently added to models. For more information, see “Setting Options for Symbols” on page 363.

Changing Shape Borders

You can change the color, line style, and width of shape borders, or you can hide the borders.
To change shape borders
1  In the Model pane, right-click the shape and click Properties.
   The Properties dialog box appears.
2  To hide the shape’s border, click Transparent on the Line tab so it’s checked.
3  To change the border color, click the down-arrow beside Color and select a color from the palette, or click Other to define your own color.
4  To change the border line style, select a style from the list.
5  To change the border width (for solid line borders only), select a width from the list. The thinnest line possible has a width of one pixel.
6  Click OK.

Filling Shapes
You can change the solid fill color of shapes, or add a patterned fill. For example, you might want to color-code positions according to function or phases of a project. For all of the supplied patterns, or hatches, you can change the colors of the background and of the hatch lines.

To fill shapes with colors and patterns
1  In the Model pane, right-click the shape and click Visual Properties.
   The Properties dialog box appears.
2  To fill the shape with a pattern, use the Fill tab of the Properties dialog box as follows:
   • To add a pattern, select from the Hatch list.
   • To change the color of the pattern’s lines, select a color from the Foreground Color palette.
   • To change the background color, select a color from the Background Color palette.
   • To make the foreground pattern transparent, click Transparent Fill so it’s checked.
   • To make the background color transparent, click Transparent Background so it’s checked.
3  Click OK.

Changing Shape Text Style
All shapes have default names, which you can replace with your own text. You can also specify the font, size, color, and style of this text.

To change the style of text in a shape
1  In the Model pane, right-click the shape and click Properties.
   The Properties dialog box appears.
2  To change text style, use the Font tab of the Properties dialog box as follows:
   • To change text font, select a font from the list.
Customizing SimVision

Changing Link Appearance
You can change the color, style, and width of links.

**To change link appearance**
1. In the Model pane, right-click the link and click Properties.
   The Properties dialog box appears.
2. To hide the link, click Transparent on the Line tab so it’s checked.
3. To change the link’s color, click the down-arrow beside Color and select a color from the palette, or click Other to define your own color.
4. To change the link’s line style, select a style from the list.
5. To change the link’s width (for solid line borders only), select a width from the list. The thinnest line possible has a width of one pixel.
6. Click OK.
A P P E N D I X  A

Forms

The following forms help you to gather the information you need before building a model.

- Program information form
- Project information form
- Organization form
**Program Information Form**

Before building a SimVision case of a program, capture the following program information:

<table>
<thead>
<tr>
<th>Program Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Name</td>
</tr>
<tr>
<td>Business Objective</td>
</tr>
<tr>
<td>Program Milestones: Milestone: Date:</td>
</tr>
<tr>
<td>1.</td>
</tr>
<tr>
<td>2.</td>
</tr>
<tr>
<td>3.</td>
</tr>
<tr>
<td>4.</td>
</tr>
<tr>
<td>5.</td>
</tr>
<tr>
<td>2.</td>
</tr>
<tr>
<td>3.</td>
</tr>
<tr>
<td>4.</td>
</tr>
<tr>
<td>5.</td>
</tr>
<tr>
<td>2.</td>
</tr>
<tr>
<td>3.</td>
</tr>
<tr>
<td>4.</td>
</tr>
<tr>
<td>5.</td>
</tr>
</tbody>
</table>
# Project Information Form

For each project in the program, capture the following information:

<table>
<thead>
<tr>
<th>Project Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name:</td>
</tr>
<tr>
<td>Organization:</td>
</tr>
<tr>
<td>Start Date:</td>
</tr>
<tr>
<td>Finish Date:</td>
</tr>
<tr>
<td>Positions:</td>
</tr>
<tr>
<td>1. 6. 11. 16.</td>
</tr>
<tr>
<td>2. 7. 12. 17</td>
</tr>
<tr>
<td>3. 8. 13. 18</td>
</tr>
<tr>
<td>4. 9. 14. 19</td>
</tr>
<tr>
<td>5. 10. 15. 20</td>
</tr>
<tr>
<td>Milestone 1: Name:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Task 1:</td>
</tr>
<tr>
<td>Task 2:</td>
</tr>
<tr>
<td>Task 3:</td>
</tr>
<tr>
<td>Task 4:</td>
</tr>
<tr>
<td>Task 5:</td>
</tr>
<tr>
<td>Task 6:</td>
</tr>
<tr>
<td>Task 7:</td>
</tr>
<tr>
<td>Task 8:</td>
</tr>
<tr>
<td>Task 9:</td>
</tr>
<tr>
<td>Task 10:</td>
</tr>
<tr>
<td>Milestone 2: Name:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Task 1:</td>
</tr>
<tr>
<td>Task 2:</td>
</tr>
<tr>
<td>Task 3:</td>
</tr>
<tr>
<td>Task 4:</td>
</tr>
<tr>
<td>Task 5:</td>
</tr>
<tr>
<td>Task 6:</td>
</tr>
</tbody>
</table>
### Project Information

<table>
<thead>
<tr>
<th>Task 7:</th>
<th>Responsible Position:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 8:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 9:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 10:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Milestone 3:</td>
<td>Name:</td>
</tr>
<tr>
<td>Task 1:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 2:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 3:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 4:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 5:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 6:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 7:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 8:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 9:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 10:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Milestone 4:</td>
<td>Name:</td>
</tr>
<tr>
<td>Task 1:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 2:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 3:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 4:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 5:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 6:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 7:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 8:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 9:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 10:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Milestone 5:</td>
<td>Name:</td>
</tr>
<tr>
<td>Task 1:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 2:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 3:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Task 4:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 5:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 6:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 7:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 8:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 9:</td>
<td>Responsible Position:</td>
</tr>
<tr>
<td>Task 10:</td>
<td>Responsible Position:</td>
</tr>
</tbody>
</table>
Organization Form
For each organization in the program, capture the following information:

<table>
<thead>
<tr>
<th>Organization Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization Name</td>
</tr>
<tr>
<td>Description:</td>
</tr>
<tr>
<td>Departments:</td>
</tr>
<tr>
<td>1.</td>
</tr>
<tr>
<td>2.</td>
</tr>
<tr>
<td>3.</td>
</tr>
<tr>
<td>4.</td>
</tr>
<tr>
<td>5.</td>
</tr>
<tr>
<td>6.</td>
</tr>
<tr>
<td>7.</td>
</tr>
<tr>
<td>8.</td>
</tr>
<tr>
<td>9.</td>
</tr>
<tr>
<td>10.</td>
</tr>
</tbody>
</table>
Appendix B

Troubleshooting Simulation

By default, when you run a simulation the simulator validates the model, then runs the number of trials specified by the program’s Trials property.

If there are errors or missing links, you must fix them before continuing with the simulation. If there are warnings, you can either fix the problems, or make a note of the warnings and click Continue to continue the simulation.

The following tables list:

• Simulation errors
• Simulation warnings
## Simulation Errors

The following table lists the errors that the simulator can detect. Errors must be fixed before you can continue with the simulation.

<table>
<thead>
<tr>
<th>Error</th>
<th>Meaning</th>
<th>Suggested Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No successor links</td>
<td>The task or milestone is not linked to a successor task or milestone.</td>
<td>Link the task or milestone to another task or milestone with a successor link. See “Linking Tasks and Milestones” on page 56.</td>
</tr>
<tr>
<td>No predecessor links</td>
<td>The task or milestone has no predecessor task or milestone.</td>
<td>Add a successor link from another task or milestone. See “Linking Tasks and Milestones” on page 56.</td>
</tr>
<tr>
<td>Multiple start objects</td>
<td>There is more than one program or project Start milestone.</td>
<td>Delete the excess Start milestones.</td>
</tr>
<tr>
<td>Multiple finish objects</td>
<td>There is more than one program or project Finish milestone.</td>
<td>Delete the excess Finish milestones.</td>
</tr>
<tr>
<td>No start object</td>
<td>The program or project is missing a Start milestone.</td>
<td>Add a Start milestone.</td>
</tr>
<tr>
<td>No finish object</td>
<td>The program or project is missing a Finish milestone.</td>
<td>Add a Finish milestone.</td>
</tr>
<tr>
<td>No primary work assignment</td>
<td>The task has no responsible position assigned.</td>
<td>Assign the task to a position. See “Assigning Positions to Tasks” on page 59.</td>
</tr>
<tr>
<td>Multiple primary assignments</td>
<td>The task has more than one responsible position assigned.</td>
<td>To view a task’s primary assignments, right-click the task in the Model pane and click Assignments. Delete the appropriate assignment (solid blue) link.</td>
</tr>
<tr>
<td>Loop detected in process network</td>
<td>There is a loop somewhere in the chain of successor links, such that the work will never complete. Loops can span projects, which makes them even more difficult to trace.</td>
<td>To help you trace the link, you can right-click each milestone and task in the Model pane and click Tasks and Successors. This lists the linked milestones or tasks.</td>
</tr>
<tr>
<td>Bad link from % to %</td>
<td>The link is not attached at one or both ends. This is visible in the Model pane as a red arrow at the unattached end.</td>
<td>Drag the red arrow in the Model pane to the appropriate target so that it snaps to the target and the arrow turns black.</td>
</tr>
<tr>
<td>Error</td>
<td>Meaning</td>
<td>Suggested Solution</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multiple supervisors</td>
<td>The position has more than one supervisor link attached to it.</td>
<td>To view the supervisors, right-click the position in the Model pane and click Supervisions. Delete the incorrect supervisor (solid black angled) link.</td>
</tr>
<tr>
<td>Sub unit of multiple departments</td>
<td>A department is a subdepartment of multiple departments.</td>
<td>To see which departments the department is linked to by a Subdepartment link, right-click the department in the Model pane (on an Organization page) and click Departments. Delete the incorrect Subdepartment (solid pink) link.</td>
</tr>
<tr>
<td>Invalid staff reference</td>
<td>The position is staffed with an invalid person. For example, the person might have been deleted from the case.</td>
<td>Check that the person exists in a department. If not, either create them, or delete them from the positions. If this error occurs, please report it to <a href="mailto:support@epm.cc">support@epm.cc</a>.</td>
</tr>
<tr>
<td>Duplicate Object IDs</td>
<td>The data model is corrupt because a simulator object has duplicate IDs.</td>
<td>Use the Set Unique IDs feature (on the Model menu) to make the IDs unique.</td>
</tr>
<tr>
<td>Invalid first milestone</td>
<td>A meeting references an invalid Start milestone.</td>
<td>Change the value of the meeting's First Meeting property to a valid milestone.</td>
</tr>
<tr>
<td>Invalid last milestone</td>
<td>The meeting references an invalid Finish milestone.</td>
<td>Change the value of the meeting's Last Meeting property to a valid milestone.</td>
</tr>
<tr>
<td>Work volume exceeds program maximum</td>
<td>During simulation, a task has a work volume 10 times greater than the CPM program work volume.</td>
<td>Subdivide the task into multiple tasks. Check for excessive exceptions or rework.</td>
</tr>
<tr>
<td>Sim duration exceeds program maximum</td>
<td>During simulation, a task is taking 10 times longer than the total CPM program duration.</td>
<td>Subdivide the task or assign more positions to it. Check for excessive exceptions or rework.</td>
</tr>
<tr>
<td>Supervisory task must have a Finish-Finish link to terminate</td>
<td>The successor link from the last task in a process to the process's supervisory task is of type Start-Start or Finish-Start instead of Finish-Finish.</td>
<td>Navigate to and select the offending successor link and change its type to Finish-Finish in the Properties pane.</td>
</tr>
<tr>
<td>Possible loop with Start-Start link from Supervisory task:</td>
<td>A Start-Start link is connected from a supervisory task to the beginning of a supervised work process task.</td>
<td>Change the link so it is connected from the supervised task to the supervisory task.</td>
</tr>
<tr>
<td>Error</td>
<td>Meaning</td>
<td>Suggested Solution</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Can't simulate position with 0 FTE</td>
<td>A position has an FTE value of 0.</td>
<td>Change the FTE property value for the position to 1 or greater.</td>
</tr>
<tr>
<td>Simulator can't find root object for model</td>
<td>The model is fatally corrupted at the program level.</td>
<td>Try creating a new workspace and cutting/pasting objects, testing the simulation as you go. It might however be necessary to start over from scratch.</td>
</tr>
<tr>
<td>Behavior file load failed</td>
<td>The file that governs program settings, such as the number of simulator trials, has not loaded properly.</td>
<td>Find the appropriate behavior file, or set the Behavior File property to one of the default behavior files included with the application.</td>
</tr>
<tr>
<td>Loop detected containing this link</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loop detected containing this project</td>
<td></td>
<td></td>
</tr>
<tr>
<td>This link has invalid &quot;from&quot; endpoint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>This link has invalid &quot;to&quot; endpoint</td>
<td></td>
<td></td>
</tr>
<tr>
<td>This link has invalid endpoints</td>
<td>The link has invalid to and from endpoints.</td>
<td></td>
</tr>
<tr>
<td>Multiple department heads</td>
<td>Departments can only have one department head, denoted by the blue star in the department's Person List dialog box.</td>
<td>Delete one of the department heads and add the person back in as a regular department member.</td>
</tr>
<tr>
<td>Sub unit of multiple departments</td>
<td>The department is a subdepartment of more than one department.</td>
<td>Delete the extra subdepartment links so that the department is a subdepartment of only one department.</td>
</tr>
<tr>
<td>No department head designated</td>
<td>The department is missing a department head. If there are multiple persons in a department, there must be a department head. If there is only one person, there is no department head required.</td>
<td>Right-click the department and click Person List. In the Person List dialog box, double-click the grey box to the left of the person you want to make department head. A blue star appears, indicating that this person is now department head.</td>
</tr>
<tr>
<td>Member of sub-department link loop</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error</td>
<td>Meaning</td>
<td>Suggested Solution</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multiple team leaders specified</td>
<td>The position has multiple team leaders, denoted by a blue star by the persons in the position's Staffing dialog box.</td>
<td>Select the position and click Staffing in the Properties pane. In the Staffing dialog box, delete all team leaders but the correct one and add the persons back as regular staffing members of the position.</td>
</tr>
<tr>
<td>No team leader specified</td>
<td>The position has no team leader.</td>
<td>Select the position and click Staffing in the Properties pane. Double-click the grey box to the left of the staffing person you want as team leader. A blue star appears denoting team leader.</td>
</tr>
<tr>
<td>No role set for worker</td>
<td>The position has no value for its Role property.</td>
<td>Select the position and choose PM, SL, or ST under Role in the Properties pane. See “Setting a Position’s Role” on page 49.</td>
</tr>
<tr>
<td>Ghost task has no reference task</td>
<td>Ghost tasks must reference a task in another project.</td>
<td>Select ghost task and click Change Ref. beside Ref. Task in the Properties pane. Select a task from the appropriate project in the Choose Reference Object dialog box, and click OK. See “Connecting Projects with Ghost Tasks and Milestones” on page 257.</td>
</tr>
<tr>
<td>Ghost milestone has no reference milestone</td>
<td>Ghost milestones must reference a milestone in another project.</td>
<td>Select ghost milestone and click Change Ref. beside Ref. Task in the Properties pane. Select a milestone from the appropriate project in the Choose Reference Object dialog box, and click OK. See “Connecting Projects with Ghost Tasks and Milestones” on page 257.</td>
</tr>
<tr>
<td>Ghost Finish cannot have successor link</td>
<td>A ghost milestone that is linked to a task with a successor link is referencing the Start milestone in another project. This means that the ghost milestone is a predecessor to the Start milestone, which is not possible.</td>
<td>Select a different reference milestone. See “Adding Ghost Tasks and Milestones” on page 260.</td>
</tr>
</tbody>
</table>
### Simulation Warnings

The following table lists the warnings that the simulator can generate during simulation. If there are warnings, you can either fix the problems immediately or ignore them and continue with the simulation. Critical warnings appear for conditions that should really be rectified before continuing. Noncritical warnings appear for unusual model situations. You can choose whether to view noncritical warnings by turning them on or off in the Options dialog box.

<table>
<thead>
<tr>
<th>Error</th>
<th>Meaning</th>
<th>Suggested Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ghost Start cannot have predecessor link</td>
<td>A task is linked with a successor link to a ghost milestone that references the Finish milestone in another project. This means that the ghost milestone is a successor to the Finish milestone, which is not possible.</td>
<td>Select a different reference milestone. See “Adding Ghost Tasks and Milestones” on page 260</td>
</tr>
<tr>
<td>Invalid calendar reference</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2005, ePM, LLC
## Critical Warnings

<table>
<thead>
<tr>
<th>Warning</th>
<th>Meaning</th>
<th>Suggested Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting has no participants</td>
<td>There are no positions assigned to the meeting.</td>
<td>Link one or more positions to the meeting with meeting participant (grey dashed) links.</td>
</tr>
<tr>
<td>Position assigned to simultaneous meetings (meeting names)</td>
<td>The position is linked to more than one meeting (as listed by name) and the meetings occur at the same time.</td>
<td>Either reschedule the conflicting meetings, or assign a different position to the meeting.</td>
</tr>
<tr>
<td>Meeting date set before project begins</td>
<td>A scheduled meeting date is before the project start date. No participants will attend.</td>
<td>Select the meeting in the Model pane and change its time in the Properties pane.</td>
</tr>
<tr>
<td>Meeting date set after project ends</td>
<td>A scheduled meeting date is after the project end date. No participants will attend.</td>
<td>Select the meeting in the Model pane and change its time in the Properties pane.</td>
</tr>
<tr>
<td>Meeting duration exceeds interval, duration reduced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Functional exception probability reached VFP limit</td>
<td>The verification failure probability (VFP) for the given task has grown to the limit set in the behavior file.</td>
<td>See “Understanding the Verification Failure Probability” on page 70.</td>
</tr>
<tr>
<td>Project exception probability reached VFP limit</td>
<td>The verification failure probability (VFP) for the given task has grown to the limit set in the behavior file.</td>
<td>See “Understanding the Verification Failure Probability” on page 70.</td>
</tr>
<tr>
<td>Duration larger than 9000 days exceeds Output time data size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task finish triggered before start, negative duration set to 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Linked Ghost objects have same parent</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Noncritical Warnings

<table>
<thead>
<tr>
<th>Warning</th>
<th>Meaning</th>
<th>Suggested Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position has no primary work assignment</td>
<td>The position is not linked to any tasks.</td>
<td>Link the position to a task using a primary assignment (solid blue) link or one or more secondary assignment (dashed blue) links. Alternatively, link the position to another position with a supervision link.</td>
</tr>
<tr>
<td>Position has multiple primary work assignments</td>
<td>The position is linked with a Primary Assignment link to more than one task.</td>
<td>Either delete the extra Primary Assignment links or change them to Secondary Assignment links.</td>
</tr>
<tr>
<td>Rework assigned before task started, ignored</td>
<td>Rework is assigned to a task before it is scheduled to start. The simulator ignores the rework.</td>
<td></td>
</tr>
<tr>
<td>Invalid target milestone</td>
<td>The milestone target date is set as an offset to an invalid milestone.</td>
<td>Select the milestone and change the value of its relative Planned Date property.</td>
</tr>
</tbody>
</table>
Glossary

Activity—See Task.

Actor—See Position.

Application experience—A measure of how familiar the position or person is with similar projects.

Baseline case—A minimal network of tasks, milestones, and positions in which positions are assigned to tasks, but they are not staffed by actual people. The baseline model is intended as a high-level, simplified view of a project that you can quickly create and simulate to validate the model framework against an external CPM schedule.

Behavior file—A file that specifies the simulator’s default behavior, such as how much rework to add to tasks with exceptions.

Business drivers—A factor that influences the project in some respect, such as a limitation on its duration. For example, a pharmaceutical project to develop a new cancer drug might be driven by the imminent release of a competitor’s drug.

Canvas—A term for the area of the Model pane where you place modeling objects. You can specify canvas height and width in the Canvas Size dialog box.

Case—A specific instance of a program.

Case Comparison report—A list of the differences between two cases, shown line-by-line in tree views.

Centralization—A measure of how centralized the decision-making is in a project. For example, high centralization indicates that most decisions are made and exceptions handled by top managerial positions such as the Project Manager. Low centralization means decisions are made by individual responsible positions.

Communication—The passing of information between positions about tasks.
Communications link—A dashed green link that links two tasks, indicating that the position responsible for the first task must communicate with the other position during or at the completion of the first task.

Coordination—A combination of the information exchange generated by communication and meetings.

Coordination Volume—The predicted time during a project or program that all positions spend at meetings and processing information requests from other positions.

CPM (Critical Path Method)—A method of charting a project’s duration that accounts for direct work only, and ignores other work types and resource links such as secondary task assignment links.

CPM cost—The predicted cost of a project considering the cost of direct work for each task.

CPM duration—The predicted duration of a project accounting for direct work by primary responsible positions only.

CQI (Component Quality Index)—See FRI.

Critical path—The set of projects in a program or tasks in a project that determine the total program or project duration. Lengthening any of the projects or tasks on the critical path lengthens the program or project duration.

CSV (comma-separated text data) file—A file format in which you can save simulation charts and then open them as spreadsheets of statistical data in applications such as Microsoft Excel.

Decision wait time—The time a position waits for a response from the supervisor about how to handle an exception, plus any time the position waits for exception resolution before making the decision by default. See also Wait Volume.

Department head—The supervisor in the department. Denoted with a blue star, the department head is by default the first person added to the department. However, the designation only occurs once there is more than one person added to the department because a single-person department needs no supervisor.

Dependency report—A list of interproject dependencies, that is, how projects are linked by ghost tasks and milestones.

Dependent task—A task at the arrow end of a rework link from another task. The dependent task is so called because its success depends on the success of the connected, or driver, task.
Direct work—The original work a task requires before any exceptions are handled. Compare with rework.

Driver task—A task at the originating end of a rework link to another task. The success of the driver task determines the success of the connected, or dependent task.

Escalator—A factor by which a salary rate is increased or decreased over the program or project lifetime. You set escalators as a property of the project, organization, department, position, or person.

Exception—A situation detected by the simulator where part of a task requires additional information or a decision, or generates an error that may need correcting.

Exception handling—Involves positions reporting exceptions to supervisors and supervisors making decisions on how to deal with the exceptions.

Failure dependency link—See Rework link.

Formalization—A measure of the formality of communication in an organization. For example, high formalization indicates that most communication occurs in formal meetings.

FRI (Functional Risk Index)—A measure of the likelihood that components produced by a project have defects. Also called CQI, or Component Quality Index.

Full-time equivalent (FTE)—A measure of position or person availability to perform a task. For example, a position with an FTE value of 3 has the equivalent of 3 full-time employees to perform tasks.

Functional exception—An error that causes rework in a task but does not affect any dependent tasks.

Ghost task—A task that mimics a task in another project for the purpose of modeling project interdependencies.

Ghost milestone—A milestone that mimics a milestone in another project for the purpose of modeling project interdependencies.

Lag time—A period of time that specifies when a milestone, task, or meeting occurs relative to another milestone or task. The lag is a property of the successor link that connects the shapes, or of the meeting or milestone shape.

Legend—An annotation object that allows you to add a small legend to a program, project, or organization.
**Links**—A set of color-coded arrows that represent the relationships between shapes.

**Matrix Strength**—A measure of the level of supervision in a project or program, and a reflection of the structure of the organization. Low matrix strength means that positions are located in skill-based functional departments and supervised directly by functional managers. High matrix strength means positions are co-located with other skill specialists in dedicated project teams and have project supervision from a Project Manager.

**Meeting**—A gathering of positions to communicate about the project and project tasks.

**Meeting Participant link**—A dashed grey line that links a position to a meeting, indicating that the position, or some or all of its staffing FTEs, must attend the meeting.

**Milestone**—A point in a project or program where a major business objective is completed.

**Model**—A visual representation of a program and its projects.

**Model pane**—The area of the SimVision workspace where you create the visual representation of the program or project.

**Noise**—The probability that a position is distracted from assigned tasks.

**Objects**—An umbrella term for shapes and links.

**Organization**—A group of departments that staff a program or project.

**Organization Assignment link**—A solid pink line that links an organization to a project within a program.

**Person**—In SimVision, a member of a department that staffs a position or part of a position. Although persons are represented by real persons in the client organizations, a person is still considered as an object in the SimVision model. For this reason, this Guide refers to a person as “it” and not “he” or “she.”

**PM**—Project Manager, the position that assumes overall responsibility for a project.

**Position**—An abstract group representing one or more FTEs (full-time equivalents) that performs work and processes information. In a staffed project, positions represent a person or a group of persons.
PRI (Project Risk Index)—A measure of the likelihood that components produced by a project will not be integrated at the end of the project, or that the integration will have defects. PRI is thus a measure of the success of system integration.

Primary Assignment link—A solid blue line that links a position to a task for which the position has primary responsibility, that is, the responsibility for handling exceptions.

Program—A set of related projects that share dependencies and together achieve the client’s business objectives. A program also includes the associated responsible organizations, milestones, and relationships between projects.

Project—A project represents work an organization must perform to achieve a major business milestone. The work is represented by tasks, milestones, the positions that perform tasks, meetings, and the dependencies between all these elements. While a model may contain numerous projects, it need only contain one. Each project in a model supports the goal of the program to which the project belongs.

Project exceptions—Errors that might cause rework in a driver task and all its dependent tasks.

Project Exception Rate—The probability that a subtask will fail and generate rework for failure dependent tasks. This probability is generally in the range 0.01 (low) to 0.10 (significant, but common). If the Project Exception Rate is greater than about 0.20, so much rework can be generated that the project may never finish.

Project Successor link—A solid black line that links a project to another project or to a project milestone.

Properties pane—The area of the SimVision workspace where you view and change object properties.

Resource-constrained simulation—A simulation that assumes all workers are available all the time to work on their tasks. When you set the exception probabilities to zero for a simulation, the simulated results are resource constrained and more closely match the CPM estimates than they would if real-world factors such as noise and errors were taken into account.

Revision block—An annotation object that lets you keep track of changes you make to a model. You can add a revision block to a program, project, or organization page. You can also generate a revision report of all annotated changes in the current case of the model.

Revision report—A list of revisions to the program, project, or organization that shows all revisions, their dates, author, and details about them.
**Rework**—Redoing all or part of a task. Compare with direct work.

**Rework Cost**—The predicted cost of rework, or rework volume weighted by average cost per FTE of positions that do rework.

**Rework link**—A dashed red line that links a task to a dependent task that will need rework if the driver task fails.

**Rework Volume**—The predicted time needed for all positions on a project to do the required rework.

**Scenario**—See Case.

**Secondary Assignment link**—A dashed blue line that links a position to a task for which the position has secondary responsibility. The difference between primary and secondary tasks is that exceptions arising from a secondary task must be handled by the primary responsible position.

**Seed**—An integer that indicates how the simulator will randomize aspects of the simulation. The seed value determines where the random number generator that drives the simulation starts generating values.

**Shapes**—A set of color-coded objects that represent model elements such as projects, tasks, positions, and organizations. Shapes and the links that join them are collectively referred to as objects.

**Simulator**—Software that simulates the work done by positions as they perform individual project tasks, including both planned direct work and coordination and rework.

**Simulation charts**—Charts that summarize and provide details of the simulated performance of the program and the individual modeled projects.

**Staffing Report**—A list of the positions and their staffing persons for the selected program, project, or department. The report indicates required and staffed FTEs for each position, and is an easy way to check for staffing issues and correct them.

**Subdepartment link**—A solid pink line that links a department to a subdepartment.

**Subtask**—Part of a task’s work volume that takes no longer than a day and no shorter than a minute. If a task is shorter than 20 days and longer than 20 minutes, a subtask represents 5% of the task volume. If the task is longer than 20 days, the simulator divides it into subtasks of one day. Similarly, if the task is shorter than 20 minutes, the simulator divides it into subtasks of one minute. Subtasks are also known as work items.
**Successor link**—A solid black line that links milestones and tasks.

**Supervision link**—A solid black line that links a supervisory position to its supervised position.

**Table View**—A way of viewing and editing object properties across a project or organization. Table View provides comprehensive control over properties by object type instead of per object, as in the Properties pane.

**Task**—Any work that consumes time, can generate communications or exceptions, and is required for project completion.

**Tree pane**—The area of the SimVision workspace that displays a visual hierarchy of open programs and their cases.

**VFP (Verification Failure Probability)**—The probability that an exception will be generated for a task. The VFP is calculated during simulation based on a number of factors, including noise, communication rates, and team experience.

**Wait Cost**—The cost of the cumulative time spent by positions waiting for decisions to be made. Wait cost is calculated as the average cost per FTE of waiting positions.

**Wait Volume**—A measure of the cumulative time spent by positions waiting for decisions to be made in a project.

**WBS (Work Breakdown Structure)**—A scheme for naming projects, milestones, and tasks in a program. You can sort these objects by WBS in the Gantt and statistics charts and in Table View.

**Work item**—See Subtask.

**Workspace**—The area of the application where you work, which contains the Model pane, other optional panes, and the toolbars.

**Work volume**—The predicted time that all positions on a project spend doing direct work.
Index

A

absolute milestone 29
activities. See tasks
actors. See positions
actual cost
  milestone 232
  project 103
  task 38
actual revenue
  milestone 232
  project 104
  task 38
adding
  annotations 376
  categories 272
  CSV files to a program 342
  departments 113
  hyperlinks 369
  organizations 109
  revisions to revision blocks 381
  skills 64
  tasks to a project 34
  text to a model 378
aligning objects 386
allocation of meeting participants 79
allocation of tasks 61
allocation percentage, staffing 123
angle snap 357
annotations
  adding 376
  adding hyperlinks to 369
  printing 327
  viewing 327
  visual model delineators 378
application experience
  bearing on project duration 49
  defined 413
  levels of 49
  setting for persons 118
  setting for positions 51
  and skill levels 49
Approve product phase 255
area charts, in Resource Charts 215
arranging open window icons 355
assigning tasks to positions 59
assignment layer filter 326
assignment links
  adding 62
  defined 53
  examples of secondary 202
  organization 262
  primary task 59
  secondary task 59
attendance level of meetings 80
authorizing SimVision 6
autofitting printouts 351
availability
  in Person Statistics chart 303
  in Project Resource charts 213

B

back of draw order 389
background color of objects 377
backlog
  about 196
  counteracting position 207
  filtering person 198
  filtering position 203
  in persons and positions 199
  peak on the critical path 308
  reducing 199
Backlog charts 160
backward in draw order 389
baseline case
  about 19
  checking milestone dates 139
  checking task durations 138
  defined 413
  evaluating 138
  validating 19
behavior file
  defined 413
  purpose 251
blue bars 378
blue star
  denoting subteam leader 123
bold italic text 379
bold text 379
bonus rate 30
borders
  changing on objects 390
  making transparent 390
boundaries, viewing on pages 349
boxes
  drawing 376
  filling 377
Breakdown Charts 159
breaking up tasks 200
business drivers
  adding to projects 90
  defined 413

C

calculating task work volume 43
calendar in SimVision 45
canvas 413
canvas size 354
cascading Model panes 355
Case Difference Choice dialog box 266
Case Difference Reports 266
Case Filter 310
cases
  Case Difference Reports 266
  changing properties in multiple 266
  comparing 270
  comparing summary statistics for 179
  creating 264
  defined 4
  deleting 265
  deriving from other cases 264
  description 264
  exporting to Microsoft Project 343
  filtering for the Executive Dashboard 310
  and models 20
  naming 264
  and programs 20
  renaming 265
  simulating 140
  switching between 265
  tabs for 245
  viewing financial data for 217
categories
  adding 272
  applying to objects 272
  applying to persons 118
  deleting 273
  filtering simulation data by 273
  filtering Staffing Report by 127
  overriding 271
  using 271
Center on Selection 361
centered objects 361
centralization
  defined 94
  and position backlog 96
  setting for organizations 111
  setting for programs 251
  setting for projects 96
changing
  department head 119
  subteam leader 124
Chart Bar
  moving 367
  viewing and hiding 366
chart color
  project 89
  task 38
chart icons
  reordering 367
  resizing 367
Chart Window
  customizing 366
  customizing toolbars in 367
  default display 140
  maximizing viewing space in 366
  Tree pane 146
  viewing elements in 146
charts
  changing settings to defaults 149
  color coding in 163
copying and pasting 347
Department Backlog 301
Department Gantt 301
Department Resource 301
described 163
Detailed Case Comparison 316
Executive Dashboard 310
Executive Multi-Project Report 311
filtering data by category 273
filtering data in 148
FRI and PRI values in 152
introduced 13
matching settings 149
Organization Backlog 295
Organization Gantt 295
Organization Statistics 290
Person Backlog 306
Person Gantt 306
Person Resource 306
Position Backlog 240
Position Gantt 239
Position Resource 239
printing 351
program 276
Program Cost Breakdown 281
Program Gantt 277
Program Performance 313
Project Person Backlog 197
Project Resource 208
Project Schedule Growth 181
Project Work Breakdown 186
Project’s Financial Statistics 229
Project’s Resource Statistics 228
resetting defaults 149
Risk Measures 315
saving as Web site 337
saving as XML files 347
setting defaults in 149
sorting columns in 221
Statistics Charts 221
truncated names in 198
viewing in other applications 346
viewing with the Chart Bar 366
viewing with the Create menu 366
checkboxes, in Properties pane 373
circles
drawing 376
closed locks 86
about 248
closing program windows 355
color
drawing 376
of links 53
of positions in charts 204
of tasks 38
setting background 390
setting for grid 358
setting foreground 390
text 378
color coding
in Executive Dashboard charts 311
in simulation charts 163
color coding models 328
columns in Gantt Chart 165
communication risk
analyzing 192
defined 152
Program Summary Statistics chart 279
Project Summary Statistics chart 179
reducing 193
summary for program 290
summary for task 237
communications links
adding 75
and the formalization setting 96
checking for tasks 185
defined 53
Communications Risk chart 192
compact logos, adding 362
Compare Date 165
comparing
case statistics 179
case summary statistics 177
cases 270
completion date 172
completion date goal 308
complexity of tasks 36
Component Quality Index. See FRI
Concur product phase 255
connectors. See ghosts.
context-sensitive help 15
cooordinating parallel tasks 175
coordination risk
analyzing for projects 195
defined 152
Coordination Risk chart 282
coordination volume 414
coordination, defined 73, 414
Copy Data
in Gantt chart 342
in Table View 334
Copy to Print option 327
Copy to View option 327
copying
Executive Dashboard charts 318
Gantt charts 347
projects 26
simulation charts 347
corrected exceptions 237
cost 103
balancing with resources 242
calculating for tasks 187
cost rate 103
fixed cost 103
labor vs nonlabor 103
simulated program nonlabor 278
simulated project nonlabor 178
total program 278
total project 178
total work for program 278
total work for project 178
Cost Breakdown chart 187
cost data
as program goal 308
project 217
CPM
defined 414
results 152
CPM durations
defined 138
in Gantt chart 164
turning on in the Gantt chart 171
CQI. See FRI
Create menu 366
creating
cases 264
multiple objects 27
programs 21
projects 24
toolbars 359
creating projects 24
critical path
changing highlight width 361
defined 414
explained 150
viewing in a project 151
viewing in Gantt chart 171
critical path tasks
defined 174
showing slack time 174
criticality
in the Gantt Chart 167
project 222
CSV files
defined 414
merging data from 342
saving simulation data in 339
time stepped data in 340
CTRL key when moving windows 354
culture of organizations 94
custom backlog filter
persons 198
positions 203
customizing
   Chart Window toolbars 367
   the Chart Window 366
   workspace toolbars 358

D

dashed lines in printouts 349
data blocks 363
decision wait time
   defined 73
   explained 51
   reducing 188
Default Grid On option 358
default properties, setting 364
default settings in charts 149
Default Show Grid 361
Default Snap to Grid 361
default subteam leader 123
defining
   organizations 108
   persons 117
   positions 45
   requirements 16
   tasks 33
deleting
   cases 265
   categories 273
custom toolbars 360
departments 114
hyperlinks 371
meetings 79
milestones 29
organizations 110
persons from positions 124
positions 47
skills 65
tasks 35
Demo version of SimVision 6
Department Backlog chart 301
Department Gantt chart 301
department head
   defined 414
   designating 113
Department Resource charts 301
departments
   adding description 114
   adding persons to 118
   changing department head 119
   creating 113
   defining 113
   deleting 114
   moving 114
   naming 113
Person Stats chart 303
Persons Work Report 304
resource charts for 301
resource demand for 301
salary escalators for 114
Staffing Report 126
statistics chart 302
dependent tasks 68
deriving cases 264
descriptions
   case 264
direct work, defined 73
Display Non-Critical Simulator Warnings 361
displaying toolbars 358
distributing objects 387
docking panes and toolbars 366
downloading SimVision 5
draw order 389
drawing
   boxes 376
circles 376
ellipses 376
lines 376
orthogonal lines 376
squares 376
driver tasks 68
duration
   CPM 152
meetings 80
simulated 152
simulated project 178

E

editing a position’s skill set 65
editing the program skill set 64
Educational version of SimVision 6
ellipses
drawing 376
filling 377
end date
  Gantt chart 171
  Person Backlog chart 206
  Project Resource charts 215
end lag for meetings 81
ePM logo, replacing 362
ePM Results XML files 347
equal height for objects 387
equal width for objects 387
errors
displaying noncritical 361
fixing simulation 141
list of simulation 400
See also exceptions
  simulation 140
Errors dialog 141
escalators
  about 93
  for departments 114
  for organizations 111
  for persons 118
  for programs 251
  for projects 93
estimating work volume 40
evaluating the baseline case 138
exception handling, defined 73
exception-handling hierarchy 58
exceptions
defined 415
functional 71
ignoring 72
project 71
quick fixing 72
reworked 72

Executive Dashboard
color coding in charts 311
copying charts 318
crosshatched bars 313
filtering cases for 310
FTE months in charts 312
Go signs 310
modifying program goals in 319
printing charts 317
refreshing 319
saving charts in other formats 318
setting program goals for 308
simulation charts 310
Stop signs 310
using 308
Executive Multi-Project Report
  FTE months in 312
  using 311
  viewing project data in 313
experience, setting for positions 49
exporting
case data to spreadsheets 339
cases to Microsoft Project 343
VPX files 339

F

F1 key for help 15
failure dependency links. See rework links
failure dependency, defined 71
fast-tracking tasks 176
filling
  boxes and ellipses 377
  objects 390
filtering
cases 310
data in charts 148
layers 325
person backlogs 198
position backlogs 203
Finance Charts 160
financial data
analyzer 216
by case 217
for all project tasks 217
for individual tasks 233
Index

setting currency scale for 220
setting time period of 220

Financial Statistics chart
  program 292
  project 229

Find Person 135

Finish milestone
  program 246
  project 27

Finish-Finish successor links 56
Finish-Start successor links 56
first meeting 80
fixed cost of tasks 37
fixing simulation errors 141
float time
  defined 169
  displayed 167
  viewing in Gantt chart 171
fonts 378
foreground color of objects 377
formalization
  and task VFP 97
  defined 94
  setting for organizations 111
  setting for programs 251
  setting for projects 96
forms
  organization information 398
  program information 394
  project information 395
Formulate product phase 255
forward in draw order 389
forward rework 69
frequency of meetings 80
FRI
  defined 153
  in Project FRI chart 190, 191
  in Project Summary Statistics chart 179, 278
FRI chart
  for projects 190
FRI values
  calculating 152
  defined 415
  in Project summary chart 289
front of draw order 389
FTE months 312
FTE value
  defined 415
  in Project Resource Charts 213
  of positions and persons 123
  removing from positions 175
  setting for Meeting Participant link 79
  setting for persons 118
  setting slack for managers 207
  and task allocation 61
functional error probability 101
  setting for programs 251
  setting for projects 101
functional exceptions 71
functional risk index
  defined 153
  in Project Summary Statistics chart 179, 278

G

Gantt chart
  about 158
  analyzing task durations 164
  columns in 165
  completion date 172
  copying 347
  copying into a spreadsheet 342
  displaying 171
  explained 167
  program vs project 164
  selecting time period 171
  specifying start and end dates 171
  viewing CPM durations 171
getting help
  context-sensitive 15
  online User Guide 14
  printable User Guide 14
ghost links 257, 325
ghost milestones
  adding 260
  defined 415
  meetings relative to 80
  using 257
ghost tasks
  adding 260
  defined 415
using 257
ghosts
  viewing in Project Dependency Reports 261
Go signs 310
Go to Person button 135
goals
  modifying in Executive Dashboard 319
goals, setting program 308
grayed out object names 260
grid
  color 358
  hiding in new workspaces 357
  hiding on current page 357
  setting properties 358
  snapping to 357
  spacing 358
  turning off for new models 361
grouping objects 388
growth of task duration 184
growth risk, calculating 181

H
hatch patterns 390
height
  canvas 354
Help command 14
hiding
  Chart Bar 366
  Chart Window toolbars 358
  Chart Window Tree View 366
Highlight Assignments 361
highlight critical path
  changing highlight width 361
Highlight Critical Path Options 361
hyperlinks
  adding to meetings 81
  adding to milestones 30
  adding to objects 369
  adding to organizations 111
  adding to persons 118
  adding to programs 251
  adding to revision blocks 381
  adding to tasks 38
  deleting 371
  number of displayed 360
within cases 369
I
icons
  reordering for charts 367
  resizing for charts 367
icons, changing 363
IDs, of objects 265
ignoring exceptions 72
images
  adding to cases 379
  moving 379
  resizing 379
  saving the Chart Window as 368
importing
  data from Microsoft Project 343
  from older versions of SimVision 339
  VPX files 339
information exchange
  modeling 68
  and team experience 95
information exchange probability
  and formalization 96
  setting for programs 251
  setting for projects 99
Inherit person property 118
installing SimVision 5
interdependent tasks 68
interface tour 7
italic text 379

J
JPEG files
  adding to cases 379

L
labels
  changing text properties 363
text 363
lag
  between milestones and meetings 77
  between tasks 56
defined 415
in successor links 56
milestone 30
setting for project successor links 254
setting for successor links 58
Landscape orientation 349
last meeting in a series 81
layers
ingedit objects on hidden 328
filtering 325
link 325
printing 327
shape 325
using 324
leader of subteams 123
learning SimVision 15
legends
ingadding default 362
ingadding to models 384
defined 415
line charts, in Resource Charts 215
lines
ingdrawing 376
setting properties 376
link layers 325
linking
projects in programs 253
tasks and milestones 56
linking tasks and milestones 56
links
adding text 11
adding with right-click menu 54
changing appearance of 391
colors of 53
communications 75
defined 5
meeting participant 78
organization assignment 262
project successor 253
reshaping 385
rework 68
subdepartment 116
Table View of 329
types of 53
Load Set option 364
locating simulation errors 141
locked properties 86
Categories 271
in templates 373
organization 110
locking properties 248
locks
locking and unlocking 249
on program properties 249
on properties 86
using with categories 271
logos, adding 362
M
manual feed when printing 349
margins
setting print 350
Match To 149
matching chart settings 149
matching skills 121
matrix strength
defined 95
setting for organizations 111
setting for programs 251
setting for projects 98
Max. Duration property 41
maximizing open window icons 355
maximum cost goal 308
maximum duration tasks 41
maximum quality risk goal 308
MDB files, importing 345
meeting participant links
assigning 78
defined 53
meeting participant links, setting allocation value of 80
meeting participants
setting FTE values for 79
meeting risk
analyzing for projects 194
defined 152
in Gantt charts 166
in Program Summary Statistics chart 279
in Project Summary Statistics chart 179
meetings
adding hyperlinks 81
adding to a project 78
adding to layers 77
assigning participants to 79
attendance level of 80
defined 77
deleting 79
determining who attends 79
duration 80
duration lag 81
frequency 80
last meeting 81
moving 79
negative effects 77
positive effects 77
properties 80
relative to ghost milestones 80
renaming 78
repeating 80
schedule till 81
setting first in a series 80
setting priority 80
setting properties 81
start lag 80
start time 80
statistics chart 237
time lag 77
merging CSV files 342
Microsoft Access Database files, importing 345
Microsoft Excel
exporting Table View data to 333
viewing simulation results in 339
Microsoft PowerPoint, viewing simulation results in 346
Microsoft Project
exporting SimVision cases to 343
importing data from 343
Microsoft Word, viewing simulation results in 346
milestone
cost statistics 232
planned date 232
work volume statistics 232
milestones
absolute vs relative 29
adding hyperlinks 30
associating products with 257
bonus rate 30
categories 30
checking for the baseline case 139
checking precedence relationships 139
defined 416
defining 27
deleting 29
Finish program 246
Finish project 27
lag time 29, 30
linking with successor links 56
moving 29
naming 30
penalty rate 30
placing in the Model pane 27
planned date 29
program 246
renaming 29
setting planned date 30
setting properties 30
Start program 246
Start project 27
statistics chart 232
summary chart 290
WBS 30
minimum revenue goal 308
mismatched skills, fixing 133
model layers 324
model legends
adding 384
adding default 362
Model pane
defined 416
viewing multiple 355
viewing projects in 22
models
adding revision blocks to 381
blue bars in 378
and cases 20
color coding 328
creating from templates 375
defined 20
importing from Microsoft Project 343
navigating complex 24
and programs 20
re-laying out 323
validating 19
Most Recently Used file list 360
moving
departments 114
meetings 79
milestones 29
objects 385
organizations 109
positions 46
tasks 35
MPX files. See Microsoft Project.
multi page printing 348
Multi-Case Edit dialog box 266

N
naming
cases 264
departments 113
positions 46
programs 246
projects 25
tasks 35
naming objects 11
naming projects 88
Navigate menu, use of 20
navigating complex models
using the Tree Pane 24
new model options 362
noise 416
noise probability
setting for programs 251
setting for projects 100
noncritical warnings, displaying 361
nonlabor costs
simulated program 278
simulated project 178
normal work day 88
normal work week 89
normalizing schedule growth 183
nudging objects 385

O
object labels 11
object properties, setting defaults 364
objects
aligning 386
changing appearance 389
changing appearance of 363
changing borders 390
creating multiple 27
defined 5
distributing 387
filling 390
giving equal height 387
giving equal width 387
grouping 388
making the same size 387
moving 385
nudging 385
ordering 389
resizing 385
selecting by type 328
setting unique IDs 265
ungrouping 388
online Help system 14
open locks 86, 248
open window icons
arranging 355
maximizing 355
restoring 355
opening CSV files 339
options
model 362
setting 360
symbol 363
view 361
ordering objects 389
organization assignment links, defined 53
Organization Backlog chart 295
Organization Gantt chart 295
organization layer filter 326
Organization Resource Charts 295
Organization Statistics chart 290
organizational culture 94
organizations
adding 109
adding hyperlinks to 111
adding subdepartments 116
assigning to projects 262
centralization 111
defined 416
defining 108
deleting 110
formalization 111
gathering information for 398
matrix strength 111
moving 109
person backlog for 198
Persons Work Report 299
properties 110
renaming 109
reordering tabs 110
resource charts for 295
resource demand for 295
setting salary escalators for 111
statistics chart 296
summary chart 290
tab color 245
Table View of 329
orientation
changing page 349
orphaned object labels 11
orthogonal lines
drawing 376
overriding properties 86, 248
P
page boundaries 349
page orientation 349
page setup for printing 348
panes 4
about 7
docking and undocking 366
panning 322
paper size 348
paper tray 349
parallel tasks
coordinating 175
making from sequential tasks 176
participants
assigning to meetings 79
pasting simulation charts 347
patterns
assigning to lines 376
filling objects with 377
filling text boxes with 379
peak backlog goal 308
penalty rate 30
percentage
of person staffing position 123
task allocation 61
zoom 322
person backlog
compared to position backlog 199
reducing 199
Person Backlog chart 306
analyzing 197
rescaling axes in 206
viewing for departments 198
viewing for organizations 198
viewing for persons 198
viewing for projects 198
Person Gantt chart 306
Person List dialog box 117
Person Resource charts 306
Person Work Reports 162
persons
adding hyperlinks to 118
adding to a department 118
application experience 118
availability 303
checking skills 186
defined 416
defining 117
deleting from positions 124
editing skill set 118
FTE value 118
Inherit property 118
and positions 46
resource charts for 306
resource demand for 306
salary 118
searching for 135
setting properties for 117
setting salary escalators for 118
skill set 118
staffing positions with 123
statistic chart 307
usage per task 228
viewing resource charts for 306
Persons Work Report
department 304
organization 299
program 291
planned milestone date 29, 30
PM. See Project Manager
Portfolio
defined 4
Portfolio version of SimVision 6
Portrait orientation 349
position backlog
analyzed 203
and centralization 96
compared to person backlog 199
counteracting 207
Position Backlog chart 240
rescaling axes in 206
Position Gantt chart 239
position of text 379
Position Resource charts 239
positions
adding 46
application experience 51
assigning tasks to 59
balancing FTE with task allocation 241
balancing skills with task requirements 242
changing skill levels of 64
checking skills 186
checking tasks for 208
color in charts 204
defined 416
defining 45
defining skill set for unstaffed 64
deleting 47
deleting persons from 124
description 47
editing skill set 65
fixing understaffed 128
moving 46
naming 46

and persons 46
properties 47
removing FTEs from 175
renaming 46
resource charts for 239
resource demand for 239
role 49
salary 47
secondary responsible 173
setting application experience 49
setting FTE value 50
staffing 123
statistics chart 240
usage per task 228
post simulation analysis 154
precedence relationships
checking for milestones 139
predecessor tasks and milestones 56
pre-project strategic planning 3
previewing
case printouts 351
closing preview window 351
PRI
defined 153
in Program Summary Statistics chart 278
in Project Summary Statistics chart 179
PRI values
calculating 152
defined 417
in Program’s Project Statistics chart 289
primary assignment links
adding 62
defined 53
primary tasks
assigning to positions 59
example of assigning 60
printing
annotations 327
autofitting pages 351
changing paper size 348
Executive Dashboard charts 317
layers 327
multi page scaling 348
on multiple pages 348
previewing 351
quick 348
setting margins 350
simulation charts 351
simulation errors 141
User Guide 14
priority
meeting 80
project 88
task 36
probabilities
functional error 101
information exchange 99
noise 100
project error 102
probability rates, setting for projects 99
process layer filter 326
process quality risk
in Communications Risk chart 192
in Milestone Statistics chart 232
in Program Summary Statistics chart 278
in Project Summary Statistics chart 179
Product FRI
in Program’s Project Statistics chart 289
Product List dialog box 256
Product PRI
in Program’s Project Statistics chart 289
product quality risk
in Communications Risk chart 192
in Milestone Statistics chart 232
in Program Summary Statistics chart 278
in Program’s Project Statistics chart 289
in Project Summary Statistics chart 179
products
adding 256
associating with existing tasks 257
calculating work volume for 255
completion phases 255
implementing 255
Program Breakdown Charts 281
program charts 163
Program Coordination Risk chart 282
program duration, simulated 278
Program Gantt Chart
analyzing 277
expanding and collapsing 277
program goals
modifying in Executive Dashboard 319
setting 308
Program Performance chart 313
Program Person Backlog chart 283
Program Resource Charts
analyzing 283
viewing 284
Program Schedule Growth chart 279
Program Statistics Chart 288
Program version of SimVision 6
Program’s Financial Statistics chart 292
Program’s Milestone Statistics chart 290
Program’s Project Statistics chart 289
Program’s Resource Statistics chart 292
programs
adding hyperlinks to 251
adding milestones 246
arranging windows 355
benefits of 244
and cases 20
closing windows 355
communication risk summary 290
copying 346
creating 21
defined 4, 244
description 250
gathering information for 394
linking projects in 253
and models 20
naming 246
properties 249
setting salary escalators for 251
simulated nonlabor costs 278
simulated total cost 278
simulated total revenue 278
simulating 276
simulation charts 276
Staffing Report 126
statistics chart 288
summary of milestones 290
summary of organizations 290
summary of projects 289
switching between 246
tab color 245
Table View of 329
  team experience 250
  total work costs 278
  viewing 245
  viewing multiple 355
  WBS 250
  WBS separator 250
Project Breakdown Charts 186
  project charts 163
Project Coordination Risk chart 195
Project Dependency Reports 261
  project duration, simulated 178
project error probability 102
  setting for programs 251
  setting for projects 102
project exception rate 417
project exceptions 71
Project Manager role 49
Project Meeting Risk chart 194
Project Person Backlog chart 197
Project Position Backlog chart
  analyzing 203
  comparing cases in 204
  viewing 204
project quality risk
  defined 152
Project Quality Risk charts
  viewing 189
Project Resource Charts
  analyzing 208
  FTE availability in 213
project risk index
  defined 153
  in Program Summary Statistics chart 278
  in Project Summary Statistics chart 179
Project Schedule Growth chart
  analyzing 181
  viewing 183
  viewing normalized 183
project successor links
  defined 53
  properties 254
  using 253
Project version of SimVision 6
Project’s Resource Statistics chart 228
projects
  adding description 88
  adding meetings 78
  adding revisions to 91
  assigning organizations to 262
  blue bars in 378
  chart color 89
  copying 26
  creating 24
  criticality 222
  defined 4
  deleting 26
  deleting revisions from 91
  financial data 217
  gathering information for 395
  linking within a program 253
  naming 25, 88
  priority 88
  relocking properties 249
  renaming the default 25
Revision Reports 91
  setting business drivers 90
  setting centralization 96
  setting formalization 96
  setting matrix strength 98
  setting normal work day 88
  setting normal work week 89
  setting probability rates 99
  setting properties 86
  setting property overrides 249
  setting salary escalators 93
  sharing 346
  simulated nonlabor costs 178
  simulated total cost 178
  simulated total revenue 178
  staffing 107
  Staffing Report 126
  summary chart 289
  switching between 245, 254
  tab color 245
Table View of 329
  total work costs 178
  WBS 89
properties
changing in multiple cases 266
changing multiple 332
grid 358
locking and unlocking 86, 248
meeting 81
milestone 30
object 363, 389
of fills 377
of lines 376
organization 110
overriding 86
overriding program 248
person 117
position 47
program 249
project successor link 254
purple 123
resetting chart defaults 149
setting defaults 364
successor link 57
Table View 328
task 36
text 378
Properties pane
 checkboxes in 373
docking and undocking 366
ertering multiple text lines 8
grayed out object names 260
hiding 354
purple properties 123
using 8
property locks 248
property overrides
 returning to default values 249
purple properties 123
Q
quality risk
 as program goal 308
 reducing 190
Quality Risk charts 159
quick fixing exceptions 72
R
reading CSV files 339
red arrows 400
red arrows on links 53
red links between projects 257
reducing
 communication risk 193
decision wait time 188
person backlog 199
quality risk 190
slack time 174
task cost 188
reference milestones 260
reference tasks 260
refreshing the Executive Dashboard 319
relative milestone 29
re-layout 323
re-layout of a model 323
relocking project properties 249
renaming
 cases 265
 meetings 78
 milestones 29
 organizations 109
 positions 46
 tasks 35
reordering tabs 245
repeating meetings 80
 reports
 Case Difference 266
 Program Revision 251
 Project Dependency 261
 Project Revision 91
 Staffing 126
required program goals 308
requirement complexity of tasks 36
requirements, defining 16
Reset Properties 149
Reset to Defaults 359
Reset to Factory Defaults option 364
resizing
 chart icons 367
 objects 385
 windows 366
Resource Charts
about 160
line charts in 215
rescaling axes in 215
resource availability in 213
setting dates in 215
staffed and unstaffed positions in 210
viewing for departments 301
viewing for organizations 295
viewing for persons 306
viewing for positions 239
viewing for projects 208
resource demand and utilization 208
Resource Statistics chart
program 292
project 228
Resource Utilization chart
viewing for programs 283
resources, balancing with cost 242
restoring open window icons 355
Retain Property Pane Settings 361
Retain Table View Settings 361
revenue data
as program goal 308
project 217
total program simulated 278
total project simulated 178
revision blocks
adding 381
adding hyperlinks to 381
adding revisions to 382
versus Revision Reports 381
Revision Reports
generating 384
program 251
project 91
versus revision blocks 381
Revision Reports, generating 384
revisions
adding to organizations 111
adding to programs 251
adding to projects 91
rework
defined 73
example 69
forward 69
link strength 75
understanding 68
rework cost 418
rework links
adding 68
checking for tasks 185
defined 53
setting strength 75
rework volume 418
reworking exceptions 72
right-click menu, for adding links 54
Risk Measures chart 315
risk metrics 152
roles
of positions 49
Project Manager 49
Subteam 49
Subteam Leader 49
Rubber Stamp tool 27
running simulations
all cases 140
baseline case 143
S
salary
escalators for departments 114
escalators for organizations 111
escalators for persons 118
escalators for programs 251
escalators for projects 93
person 118
position 47
same height for objects 387
same width for objects 387
Save All charts 337
Save Now 359
Save on Exit 359
Save Set option 364
Save Settings to Default 149
saving Chart Window views 368
saving toolbars
immediately 359
on exit 359
scaling models when printing 348
scenarios. See cases
Schedule Growth charts 159
secondary assignment links
  adding 63
  defined 53
  examples of using 202
  reducing backlog 200
  and task durations 173
secondary tasks
  assigning to positions 59
  example of assigning 60
seed 250
selecting objects in Table View 330
selections
  by model element type 328
  viewing 322
sequential tasks 176
serial number 6
Set as Defaults 149
Set Path Width 361
Set Scales 220
Set Unique ID 265
setting print margins 350
setting program goals 308
shape layers 325
shapes
  about 9
  adding hyperlinks to 369
  adding text 11
  defined 5
  Table View of 329
toolbars 9
sharing projects 346
Shift key
  drawing circles 376
  drawing orthogonal lines 376
  drawing squares 376
Show Fully Staffed 128
simulated duration 152
simulated program duration 278
simulated project duration 178
simulating
  programs 276
  project cases 157
simulation analysis report 154

simulation charts
  autofitting pages 351
  copying and pasting 347
  Department Backlog 301
  Department Gantt 301
  Department Resource 301
described 163
displaying Chart Bar 366
  filtering data by category 273
  filtering data in 148
  FRI and PRI values 152
  introduced 13
  matching settings 149
Organization Backlog 295
Organization Gantt 295
Organization Statistics 290
Person Backlog 306
Person Gantt 306
Person Resource 306
Position Backlog 240
Position Gantt 239
Position Resource 239
printing 351
program 276
Program Cost Breakdown 281
Program Gantt 277
Program Person Backlog 283
Program Persons Work Report 291
Program Resource Charts 283
Program Schedule Growth 279
Program Statistics Chart 288
Program Work Breakdown 281
Program’s Financial Statistics 292
Program’s Milestone Statistics 290
Program’s Project Statistics 289
Program’s Resource Statistics 292
project and program 163
Project Communication Risk 192
Project Coordination Risk 195
Project Cost Breakdown 186
Project Functional Risk Index 190, 191
Project Meeting Risk 194
Project Person Backlog 197
Project Resource 208
Project Schedule Growth 181
Project Work Breakdown 186
Project’s Financial Statistics 229
Project’s Resource Statistics 228
resetting defaults 149
saving as XML files 347
saving views of 368
sorting columns in 221
Statistics Charts 221
viewing 146
viewing in Microsoft PowerPoint 346
viewing in Microsoft Word 346
viewing in spreadsheets 339
simulation errors
baseline case 140
displaying noncritical 361
fixing 141, 400
troubleshooting using layers 324
simulation warnings 140
simulator
behavior file 251
defined 4
seed 250
setting number of trials 250
trials 250
SimVision
calendar 45
tutorials 15
versions in this release 6
size
setting for canvas 354
size of text 379
skill levels
and application experience 49
changing for unstaffed positions 64
defining for unstaffed positions 64
skill mismatches
checking for staffed positions 186
checking for unstaffed positions 186
fixing 133
skill set
defining for persons 118
defining for unstaffed positions 64
editing for persons 118
editing for positions 65
skills
adding to a project 64
balancing person and position 121
deleting 65
for tasks 36
matching person with task 121
SL. See Subteam Leader role
slack time
for managers 207
in critical path tasks 174
reducing 174
snap
to angles 357
to grid 357
snap to grid
turning off 361
solution complexity of tasks 37
sorting in Table View 330
splitting tasks 200
spreadsheets
viewing simulation results in 339
viewing Table View data in 333
squares
drawing 376
ST. See Subteam role
staffing
about 107
assigning subteam leaders 124
by percentage 123
dialog box 121
positions 123
Staffing Report
filtering by category 127
filtering by task category 127
Goto button 129
reading 126
Show Fully Staffed option 128
using to fix skill mismatches 133
using to staff positions 128
staffing understaffed positions 128
standard deviation
viewing for program coordination risk 282
viewing for summary statistics 179
Standard toolbar
hiding 354
star
denoting subteam leader 123
start date
Gantt chart 171
Person Backlog chart 206
Project Resource charts 215
start lag of meetings 80
Start milestone
program 246
project 27
start time of meetings 80
Start-Start successor links 56
statistics
comparing case summaries 179
Statistics Charts 161
statistics charts
department 302
department Person Stats 303
department Persons Work Report 304
meeting 237
milestone 232
organization 296
organization’s Persons Work Report 299
person 307
position 240
program 288
saved as Web pages 337
sorting columns in 221
subdepartment 302
subdepartment Person Stats 303
subdepartment Persons Work Report 304
task 235
Status Bar
hiding 354
Stop signs 310
strategic planning 3
strength of rework links 75
strike-out text 379
style of lines 376
subdepartment links
defined 53
using 116
subdepartments
defining 116
linking to departments 116
Person Stats chart 303
Persons Work Report 304
statistics chart 302
subtasks 99
subteam leader
assigning 124
changing 124
default 123
Subteam Leader role 49
Subteam role 49
subteams, defined 123
successor links 56
adding 57
defined 53
Finish-Finish 56
Finish-Start 56
lag 56
linking
tasks and milestones 56
placing 57
properties 57
setting lag 58
Start-Start 56
successor tasks and milestones 56
summary of projects 289
summary statistics
program 278
project 177
Summary Statistics charts 159
supervision links
assigning to positions 58
defined 53
supervision structure 58
supervisory tasks 42
Support product phase 255
SVD files 364
switching between cases 265
switching between programs 246
switching between projects 245, 254
symbols
changing appearance of 363
system requirements 5
T
Table View
displaying 329
Index

editing hidden layer objects 328
example of changing multiple properties 335
example of changing single property 334
exporting data from 333
grayed out object names 260
modifying default behavior 361
purple properties 123
selecting objects in 330
setting multiple properties in 332
sorting object subsets 330
sorting objects in 330
switching between objects 329
tabs in 329
using 328
tabs
case 264
organization 109
program 21
reordering 245
reordering organization 110
task allocation
balancing with position FTE 241
refining 61
setting for the baseline case 61
using to alleviate position backlog 207
task cost, reducing 188
task duration
and work volume 39
task durations
analyzing in Gantt chart 164
calculating 173
checking in the baseline case 138
task requirements, balancing with position skills 242
task work type
Max Duration 41
setting 38
Supervisory 42
Work Duration 41
Work Volume 40
tasks
adding descriptions 38
adding hyperlinks 38
adding to a project 34
allocation percentage 61
assigning to positions 59
associating products with 257
calculating work volume 43
categories 38
chart color 38
checking communications links 185
checking rework links 185
connecting with rework links 73
cost data 217, 233
cost statistics 235
critical path 174
defined 419
defining 33
deleting 35
dependent 68
driver 68
dependent 68
driver 68
examples of assigning secondary 202
fast-tracking 176
fixed cost 37
interdependence 68
lags 33
linking with successor links 56
making parallel 176
maximum duration 41
moving 35
naming 35
parallel 33, 34
primary 59
priority 36
properties 36
reasons for growth 184
reducing FTE value of 175
renaming 35
requirement complexity 36
revenue data 217, 233
right-clicking to center in Model pane 24
secondary 59
setting properties 38
setting work type 38
skills 36
solution complexity 37
splitting 200
statistics chart 235
supervisory 42
time lags 34
uncertainty 77
understanding 33, 34
variable duration 40
WBS 38
weekends included in 39
work type 39
work volume statistics 235
team experience
defined 94
setting for programs 250
Template Mode 373
Template Wizard 375
templates
clearing template data 374
creating 373
creating models from 375
using 372
text
adding to models 378
adding to shapes and links 11
changing font 378
changing style in objects 390
entering in Properties pane 8
in labels 363
italicizing 379
making bold 379
making bold italic 379
setting color 378
setting properties 378
setting size 378
striking out 379
underlining 379
viewing position 379
viewing size 379
text report of simulation 154
tiling Model panes 355
time lag
between milestones 30
between milestones and meetings 77
between tasks 56
setting for project successor links 254
setting for successor links 58
time stepped data 340
toolbars
creating 359
customizing Chart Window 367
customizing workspace 358
deleting custom 360
described 14
docking and undocking 366
resetting to default 359
shape 9
tools
adding to toolbars 359
total costs
simulated program 278
simulated project 178
total revenue
simulated program 278
simulated project 178	
tour of interface 7
training 15
transparent borders on objects 390
transparent lines 376
Tree pane
defined 419
docking and undocking 366
hiding 354
in Chart Window 146
viewing programs in 245
Tree View
Chart Window 366
trials 250
troubleshooting simulation 400
tutorials, using 15

U

certainty of tasks 77
underlining text 379
understaffed positions 128
undocking panes and toolbars 366
ungrouping objects 388
unique IDs for objects 265
unlocked properties 86
Categories 271
explained 248
unlocking properties 249
upgrading SimVision 5
User Guide 14
Index

V

validating a model 19
Validation. See validating
variable duration tasks 40
Verification Failure Probability
and formalization 97
and forward rework 69
and rework 68
correcting problems with 71
defined 419
explained 70
versions of SimVision 6
VFP. See Verification Failure Probability.
Viewer version of SimVision 6
viewing
annotations 327
Chart Bar 366
Chart Window Tree View 366
layers 324
open programs 355
programs 245
selected objects 322
simulation charts 146
viewing the critical path 151
VPM files. See workspace files.
VPX files
opening 339
saving as 339
VRX files 347

W

wait cost 51
wait time 73
wait volume 51
warnings during simulation 140
WBS
in Gantt Chart 165
milestone 30
program 250
project 89
separator 250
task 38
Web site, saving charts as 337
weekends, included in task work volume 39
width
canvas 354
line 376
windows
Chart Window 368
docking 366
resizing 366
Work Breakdown chart
analyzing 187
work day
setting for programs 251
setting for projects 88
work items 99
Work Report
program persons 291
work type 236
work units 236
work value 236
work volume
and task duration 39
calculating 43
calendar for calculating 45
defined 419
estimating 40
explained 39
weekends included in 39
Work Volume Calculator
docking 354
moving 354
using 43
Work Volume property 40
work week
setting for programs 251
setting for projects 89
workspace
defined 419
displaying elements 354
saving as VPX files 339
saving copies of 366
startup models in 363
workspace files
naming 246
saving 246
sharing 346
worst backlog date
  Person Statistics chart 307
  Position Statistics chart 240
worst task
  Person Statistics chart 307
  Position Statistics chart 240

XML files, saving charts as 347

zooming
  the Model pane 322
  the print preview 351